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1 Getting Started

Curve Fitting Toolbox Product Overview

In this section...

“Product Overview” on page 1-2
“Key Features” on page 1-2

“Interactive and Programmatic Environments” on page 1-3

Product Overview

Curve Fitting Toolbox™ provides graphical tools and command-line functions
for fitting curves and surfaces to data. The toolbox lets you perform
exploratory data analysis, preprocess and post-process data, compare
candidate models, and remove outliers. You can conduct regression analysis
using the library of linear and nonlinear models provided or specify your
own custom equations. The library provides optimized solver parameters
and starting conditions to improve the quality of your fits. The toolbox also
supports nonparametric modeling techniques, such as splines, interpolation,
and smoothing.

After creating a fit, you can apply a variety of post-processing methods for
plotting, interpolation and extrapolation; estimating confidence intervals; and
calculating integrals and derivatives.

Key Features

¢ Graphical tools for curve and surface fitting
¢ Linear and nonlinear regression with custom equations

e Library of regression models with optimized starting points and solver
parameters

® Interpolation methods, including B-splines, thin plate splines, and
tensor-product splines

® Smoothing techniques, including smoothing splines, localized regression,
Savitsky-Golay filters, and moving averages

® Preprocessing routines, including outlier removal and sectioning, scaling,
and weighting data
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® Post-processing routines, including interpolation, extrapolation, confidence
intervals, integrals and derivatives

Interactive and Programmatic Environments

Curve Fitting Toolbox software allows you to work in two different
environments:

® An interactive environment, with Surface Fitting Tool, Curve Fitting Tool
and Spline Tool graphical user interfaces

® A programmatic environment that allows you to write object-oriented
MATLAB® code using curve and surface fitting methods

To open Curve Fitting Tool, Surface Fitting Tool, or Spline Tool, enter one
of the following:

e cftool
e sftool

® splinetool

To list the Curve Fitting Toolbox functions for use in MATLAB programming,
type

help curvefit

The code for any function can be opened in the MATLAB Editor by typing

edit function_name

Brief, command line help for any function is available by typing

help function_name

Complete documentation for any function is available by typing

doc function_name

You can change the way any toolbox function works by copying and renaming
its file, examining your copy in the editor, and then modifying it.

1-3
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You can also extend the toolbox by adding your own files, or by using your
code in combination with functions from other toolboxes, such as Statistics
Toolbox™ or Optimization Toolbox™ software.


http://www.mathworks.com/products/statistics/
http://www.mathworks.com/products/statistics/
http://www.mathworks.com/products/optimization/

Curve Fitting

Curve Fitting

Interactive Curve Fitting
To interactively fit curves, see the following sections:

1 “Interactive Curve Fitting Example” on page 2-2
2 “Preprocessing Data” on page 2-22
3 “Fitting Data” on page 2-48

Programmatic Curve Fitting

To programmatically fit curves, see these sections in Programmatic Curve
and Surface Fitting:

1 “Introducing Programmatic Curve Fitting” on page 4-2
2 “Curve Fitting Objects and Methods” on page 4-9

3 “Generating Code From Curve Fitting Tool” on page 4-30
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Surface Fitting

Interactive Surface Fitting

To interactively fit surfaces, see Chapter 3, “Interactive Surface Fitting” for
information on the following topics:

1 Fitting a surface

2 Selecting fit settings

3 Fitting multiple surfaces

4 Comparing surface fits

5 Generating code files and exporting fits to the workspace

6 “Interactive Surface Fitting Examples” on page 3-12

Programmatic Surface Fitting

To programmatically fit surfaces, see the following topics:

1 “Introducing Programmatic Surface Fitting” on page 3-45

2 “Surface Fitting Objects and Methods” on page 4-41



Spline Fitting

Spline Fitting

In this section...

“Interactive Spline Fitting” on page 1-7
“Programmatic Spline Fitting” on page 1-7

Interactive Spline Fitting

You can access all spline functions from the splinetool GUIL
See “Introducing Spline Fitting” on page 6-2.
Programmatic Spline Fitting

To programmatically fit splines, see:

e List of Spline Functions

® Guide to Spline Fitting for descriptions of types of splines and numerous
examples.
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Interactive Curve Fitting

¢ “Interactive Curve Fitting Example” on page 2-2
® “Preprocessing Data” on page 2-22

¢ “Fitting Data” on page 2-48

e “Parametric Fitting” on page 2-52

o “Creating Custom Models” on page 2-77

¢ “Nonparametric Fitting” on page 2-106



2 Interactive Curve Fitting

Interactive Curve Fitting Example

In this section...

“Opening Curve Fitting Tool” on page 2-2
“Importing Data” on page 2-3
“Interactive Curve Fitting Procedure” on page 2-5

“Analyzing the Fit” on page 2-16

“Saving Your Work” on page 2-19

Opening Curve Fitting Tool
The Curve Fitting Tool is a graphical user interface (GUI) that allows you to

® Visually explore one or more data sets and fits as scatter plots.

® Graphically evaluate the goodness of fit using residuals and prediction
bounds.

® Access additional interfaces for

= Importing, viewing, and smoothing data.

Fitting data, and comparing fits and data sets.

Marking data points to be excluded from a fit.

Selecting which fits and data sets are displayed in the tool.

Interpolating, extrapolating, differentiating, or integrating fits.

Open Curve Fitting Tool with the cftool command.

cftool



Interactive Curve Fitting Example

.} Curve Fitting Tool =] 3]

File View Tools Window Help

N =T

o IF you have thres dimensional data, try the Surface Fitting Tool x

Data | Fitting | Exclude Plotting Analysis

05 Select "Data” to begin curve fitting —

Importing Data

Before you can import data into Curve Fitting Tool, the data variables must
exist in the MATLAB workspace. For this example, the data is stored in the
MATLARB file census.mat.

load census
The workspace now contains two new variables, cdate and pop:

® cdate is a column vector containing the years 1790 to 1990 in 10-year
increments.

® pop is a column vector with the US population figures that correspond
to the years in cdate.

You can import data into Curve Fitting Tool with the Data GUI.
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2 Interactive Curve Fitting

Open the Data GUI by clicking the Data button on Curve Fitting Tool. As
shown below, the Data GUI consists of two panes: Data Sets and Smooth. The
Data Sets pane allows you to

® Import predictor (X) data, response (Y) data, and weights. If you do not
import weights, then they are assumed to be 1 for all data points.

® Specify the name of the data set.

® Preview the data.
To load cdate and pop into Curve Fitting Tool,

1 Select the variable names cdate and pop from the X Data and Y Data lists.

The data is displayed in the Preview window.

i ] |
Data Sets | Smggthl
Importworkspace vectors: - Preview
*
Select the data X Data: [caate | .
varihle names.  Data: [pap | .
Weights: {hone) - +
*
Data set name: Ipop vs, cdate .
Click Create dataset .
. Create data set *
to import the data. 4| .
*
*
Data sets: ot
*
et
B Eenarme | elete |
Close | Help |

The Smooth pane is described in “Preprocessing Data” on page 2-22.

2 Click the Create data set button to complete the data import process.
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Interactive Curve Fitting Example

3 Click Close.

Interactive Curve Fitting Procedure
You fit data with the Fitting GUI.

Open the Fitting GUI by clicking the Fitting button on Curve Fitting Tool.

The Fitting GUI consists of two parts: the Fit Editor and the Table of Fits.
The Fit Editor allows you to
® Specify the fit name, the current data set, and the exclusion rule.

e Explore various fits to the current data set using a library or custom
equation, a smoothing spline, or an interpolant.

¢ QOverride the default fit options such as the coefficient starting values.
® Compare fit results including the fitted coefficients and goodness of fit
statistics.

The Table of Fits allows you to

® Keep track of all the fits and their data sets for the current session.
® Display a summary of the fit results.

® Save or delete the fit results.

The Data Fitting Procedure

For this example, begin by fitting the census data with a second degree
polynomial. Then continue fitting the data using polynomial equations up to
sixth degree, and a single-term exponential equation.

The data fitting procedure follows these steps:
1 From the Fit Editor, click New Fit.
The new fit always defaults to a linear polynomaial fit type. Use New Fit

at the beginning of your curve fitting session, and when you are exploring
different fit types for a given data set.



2 Interactive Curve Fitting

2 To use a second degree polynomaial for the initial fit, select quadratic
polynomial from the Polynomial list. Edit the Fit name to poly2.

3 Click the Apply button or select the Immediate apply check box. The
library model, fitted coefficients, and goodness of fit statistics are displayed
in the Results area of the Fitting GUI..

The Fitting GUI is shown below with the results of fitting the census data
with a quadratic polynomial.



Interactive Curve Fitting Example

[Fitting

Fit Edfitor
Mew fit | Copy i

Ftname:  |poh?

Data set: |pq:»scd§r

:J Exchsionnie: | (nore) -

Type of itz |WTJEWH

=] Center and scale ¥ data

fcube pobynomial
dtin degres polynamis
St degree pobynamial

W= Hn Aocwac reb menmial

Fit optons...
Resuits

=
I™ Immediste gopty Cood I Loty I

FMESE: 2.G72

Linear model PolyZ:

E{x) = pl*x~2 + p2*x + p3
Coefficients (with 5% confidence bounds):
Pl = 0.006541 (D.0DE1Z4, O.0DSHSE)
Pz = -23.51 (-Z25.0%, -Z1.%3)
p3 = Z.113e+0D4 (1.964e+0D4, Z.262e+004)
Goodness of fit:
38E: 156C
R-squace: 0.%%87
Adjusted R-square: 0.¥%E&E

=100 %]

Table of Fits
@ | Ftname | Datsset | Eguatonname | 556 Rsquare |
@ palyz ve. cdate Poly2 155.023299.../0.9967 1 2%...

Delete it | Save to workspace.. | Table options.., |

_Gase | _ep |

Your new fit is plotted in Curve Fitting Tool.

The data, first fit, and residuals in Curve Fitting Tool are shown
below. Display the residuals as a line plot by selecting the menu item
View > Residuals > Line plot.
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2-8

<) Curve Fitting Tool = [O] x]
File “iew Tools WWindow Help
g ®a | @

Data... I Fitting... Exclude... Platting.. I Analysis... I

Cata and Fits
250 ' '

+  popws. cdate

200} poly2

150} -

100} -
s0f i

H ! L L L L
1800 4820 4840 1860 1880 1900 4920 1840 1860 1980

Residuals

—— poly2

These residuals indicate that
a better fit may be possible.

- = -

L L L ! L L L ! L L
1800 1820 4240 1860 1880 4900 4920  1%d0 1860 1980

The residuals indicate that a better fit may be possible. Therefore, you
should continue fitting the census data following the procedure outlined in
the beginning of this section.

1 Return to the Fitting GUI.

2 Add new fits to try the other library equations. For fits of a given type (for
example, polynomials), use Copy Fit instead of New Fit because copying
a fit retains the current fit type state thereby requiring fewer steps than
creating a new fit each time. Add polynomial fits up to the sixth degree,
and add an exponential fit.

3 For each new fit look at the Results pane information, and the residuals
plot in Curve Fitting Tool.



Interactive Curve Fitting Example

The residuals from a good fit should look random with no apparent pattern.
A pattern, such as a tendency for consecutive residuals to have the same
sign, can be an indication that a better model exists.

4 When you fit higher degree polynomials, the Results area displays this
warning:

Equation is badly conditioned. Remove repeated data points
or try centering and scaling.

When you see this warning, to normalize data, in the Fitting GUI select the
Center and scale X data check box.

The warning about scaling arises because the fitting procedure uses the cdate
values as the basis for a matrix with very large values. The spread of the
cdate values results in scaling problems. To address this problem, you can
normalize the cdate data. Normalization is a process of scaling the predictor
data to improve the accuracy of the subsequent numeric computations. A way
to normalize cdate is to center it at zero mean and scale it to unit standard
deviation. The programmatic equivalent code is:

(cdate - mean(cdate))./std(cdate)

Note Because the predictor data changes after normalizing, the values of the
fitted coefficients also change when compared to the original data. However,
the functional form of the data and the resulting goodness of fit statistics do
not change. Additionally, the data is displayed in Curve Fitting Tool using
the original scale.

Determining the Best Fit

To determine the best fit, you should examine both the graphical and
numerical fit results.

Examining the Graphical Fit Results. Your initial approach in determining

the best fit should be to examine the graphs of the fits and residuals. The
graphical fit results shown below indicate that
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¢ The fits and residuals for the polynomial equations are all similar, making
it difficult to choose the best one.

® The fit and residuals for the single-term exponential equation indicate it is
a poor fit overall. Therefore, it is a poor choice for extrapolation.

). Curve Fitting Tool M[=]E3

File “iew Tools  Window  Help

g e B

Diata... | Fittirg... | Exclude... | Plottitg... | Analysis... |

Data and Fits
T T T T T T T T T

280 - /

150 - —

100 - —

I I I I L I I L I I
1800 1820 1840 1860 1820 1900 1820 1840 1960 1980

Residuals

I I I I L I I L I I
1800 1820 1840 18460 1820 15900 1820 1540 1960 1580
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Click Plotting to open the Plotting GUI and remove exp1 from the scatter
plot display.

Drang ~i0ix

Flot data sets Plot fits

Cata set Fit Ciata set
v |pop vs. cdate v | paly2 pap ws. coate
v paly3 pop vs. coate
[l | polyd pop ws. cdate
v | palys pap ws. coate

IE ool oop v5. date Remove this fit from
& pop vs. coate

the scatter phot.

[ £lear as=ociated fits when clearing data sets:

Close I Help |

Because the goal of fitting the census data is to extrapolate the best fit to
predict future population values, you should explore the behavior of the fits
up to the year 2050. You can change the axes limits of Curve Fitting Tool by
selecting the menu item Tools > Axis Limit Control.

Alter the X Upper Limit to 2050, and increase the Y Upper Limit to 400. The
census data and fits are shown below for an upper abscissa limit of 2050. The
behavior of the sixth degree polynomial fit beyond the data range makes it a
poor choice for extrapolation.
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2-12

) Curve Fitting Tool =] 3]
File View Tools Window Help
NI
o Data... | Fitting.. | Exclude... Platting... Analysis...
i Iimn Data and Fits
400 Elann T T T T T
300
200
100+
 Lowver Limit
Yy
|:1 2187 0 ' : : :
j 1800 1850 1900 1950 2000 2050
¥ Upper Limit
— Residuals
=
5L
0 = =
ol
ETH = A0 | | | | |
j 1800 1850 1900 1950 2000 2050
1788 ﬁ I 2050 ﬂ
X Lowver Limit H Upper Limit

As you can see, you should exercise caution when extrapolating with
polynomial fits because they can diverge wildly outside the data range.

Examining the Numerical Fit Results. Because you can no longer
eliminate fits by examining them graphically, you should examine the
numerical fit results. There are two types of numerical fit results displayed
in the Fitting GUI: goodness of fit statistics and confidence intervals on the
fitted coefficients. The goodness of fit statistics help you determine how well
the curve fits the data. The confidence intervals on the coefficients determine
their accuracy.

Some goodness of fit statistics are displayed in the Results area of the Fit
Editor for a single fit. All goodness of fit statistics are displayed in the Table
of Fits for all fits, which allows for easy comparison.

In this example, the sum of squares due to error (SSE) and the adjusted
R-square statistics are used to help determine the best fit. The SSE statistic
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is the least-squares error of the fit, with a value closer to zero indicating a
better fit. The adjusted R-square statistic is generally the best indicator of the
fit quality when you add additional coefficients to your model.

You can modify the information displayed in the Table of Fits with the Table
Options GUI. You open this GUI by clicking the Table options button on
the Fitting GUI. As shown below, select the adjusted R-square statistic and
clear the R-square statistic.

J Table Options x|

Check to view column in Table of Fits:

W [@ Status I~ DFE

W Fit name W AdjR-sq
W Data set ™ RMSE

W Equation name [ # Coeff
v S5E ™ Type of fit

™ R-square

Close Help

The numerical fit results are shown below. You can click the Table of Fits
column headings to sort by statistics results.

The SSE for exp1 indicates it is a poor fit, which was already determined by
examining the fit and residuals. The lowest SSE value is associated with
poly6. However, the behavior of this fit beyond the data range makes it a
poor choice for extrapolation. The next best SSE value is associated with the
fifth degree polynomial fit, poly5, suggesting it may be the best fit. However,
the SSE and adjusted R-square values for the remaining polynomial fits are
all very close to each other. Which one should you choose?

2-13



2 Interactive Curve Fitting

i ol =
Fit Editor
hew it C-omrtl
Frrame:  fools
Cata set: |pq:»scdir _:J Exclusionmie: | (nona) _:J
Typeofit |Poymoma =] F Center and scale x datm

=
4th degree polynomial J
St degres pohyhomial
th degree pobynomial :l
Fit options... I~ Immediate apphy -.’a.--—'I Ay
Results

Linear model Poly5:
F{x) = pl*x~5 + p2=x~4 + p3*x"3 + pd*x~2 + p5*x + pé
where ¥ iz notmalized by mean 1ES0 and =td &£2.05
Coefficlients (with %3% confidence bounds):

pl = 0D.5877 ({=-Z.305, 3.48)

Pz = D.7047 ({-1.6B4, 3.D%4)

pl = -D0.%153 {-1D.1%, B.358)

pd = 23,47 (17.42, 26_52)

pa = 74,97 J(GB.37, Bl.3T)

pE = 62.23 (3%.51, 64.%3) ll
Table of Fits
B | Ftreme | Camset | Equstenname | 5E | resguee |
@ pole vE, cate  Poh 106927557999, 0. 9591 462547, .
@ ol vs.cdate  [Polyd [145.966924373... [0.9368 195642 .. |
E poh3 popve cdate o3 [142. 768724181, 0,208 78721212,
@ poky2 pop vs, cdake Pohy2 |155.0292991 76, 0.9507 1256577,

Crslerte fit | Save to workspace... | Tabie options... |

_Gose | _beb |

To resolve this issue, examine the confidence bounds for the remaining fits
in the Results pane. By default, 95% confidence bounds are calculated. You
can change this level by selecting the menu item View > Confidence Level
from Curve Fitting Tool.
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The p1, p2, and p3 coefficients for the fifth degree polynomial suggest that it
overfits the census data. However, the confidence bounds for the quadratic
fit, poly2, indicate that the fitted coefficients are known fairly accurately.
Therefore, after examining both the graphical and numerical fit results, it
appears that you should use poly2 to extrapolate the census data.

Note The fitted coefficients associated with the constant, linear, and
quadratic terms are nearly identical for each polynomial equation. However,
as the polynomial degree increases, the coefficient bounds associated with the
higher degree terms increase, which suggests overfitting.

Saving the Fit Results

By clicking the Save to workspace button, you can save the selected fit and
the associated fit results to the MATLAB workspace. The fit is saved as a
MATLAB object and the associated fit results are saved as structures. This
example saves all the fit results for the best fit, poly2.

+). Save Fit to MATLAB Workspace x|

[v Save fit to MATLAB ohject named: I;medmudeh
v Save goodness of fit to MATLAB struct named: Igandness1
Iv Save fit output to MATLAB struct named: Inutpuﬂ

QK I Cancel |

fittedmodell is saved as a Curve Fitting Toolbox cfit object.

whos fittedmodel1

Name Size Bytes Class
fittedmodel1 1x1 6178 cfit object

Grand total is 386 elements using 6178 bytes

The cfit object display includes the model, the fitted coefficients, and the
confidence bounds for the fitted coefficients.
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fittedmodel1

fittedmodell =
Linear model Poly2:
fittedmodell (x) = p1*x°2 + p2*x + p3
Coefficients (with 95% confidence bounds):

pli =  0.006541 (0.006124, 0.006958)
p2 = -23.51 (-25.09, -21.93)
p3 = 2.113e+004 (1.964e+004, 2.262e+004)

The goodness1 structure contains goodness of fit results

goodness1

goodness1 =
sse: 159.0293
rsquare: 0.9987
dfe: 18
adjrsquare: 0.9986
rmse: 2.9724

The outputi structure contains additional information associated with the fit.

outputi

outputtl =
numobs: 21
numparam: 3
residuals: [21x1 double]
Jacobian: [21x3 double]
exitflag: 1
algorithm: 'QR factorization and solve'

Analyzing the Fit

You can evaluate (interpolate or extrapolate), differentiate, or integrate a fit
over a specified data range with the Analysis GUI. You open this GUI by
clicking the Analysis button on Curve Fitting Tool.
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For this example, you will extrapolate the quadratic polynomaial fit to predict
the US population from the year 2000 to the year 2050 in 10 year increments,
and then plot both the analysis results and the data. To do this:

® Enter the appropriate MATLAB vector in the Analyze at Xi field.

e Select the Evaluate fit at Xi check box.

® Select the Plot results and Plot data set check boxes.

e (Click the Apply button.

The numerical extrapolation results are shown below.

<} Analysis =10l x|

Specil"y the fit and Fitto analyze: |polv2 (pop vs. ... 'l Hi T

- Eannananen (2000 274622
. Analyze at¥i=[2000:10:2050

data fo unu|y1e | yz 2010 30184
. ) 2020 330.334
Se|edl|1|sc|1ec|( II))( — [¥ Evaluate fit at i 2030 60,152
to extrapolate. Prediction bounds: 2040 391.279
& Mone 2050 423.714

" Forfunction
© For new observation

Level | 95 %

[ 15t derivative at Xi
[ 2nd derivative at xi

[ Integrate to Xi

& Start from ming<i

© Start fram I
Plot both the analysis { [ Plot resuits

results and the data. [ Plot data set: pop vs. cdate

Save to workspace... | Apply | — |

The extrapolated values and the census data set are displayed together in
a new figure window.
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-} Curve Fitting Analysis i =] 5]

File Edit ‘iew Insert Tools ‘window Help

[Dema rxars, 222

Analysis of fit "poly2" for dataset "pop vs. cdate”
450 T T T T

—— paly2

200 - % popve. cdate

350 - B

300 - B

280 + s i

Fit

200 - * .
150 - % i
100 * g

50t i .

b
%
§ % * 1

D 1 1 Il
1780 1800 1840 1900 1950 2000 2080

Saving the Analysis Results

By clicking the Save to workspace button, you can save the extrapolated
values as a structure to the MATLAB workspace.

+) Save Analysis Results to Workspace x|

Save analysis results to MATLAB struct named:Enalysisresultm
ke I Cancel |

The resulting structure is shown below.

analysisresultsi
analysisresultst =

xi: [6x1 double]
yfit: [6x1 double]
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Saving Your Work

Curve Fitting Toolbox software provides you with several options for saving
your work. You can save one or more fits and the associated fit results as
variables to the MATLAB workspace. You can then use this saved information
for documentation purposes, or to extend your data exploration and analysis.
In addition to saving your work to MATLAB workspace variables, you can

® “Save the Session” on page 2-19

® “Generate Code to a File” on page 2-20

Before performing any of these tasks, you may want to remove unwanted data
sets and fits from Curve Fitting Tool display. An easy way to do this is with

the Plotting GUI. The Plotting GUI shown below is configured to display only
the census data and the best fit, poly2.

<) Plotting o [=[ 9]
Flot data sets Plat fits
Data set Fit Data set

¥|pop vs. cdate [¥|poly2 popvs. cdate

||: paly3 pop vs. cdate Clear the remaining fits
polyd popvs. cdate . .

Floons e cdate associated with the census
[ |palye pop vs. cdate data except the best fit.
mETY pop vs. cdate

[ Clear associated fits when cleating data sets.

o |

Save the Session

The curve fitting session is defined as the current collection of fits for all
data sets. You may want to save your session so that you can continue data
exploration and analysis at a later time using Curve Fitting Tool without
losing any current work.

Save the current curve fitting session by selecting the menu item File > Save
Session from Curve Fitting Tool. The Save Session dialog is shown below.
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2-20

Save Session HE
Save jh: I i3 CFSessionFiles ﬂ gl
DecayRate. cfit
poly1fit.cfit
poly2it cfit
poly i, it
reaction]. cfit
reachion?. cfit
File marme: Icensus \ﬂl
Save as type: |"_cfit j Cancel |

The session is stored in binary form in a cfit file, and contains this
information:

e All data sets and associated fits

® The state of the Fitting GUI, including Table of Fits entries and exclusion
rules

e The state of the Plotting GUI

To avoid saving unwanted data sets, you should delete them from Curve
Fitting Tool. You delete data sets using the Data Sets pane of the Data GUI. If
there are fits associated with the unwanted data sets, they are deleted as well.

You can load a saved session by selecting the menu item File > Load
Session from Curve Fitting Tool. When the session is loaded, the saved state
of Curve Fitting Tool display is reproduced, and may display the data, fits,
residuals, and so on. If you open the Fitting GUI, then the loaded fits are
displayed in the Table of Fits. Select a fit from this table to continue your
curve fitting session.

Generate Code to a File

You may want to generate a file that captures your work, so that you can
continue your analysis outside of Curve Fitting Tool. You can use the file
without modification, or edit it as needed.
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To generate a text file from a session in Curve Fitting Tool, select the menu
item File > Generate Code.

The file captures the following information from Curve Fitting Tool:

e Names of variables, fits, and residuals

¢ Fit options, such as whether the data should be normalized, initial values
for the coefficients, and the fitting method

e Curve fitting objects and methods used to create the fit
You can recreate your Curve Fitting Tool session by calling the file from the
command line with your original data as input arguments. You can also call

the file with new data, and automate the process of fitting multiple data sets.

For more information on working with a generated file, see “Generating Code
From Curve Fitting Tool” on page 4-30.
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Preprocessing Data

2-22

In this section...

“Importing Data” on page 2-22

“Viewing Data” on page 2-26

“Smoothing Data” on page 2-29

“Excluding and Sectioning Data” on page 2-37

“Missing Values and Outliers” on page 2-47

Importing Data

¢ “Introduction” on page 2-22

e “Creating a Data Set” on page 2-23

¢ “Working with Data Sets” on page 2-24
¢ “Example: Importing Data” on page 2-24

Introduction

You import data sets into Curve Fitting Tool with the Data Sets pane of the
Data GUI. Using this pane, you can

® Select workspace variables that compose a data set
¢ Display a list of all imported data sets

® View, delete, or rename one or more data sets

The Data Sets pane is shown below followed by a description of its features.
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[Data Sefs | smoon|

[ Import workspace vectors: Preview
H Data: (hone) ¥ or a single ¥ vectar.
Y Data: nang hd
(onstruct and (none}
Weights: (hone) hd

name the data set. ™|

Data setname: I

Data gets

Data sets list —]

Select® and Y vectors of equal length,

=0l x|

Cloge | Help |

Creating a Data Set

¢ Import workspace vectors — All selected variables must be the same
length. You can import only vectors, not matrices or scalars. Infs and NaNs
are ignored because you cannot fit data containing these values, and only
the real part of a complex number is used. To perform any curve-fitting

task, you must select at least one vector of data:
= X data — Select the predictor data.

= Y data — Select the response data.

= Weights — Select the weights associated with the response data. If
weights are not imported, they are assumed to be 1 for all data points.

®* Preview — The selected workspace vectors are displayed graphically in

the preview window. Weights are not displayed.

¢ Data set name — The name of the imported data set. The toolbox
automatically creates a unique name for each imported data set. You can
change the name by editing this field. Click the Create data set button to

complete the data import process.
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Working with Data Sets

®* Data sets — Lists all data sets added to Curve Fitting Tool. The data sets
can be created from workspace variables, or from smoothing an existing
imported data set. When you select a data set, you can perform these
actions:

= Click View to open the View Data Set GUI. Using this GUI, you can view
a single data set both graphically and numerically. Additionally, you can
display data points to be excluded in a fit by selecting an exclusion rule.

= Click Rename to change the name of a single data set.

= Click Delete to delete one or more data sets. To select multiple data sets,
you can use the Ctrl key and the mouse to select data sets one by one, or
you can use the Shift key and the mouse to select a range of data sets.

Example: Importing Data

This example imports the ENSO data set into the Curve Fitting Tool using
the Data Sets pane of the Data GUL.

You can interactively import data to Curve Fitting Tool as described below:

1 Load the data from the file enso.mat into the MATLAB workspace. Enter:

load enso

The workspace contains two new variables, pressure and month:

® pressure is the monthly averaged atmospheric pressure differences
between Easter Island and Darwin, Australia. This difference drives the
trade winds in the southern hemisphere.

® month is the relative time in months.
2 Enter cftool to open Curve Fitting Tool.
3 Click Data to open the Data GUI.
4 Select the workspace variables month and pressure for X and Y.

The predictor and response data are displayed graphically in the Preview
window. Weights and data points containing Infs or NaNs are not displayed.
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5 Optionally, edit the data set name.

You should specify a meaningful name when you import multiple data sets.
If you do not specify a name, the default name, which is constructed from
the selected variable names, is used.

6 Click the Create data set button.

The Data sets list box displays all the data sets added to the toolbox. Note
that you can construct data sets from workspace variables, or by smoothing
an existing data set.

If your data contains Infs or complex values, a warning message like the
following appears after you click the Create data set button.

zl
! : lgnoring Infs in data and using onhy the real component of complex data.

The Data Sets pane shown below displays the imported ENSO data in the
Preview button, the data set enso is added to the Data sets list box. You
can then view, rename, or delete enso by selecting it in the list box and
clicking the appropriate button.
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=10l

Data Sets | Smggthl

Importwarkspace vectars: [ Presiesy
Select the workspace ¥ Data: [month |
. +*
variable names. ¥ Data: [pressure <] * e P
. + . s
Weights: (nonej - Y . *e e .
v il emn e o ?
e e
ilvthe d ¥ %"):* RVER &
Specify the data set name. Data setname: [enso Ve, e e
* 2t
LU S o
Click Crente dotu set to Create data set | et Lee
. *
import the data. ot oy
+*
Data sets: 4 * *
xS,y +
census
L= REenarme | Delete |

Close | Help |

Alternatively, you can import data programmatically by specifying the
variable names as arguments to the cftool function as follows.

cftool(month,pressure)
In this case, Curve Fitting Tool opens and displays a plot of the data. The
Data GUI does not appear, because Curve Fitting Tool creates the data set

automatically. If you already imported the data interactively, the tool creates
a second data set.

Viewing Data

® “Viewing Data Graphically” on page 2-27
* “Viewing Data Numerically” on page 2-28

2-26



Preprocessing Data

Viewing Data Graphically

After you import a data set, it is automatically displayed as a scatter plot in
Curve Fitting Tool. The response data is plotted on the vertical axis and the
predictor data is plotted on the horizontal axis.

The scatter plot is a powerful tool because it allows you to view the entire data
set at once, and it can easily display a wide range of relationships between the
two variables. You should examine the data carefully to determine whether
preprocessing is required, or to deduce a reasonable fitting approach. For
example, it’s typically very easy to identify outliers in a scatter plot, and to
determine whether you should fit the data with a straight line, a periodic
function, a sum of Gaussians, and so on.

Enhancing the Graphical Display. Curve Fitting Toolbox software provides
several tools for enhancing the graphical display of a data set. These tools are
available through the Tools menu, the GUI toolbar, and right-click menus.

You can zoom in or out, turn on or off the grid, and so on using the Tools
menu and the GUI toolbar shown below.

Custam Equation S ® =M L
¥ | egend
Grid

Zoom In Tools 6UI Toolbar

Zoom Cut Henu
Pan

Axiz Limit Cortral
Default Axis Limits

You can change the color, line width, line style, and marker type of the
displayed data points using the right-click menu shown below. You activate
this menu by placing your mouse over a data point and right-clicking. Note
that a similar menu is available for fitted curves.
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Color, ..

Line ‘Width  » . .
lnestle » | Right-click menu
Marker r

The ENSO data is shown below after the display has been enhanced using
several of these tools.

Fie View Tools Wik Help

8 aan B EE
van | eea | e Piettio natysin
W Lipner Limt
(. 25 - . . T
2 : i i [ enseH Dhispluy Ihg legend for
i : : the ENSO data set.
sl —
. | ;:‘3;‘;:;9“;. v Display data fips using
64t ' f 1 . 4 ilvl MATLAB's click functionality.
f f + .
'w'f!” ﬂm i f’“luy|' 'Q\ IL f l(J! i [ }ll\& - Change the color, marker
& h ” ik || U W ﬂ )| i k g W _J type and line style for the data.
[ Lf % ij [ i k‘l{ . J
J : Display the grid.
k- L e
[ o
lﬁa‘ €0 momm e ﬁg‘— Change the axis limits.

Viewing Data Numerically

You can view the numerical values of a data set, as well as data points to
be excluded from subsequent fits, with the View Data Set GUI. You open

this GUI by selecting a name in the Data sets list box of the Data GUI and
clicking the View button.
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The View Data Set GUI for the ENSO data set is shown below, followed by

a description of its features.

<) ¥iew Data Set _|o] x|
Data set: enso Tl YWeights
¥ manth 1 1 128 -
X pressure 2 2 11.3
Weights: (none) 3 3 10.6
S 4 4 11.2
* + E a a 104
+ M .+t
4 * e Iy 4] 4] 78
S P *,s’ ST 7 77
+ *
oo el L b e 8 17
-
o T 5 3 12.9
ot at e W
L AP 10 10 143
* - *
AP % % 11 11 104
+ .t 12 12 137
* 13 13 174
% 14 14 14
Exclusion rules: 15 15 15.3
16 16 84
|(n0ne) ;I 17 17 =T ;I

Close |

e Data set — Lists the names of the viewed data set and the associated

variables. The data is displayed graphically below this list.

The index, predictor data (X), response data (Y), and weights (if imported)
are displayed numerically in the table. If the data contains Infs or NaNs,
those values are labeled “ignored.” If the data contains complex numbers,

only the real part is displayed.

e Exclusion rules — Lists all the exclusion rules that are compatible with
the viewed data set. When you select an exclusion rule, the data points
marked for exclusion are grayed in the table, and are identified with an

[l

x” in the graphical display. To exclude the data points while fitting, you

must create the exclusion rule in the Exclude GUI and select the exclusion
rule in the Fitting GUL

An exclusion rule is compatible with the viewed data set if their lengths are
the same, or if it is created by sectioning only.

Smoothing Data

® “Introduction” on page 2-30

® “Creating a Smoothed Data Set” on page 2-32
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2-30

® “Smoothing Method” on page 2-32
e “Working with Smoothed Data Sets” on page 2-33
e “Example: Smoothing Data” on page 2-33

Introduction

If your data is noisy, you might need to apply a smoothing algorithm to expose
its features, and to provide a reasonable starting approach for parametric
fitting. The two basic assumptions that underlie smoothing are

® The relationship between the response data and the predictor data is
smooth.

® The smoothing process results in a smoothed value that is a better estimate
of the original value because the noise has been reduced.

The smoothing process attempts to estimate the average of the distribution
of each response value. The estimation is based on a specified number of
neighboring response values.

You can think of smoothing as a local fit because a new response value is
created for each original response value. Therefore, smoothing is similar

to some of the nonparametric fit types supported by the toolbox, such as
smoothing spline and cubic interpolation. However, this type of fitting is not
the same as parametric fitting, which results in a global parameterization
of the data.

Note You should not fit data with a parametric model after smoothing,
because the act of smoothing invalidates the assumption that the errors are
normally distributed. Instead, you should consider smoothing to be a data
exploration technique.

There are two common types of smoothing methods: filtering (averaging) and
local regression. Each smoothing method requires a span. The span defines
a window of neighboring points to include in the smoothing calculation for
each data point. This window moves across the data set as the smoothed
response value is calculated for each predictor value. A large span increases
the smoothness but decreases the resolution of the smoothed data set, while
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a small span decreases the smoothness but increases the resolution of the
smoothed data set. The optimal span value depends on your data set and the
smoothing method, and usually requires some experimentation to find.

Curve Fitting Toolbox software supports these smoothing methods:

* Moving average filtering — Lowpass filter that takes the average of
neighboring data points.

® Lowess and loess — Locally weighted scatter plot smooth. These methods
use linear least-squares fitting, and a first-degree polynomial (lowess) or a
second-degree polynomial (loess). Robust lowess and loess methods that
are resistant to outliers are also available.

® Savitzky-Golay filtering — A generalized moving average where you derive
the filter coefficients by performing an unweighted linear least-squares fit
using a polynomial of the specified degree.

Note that you can also smooth data using a smoothing spline. Refer to
“Nonparametric Fitting” on page 2-106 for more information.

You smooth data with the Smooth pane of the Data GUI. The pane is shown
below followed by a description of its features.
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Diata Sets  Smoath |

Original data set; enso hd
Data sets =
Smoothed data et |enso {=moath)

. [ Method: Moving Average -

Smoothing method _ =
nd Span: ]

and paramefers BagiEs:

. Create smoothed data set |

[~ Smoothed data sets:

enso {smoath)

Data sets list

= Eenarme | [Deleta | Savetnwarkspace. .. |

Close | Help |

Creating a Smoothed Data Set

® Original data set — Select the data set you want to smooth.

* Smoothed data set — Specify the name of the smoothed data set. Note
that the process of smoothing the original data set always produces a new
data set containing smoothed response values.

Smoothing Method

® Method — Select the smoothing method. Each response value is replaced
with a smoothed value that is calculated by the specified smoothing method.
= Moving average — Filter the data by calculating an average.

= Lowess — Locally weighted scatter plot smooth using linear
least-squares fitting and a first-degree polynomial.
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= Loess — Locally weighted scatter plot smooth using linear least-squares
fitting and a second-degree polynomial.

= Savitzky-Golay — Filter the data with an unweighted linear
least-squares fit using a polynomial of the specified degree.

= Robust Lowess — Lowess method that is resistant to outliers.
= Robust Loess — Loess method that is resistant to outliers.
® Span — The number of data points used to compute each smoothed value.

For the moving average and Savitzky-Golay methods, the span must be
odd. For all locally weighted smoothing methods, if the span is less than 1,
it is interpreted as the percentage of the total number of data points.

* Degree — The degree of the polynomial used in the Savitzky-Golay
method. The degree must be smaller than the span.

Working with Smoothed Data Sets

®* Smoothed data sets — Lists all the smoothed data sets. You add a
smoothed data set to the list by clicking the Create smoothed data set
button. When you select a data set from the list, you can perform these
actions:

= Click View to open the View Data Set GUI. Using this GUI, you can view
a single data set both graphically and numerically. Additionally, you can
display data points to be excluded in a fit by selecting an exclusion rule.

= Click Rename to change the name of a single data set.

= Click Delete to delete one or more data sets. To select multiple data sets,
you can use the Ctrl key and the mouse to select data sets one by one, or
you can use the Shift key and the mouse to select a range of data sets.

= Click Save to workspace to save a single data set to a structure.

Example: Smoothing Data

This example smooths the ENSO data set using the moving average, lowess,
loess, and Savitzky-Golay methods with the default span. As shown below,
the data appears noisy. Smoothing might help you visualize patterns in the
data, and provide insight toward a reasonable approach for parametric fitting.
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The Smooth pane shown below displays all the new data sets generated by
smoothing the original ENSO data set. Whenever you smooth a data set,

a new data set of smoothed values is created. The smoothed data sets are
automatically displayed in Curve Fitting Tool. You can also display a single
data set graphically and numerically by clicking the View button.
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values is created from the original data set. o Tt oy B

All smoothed data sets are listed here.
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Use the Plotting GUI to display only the data sets of interest. As shown
below, the periodic structure of the ENSO data set becomes apparent when
it is smoothed using a moving average filter with the default span. Not
surprisingly, the uncovered structure is periodic, which suggests that a
reasonable parametric model should include trigonometric functions.
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The smoothing process uncovers obvious
periodic structure in the data.
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Saving the Results. By clicking the Save to workspace button, you can
save a smoothed data set as a structure to the MATLAB workspace. This
example saves the moving average results contained in the enso (ma) data set.

<} Save Smoothed Data to Workspace

Save smoothed data to MATLAB struct named:lsmontheddata1
oK | Cancel |
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The saved structure contains the original predictor data x and the smoothed
data vy.

smootheddata1

smootheddatal =
X: [168x1 double]
y: [168x1 double]

Excluding and Sectioning Data

¢ “Introduction” on page 2-37

¢ “Exclusion Rules” on page 2-38

¢ “Excluding Individual Data Points” on page 2-39

¢ “Excluding Data Sections in the Domain or Range” on page 2-39
® “Marking Outliers” on page 2-39

e “Sectioning” on page 2-42

¢ “Example: Excluding and Sectioning Data” on page 2-44

Introduction

If there is justification, you might want to exclude part of a data set from a
fit. Typically, you exclude data so that subsequent fits are not adversely
affected. For example, if you are fitting a parametric model to measured
data that has been corrupted by a faulty sensor, the resulting fit coefficients
will be inaccurate.

Curve Fitting Toolbox software provides two methods to exclude data:

o Marking Outliers — Outliers are defined as individual data points that
you exclude because they are inconsistent with the statistical nature of
the bulk of the data.

® Sectioning — Sectioning excludes a window of response or predictor data.
For example, if many data points in a data set are corrupted by large
systematic errors, you might want to section them out of the fit.
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For each of these methods, you must create an exclusion rule, which captures
the range, domain, or index of the data points to be excluded.

To exclude data while fitting, you use the Fitting GUI to associate the
appropriate exclusion rule with the data set to be fit. Refer to “Example:
Robust Fitting” on page 2-68 for more information about fitting a data set
using an exclusion rule.

You mark data to be excluded from a fit with the Exclude GUI, which
you open from Curve Fitting Tool. The GUI is shown below followed by
a description of its features.

Exclusion fule. ——  Exclusion rule name:|ex03

Exdudeindividual _|
data points.

Exclude data secfions
by domain or range. |

<} Exnclude

=10l %]

Existing exlusion rules:

~Exclude Point:

Select data set Ienso VI Exclude graphically |

Check to exclude paint:

Index H A4
1 1 129 -
Oz 2 1.3
WE 3 106 4|

~Exclude Section

Exclude X [== -] |

Exclude X == =| |

excl
exc2

Exclude Y [== - |

Exclude ¥ == =| |

| Create exclusion rule I

Sy | = |

Eenarme | [elete |

Close | Help |

Exclusion Rules

¢ Exclusion rule name — Specify the name of the exclusion rule that
identifies the data points to be excluded from subsequent fits.

¢ Existing exclusion rules — Lists the names of all exclusion rules created
during the current session. When you select an existing exclusion rule, you
can perform these actions:

= Click Copy to copy the exclusion rule. The exclusions associated with
the original exclusion rule are recreated in the GUI. You can modify
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these exclusions and then click Create exclusion rule to save them to
the copied rule.

= Click Rename to change the name of the exclusion rule.

= Click Delete to delete the exclusion rule. To select multiple exclusion
rules, you can use the Ctrl key and the mouse to select exclusion rules
one by one, or you can use the Shift key and the mouse to select a range
of exclusion rules.

= Click View to display the exclusion rule graphically. If a data set is
associated with the exclusion rule, the data is also displayed.

Excluding Individual Data Points

e Select data set — Select the data set from which data points will be
marked as excluded. You must select a data set to exclude individual
data points.

¢ Exclude graphically — Open a GUI that allows you to exclude individual
data points graphically.

Individually excluded data points are marked by an “x” in the GUI, and are
automatically identified in the Check to exclude point table.

® Check to exclude point — Select individual data points to exclude. You
can sort this table by clicking on any of the column headings.

Excluding Data Sections in the Domain or Range
® Section — Specify data to be excluded. You do not need to select a data set
to create an exclusion rule by sectioning.

= Exclude X — Specify beginning and ending intervals in the predictor
data to be excluded.

= Exclude Y — Specify beginning and ending intervals in the response
data to be excluded.

Marking Outliers

Outliers are defined as individual data points that you exclude from a fit
because they are inconsistent with the statistical nature of the bulk of the
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data, and will adversely affect the fit results. Outliers are often readily
1dentified by a scatter plot of response data versus predictor data.

Marking outliers with Curve Fitting Tool follows these rules:

® You must specify a data set before creating an exclusion rule.

In general, you should use the exclusion rule only with the specific data set
it was based on. However, the toolbox does not prevent you from using the
exclusion rule with another data set provided the size is the same.

¢ Using the Exclude GUI, you can exclude outliers either graphically or
numerically.

As described in “Parametric Fitting” on page 2-52, one of the basic
assumptions underlying curve fitting is that the data is statistical in nature
and is described by a particular distribution, which is often assumed to be
Gaussian. The statistical nature of the data implies that it contains random
variations along with a deterministic component.

data = deterministic component + random component

However, your data set might contain one or more data points that

are non-statistical in nature, or are described by a different statistical
distribution. These data points might be easy to identify, or they might be
buried in the data and difficult to identify.

A non-statistical process can involve the measurement of a physical variable
such as temperature or voltage in which the random variation is negligible
compared to the systematic errors. For example, if your sensor calibration
is inaccurate, the data measured with that sensor will be systematically
inaccurate. In some cases, you might be able to quantify this non-statistical
data component and correct the data accordingly. However, if the scatter plot
reveals that a handful of response values are far removed from neighboring
response values, these data points are considered outliers and should be
excluded from the fit. Outliers are usually difficult to explain away. For
example, it might be that your sensor experienced a power surge or someone
wrote down the wrong number in a log book.

If you decide there is justification, you should mark outliers to be excluded
from subsequent fits—particularly parametric fits. Removing these data
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points can have a dramatic effect on the fit results because the fitting process
minimizes the square of the residuals. If you do not exclude outliers, the
resulting fit will be poor for a large portion of your data. Conversely, if you
do exclude the outliers and choose the appropriate model, the fit results
should be reasonable.

Because outliers can have a significant effect on a fit, they are considered
influential data. However, not all influential data points are outliers. For
example, your data set can contain valid data points that are far removed
from the rest of the data. The data is valid because it is well described by
the model used in the fit. The data is influential because its exclusion will
dramatically affect the fit results.

Two types of influential data points are shown below for generated data. Also
shown are cubic polynomial fits and a robust fit that is resistant to outliers.

Influential Data Points

150
100
- These outliers odversely
* uffect the fit.
50 1 1 1 1 1 1 1 1 1 1
0 1 2 3 4 5 i} 7 ] 9 10
ia)
150 T T T T T T T T
« data
cubic fit
100 7
These dutn points ure
tonsistent with the model.

50 1 1 1 | | | | | | |

0 1 2 3 4 5 [ 7 8 9 10

(b)
150 T T T T T T T T
= data
robust cubic fit

100 q
50 1 1 1 1 1 1 1 1 1 1

0 1 2 3 4 5 & 7 a 9 10
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Plot (a) shows that the two influential data points are outliers and adversely
affect the fit. Plot (b) shows that the two influential data points are
consistent with the model and do not adversely affect the fit. Plot (¢) shows
that a robust fitting procedure is an acceptable alternative to marking
outliers for exclusion.

Sectioning

Sectioning involves specifying response or predictor data to exclude. You
might want to section a data set because different parts of the data set are
described by different models or are corrupted by noise, large systematic
errors, and so on.

Sectioning data with Curve Fitting Tool follows these rules:
¢ If you are only sectioning data and not excluding individual data points,

then you can create an exclusion rule without specifying a data set name.

® You can associate an exclusion rule with any data set provided that the
exclusion rule overlaps with the data. This is useful if you have multiple
data sets from which you want to exclude data points using the same rule.

e Use the Exclude GUI to create the exclusion rule.

® You can exclude vertical strips at the edges of the data, horizontal strips
at the edges of the data, or a border around the data. Refer to “Example:
Excluding and Sectioning Data” on page 2-44 for an example.

® To exclude multiple sections of data, you can use the excludedata function
from the MATLAB command line.
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Two examples of sectioning by domain are shown below for generated data.

Sectioning Data

18 T T - T T = T T T T
Thissection fit with o =T
[ineur polynomical .__1_5__ e o ‘,Emﬁ:,.\,\ ) 7
14[ B = &) _MU‘-‘C:QQW _

Thissection fit with 0 12 :”_5’__”_—‘*:\‘_'\:\ ) ]

tubic polynomicol -—1;_ : e Yol |
o Data : k"u(f&
gl | = = =Linearfit| : e
Cubicfit| |
6 T T 1 1 1 1 1 1 1
0 2 4 6 8 10 12 14 16 18 20
Dato corrupted by noise
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The upper shows the data set sectioned by fit type. The section to the left of 4
is fit with a linear polynomial, as shown by the bold, dashed line. The section
to the right of 4 is fit with a cubic polynomial, as shown by the bold, solid line.

The lower plot shows the data set sectioned by fit type and by valid data.
Here, the right-most section is not part of any fit because the data is corrupted
by noise.

Note For illustrative purposes, the preceding figures have been enhanced
to show portions of the curves with bold markers. Curve Fitting Toolbox
software does not use bold markers in plots.
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Example: Excluding and Sectioning Data
This example modifies the ENSO data set to illustrate excluding and

sectioning data. First, copy the ENSO response data to a new variable and
add two outliers that are far removed from the bulk of the data.

yy = pressure;
yy(ceil(length(month)*rand(1))) = mean(pressure)*2.
yy(ceil(length(month)*rand(1))) mean(pressure) *3.

53
0;

Import the variables month and yy as the new data set enso1, and open the
Exclude GUIL

Assume that the first and last eight months of the data set are unreliable, and
should be excluded from subsequent fits. The simplest way to exclude these
data points is to section the predictor data. To do this, specify the data you
want to exclude in the Exclude Sections field of the Exclude GUI.

Exclude ¥ |<: 'I IB Exclude ¥ |=: 'I |1B1
Exclude ¥ |=: YI I Exclude |=: vl I

Exclude Sections

There are two ways to exclude individual data points: using the Check to
exclude point table or graphically. For this example, the simplest way to
exclude the outliers is graphically. To do this, select the data set name and
click the Exclude graphically button, which opens the Select Points for
Exclusion Rule GUIL

Select the data set.

Exclude Points

Open the GUI to exclude
data points graphically.

Select data set: Ienso Ll Exclude graphically

Check to exclude point:

Indes ¥ ¥

1 1 1248 RN
Oz 2 1.3

mE k] 10.6 =l

To mark data points for exclusion in the GUI, place the mouse cursor over
the data point and left-click. The excluded data point is marked with a red
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X. To include an excluded data point, right-click the data point or select the
Includes Them radio button and left-click. Included data points are marked
with a blue circle. To select multiple data points, click the left mouse button
and drag the selection rubber band so that the rubber band box encompasses
the desired data points. Note that the GUI identifies sectioned data with gray
strips. You cannot graphically include sectioned data.

As shown below, the first and last eight months of data are excluded from
the data set by sectioning, and the two outliers are excluded graphically.
Note that the graphically excluded data points are identified in the Check to
exclude point table. If you decide to include an excluded data point using
the table, the graph is automatically updated.

-} Select Points for Excluded Set (=]

The x's indicate data

. ' ' ' © Included

points excluded manually. = M
Outside domain/range
s

The vertical gray strips 25

indicate data points \

sectioned by domain. A Y. [ =

o o o @% ®: month
15 ] ]

O? @C@é? g @é%% o@ Og Selecting Points:
@ CS% o) (@ ' Excludes Them
10 C@é &

" Includes Them

°,2 %8

g ° 000 O, 3 % Evclude Al |
=]

0 @ Include Al |

Close |

If there are fits associated with the data, you can exclude data points based on
the residuals of the fit by selecting the residual data in the Y list.
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The Exclude GUI for this example is shown below.

<} Exclude

- (O] x|
Exclusion rule name: [enso_exc1 Existing exlusion rules:
~Exclude Point: secl

secl
Select data set: Ienso VI Exclude graphically |
Checkto exclude paint:
Index
[]159 159 13.8 4|
| 160 160 a.7 |
[]161 161 a6 -

~Exclude Section
Exclude X |<: vl |8 Exclude X |>: vl |161
Exclude v |<: vl | Exclude ¥ |== )

I = I GOy | BN |
| Create exclusion rule I Eenarme | Delete |

Close | Help |

Individual data points
marked for exclusion.

Data points outside the
specified domain are
marked for exclusion.

To save the exclusion rule, click the Create exclusion rule button. To
exclude the data from a fit, you must select the exclusion rule from the Fitting
GUI. Because the exclusion rule created in this example uses individually

excluded data points, you can use it only with data sets that are the same
size as the ENSO data set.

Viewing the Exclusion Rule. To view the exclusion rule, select an existing
exclusion rule name and click the View button.
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The View Exclusion Rule GUI shown below displays the modified ENSO data

set and the excluded data points, which are grayed in the table.

=10
Exclusion rule: ensol_excl Index Yo |weights
. 1 1 128 N
Data set: ensol
2 2 11.3 J
3 3 10.6 .
N} ' i 113 The excluded data points
5 g 108 are grayed in the table.
1 3 6 75
7 7 77
8 8 1.7
+ + 3 4y
A Y. 4, g g 12.9
+ + -
?f"?g.c?,{; 2 5 ‘«t‘ 10 0 143
"‘"’.’:*f‘ .ﬁ -~ 1 11 10.9
AR LR DO T 12 12 137
* . 13 13 17.1
14 14 14
15 15 16.3
8=X=161 16 16 8.5
17 17 AT

Missing Values and Outliers

Although Curve Fitting Toolbox software ignores Infs and NaNs when fitting
data, and you can exclude outliers during the fitting process, you might
still want to remove this data from your data set. To do so, you modify the
associated data set variables from the MATLAB command line.

For example, when using toolbox functions such as fit from the command
line, you must supply predictor and response vectors that contain finite
numbers. To remove Infs, you can use the isinf function.

ind = find(isinf(xx));
xx(ind) = [];
yy(ind) [1;

To remove NaNs, you can use the isnan function. For examples that remove
NaNs and outliers from a data set, refer to “Missing Data” in the MATLAB
documentation.
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Fitting Data

You fit data using the Fitting GUI. To open the Fitting GUI, click the Fitting
button from Curve Fitting Tool.

The Fitting GUI is shown below for the census data described in Chapter 1,

“Getting Started”, followed by the general steps you use when fitting any
data set.
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i o] =
Fit Exfitor
Nem'ﬂtl Copry |
FErame:  pohs
Cata set: Ipapvs. cdate :_I Exclusionnue: | {nome) :_J
Typeofit |Poymoma =] F Center and scale x datm

th degree pobynomial

Fit options..., ™ Immedate spphy

Linear model Poly5: —
F{x) = pl*x~5 + p2=x~4 + p3*x"3 + pd*x~2 + p5*x + pé

where ¥ iz notmalized by mean 1ES0 and =td &£2.05
Cozfficients (with 93% confidence bounds):

pl = 0D.5877 ({=-Z.305, 3.48)

Pz = D.7047 ({-1.6B4, 3.D%4)

pl = -D0.%153 {-1D.1%, B.358)

pd = 23,47 (17.42, 26_52)

pa = 74,97 J(GB.37, Bl.3T)

pE = 62.23 (3%.51, 64.%3) :I
Table of Fits
B | Ftreme | Camset | Equstenname | 5E | resguee |
@ pole vs, cdate  PohE 106, 377557399, |0.999 | 3462847
B polys popvs. cdate  Potyd [145.966924373... [0.9368 195642 .. |
& poly3 popvs. cdate Pty [142.768724181... p.osa7aTo1212... |
W poty2 bop s, odate  Poly2 1550252951 76... 039587 12565 77.,

Delete it | Save toworkepace,. | Tabe cptors,. |

_Gose | b |

1 Select a data set and fit name.

¢ Select the name of the current fit. When you click New fit or Copy fit,
a default fit name is automatically created in the Fit name field. You

can specify a new fit name by editing this field.
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e Select the name of the current data set from the Data set list. All
imported and smoothed data sets are listed.

2 Select an exclusion rule.

If you want to exclude data from a fit, select an exclusion rule from the
Exclusion rule list. The list contains only exclusion rules that are
compatible with the current data set. An exclusion rule is compatible with
the current data set if their lengths are identical, or if it is created by
sectioning only.

3 Select a fit type and fit options, fit the data, and evaluate the goodness of fit.

® The fit type can be a library or custom parametric model, a smoothing
spline, or an interpolant.

e Select fit options such as the fitting algorithm, and coefficient starting
points and constraints. Depending on your data and model, accepting
the default fit options often produces an excellent fit.

¢ Fit the data by clicking the Apply button or by selecting the Immediate
apply check box.

e Examine the fitted curve, residuals, goodness of fit statistics, confidence
bounds, and prediction bounds for the current fit.

4 Compare fits.

¢ Compare the current fit and data set to previous fits and data sets by
examining the goodness of fit statistics.

¢ Use the Table Options GUI to modify which goodness of fit statistics are
displayed in the Table of Fits. You can sort the table by clicking on
any column heading.
5 Save the fit results.

If the fit is good, save the results as a structure to the MATLAB workspace.
Otherwise, modify the fit options or select another model.

For more information on model types, fit settings, and examples, see:

® “Parametric Fitting” on page 2-52
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® “Nonparametric Fitting” on page 2-106

2-51



2 Interactive Curve Fitting

Parametric Fitting

2-52

In this section...

“Introduction” on page 2-52

“Library Models” on page 2-53
“Specifying Fit Options” on page 2-58
“Example: Rational Fit” on page 2-62

“Example: Robust Fitting” on page 2-68

Introduction

Parametric fitting involves finding coefficients (parameters) for one or more
models that you fit to data. The data is assumed to be statistical in nature
and is divided into two components: a deterministic component and a random
component.

data = deterministic component + random component

The deterministic component is given by a parametric model and the random
component is often described as error associated with the data.

data = model + error

The model is a function of the independent (predictor) variable and one or
more coefficients. The error represents random variations in the data that
follow a specific probability distribution (usually Gaussian). The variations
can come from many different sources, but are always present at some level
when you are dealing with measured data. Systematic variations can also
exist, but they can lead to a fitted model that does not represent the data well.

The model coefficients often have physical significance. For example,
suppose you have collected data that corresponds to a single decay mode of a
radioactive nuclide, and you want to estimate the half-life (7,,) of the decay.
The law of radioactive decay states that the activity of a radioactive substance
decays exponentially in time. Therefore, the model to use in the fit is given by
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y=ype M

where y, is the number of nuclei at time ¢ = 0, and A is the decay constant.
The data can be described by

data = yoe_lt +error

Both y, and A are coefficients that are estimated by the fit. Because T,

= In(2)/A, the fitted value of the decay constant yields the fitted half-life.
However, because the data contains some error, the deterministic component
of the equation cannot be determined exactly from the data. Therefore, the
coefficients and half-life calculation will have some uncertainty associated
with them. If the uncertainty is acceptable, then you are done fitting the data.
If the uncertainty is not acceptable, then you might have to take steps to
reduce it either by collecting more data or by reducing measurement error
and collecting new data and repeating the model fit.

In other situations where there is no theory to dictate a model, you might also
modify the model by adding or removing terms, or substitute an entirely
different model.

Library Models

Curve Fitting Toolbox parametric library models are described below.

¢ “Exponentials” on page 2-54
* “Fourier Series” on page 2-54
® “Gaussian” on page 2-55

¢ “Polynomials” on page 2-55

® “Power Series” on page 2-56
e “Rationals” on page 2-56

® “Sum of Sines” on page 2-57

e “Weibull Distribution” on page 2-58
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Exponentials
The toolbox provides a one-term and a two-term exponential model.

y = aet®

y = aeP +ce

dx

Exponentials are often used when the rate of change of a quantity is
proportional to the initial amount of the quantity. If the coefficient associated
with e is negative, y represents exponential decay. If the coefficient is positive,
y represents exponential growth.

For example, a single radioactive decay mode of a nuclide is described by a
one-term exponential. a is interpreted as the initial number of nuclei, b is the
decay constant, x is time, and y is the number of remaining nuclei after a
specific amount of time passes. If two decay modes exist, then you must use
the two-term exponential model. For each additional decay mode, you add
another exponential term to the model.

Examples of exponential growth include contagious diseases for which a cure
1s unavailable, and biological populations whose growth is uninhibited by
predation, environmental factors, and so on.

Fourier Series

The Fourier series is a sum of sine and cosine functions that is used to
describe a periodic signal. It is represented in either the trigonometric form or
the exponential form. The toolbox provides the trigonometric Fourier series
form shown below,

n
y=ag+ 2 a; cos(nwx) + b; sin(nwx)
=1

where a, models a constant (intercept) term in the data and is associated with
the i = 0 cosine term, w is the fundamental frequency of the signal, n is the
number of terms (harmonics) in the series, and 1<n<8.

For more information about the Fourier series, refer to “Fourier Transforms”
in the MATLAB documentation.
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Gaussian
The Gaussian model is used for fitting peaks, and is given by the equation

yziaii‘[xéb" ]

where a is the amplitude, b is the centroid (location), c is related to the peak
width, n is the number of peaks to fit, and 1<n<8.

Gaussian peaks are encountered in many areas of science and engineering.
For example, line emission spectra and chemical concentration assays can be
described by Gaussian peaks.

Polynomials
Polynomial models are given by

n+l

y = z pixn+1—i
=1

where n + 1 is the order of the polynomial, n is the degree of the polynomial,
and 1<n<9. The order gives the number of coefficients to be fit, and the degree
gives the highest power of the predictor variable.

In this guide, polynomials are described in terms of their degree. For example,
a third-degree (cubic) polynomial is given by

3 2
Y=D1X" + poX” + p3X+ Py

Polynomials are often used when a simple empirical model is required. The
model can be used for interpolation or extrapolation, or it can be used to
characterize data using a global fit. For example, the temperature-to-voltage
conversion for a Type J thermocouple in the 0° to 760° temperature range is
described by a seventh-degree polynomial.
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Note If you do not require a global parametric fit and want to maximize the
flexibility of the fit, piecewise polynomials might provide the best approach.
Refer to “Nonparametric Fitting” on page 2-106 for more information.

The main advantages of polynomial fits include reasonable flexibility for
data that is not too complicated, and they are linear, which means the fitting
process is simple. The main disadvantage is that high-degree fits can become
unstable. Additionally, polynomials of any degree can provide a good fit
within the data range, but can diverge wildly outside that range. Therefore,
you should exercise caution when extrapolating with polynomials. Refer

to “Determining the Best Fit” on page 2-9 for examples of good and poor
polynomial fits to census data.

Note that when you fit with high-degree polynomials, the fitting procedure
uses the predictor values as the basis for a matrix with very large values,
which can result in scaling problems. To deal with this, you should normalize
the data by centering it at zero mean and scaling it to unit standard deviation.
You normalize data by selecting the Center and scale X data check box on
the Fitting GUIL.

Power Series
The toolbox provides a one-term and a two-term power series model.

y=axb

y=a+bx°

Power series models are used to describe a variety of data. For example, the
rate at which reactants are consumed in a chemical reaction is generally
proportional to the concentration of the reactant raised to some power.

Rationals
Rational models are defined as ratios of polynomials and are given by
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where n is the degree of the numerator polynomial and 0<n<5, while m is the
degree of the denominator polynomial and 1<m<5. Note that the coefficient
associated with x™ is always 1. This makes the numerator and denominator
unique when the polynomial degrees are the same.

In this guide, rationals are described in terms of the degree of the
numerator/the degree of the denominator. For example, a quadratic/cubic
rational equation is given by

2
__ P1X +tPpeXx+p3
x3 + q1x2 + q2x + Q3

Like polynomials, rationals are often used when a simple empirical model
is required. The main advantage of rationals is their flexibility with data
that has complicated structure. The main disadvantage is that they become
unstable when the denominator is around zero. For an example that uses
rational polynomials of various degrees, refer to “Example: Rational Fit”
on page 2-62.

Sum of Sines

The sum of sines model is used for fitting periodic functions, and is given
by the equation

n
y= Zai sin(b;x +¢;)
=1

where a is the amplitude, b is the frequency, and c is the phase constant for
each sine wave term. n is the number of terms in the series and 1<n<8. This
equation is closely related to the Fourier series described previously. The
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main difference is that the sum of sines equation includes the phase constant,
and does not include a constant (intercept) term.

Weibull Distribution

The Weibull distribution is widely used in reliability and life (failure rate)
data analysis. The toolbox provides the two-parameter Weibull distribution

b
y= abxb—le—ax

where a is the scale parameter and b is the shape parameter. Note that there
is also a three-parameter Weibull distribution with x replaced by x — ¢ where
c is the location parameter. Additionally, there is a one-parameter Weibull
distribution where the shape parameter is fixed and only the scale parameter
is fitted. To use these distributions, you must create a custom equation.

Curve Fitting Toolbox software does not fit Weibull probability distributions
to a sample of data. Instead, it fits curves to response and predictor data such
that the curve has the same shape as a Weibull distribution.

Specifying Fit Options

¢ “Introduction” on page 2-59

¢ “Fitting Method and Algorithm” on page 2-59
¢ “Finite Differencing Parameters” on page 2-60
¢ “Fit Convergence Criteria” on page 2-61

e “Coefficient Parameters” on page 2-61
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Introduction

You specify fit options with the Fit Options GUI. The fit options for the
single-term exponential are shown below. The coefficient starting values and
constraints are for the census data.

<) Fit Dptions for expl |
Method: MonlinearLeastSquares -
DS |off =I'| |- Fiiting method and algorithm
Algarithm: |Trust—RegiDn j
DifinChange: 10E8 | | pow g .

! L Finite differencing parameters
CifaxChange: | o1 ) _|
MaxFunEvals: | GO0 7]
Maxdter: | 400 . _

— Fit convergence criteria

TalFun: | 1.0E-6
Tal: | 1.0E6 | _|]
Lnknowns| StafPoint| Lower Upper
a 8.048-15 -Inf] it | | Coefficient parameters
b 1.91e-02 -Inf Inf|

The available GUI options depend on whether you are fitting your data using
a linear model, a nonlinear model, or a nonparametric fit type. All the options
described below are available for nonlinear models. Method, Robust, and
coefficient constraints (Lower and Upper) are available for linear models.
Interpolants and smoothing splines include Method, but no configurable
options.

Fitting Method and Algorithm

¢ Method — The fitting method.

The method is automatically selected based on the library or custom model
you use. For linear models, the method is LinearLeastSquares. For
nonlinear models, the method is NonlinearLeastSquares.
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* Robust — Specify whether to use the robust least-squares fitting method.
The values are

= Off — Do not use robust fitting (default).
= On — Fit with default robust method (bisquare weights).
= LAR — Fit by minimizing the least absolute residuals (LAR).

= Bisquare — Fit by minimizing the summed square of the residuals,
and down-weight outliers using bisquare weights. In most cases, this is
the best choice for robust fitting.

¢ Algorithm — Algorithm used for the fitting procedure:

= Trust-Region — This is the default algorithm and must be used if you
specify coefficient constraints.

= Levenberg-Marquardt — If the trust-region algorithm does not
produce a reasonable fit, and you do not have coefficient constraints, you
should try the Levenberg-Marquardt algorithm.

= Gauss-Newton — This algorithm is included for pedagogical reasons
and should be the last choice for most models and data sets.

Finite Differencing Parameters

¢ DiffMinChange — Minimum change in coefficients for finite difference
Jacobians. The default value is 108,

¢ DiffMaxChange — Maximum change in coefficients for finite difference
Jacobians. The default value is 0.1.

Note that DiffMinChange and DiffMaxChange apply to

¢ Any nonlinear custom equation — that is, a nonlinear equation that you
write.

® Some, but not all, of the nonlinear equations provided with Curve Fitting

Toolbox software.

However, DiffMinChange and DiffMaxChange do not apply to any linear
equations.
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Fit Convergence Criteria

MaxFunEvals — Maximum number of function (model) evaluations
allowed. The default value is 600.

MaxIter — Maximum number of fit iterations allowed. The default value
is 400.

TolFun — Termination tolerance used on stopping conditions involving
the function (model) value. The default value is 10,

TolX — Termination tolerance used on stopping conditions involving the
coefficients. The default value is 10,

Coefficient Parameters

Unknowns — Symbols for the unknown coefficients to be fitted.

StartPoint — The coefficient starting values. The default values depend
on the model. For rational, Weibull, and custom models, default values are
randomly selected within the range [0,1]. For all other nonlinear library
models, the starting values depend on the data set and are calculated
heuristically.

Lower — Lower bounds on the fitted coefficients. The bounds are used
only with the trust region fitting algorithm. The default lower bounds for
most library models are -Inf, which indicates that the coefficients are
unconstrained. However, a few models have finite default lower bounds.
For example, Gaussians have the width parameter constrained so that it
cannot be less than 0.

Upper — Upper bounds on the fitted coefficients. The bounds are used
only with the trust region fitting algorithm. The default upper bounds
for all library models are Inf, which indicates that the coefficients are
unconstrained.

For more information about these fit options, refer to the Optimization
Toolbox documentation.

The default coefficient starting points and constraints for library and custom
models are given below. If the starting points are optimized, then they are
calculated heuristically based on the current data set. Random starting
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points are defined on the interval [0,1] and linear models do not require
starting points.

If a model does not have constraints, the coefficients have neither a lower
bound nor an upper bound. You can override the default starting points and

constraints by providing your own values using the Fit Options GUI.

Default Starting Points and Constraints

Model Starting Points Constraints
Custom linear N/A None
Custom nonlinear Random None
Exponentials Optimized None
Fourier series Optimized None
Gaussians Optimized >0
Polynomials N/A None
Power series Optimized None
Rationals Random None
Sum of sines Optimized b,>0
Weibull Random a,b>0

Note that the sum of sines and Fourier series models are particularly sensitive
to starting points, and the optimized values might be accurate for only a few
terms in the associated equations.

Example: Rational Fit

This example fits measured data using a rational model. The data describes
the coefficient of thermal expansion for copper as a function of temperature
in degrees kelvin.

To get started, load the thermal expansion data from the file hahni.mat,
which is provided with the toolbox.

load hahni
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The workspace now contains two new variables, temp and thermex:

® temp is a vector of temperatures in degrees kelvin.

® thermex is a vector of thermal expansion coefficients for copper.

Import these two variables into Curve Fitting Tool and name the data set
CuThermEx.

For this data set, you will find the rational equation that produces the best fit.

As described in “Library Models” on page 2-53, rational models are defined as
a ratio of polynomials

n n-1
_ DP1X " + pox toot DPpi1

g™ g,

where n is the degree of the numerator polynomial and m is the degree of the
denominator polynomial. Note that the rational equations are not associated
with physical parameters of the data. Instead, they provide a simple and

flexible empirical model that you can use for interpolation and extrapolation.
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As you can see by examining the shape of the data, a reasonable initial choice
for the rational model is quadratic/quadratic. The Fitting GUI configured for
this equation is shown below.

-0l =]
Fit Editor
ey fit | Copy fit |
FitName: |Rat22
Data set  |CuThermEx | Exclusion rule:  [inone) -
Type of it [Rational | [T Center and scale X data
Rational
Mumerator Denominator
canstant = |/linear polynomial |
linear palynamial : Begin the fitting process with a
guadratic po cubic polynomial | qUtII‘.II'tIﬁquI.I:ItII‘tIﬁC ruIionul f“
i i Tl 4th deares polvnomial ~
Fit options... | [ Immediate apply Zaricel | ARl |
Results
General model RatiZzZ: 1E5
fix) = (pl*x*Z 4+ p2Z%x + p3) / (242 4+ gql¥x 4+ g2)
Coefficients (with 95% confidence bhounds):
pl = 21.21 (2l.01, Z1.42)
p2 = -876.5 (-948.5, -804.2) —
p3 = 9147 (7620, 1.067=+004)
ql = 23.55 (18.8, 28.3)
q2 = 756.5  (233.4, 1280) -
Table of Fits

MName Data set

CuThermEx |Rational

Delete fit Save towarkspace... | Table options... |

Close |
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The data, fit, and residuals are shown below.

The fit clearly misses

o some of the data.

&

OV

00 200 300 400 &0 00 00 800
1
Raed

1

osf e § 1 .
5 . Hwe e The residuals show a strong pattern

° LT et ™ indicating a better fitis possible.
o8l ¥ g T 1

-

Wy 00 30 400 S0 60 N0 M0

The fit clearly misses the data for the smallest and largest predictor values.
Additionally, the residuals show a strong pattern throughout the entire data
set indicating that a better fit is possible.
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For the next fit, try a cubic/cubic equation. The data, fit, and residuals are
shown below.

J Curve Fitting Tool =10l

File W“iew Tools “Window Help
&l &2 k=E

Data... | Fitting... | Exclude... | Flotting... | Analysis.. |

Data and Fits

CuThermEx
Rat33

The fit exhibits several
—— discontinuities around the
zeros of the denominator.

1 1 1 1 1 1 1 1
100 200 300 400 500 B00 700 800

Residuals
15 T T T T T T T T
1
L]
05T e 4 -
.. N .:‘-.»‘. e
it et 1
e Gt -
os| ¥ W s Y 1

1 1 1 1 1 1 1 1
100 200 300 400 500  BOD FOO 800

The numerical results shown below indicate that the fit did not converge.

Results

Fit computation did not converge: = E .
Maximum number of iterations exceeded. Increasing MaxIter :I.he‘ f" dld nof (Onverge, w_hICh
(in fit options) may allow for a better fit, or the current - md'“ﬂes thut ”’B mOdeI mlght
eruation may not be a good model for the data. he a poor (hoice for Ihe dﬂﬂ

Fit found when optimization terminated:

General model Rat33:
£ix) = (pl*=x*3 + p2*x*2 + p3*x + p4) /
(%43 + gl*®*2 + g2%% + g3)
Coefficients (with 95% confidence bounds):
pl = 21.2 (20.85, 21.55)

p2 = -888.8 (-2168, 390.4) =
p3 = 1.069e+004 (-3.784e+004, 5.922e+004)

pd = -3.353e+004  (-4.694e+005, 4.023e+005)

ql = 20.82  (-31.13, 72.77)

qz = 1428  (-1804, 4659)

g3 = -2.545:+004  (-5.456e+004, -2337) =
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Although the message in the Results window indicates that you might
improve the fit if you increase the maximum number of iterations, a better
choice at this stage of the fitting process is to use a different rational equation
because the current fit contains several discontinuities. These discontinuities
are due to the function blowing up at predictor values that correspond to

the zeros of the denominator.

As the next try, fit the data using a cubic/quadratic equation. The data, fit,

and residuals are shown below.

-} Curve Fitting Tool

File View Tools Window Help

=10l x|

P
Data... | Fitting... | Exclude... Flotting... Analyziz... |
Data and Fits
of T T T T T T T T
15+ +  CuThermEx H
— Rat32
10 B
5 -
] 1 1 1 1 1 1 1 1 .
100 200 300 400 500 B00 700 800
Residuals
0.4 T T T T T T T T
. .
02f ,* B %]
s . [ T . .
P BT R qe T S . *
Oftom o a0t dtond o0 Java "S0% " o* o ¢ -
£ AT T S e L
a2l - ' - : .
-0.4

1 1 1 1 1 1
100 200 300 400 500 500

1 1
700 800

The fit is well be haved

over the entire data range.

The residuals are
—— randomly scattered
about zero.

The fit is well behaved over the entire data range, and the residuals are
randomly scattered about zero. Therefore, you can confidently use this fit

for further analysis.
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Example: Robust Fitting

This example fits data that is assumed to contain one outlier. The data
consists of the 2000 United States presidential election results for the state of
Florida. The fit model is a first degree polynomial and the fit method is robust
linear least squares with bisquare weights.

In the 2000 presidential election, many residents of Palm Beach County,
Florida, complained that the design of the election ballot was confusing, which
they claim led them to vote for the Reform candidate Pat Buchanan instead
of the Democratic candidate Al Gore. The so-called “butterfly ballot” was
used only in Palm Beach County and only for the election-day ballots for the
presidential race. As you will see, the number of Buchanan votes for Palm
Beach is far removed from the bulk of data, which suggests that the data
point should be treated as an outlier.

To get started, load the Florida election result data from the file
flvote2k.mat, which is provided with the toolbox.

load flvote2k

The workspace now contains these three new variables:

® buchanan is a vector of votes for the Reform Party candidate Pat Buchanan.
® bush is a vector of votes for the Republican Party candidate George Bush.

® gore is a vector of votes for the Democratic Party candidate Al Gore.

Each variable contains 68 elements, which correspond to the 67 Florida
counties plus the absentee ballots. The names of the counties are given in
the variable counties. From these variables, create two data sets with the

Buchanan votes as the response data: buchanan vs. bush and buchanan
vs. gore.

For this example, assume that the relationship between the response and
predictor data is linear with an offset of zero.

buchanan votes = (bush votes)(m,)

buchanan votes = (gore votes)(m.,)
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m, is the number of Bush votes expected for each Buchanan vote, and m, is
the number of Gore votes expected for each Buchanan vote.

To create a first-degree polynomial equation with zero offset, you must create
a custom linear equation.

1 In Curve Fitting Tool, click Fitting.
2 In the Fitting GUI , click New fit.

3 Select Custom Equations from the Type of fit list, and click the New
button to open the New Custom Equation dialog box.

4 To create a first degree polynomial with zero offset, on the Linear Equations
tab:

a Edit the coefficient name to m, and the Terms to x.

b Clear the checkbox Unknown constant coefficient to remove the
constant term.

¢ Specify FlaEelection for the Equation name.

The Linear Equations tab of the New Custom Equation dialog box is
shown below.
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) Mew Custom Equation

Linear Equations | izeneral Equations I

Independent variable: Ix

=10 |

—Equation
Inknown
Coeffidents  Terms
Iy = Im H Ix

[T Unknown constant coefficient Add a term Remove |ast term
Equation: m*(x)
Equation name: |F|E|E|El:til:ll'||
K Cancel | Help |

d Click OK.

Before fitting, you should exclude the data point associated with the absentee
ballots from each data set because these voters did not use the butterfly
ballot. As described in “Marking Outliers” on page 2-39, you can exclude
individual data points from a fit either graphically or numerically using the
Exclude GUI. For this example, you should exclude the data numerically. The
index of the absentee ballot data is given by

ind = find(strcmp(counties, 'Absentee Ballots'))

ind
68
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In Curve Fitting Tool, click Exclude. The Exclude GUI is shown below.

<} Exclude =10l x|

Existing exlusion rules:

Exclusion rule name: IAbsenteeVDtes

~Exclude Paoint

Select data set Ibuchanan vs. hush VI Exclude graphically |

Checkto exclude paint:

Indesx H A4
|66 12182 120 4|
Mark the absentee |67 4994 88 |
7|68 1575 5 -

votes to be excluded.

~Exclude Section

Exclude X == =] | Exclude X [== = |

Exclude == =| | Exclude Y [»= | | Comy | pr— |

Create exclusion rule | Fenarme | [Delete I
Close | Help |

1 Select the data set.

2 Select the check box to exclude point 68.
3 Name the exclusion rule AbsenteeVotes.
4 Click Create exclusion rule.

5 Click Close.

You will associate the exclusion rule with the data set to be fitted when you
return to the Fitting GUI.

For each data set, create a robust fit with bisquare weights using the
FlaElection equation defined above. For comparison purposes, also perform
a regular linear least-squares fit. Follow these steps:

1 In the Fitting GUI, select the buchanon vs bush data set, the custom
equation fit type, and select the FlaElection equation you defined

previously.

2 Select AbsenteeVotes in the Exclusion rule list.
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3 Click Fit Options and select Robust Bisquare. Close the Fit Options
dialog box.

4 Specify a meaningful fit name such as BBLinRobust.

5 Click Apply to save the changes to the fit (or select the Immediate apply
check box to avoid the need for this).

6 Click Copy fit and change the data set to buchanon vs gore to create a
similar robust fit to the other data set. Edit the fit name to BGLinRobust.

7 For both your robust fits, click Copy fit and change the new fit’s Robust fit
option setting to Off. These two fits perform a regular linear least-squares
fit for comparison purposes. Edit the fit names to BBLin and BGLin.

The Fit Editor and the Fit Options GUI are shown below for a robust fit.

Fit Editor

e fit Copy fit
Fithame: |BBELinRoh
huchananvs. hush =
Type offitt  |Custorn Equations | ¥

Custom Equation

=10l x|

| Associate the excluded
absentee votes with the fit.

Data set:

Exclusion rule: IRl G —

[ Center and scale ¥ data

1
«) Fit Options for custom: FlaElect

Method: LinearLeastSquares

FlaElection

=
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Open the Fit Options GUI.

rooust: [ET S -

Unknowng |
m |

Loweer | Upper |

-In] Inf|

— Choose robust fitfing
with bisquare weights.

o |
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The data, robust and regular least-squares fits, and residuals for the
buchanan vs. bush data set only are shown below. Use the Plotting dialog
box to control what is shown in Curve Fitting Tool plots.

-} Curve Fitting Tool ;IEIEI

File Wiew Tools window Help

le|® o=k

Data. | Fitting | Exclude: | Plotting. Analyziz |
Data and Fits

5000 T T T T

buchanan vs. hush, point #50 The data ﬁp shows that
o) g {x=152051, y=3411 ] -
ol =341y Buchanan reccived 3411

O buchananvs. bush votes in Palm Beach County.
2000k (777 BBLinRob

1000 -

Residuals x 10

3000 ‘ ; ; ; : The Palm Beach County

oon | residual is very large.
— BBLinRab
—— BELin

1o}

The Miami/Dade County

residual is abo very large.

Click and hold a point in the Curve Fitting Tool plots to see the data tip. You
can identify the Palm Beach County data in the scatter plot by using the data
tips feature. The index number of the data point for Palm Beach is 50.

ind
ind

find(strcmp(counties, 'Palm Beach'))

50

The graphical results show that the linear model is reasonable for the majority
of data points, and the residuals appear to be randomly scattered around
zero. However, two residuals stand out. The largest residual corresponds to
Palm Beach County. The other residual is at the largest predictor value, and
corresponds to Miami/Dade County.

The numerical results are shown below. The inverse slope of the robust fit
indicates that Buchanan should receive one vote for every 197.4 Bush votes.
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Results

Linear model: <
fix) = n*x

Coefficients (with 95% confidence bounds):
m = 0.005066  (0.004794, 0.005337) j

The data, robust and regular least-squares fits, and residuals for the buchanan
vs. gore data set are shown below.

-} Curve Fitting Tool =1al x|

File Wiew Tools ‘Window Help
a2z

Data... | Fitting... | Exclude... Flatting.. Analysiz... |

Data and Fits

" G
3000 | < buchanan s, gore b
=== BisLinRob
2000 || — BGLin I
1000 -
0
. il
Residuals x 10
4000 r T T T T .
o DReb The Palm Beach County
A0 residual is very large.
i The Miomi/Dade and
- Broward County residuals
2000 L . . . : : L : are also very large.
0 05 1 15 2 25 3 35 ylrg
10

Again, the graphical results show that the linear model is reasonable for the
majority of data points, and the residuals appear to be randomly scattered
around zero. However, three residuals stand out. The largest residual
corresponds to Palm Beach County. The other residuals are at the two largest
predictor values, and correspond to Miami/Dade County and Broward County.

The numerical results are shown below. The inverse slope of the robust fit
indicates that Buchanan should receive one vote for every 189.3 Gore votes.
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Results

Linear model: ﬂ
fix) = n¥x

Coefficients (with 95% confidence bhounds):
m = 0.005254 (0.00504, 0.005528) ;I

Using the fitted slope value, you can determine the expected number of
votes that Buchanan should have received for each fit. For the Buchanan
versus Bush data, you evaluate the fit at a predictor value of 152,951. For
the Buchanan versus Gore data, you evaluate the fit at a predictor value of
269,732. These results are shown below for both data sets and both fits.

Expected Buchanan Votes in Palm Beach County

Expected Buchanan
Data Set Fit Votes

Buchanan vs. Bush Ordinary least squares | 814

Robust least squares 775

Buchanan vs. Gore Ordinary least squares | 1246

Robust least squares 1425

The robust results for the Buchanan versus Bush data suggest that Buchanan
received 3411 — 775 = 2636 excess votes, while robust results for the Buchanan
versus Gore data suggest that Buchanan received 3411 — 1425 = 1986 excess
votes.

The margin of victory for George Bush is given by

margin = sum(bush)-sum(gore)
margin

537

Therefore, the voter intention comes into play because in both cases, the
margin of victory is less than the excess Buchanan votes.

In conclusion, the analysis of the 2000 United States presidential election
results for the state of Florida suggests that the Reform Party candidate
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received an excess number of votes in Palm Beach County, and that this excess
number was a crucial factor in determining the election outcome. However,
additional analysis is required before a final conclusion can be made.
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Creating Custom Models

In this section...

“Custom Models vs. Library Models” on page 2-77
“Creating Custom Models” on page 2-77

“Editing and Saving Custom Models” on page 2-81
“Example: Legendre Polynomial” on page 2-83
“Example: Fourier Series” on page 2-91

“Example: Gaussian with Exponential Background” on page 2-101

Custom Models vs. Library Models

If the toolbox library does not contain a desired parametric equation, you can
create your own custom equation. Library models, however, offer the best
chance for rapid convergence. This is because:

¢ For most library models, optimal default coefficient starting points are
calculated. For custom models, the default starting points are chosen at
random on the interval [0,1].

¢ Library models use an analytic Jacobian; custom models use finite
differencing.

® When using the Analysis GUI, library models use analytic derivatives and
integrals if the integral can be expressed in closed form; custom models use
numerical approximations.

Creating Custom Models

Create custom equations with the New Custom Equation GUI. Open the
GUI in one of two ways:

¢ From Curve Fitting Tool, select Tools > Custom Equation.

¢ From the Fitting GUI, select Custom Equations from the Type of fit list,
then click the New button.
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The GUI contains two panes: one for creating linear custom equations and
one for creating general (nonlinear) custom equations.

Linear Equations

Linear models are linear combinations of (perhaps nonlinear) terms. They
are defined by equations that are linear in the parameters. Use the Linear
Equations pane on the New Custom Equation GUI to create custom linear
equations. Interface controls are described below.

) New custom Equation ————————IelFy

‘Linear Equations | General Equations |

Independent variable: |><

~Equaftion
Lnkrmown
Coefficients Terms
y = |a *( Jsin(x - pi) )

e

¥ Unknown constant coefficient Add a terml Remaove |ast terml

Equation: a*(sin(x - pi))+c

Equation name: |a*(sir‘|(>< - piy)+c

QK | Cancel | Help |

¢ Independent variable — Symbol representing the independent

(predictor) variable. The default symbol is x.
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® Equation — Symbol representing the dependent (response) variable,
followed by the linear equation. The default symbol is y.

Unknown Coefficients — The unknown coefficients to be determined
by the fit. The default symbols are a, b, ¢, and so on.

Terms — Functions of the independent variable. These may be
nonlinear. Terms may not contain a coefficient to be fitted.

Unknown constant coefficient — If selected, a constant term
(y-intercept) is included in the equation. Otherwise, a constant term
is not included.

Add a term — Add a term to the equation. An unknown coefficient is
automatically added for each new term.

Remove last term — Remove the last term added to the equation.

* Equation name — The name of the equation. By default, the name is
automatically updated to be identical to the custom equation given by
Equation. If you override the default, the name is no longer automatically
updated.

General Equations

General models are, in general, nonlinear combinations of (perhaps
nonlinear) terms. They are defined by equations that may be nonlinear
in the parameters. Use the General Equations pane on the New Custom
Equation GUI to create custom general equations. Interface controls are
described below.
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) New Custom Equation———————JRBIEY

Linear Equations ; General Equations |

Independent variable: |><

Equation: |y = |a*e><p(—b*><)+c
Unknowns | StartPoint Lower Upper
a 0.171 -Inf] Inf}
b 9.65e-03 -Inf] Inf]
C 0.404 -Inf] Inf}

Equation name: |a*e><p(—b*><)+c

QK | Cancel | Help |

¢ Independent variable — Symbol representing the independent
(predictor) variable. The default symbol is x.

¢ Equation — Symbol representing the dependent (response) variable,
followed by the general equation. The default symbol is y. As you type in
the terms of the equation, the unknown coefficients, associated starting
values, and constraints automatically populate the table. By default,
the starting values are randomly selected on the interval [0,1] and are
unconstrained.

You can immediately change the default starting values and constraints in
this table, or you can change them later using the Fit Options GUI.

¢ Equation name — The name of the equation. By default, the name is
automatically updated to be identical to the custom equation given by
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Equation. If you override the default, the name is no longer automatically
updated.

Note If you use the General Equations pane to define a linear equation, a
nonlinear fitting procedure is used. While this is allowed, it is inefficient, and
can result in less than optimal fitted coefficients. Use the Linear Equations
pane to define custom linear equations.

Editing and Saving Custom Models

When you click OK on the New Custom Equation GUI, the displayed
Equation name is saved for the current session in the Custom Equations
list on the Fitting GUI. The list is highlighted in the picture of the Fitting
GUI below.
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=10 x|

Fit Editor

Mew fit | Copy fit |

Fit name:  [fit 1

Data set: ﬂ Exclusion rule: | (none) =

Type of fit: | Custom Equations Ll ™ Center and scale ¥ data

-Custom Equations

Mew

Edit

Copy and Edit
Delete

Fit options... [ Immediate apply ~ Cancel | Apply |
Results
Click "Rpply" to save the changes to the fit.

4 [*]
Table of Fits
@ Fitname Data set Equation name SSE R...
|@ ffit 1 (none) MaM MaM
Delete fit Save to workspace. .. Table options... |
Close | Help |
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To edit a custom equation, select the equation in the Custom Equations list
and click the Edit button. The Edit Custom Equation GUI appears. The
Edit Custom Equation GUI is identical to the New Custom Equation GUI,
but i1s pre-populated with the selected equation. After editing an equation

in the Edit Custom Equation GUI, click OK to save it back to the Custom
Equations list for further use in the current session. A button to Copy
and Edit is also available, if you want to save both the original and edited
equations for the current session.

To save custom equations for future sessions, select the File > Save Session
menu item in Curve Fitting Tool.

Example: Legendre Polynomial

This example fits data using several custom linear equations. The data is
generated, and is based on the nuclear reaction 2C(e,e’a)®Be. The equations
use sums of Legendre polynomial terms.

Consider an experiment in which 124 MeV electrons are scattered from 2C
nuclei. In the subsequent reaction, alpha particles are emitted and produce
the residual nuclei ®Be. By analyzing the number of alpha particles emitted as
a function of angle, you can deduce certain information regarding the nuclear
dynamics of 12C. The reaction kinematics are shown below.

e is the intident electron.
12¢is the corbon furget.

f is the momentum trunsferred to *Be.
g' is the scottered electron,
coisthe emitted olpho porticle.

_ B, is the electron scottering ongle.

B, is the ulpho seottering ongle.

The data is collected by placing solid state detectors at values of ®_ ranging
from 10° to 240° in 10° increments.
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It is sometimes useful to describe a variable expressed as a function of angle
in terms of Legendre polynomials

y(x) =Y a,P,(x)
n=0

where P (x) is a Legendre polynomial of degree n, x is cos(®_), and a, are the
coefficients of the fit. Refer to the legendre function for information about
generating Legendre polynomials.

For the alpha-emission data, you can directly associate the coefficients with
the nuclear dynamics by invoking a theoretical model. Additionally, the
theoretical model introduces constraints for the infinite sum shown above.

In particular, by considering the angular momentum of the reaction, a
fourth-degree Legendre polynomial using only even terms should describe the
data effectively.

You can generate Legendre polynomials with Rodrigues’ formula:

P (x)=—1 (iJ 2 -1

2" i\ dx

The Legendre polynomials up to fourth degree are given below.

Legendre Polynomials up to Fourth Degree

P.(x)

1

X

(1/2)(3x%— 1)

(1/2)(5x® — 3x)

Alw|loliRr|lols

(1/8)(35x* — 30x2 + 3)

You will fit the data using a fourth-degree Legendre polynomial with only
even terms:
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y1(x) = ag +ay [% )(3x2 ~D+ay (% )(35x4 ~30x2 +3)

Follow these steps:

1 Load the '2C alpha-emission data from the file carbon12alpha.mat, which
is provided with the toolbox.

load carboni2alpha

The workspace now contains two new variables, angle and counts:

® angle is a vector of angles (in radians) ranging from 10° to 240° in 10°
increments.

® counts is a vector of raw alpha particle counts that correspond to the
emission angles in angle.

2 Import these two variables into Curve Fitting Tool.
In Curve Fitting Tool, click Data to open the Data GUI.

In the Data GUI:

a Select angle and counts for X and Y.
b Name the data set C12Alpha

¢ Click Create data set.

d Click Close to dismiss the Data GUL

3 In Curve Fitting Tool, click Fitting to open the Fitting GUI.

4 In the Fitting GUI:
a Click New fit.
b Specify a meaningful fit name.
¢ Select the C12Alpha data set.
d Select Custom Equations for the type of fit.

The Fit Editor for a custom equation fit type is shown following.
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=10l x|
Fit Editor
Mew fit | Copy fit |

Fit name: Iﬁt 1leg4Even

Data zet: - Exclusion rule: (none) -
Type of fit: I Custom Equations LI [~ Center and scale X data
~Custom Equations

Click ™ew” to create a custom equation, New

Edit
Copy and Edit
Delete

Fit options... | I Immedizte apply Caneel | Apply |

Results

Table of Fits

@ Fit name Data set Eguation name S5E B
@ [ft1 (none) NaM Nal

Delete fit Save to workspace. .. Table options... |

Cloze | Help |

e Click New to open the New Custom Equation dialog box.

You use the Linear Equations tab on the New Custom Equation dialog
box, because the Legendre polynomials depend only on the predictor
variable and constants. This tab is shown below for the model given by
¥,(x) (that is, the equation given at the beginning of this procedure). Note
that because angle is given in radians, the argument of the Legendre
terms is given by cos(0,).
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) Hew Custom Equation g =10l x|

Linear Equations I General Equations |

Independent variable: Ix
~Equation
Unknawn
Coeffidents  Terms
v = |az =( |(1/2)*(3%c0s(x) " 2-1) )
+ Ia4 ([ 1/8) (35 cos(x) ~4-30%cos(x) "~ 2+3)
o IaIZI
[¥ Unknown constant coefficient Add a term Remove last term
Equation: a2*((1/2)*(3%cos ()~ 2-1)) +a4™((1/8) *(35%cos () ~+-30%cos (x. ..
Equation name: ILeg4Even
OK | Cancel | Help |

Edit the settings as follows until your Custom Equation dialog box
resembles the example shown.

i Edit the coefficent names to a2, a4, and a0 (click Add a term to get
the third term).

ii Edit the Terms for a2 to (1/2)*(3*cos(x)"2-1).

iii Edit the Terms for a4 to (1/8)*(35*cos(x)"4-30*cos(x)"2+3).
iv Specify the Equation name Leg4Even.

v Click OK.

5 In the Fitting GUI, click Apply to save the changes to the fit.
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The fit and residuals are shown below in Curve Fitting Tool. The fit appears

to follow the trend of the data well, while the residuals appear to be randomly
distributed and do not exhibit any systematic behavior.

<) Curve Fitting Tool (O] %]
File “iewy Toolz ‘Whdow Help

2 & & H

Dets... |

Exclude... | Plotting. .. | Analysis. |

Data and Fits
T

+  GCizalpha
LegdEven

Residuals
30 T T T

The numerical fit results displayed in the Fitting GUI are shown below. The
95% confidence bounds indicate that the coefficients associated with P(x)

and P,(x) are known fairly accurately, but that the P,(x) coefficient has a
relatively large uncertainty.
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Results

Linear model: 1=
fix) = a2*(1/2)%(3%cos(x)*2-1) + ad*(1/8)*

Coefficients (with 95% confidence bounds):

The coefficients associated with P x) and
az = 23.86 (4.436, 43.29) }

ad = 201.9 (180.2, 223.6) Pylx)are I(mwnn(curnle|y,|3ull|1e Polx)

- e 192, L2 coefficient has o larger uncertainty.

Goodness of fit:
S3E: 7968
R-square: 0.9668
Adjusted R-sguare: 0.9637 —

FMSE: 19.48 =
1| | _’I_I

To confirm the theoretical argument that the alpha-emission data is best
described by a fourth-degree Legendre polynomial with only even terms, fit
the data using both even and odd terms:

Yo (x) = y1(x) +a;x +ag (% )(5x3 -3x)

1 In the Fitting GUI, click Copy and Edit to make a modified copy of your
previous Legendre polynomial.

2 Edit the Linear Equations tab of the New Custom Equation dialog box as
follows to fit the model given by y,(x).

a Click Add a term twice to add the odd Legendre terms.
b Edit the new coefficient names to a1 and a3.

¢ Edit the Terms for a1 to cos(x).

d Edit the Terms for a3 to cos(x).

e Specify the Equation name Leg4Even0dd.

The New Custom Equation dialog box should resemble the example
following.
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) Copy and Edit Custom Equation z 10l =l
Linear Equations I General Equations |
Independent variable: Ix
~Equation
Unknown
Coeffidents  Terms
v = a2  |(1/2)*(37cosf)~2-1) )
* |a4 * I(1,'8)‘(35‘tns{x)*4—30‘tns{x)*2+3) ]
+ Ial H Icns(x) )]
+ [a3 *( |(1/2)¥(5%cos(x) " 3-3"cos(x]) )
5 IaIZI
[¥ Unknown constant coefficent Add a term Remove last term
Equation: a2*((1/2)*(3%cos ()~ 2-1)) +a4™((1/8) *(35%cos(x) ~4-30*cos (X...
Equation name: |KE ST=alells]
0K Cancel | Help |

f Click OK to close the dialog box.
3 In the Fitting GUI select your new equation Leg4Even0dd, and click Apply

to save the changes to the new fit. Observe the new fit plotted in Curve
Fitting Tool.
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The numerical results shown in the Fitting GUI indicate that the odd
Legendre terms do not contribute significantly to the fit, and the even
Legendre terms are essentially unchanged from the previous fit. This
confirms that the initial model choice is the best one.

Results

Linear model: =
£(x) = a27(1/2)7(37c0s(x)*2-1) + ad¥ (1/6)%
Cogpfficients (with 95% confidence bounds):
az = Z4.18 (3.28L, 43 11 The odd Legendre coefficients are likely
ad 201.5 {177.6, 225.5) . N .
al 1.837 {-12.89, 16.56) condidotes for removal fo simplify the fit
a3 L2l (-2z.5z, 20,11 becouse their values are small and their

al 103.1 (92.71, ll3.6) . ;
confidence bounds contain zero.

Goodness of firt:
S8E: 7540
R-scuare: 0.9669
Ldjusted R-zgquare: 0.96

FM3E: 20.44 -
4 »

Example: Fourier Series

This example fits the ENSO data using several custom nonlinear equations.
The ENSO data consists of monthly averaged atmospheric pressure
differences between Easter Island and Darwin, Australia. This difference
drives the trade winds in the southern hemisphere.

As shown in “Example: Smoothing Data” on page 2-33, the ENSO data is
clearly periodic, which suggests it can be described by a Fourier series

yx) =ag+ . q cos(2n§J+ b; sin(znﬁ)

i1 i Gi

where a; and b, are the amplitudes, and ¢, are the periods (cycles) of the data.

The question to be answered in this example is how many cycles exist? As
a first attempt, assume a single cycle and fit the data using one sine term
and one cosine term.

y1(x)=ag+ay cos(Znﬁ)+ (o)) sin(ZniJ

a a
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If the fit does not describe the data well, add additional sine and cosine terms
with unique period coefficients until a good fit is obtained.

Because there is an unknown coefficient c¢; included as part of the
trigonometric function arguments, the equation is nonlinear. Therefore, you
must specify the equation using the General Equations tab of the Custom
Equation GUIL
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The General Equations tab of the dialog box is shown below for the equation
given by y,(x).

) Copy and Edit Custom Equation 10l =l

Linear Equations General Equations I

Independent variable: Ix

Equation: [y = IaD+al‘tns(2‘pi"xfc 1)+b 1%sin{2*pi*x/c1)
Unkno... | StartP... | Lower Upper
al 3.44e-02 -Inf] Inf]
al 0.503 -Inf] Inf]
b1 0.839 -Inf] Inf
cl 3.31e-02 -Inf] Inf]

Equation name: IEnso 1Perind
Help |

1 Enter aO+at1*cos(2*pi*x/c1)+b1*sin(2*pi*x/c1) in the equation edit
box.

By default, the coefficients are unbounded and have random starting
values between 0 and 1.

2 Specify the equation name Enso1Period.

3 Click OK.

Note that the toolbox includes the Fourier series as a nonlinear library
equation. However, the library equation does not meet the needs of this
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example because its terms are defined as fixed multiples of the fundamental
frequency w. Refer to “Fourier Series” on page 2-54 for more information.

Try applying the fit to the enso data set.

1 Enter load enso at the command line, and use the Data GUI to create
a data set of pressure and month.

2 In the Fitting GUI, click New fit.

3 Select the enso data set.

4 Select Custom Equations for the type of fit.

5 Select the Enso1Period equation and click Apply.

The numerical results shown below indicate that the fit does not describe
the data well. In particular, the fitted value for c1 is unreasonably small.
Your initial fit results might differ from the results shown here because the
starting points are randomly selected.

Results

General model: =

Lix) = al+al*cos(Z%pi*x/cl)+bl¥aini2%pi*xscl)
Coefficients (with 95% confidenhce bounds):
al = 10.64 (10.12, 11.17)

al -0.06473 [-1.548, 1.418)
bl 0.3578 (-0.4135, 1.129)
cl = 0.6402  (0.6374, 0.643)

Goodness of f£it:
S3E: 1952
B-zquare: 0.005695
Adjusted R-souare: -0.01249 —
REM3E: 3.45 ;I

As you saw in “Example: Smoothing Data” on page 2-33, the data include
a periodic component with a period of about 12 months. However, with c1
unconstrained and with a random starting point, this fit failed to find that
cycle. To assist the fitting procedure, constrain c1 to a value between 10

and 14.

To define constraints for unknown coefficients, use the Fit Options dialog box.

1 In the Fitting GUI, click the Fit options button.
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2 In the Fit Options dialog box, edit the bounds for ¢1 to constrain the cycle

between 10 and 14 months.

~). Fit Dptions for custom: Enso1P x|
Method: MonlinearLeastSquares
Robust jor =l
Algorithrm: |Trust—Regi0n j
DifinChange: | 1.0E-8
DifaxChange: | K]
MaxFunEvals: | 600
Maniter: | 400
TolFun: | 1.0E-6
Talx: | 1.0E-6
Unknowns| StartPoint|  Lower Upper
al 5.000 -Inf| Inf|
al 0.3148 -Inf] Inf]
b1 0.700 -Inf| Inf|
cl 0.642 10.000 14.000

___ (onstrain the cycle o be
between 10 and 14 months.

3 Click Close to close the dialog, and in the Fitting GUI click Apply to save
the changes to the new fit. Observe the new fit plotted in Curve Fitting

Tool.
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The fit, residuals, and numerical results are shown below.

-} Curve Fitting Tool =10 x|
File View Tools Window Help
|&|® 2|2
Data... | Fitting... | Exclude... Flotting... Analyzis... |
Data and Fits
* . . ..... + enso
Lin . e | — EnzolPeriod ]
1 \/\-)/ \j ] L The fit for one cycle.
* Vool ¥
5L - .' . . Yo s, *e |
D C 1 1 1 1 1 1 hd 1 1 b
o] 20 40 B0 80 100 120 140 160
Residuals
10 T T T T T T
.|+ EnsolPeriod
st . . ..
ST s R R The residuaks indicate that at
I A Y A Jol T AN — .
0 5, ’ : ..o 2 . .l ~.: ; ..:... R L east one more CYCIE exists.
UL e e T S L.
5E ot . . .
Results
_1D [l 1 1 1 1 1 . -
0 o0 40 50 a0 100 General model: =
fix) = al+al*cos(Z*pi*xscl)+bl*sin(Z*%pi*x/cl)

Coefficients (with 95% confidence bounds):

a0 = 10.63 (10.22, 11.03) |
al = 2,876 (2.187, 3.565)

The numerical results bl = 1.176 (0.09147, Z2.261)
cl = 11.94 (11.85, 12.03)

indicate a 12 month cycle.

The fit appears to be reasonable for some of the data points but clearly does
not describe the entire data set very well. As predicted, the numerical results
indicate a cycle of approximately 12 months. However, the residuals show a
systematic periodic distribution indicating that there are additional cycles
that you should include in the fit equation. Therefore, as a second attempt,
add an additional sine and cosine term to y,(x)

¥o(x) = y1(x) + ag cos on = |+ by sin on =
Co Co
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and constrain the upper and lower bounds of ¢, to be roughly twice the bounds
used for c;.

1 In the Fitting GUI. click Copy fit.
2 Select the Enso1Period custom equation and click Copy and edit.

Add the following terms to the end of the previous equation:
+a2*cos(2*pi*x/c2)+b2*sin(2*pi*x/c2)

3 Edit the bounds for ¢1 to constrain the cycle between 10 and 14 months.

4 Edit the bounds for c2 to be roughly twice the bounds used for c1
(20<c2<30).

5 Edit the equation name to Enso2Period, and click OK.

6 In the Fitting GUI, select the Enso2Period equation and click Apply.
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The fit, residuals, and numerical results are shown below.

L=
File View Tools Window Help
@ # o=
Data... | Fitting... | Exclude... | Flotting... | Analyziz...
Data and Fits
* . + o [+ enso
15 . . » ;o . ‘s| — Enso2Period [
. S, Ry ._U\
10 7 L . LS Y ] .
i . A . L The fit for two cycles.
- - 0. - -
5L - e . ., s J
D I 1 1 1 1 1 1 hd 1 1 b
] 20 40 G0 a0 100 120 140 160
Residuals
10 T T T T T T T T
+  Enso2Period
&
The residuals indicate that
one more cycle might exist.

Results

General model:

Eix) =
al = 10,59
al = 2.865
az = -0.8lz6
bl = 1.282
bhZ = 0. 5006
The numerical resulis indicate el = 11.93
cZ = zl.86

an additional 22 month cycle.

al+al*cos(Z%pi*=/cl)+bl¥sin(2%pi*xscl)+
Coefficients (with 95% confidence bhounds):

-

{10.2, 10.99)
{2.172, 3.557)
{-1.567, -0.05857)
(0,223, 2.341)
{-0.4819, 1.483)
{11.85, 12.02)
{20.95, 22.76)

i of

The fit appears to be reasonable for most of the data points. However, the
residuals indicate that you should include another cycle to the fit equation.
Therefore, as a third attempt, add an additional sine and cosine term to y,(x)

y3(x) = y9(x) + ag cos o= |+ by sin o=
a3 €3
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and constrain the lower bound of ¢, to be roughly three times the value of c;.
1 In the Fitting GUI. click Copy fit.
2 Select the Enso2Period custom equation and click Copy and edit.

Add the following terms to the end of the previous equation:
+a3*cos(2*pi*x/c3)+b3*sin(2*pi*x/c3)

3 Edit the lower bound of ¢3 to be 36, roughly three times the value of c1.
4 Edit the equation name to Enso3Period.

5 In the Fitting GUI, select the Enso3Period equation and click Apply.
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The fit, residuals, and numerical results are shown below.

-} Curve Fitting Tool - 18] x|
File View Tools Window Help
g ® 2ls |5k
Data... | Fitting... | Exclude... Flotting... Analyziz... |
Data and Fits
' . s ey [+ enso
L12] S .. ‘e| — Enso3Period [
* .4 N o . . . M y 3
o AWE . 4 £ \-j .\/ L The fit for three cycles.
A . b .
a5+ b . .o .o . 4
D IC 1 1 1 1 1 1 b 1 1 1
] 20 40 50 50 100 120 140 160
Residuals
10 T T T T T T T T
+  Enso3Period .
. The residuals appear
—— fairly random for most
of the data set.

The numerical resulis indicate
12, 22, and 44 month cycles.

o

Results
General model: o
fix) = al+al*cos(2%pi*x/cli+bl*sin(2%pi*x/cl)+
Coefficients (with 95% confidence bounds):
al = 10.52  (10.16, 10.89)
al = Z.804 (2.144, 3.464)
az = -0.7867 (-1.58, 0.006603)
ad = -1.608  (-2.13, -1.088)
bl = 1.474 (0.5307, Z.418)
hz = 0.7441 (-0.06543, 1.554)
b3 = 0.1669 (-0.8447, 1.179)
cl = 11.92 (11.84, 11.99)
cZ = 22,04 (21.29, 22.78)
c3 = 43,56  (41.64, 45.48)

5

4] |

The fit is an improvement over the previous two fits, and appears to account
for most of the cycles present in the ENSO data set. The residuals appear
random for most of the data, although a pattern is still visible indicating that
additional cycles may be present, or you can improve the fitted amplitudes.

In conclusion, Fourier analysis of the data reveals three significant cycles.
The annual cycle is the strongest, but cycles with periods of approximately 44
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and 22 months are also present. These cycles correspond to El Nino and the
Southern Oscillation (ENSO).

Example: Gaussian with Exponential Background

This example fits two poorly resolved Gaussian peaks on a decaying
exponential background using a general (nonlinear) custom model. To get
started, load the data from the file gauss3.mat, which is provided with the
toolbox.

load gauss3
The workspace now contains two new variables, xpeak and ypeak:

® xpeak is a vector of predictor values.
® ypeak is a vector of response values.

Import these two variables into Curve Fitting Tool and accept the default data
set name ypeak vs. xpeak.

You will fit the data with the following equation

yx) =ae P +aje\ @) +age \ @

where a; are the peak amplitudes, b, are the peak centroids, and ¢, are related
to the peak widths. Because there are unknown coefficients included as part
of the exponential function arguments, the equation is nonlinear. Therefore,
you must specify the equation using the General Equations tab of the New
Custom Equation dialog box. This tab is shown below for y(x).
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<)} Create Custom Equation = |EI|1|
Linear Equations  General Equations |
Independent variahle: &
Equation:bf = |a*exp(—b*)<)+a1*exp(—((x—b1)rc1)"2)+32*exp(—((x—bEJIcz)"Ej
Unknowns | StartPoint Lower Upper
a 0167 -Inf] Inf]
al 0.809 -Inf] Inf]
aZ 0.523 -Inf] Inf]
h 0.744 -Inf] Inf]
b1 0105 -Inf] Inf]
h2 0.204 -Inf] Inf]
cl 0173 -Inf] Inf]
) 0.345 -Inf] Inf]

Equation name: IGaussEExm

Ok | Cancel I Help |

Two Gaussian peaks on an
exponential background.

By default, the coefficients are
unbounded and have random
starting values between O and 1.
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The data, fit, and numerical fit results are shown below. Clearly, the fit is

poor.

-} Curve Fitting Tool

File ‘Wiew Tools

Window  Help

i =10l ]

g ® 2|12k

[rata... | Fitting... | Exclude... | Flotting... | Analyziz... |

180
160
140
120
100
80
60
40
20

+  ypeak vs xpeak |7
— GaussZExpl

Results

Fit cowputation did not conwverge: =
Maximum number of function evaluations exceeded. Increasing
MaxFunEvals (in fit options) may allow for a better £it, or
the current ecquation may not be a good model for the data.

Fit found when optimization terminated:

General model:

fix) = a*expi-b¥x)4+al%exp(-(ix-bl]/cl)*2]+a2%expi-i (>
Coefficients (with 95% confidence bounds):

a = 495,2 (-Inf, Inf)

al = 0.8086 (-Inf, Inf)

az = -323.8 (-Inf, Inf) 1
b = 0.01304 (-Inf, Inf)

bl = 0.1053  {-Inf, Inf)

bz = -Z.094 (-Inf, Inf)

cl 0.1733 (-Inf, Inf)

oz = -7z.89 (-Inf, Inf) =
4| | »

Because the starting points are randomly selected, your initial fit results
might differ from the results shown here.

The results include this warning message.
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Fit computation did not converge:

Maximum number of function evaluations exceeded. Increasing
MaxFunEvals (in fit options) may allow for a better fit, or
the current equation may not be a good model for the data.

To improve the fit for this example, specify reasonable starting points for
the coefficients. Deducing the starting points is particularly easy for the
current model because the Gaussian coefficients have a straightforward
interpretation and the exponential background is well defined. Additionally,
as the peak amplitudes and widths cannot be negative, constrain a,, a,, ¢,,
and c, to be greater then zero.

To define starting values and constraints for unknown coefficients, use the
Fit Options GUI, which you open by clicking the Fit options button. The
starting values and constraints are shown below.

<} Fit Dptions for custom: Gauss 1[
Method: MonlinearLeastSguares
Robust: jort =
Algarithim: |Trust—Regi0n LI
DiftinChange: | 1.0E-8
DifaxChange: | 01
MaxFunEvals: | 600
Maxiter: | 400
TalFun: | 1.0E-6
Tolx: | 1.0E-6
Unknowns| StartPaint Lower Upper
a 100.000 -Inf] Inf]
al 100.000 1] 1f]
al g0.000 1] Inf] . ..
b T 00801 T i Specify reasonable coefficient
b 110.000 -Inf Inf starting values and constraints.
b2 140.000 -Inf] Inf]
cl 20.000 0 Inf]
c2 20.000 1] 1]
o |
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The data, fit, residuals, and numerical results are shown below.

-} Curve Fitting Tool

File View Tools Window Help

=1ol]

g ® 2|2k

[rata... | Fitting... | Exclude... Flotting... Analyziz... |
140 F T T T T 9
ypeak vs. xpeak
170 — GaussZBxpl

0 a0

100

150

Results
General model: 1=
fix) = avexpi-b¥x)+al%exp(-((x-bl)/cl)*2]+az¥exp
Coefficients (with 95% confidence bounds):
a = 95,94  (97.9, 99.98)
al = lo0.7  (99.09, 102.3)
az = 73,71 (71.32, 76.09)
b = 0.01085  (0.0107, 0.0111%9)
bl = 11l.6 {l10.9, 112.3)
bz = 147.8 (147, 148.6)
cl = 23.3  (22.58, 24.02)
cz = 192,67 (l8.92, 20.41)

Goodness of firt:
35E: 1244
R-square: 0.9969
Adjusted B-scuare: 0.9968 1

RNSE: 2.268 —
4 | _’I_I
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Nonparametric Fitting

2-106

In this section...

“Introduction” on page 2-106
“Example: Nonparametric Fitting” on page 2-106

Introduction

In some cases, you are not concerned about extracting or interpreting fitted
parameters. Instead, you might simply want to draw a smooth curve through
your data. Fitting of this type is called nonparametric fitting. The Curve
Fitting Toolbox software supports these nonparametric fitting methods:

¢ Interpolants — Estimate values that lie between known data points.

® Smoothing spline — Create a smooth curve through the data. You adjust
the level of smoothness by varying a parameter that changes the curve from
a least-squares straight-line approximation to a cubic spline interpolant.
For more information about interpolation, refer to “Functions of One Variable”
and the interp1 function in the MATLAB documentation.

Example: Nonparametric Fitting
This example fits the following data using a cubic spline interpolant and
several smoothing splines.

X = (4*pi)*[0 1 rand(1,25)1];
y sin(x) + .2*(rand(size(x))-.5);

As shown below, you can fit the data with a cubic spline interpolant by
selecting Interpolant from the Type of fit list.



Nonparametric Fitting

=) Fitting

Fit Editor

I fit Copy fit
FitMame: |CubicSp
Data set: MoisySine 'l Exclusion rule:  |inone) 'l
Type offit:  |Interpolant 'l [ Center and scale X data

Interpolant

=10/

linear
nearest neighbor

shape-preserving

The results shown below indicate that goodness-of-fit statistics are not defined
for interpolants.

Results

Cubic spline interpolant:

fix) = piecewise polynomial computed from p
Coefficients:

|»

p = coefficient structure

Goodness of fit:
S5E: 2.359e-033
R-square: 1 [
Adjusted R-square: Nal

A cubic spline interpolation is defined as a piecewise polynomial that results
in a structure of coefficients. The number of “pieces” in the structure is one
less than the number of fitted data points, and the number of coefficients for
each piece is four because the polynomial degree is three. The toolbox does
not allow you to access the structure of coefficients.

As shown below, you can fit the data with a smoothing spline by selecting
Smoothing Spline in the Type of fit list.
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Fit Editor

[lew fit | Copy fit |

Fit Mame ISmnntm
Diata set INmsvSine - Exclusion rule I(none) -
Type offit  |Smoothing Spline < [ Center and scale X data

Smoothing Spline
Smoothing Parameter:

& Default The default smoothing
© Bpecity ;l [o-39819 ;l —— parameter i based on
the data set you fit.

The level of smoothness is given by the Smoothing Parameter. The default
smoothing parameter value depends on the data set, and is automatically
calculated by the toolbox after you click the Apply button.

For this data set, the default smoothing parameter is close to 1, indicating
that the smoothing spline is nearly cubic and comes very close to passing
through each data point. Create a fit for the default smoothing parameter and
name it Smooth1. If you do not like the level of smoothing produced by the
default smoothing parameter, you can specify any value between 0 and 1. A
value of 0 produces a linear polynomial fit, while a value of 1 produces a
piecewise cubic polynomial fit that passes through all the data points. For
comparison purposes, create another smoothing spline fit using a smoothing
parameter of 0.5 and name the fit Smooth2.

The numerical results for the smoothing spline fit Smooth1 are shown below.

Results

Smoothing spline: =
fix) = piecewise polynomial computed from p
Smoothing parameter:
p = 0.99919036

Goodness of fir:
S5E: 0.003493
R-smquare: 0.9937
Adjusted R-square: 0.5353
BMZE: 0.02217 j

The data and fits are shown below. The default abscissa scale was increased
to show the fit behavior beyond the data limits. You change the axes limits
with Tools > Axes Limit Control menu item.
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.} Curve Fitting Tool =] 3]

File Wiew Tools wWindow Help
el o2k

Data... | Fitting... | Exclude... Flatting. . Analpsiz... |

< MoisySine
L N - S L CubicZp H
— Smaoothl
=== Smaooth2
. / _ The cubic spline and default
smoothing spline results are
similar for interior points.
D | -
' .
The cubic spline and default
sl . smoothing spline results

diverge at the end poinis.

The default smoothing
parameter produces a /
smoother result than
the interpolant.

Note that the default smoothing parameter produces a curve that is smoother
than the interpolant, but is a good fit to the data. In this case, decreasing
the smoothing parameter from the default value produces a curve that is
smoother still, but is not a good fit to the data. As the smoothing parameter
increases beyond the default value, the associated curve approaches the cubic
spline interpolant.
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Interactive Surface Fitting

¢ “Fitting a Surface” on page 3-2

e “Interactive Surface Fitting Examples” on page 3-12

e “Selecting Fit Settings” on page 3-30

¢ “Fitting Multiple Surfaces ” on page 3-37

¢ “Comparing Surface Fits” on page 3-39

® “Generating Code and Exporting Fits to the Workspace” on page 3-45
¢ “Working with Sessions” on page 3-50
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Fitting a Surface

In this section...

“Introducing the Surface Fitting Tool” on page 3-2
“How to Fit a Surface” on page 3-3

“Opening the Surface Fitting Tool” on page 3-4
“Selecting Data” on page 3-4

“Refining Your Fit” on page 3-8

“Removing Outliers” on page 3-8

“Selecting Validation Data” on page 3-9
“Exploring and Customizing Plots” on page 3-10

Introducing the Surface Fitting Tool

You can interactively fit surfaces to data and view plots with the flexible and
intuitive Surface Fitting Tool graphical user interface. You can use Surface
Fitting Tool to:

® Create, plot, and compare multiple surface fits

® Use linear or nonlinear regression, interpolation, local smoothing
regression, or custom equations

® View goodness-of-fit statistics, display confidence intervals and residuals,
remove outliers and assess fits with validation data

® Automatically generate code for fitting and plotting surfaces, or export fits

to workspace for further analysis

The following image shows the Surface Fitting Tool displaying a session with
multiple fits and plots.
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=} Surface Fitting Tool

Sle Rt Mew Tools [Desdop Window Help

[« M| & = ([ |

it|| Smoathing regression = | polpdd = | ]‘:]
| Smoathing regression 0O x
Fit name: |54'rmﬂ1.ng regression I Leoraess Fit rame: |Fdl."13 I Pelynomisl
L j" Pelynomial; | Ungar Kiout: |« j" Degrees; x: | 4 'I ¥
] m i |5— W m : IG‘F—
Zoulput: [z 'I Recbust: |cnr-r Zoutpit: [z "I [ Center and scale
Weights: | irene) 'I [ Center and scal= Weights: [(reme) = [
Resits | Emocthing regression || | paaie
Lecally eichl.a:l-: ?oEw Ry l'_i'n-z;arrnmjelT
i . —
v} = low ; * Eucluded zvs. &, y Fx,y] = p
where xig 124, P :
and wherne : I where x
Cosfficents: | 1. and v
p= coeffige ' Cosfficernts |
0& . B0 =
Goodness af fit: 4 A plo =
55E: 2,332 05 Bl =
A-square: 0,89 i pil =
Acdpasted o 04 pil=
AMSE: 01072 ; pOZ =
02 -
i pal =
l:l 1' plz =
: 0= —
024 pEl=
P\zz -
1000
Goodness of
o g SEE: §,575 *
1| r| ¥ ¥ 4 r &
IFﬂ:rl:mz w Diats Fitbype |S5E R-=quar= |OFE AdjR-=q |RMEE = Coeff | Wabdat., .| Valida.., | Vaida...

4 unbt=d ft 4 Inearmtery ﬂ
il poly+3 lzus, x, ¥ polytd ] 09.7304 173 JU.'."E‘! 0. 1564 12 !__l
T inb=rp lzvs, x, ¥ Inesrmlerg|5.8651=-31)1 1] _ﬂuH lHu.‘l 233 d

#

How to Fit a Surface

The process of fitting a surface to data involves the following steps:

1 “Opening the Surface Fitting Tool” on page 3-4

2 “Selecting Data” on page 3-4
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3 “Refining Your Fit” on page 3-8
4 “Removing Outliers” on page 3-8
5 “Selecting Validation Data” on page 3-9

6 “Exploring and Customizing Plots” on page 3-10

For instructions demonstrating how to load some example data and create a
surface fit, see “Interactive Surface Fitting Examples” on page 3-12.

For next steps, see also “Fitting Multiple Surfaces ” on page 3-37 and
“Comparing Surface Fits” on page 3-39

Opening the Surface Fitting Tool
Open the Surface Fitting Tool using one of these methods:
* Enter sftool at the MATLAB command line.
® Select from the MATLAB Start menu:
Start > Toolboxes > Curve Fitting > Surface Fitting Tool (sftool)

Next, you are ready to select the data you want to fit to the surface.

Selecting Data

To select data to fit, use the drop-down lists in the Surface Fitting Tool to
select variables for X input, Y input, and Z output.

Note To load example data to use in the Surface Fitting Tool, enter load
franke at the command line. See “Franke Data Interactive Surface Fitting
Example” on page 3-12 for more instructions.

You can use the Surface Fitting Tool drop-down lists to select any numeric
variables (with more than one element) in your MATLAB workspace.
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Fit name: |p-:.|y2

¥ inpuk: IGn

Y inpuk: INE

Z aukpuk: IOT

Ll Lef L 15

Weights: Il{nu:une)

For X, Y, and Z you can select:

e Matrices with the same number of elements

¢ Data in the form of a table
For more information see “Selecting Compatible Size Data” on page 3-6.

Similarly, you can select any numeric data in your workspace to use as
Weights.

When you select three variables, the Surface Fitting Tool immediately
creates a fit with the default settings. You can turn off Auto fit to avoid
time-consuming refitting for large data sets, by clearing the Auto fit check
box.

[+ Auto fit

it

Note The Surface Fitting Tool uses a snapshot of the data you select.
Subsequent workspace changes to the data have no effect on your surface
fits. To update your fit data from the workspace, first change the variable
selection, and then reselect the variable with the drop-down controls.
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Selecting Compatible Size Data

For X input, Y input, and Z output you can select either “Matrices of the Same
Size” on page 3-6 or “T'able Data” on page 3-6.

Matrices of the Same Size. Surface Fitting Tool expects inputs to be the
same size. If the sizes are different but the number of elements are the same,
then the tool reshapes the inputs to create a fit and displays a warning in the
Results pane. The warning indicates a possible problem with your selected
data.

Table Data. Table data means that X and Y represent the row and column
headers of a table (sometimes called breakpoints) and the values in the table
are the values of the Z output.

Sizes are compatible if:

e X is a vector of length n.
® Y is a vector of length m.
® 7 is a 2D matrix of size [m,n].

The following table shows an example of data in the form of a table with n
= 4 andm = 3.

x(1) x(2) x(3) x(4)
y(1) z(1,1) z(1,2) z(1,3) z(1,4)
y(2) z(2,1) z(2,2) z(2,3) z(2,4)
y(3) z(3,1) z(3,2) z(3,3) z(3,4)

Like the surf function, the tool expects inputs where length(X) = n,
length(Y) = mand size(Z) = [m,n]. If the size of Z is [n,m], the tool
creates a fit but first transposes Z and warns about transforming your data.
You see a warning in the Results pane like the following example:

Using X Input for rows and Y Input for columns

to match Z Output matrix.

For suitable example table data, run the following code:



Fitting a Surface

x = linspace( 0, 1, 7 );
y = linspace( 0, 1, 9 ).';
z = bsxfun( @franke, x, y );

Weights. If you specify Weights, assign an input the same size as Z. If the
sizes are different but the number of elements is the same, Surface Fitting
Tool reshapes the weights and displays a warning.

Troubleshooting Data Problems

If there are problems with the data you select, you see messages in the
Results pane. For example, the Surface Fitting Tool ignores Infs, NaNs, and
imaginary components of complex numbers in the data, and you see messages
in the Results pane in these cases.

If you see warnings about reshaping your data or incompatible sizes, read
“Selecting Compatible Size Data” on page 3-6 for information.

If you see the following warning: Duplicate x-y data points detected:
using average of the z values., this means that there are two or more
data points where the input values (x, y) are the same or very close together.
The default interpolant fit type needs to calculate a unique value at that
point. You do not need do anything to fix the problem, this warning is just for
your information. The Surface Fitting Tool automatically takes the average z
value of any group of points with the same x-y values.

Other problems with your selected data can produce the following error:

Error computing Delaunay triangulation. Please try again with
different data.

Some arrangements of data make it impossible for Surface Fitting Tool to
compute a Delaunay triangulation. Three out of the four surface interpolation
methods (linear, cubic, and nearest) require a Delaunay triangulation of the
data. An example of data that can cause this error is a case where all the data
lies on a straight line in x-y. In this case, Surface Fitting Tool cannot fit a
surface to the data. You need to provide more data in order to fit a surface.
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Note Data selection is disabled if you are in debug mode. Exit debug mode to
change data selections.

Refining Your Fit

You can refine your fit, using any of the following optional steps:

¢ Change fit type and settings. Select GUI settings to use the Surface
Fitting Tool built-in fit types or create custom equations. Built-in fit types
are Interpolant, Polynomial, and Lowess. See “Selecting Fit Settings”
on page 3-30.

¢ Exclude data by removing outliers in the Surface Fitting Tool. See
“Removing Outliers” on page 3-8.

® Select weights. See “Selecting Data” on page 3-4.
® Select validation data. See “Selecting Validation Data” on page 3-9

® (Create multiple fits and you can compare different fit types and settings
side by side in the Surface Fitting Tool. See “Fitting Multiple Surfaces ” on
page 3-37 and “Comparing Surface Fits” on page 3-39.

Removing Outliers
To remove outliers, follow these steps:

B

1 Select Tools > Exclude Outliers or click the toolbar button " .

When you move the mouse cursor to the plot, it changes to a cross-hair to
show you are in outlier selection mode.

2 Click a point that you want to exclude in the surface plot or residuals
plot. Alternatively, click and drag to define a rectangle and remove all
enclosed points.

A removed plot point becomes a red star in the plots. If you have Auto-fit
selected, the Surface Fitting Tool refits the surface without the point.
Otherwise, you can click Fit to refit.

3 Repeat for all points you want to exclude.



Fitting a Surface

When removing outliers, it can be helpful to display a 2-D residuals plot for
examining and removing outliers. With your plot cursor in rotation mode
(select Tools > Rotate 3D.) Next, right-click the plot to select X-Y, X-Z, or
Y-Z view. The following image shows an X-Z plot with some outliers removed.

T2

018247 ~ - r
: —¥ |owess - regiduals
' —k  Excluded TQ ve. M, L
| ]
w1 [qe
.r.h_a..—.- i A | A | =
L Y )
. - . .
O TEETIR e e e e e e e e F T TR 3
500 4484 375

i

To replace excluded points in the fit, click an excluded point again in Exclude
Outliers mode.

x+

To return to rotation mode, click the Exclude outliers toolbar button " *
again to turn off outlier selection mode.

Selecting Validation Data

To specify validation data for the currently selected fit, follow these steps:

1 Select Fit > Specify Validation Data. The Specify Validation Data
dialog box opens.

2 Select variables for X input, Y input, and Z output.

When you select the three variables, the tool calculates validation statistics
(SSE and RMSE) and displays them in the Results pane and the Table
of Fits. For definitions of these statistics, see “Using the Statistics in the
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Table of Fits” on page 3-43. Your validation data points display on the
surface plot and residual plot along with the original data.

3 Close the dialog box.

Exploring and Customizing Plots

You can change mouse mode for manipulating plots, customize your view to
show different plots of your fit, and control plot options with the toolbar,
Tools and View menus. This section describes the options available.

Using Rotation, Data Cursor, and Outlier Exclusion
Click-and-drag rotation or Rotate 3D is the default mouse mode in Surface
Fitting Tool. You can use the toolbar or Tools menu to switch to Data
Cursor or Exclude Outliers modes.

Surface Fitting Tool remembers your selected mouse mode in each fit figure
within a session.

Note To return to rotate mode, switch off Data Cursor or Exclude
Outliers mouse mode.

Use the toolbar or Tools menu to toggle your mouse mode in your plots:

L

. E — Data Cursor selects data cursor mode, where you can click points
to display input and output values.

e "% _ Exclude Outliers selects outlier mode, where you can click points
to remove or include them in your fit. See “Removing Outliers” on page 3-8.

Customizing the Fit Display

To customize your plot display, you can use the toolbar, Tools menu or the
View menu. See also “Comparing Surface Fits” on page 3-39.
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Tools Menu and Toolbar.

. & — Legend toggles display of the Legend on all plots in the currently
selected fit tab.

. £ — Grid toggles display of the grid on all plots in the currently selected
fit tab.

.
] ﬂ — Axes Limits opens a dialog box where you can specify upper and
lower bounds for the X and Y axes of plots. Click the Reset button in the
Axes Limits dialog box to return to the default axes limits.

® Tools > Surface Prediction Bounds allows you to choose which bounds
to display: None, 90%, 95%, 99%, or Custom., The custom option opens a
dialog box where you can enter the required confidence level.

View Menu and Toolbar.

e Available in both the View menu and the toolbar:

=l Surface Plot toggles display of the surface plot in the currently

selected fit tab. This item is disabled if only the surface plot is displayed.

— Residuals Plot toggles display of the residuals plot in the
currently selected fit tab. This item is disabled if only the residuals
plot is displayed.

- — Contour Plot toggles display of the contour plot in the currently
selected fit tab. This item is disabled if only the contour plot is displayed.

* View > Fit Settings toggles display of the fit controls pane in the currently
selected fit tab (Fit name, inputs, fit type, and so on).

¢ View > Fit Results toggles the display of the Results pane in the
currently selected fit tab. When you display the Results pane, you can see
model terms and coefficients, goodness-of-fit statistics, and information
messages about the fit.

e View > Table of Fits toggles the display of the Table of Fits pane in
Surface Fitting Tool.
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Interactive Surface Fitting Examples

In this section...

“Franke Data Interactive Surface Fitting Example” on page 3-12

“Biopharmaceutical Interactive Surface Fitting Example” on page 3-22

Franke Data Interactive Surface Fitting Example

The Surface Fitting Tool provides some example data generated from Franke’s
bivariate test function. This data is suitable for trying various fit settings in
Surface Fitting Tool.

To load the example data and create, compare, and export surface fits, follow
these steps:

1 To load example data to use in the Surface Fitting Tool, enter 1load franke
at the MATLAB command line. The variables x, y, and z appear in your
workspace.

The example data is generated from Franke’s bivariate test function, with
added noise and scaling, to create suitable data for trying various fit
settings in Surface Fitting Tool. For details on the Franke function, see
the following paper:

Franke, R., Scattered Data Interpolation: Tests of Some Methods,
Mathematics of Computation 38 (1982), pp. 181-200.

2 To divide the data into fitting and validation data, enter the following

syntax:
Xv = x(200:293);
yv = y(200:293);
zv = z(200:293);
X = x(1:199);
y = y(1:199);
z = 2z(1:199);

3 To fit a surface using this example data:
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a Open Surface Fitting Tool. Enter sftool, or select
Start > Toolboxes > Curve Fitting > Surface Fitting Tool
(sftool).

b Select the variables x, y, and z interactively in the Surface Fitting Tool.

Fit name: Iunﬁtleu:l fit1
X input: (none) LI
g —
Z output: [V
¥
Weights: |yv
Z =
Results v
0 Select X input, ¥ input and Z output

Alternatively, you can specify the variables when you enter

sftool(x,y,z) to open Surface Fitting Tool (if necessary) and create a
default fit.

The Surface Fitting Tool plots the data points as you select variables.
When you select x, y, and z, the tool automatically creates a default surface

fit. The default fit is an interpolating surface that passes through the
data points.
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.} Surface Fitting Tool ; i =] 5|
File Fit View Tools Desktop Window Help | | A X
By IR EFE BOB=0

Fit name: Iuntiﬂed fit 1| I Interpolant ¥ Auto fit

[=
Xinput: Ix j' Method: I Linear LI Hit
¥ input: I‘f' j' ¥ Center and scale Stop
Z output: Iz vl

Weights: |{none) -

Results

Linear interpolant: e [ Juntitled fit 5

flx,v) = piecewise linear su

where x is normalized by m

and where v is normalized b
Coefficents:

p = coefficent structure

Goodness of fit:
S55E; 7.25%e-031
R-square: 1
Adjusted R-square: NaM
RMSE: NaM

1| | »

|| untited fit5 = ‘ ‘|

able of Fits . o o o £ (o &
Fit.. 2 [Data  [Fittype [352  [rsquare[DFE  [Adirsq [mmse  [#coeff |validati...|vaiidati.. |validati..|
& unt... [z vs. x, y [inearin... [7.2588... [1 o [Mat [Mal | 193] | | |

£

4 Try a Lowess fit type. Select the Lowess fit type from the drop-down list
in the Surface Fitting Tool.

Interpolant LI

Interpalant
Polynomial
Custom Equation

The Surface Fitting Tool creates a local smoothing regression fit.

5 Try altering the fit settings. Enter 10 in the Span edit box.
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By reducing the span from the default to 10% of the total number of data
points you produce a surface that follows the data more closely. The span
defines the neighboring data points the toolbox uses to determine each
smoothed value.

. . .
y s00 1000 1500 2000 2500 3000
K

6 Edit the Fit name to Smoothing regression.

7 If you divided your data into fitting and validation data in step 2, select
this validation data. Use the validation data to help you check that your
surface is a good model, by comparing it against some other data not used
for fitting.

a Select Fit > Specify Validation Data. The Specify Validation Data
dialog box opens.

b Select the validation variables in the drop-down lists for X input, Y
input, and Z output: xv, yv, and zv.

Review your selected validation data in the plots and the validation
statistics (SSE and RMSE) in the Results pane and the Table of Fits.
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. _ _ . [ Smoathing regression
1% ___________ oo ) G ononssrammcies ® zuysowy
: TV WS, W, Y

y 0 “epp 1000 1500 2000 2500 3000
H

8 Create another fit to compare by making a copy of the current surface fit.
Either select Fit > Duplicate "Smoothing regression”, or right-click the
fit in the Table of Fits, and select Duplicate

The tool creates a new fit figure with the same fit settings, data, and
validation data. It also adds a new row to the table of fits at the bottom.

9 Change the fit type to Polynomial and edit the fit name to Polynomial.

Lowess LI
Interpolant

Polynomial
Custom Equation
Lowess

10 Change the Degrees of x and y to 3, to fit a cubic polynomial in both
dimensions.

11 Look at the scales on the x and y axes, and read the warning message
in the Results pane:

Equation is badly conditioned. Remove repeated data points
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or try centering and scaling.

Select the Center and scale check box to normalize and correct for the
large difference in scales in x and y.

Polynomial ;I
Degrees: x: |3 LI VE |3 LI
Robust: I off LI

Fit Options... |

Normalizing the surface fit removes the warning message from the Results
pane.

12 Look at the Results pane. You can view (and copy if desired):
® The model equation
® The values of the estimated coefficients
® The goodness of fit statistics

¢ The goodness of validation statistics

Linear model Poly33:
f(x,y) = p00 + p10*x + pO1*y + p20*x"2 + p1i1*x*y...
+ p02*y"2 + p30*Xx"3 + p21*x"2*y
+ p12*x*y~2 + p03*y"3
where x is normalized by mean 1977 and std 866.5
and where y is normalized by mean 0.4932 and std 0.29
Coefficients (with 95% confidence bounds):

p00 = 0.4359 (0.3974, 0.4743)

p10 = -0.1375 (-0.194, -0.08104)
po1 = -0.4274 (-0.4843, -0.3706)
p20 = 0.0161 (-0.007035, 0.03923)
p11 = 0.07158 (0.05091, 0.09225)
po2 = -0.03668 (-0.06005, -0.01332)
p30 = 0.02081 (-0.005475, 0.04709)
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p21 = 0.02432 (0.0012, 0.04745)
p12 = -0.03949 (-0.06287, -0.01611)
po3 = 0.1185 (0.09164, 0.1453)

Goodness of fit:
SSE: 4.125
R-square: 0.776
Adjusted R-square: 0.7653
RMSE: 0.1477

Goodness of validation:
SSE : 2.26745
RMSE : 0.155312

13 To export this fit information to the workspace, select Fit > Save to
Workspace. Executing this command also exports other information

such as the numbers of observations and parameters, residuals, and the
fitted model.

You can treat the fitted model as a function to make predictions or evaluate
the surface at values of X and Y. For details see “Exporting a Fit to the
Workspace” on page 3-47.

14 Display the residuals plot to check the distribution of points relative to the

surface. Click the toolbar button |E or select View > Residuals Plot.

-

500 1000 1500 2000 2500 3000 |
. ¥
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05-

15 Right-click the residuals plot to select the Go to X-Z view. The X-Z view is
not required, but the view makes it easier to see to remove outliers.

16 To remove outliers, click the toolbar button i or select Tools > Exclude
Outliers.

When you move the mouse cursor to the plot, it changes to a cross-hair to
show you are in outlier selection mode.

a Click a point that you want to exclude in the surface plot or residuals
plot. Alternatively, click and drag to define a rectangle and remove all
enclosed points.

A removed plot point displays as a red star in the plots.

(I

T 1 T I
—® Puolynomial - residuals
— Excluded z vs. x, v

esiduals

EA

L e Ml i
Ol A
B

i i i i i

1000 1500 2000 2500 3000

b If you have Auto-fit selected, the Surface Fitting Tool refits the surface
without the point. Otherwise, you can click Fit to refit the surface.

¢ To return to rotation mode, click the toolbar button = again to switch
off Exclude Outliers mode.

17 To compare your fits side-by-side, use the tile tools. Select
Window > Left/Right Tile, or use the toolbar buttons.
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) surface Fitting Tool =13l x|
File Fit Wew Tools Desktop Window Help £ |
HIOH=0O

Polynomial O a x

Fit name: ISmoDﬂmng regression I Lowess Fit name: IPonnomiaI I Palynomial 2

X input: Ix Vl
' input: Iy VI

Palynomial: I Linear

X input: Ix VI
' input: I\f vl

Degrees: x: |3 vly: 3 9

Locally weighted st

_—

f(x,y) =loweg

where x is nor]

and where y ig
Coefficents:

p = coeffiden

Goodness of fit:
SSE: 2.424
R-square: 0.8684
Adjusted R-squar|
RMSE: 0.117

Goodness of validg
SSE: 1.76692
RMSE : 0.137102)

|:|Smomhing regression
* Tysouy
O Tvus WY,y

Span: I 10 Robust: off I
2 output: Iz & l Robust: I Off Z output: Iz b I W Center and scale
Weights: | (none) - ¥ Center and scale Weights: |{none) e Fit Options. ..
Results Results

Linear model Paly33:
fx,y) = p00 +p
+p12%

where x is norm
and where yis
Coeffidents (with 95

po0 = 0,421
plo= -0.114
pol=  -0.412
p20= 0.014
pil= 0,067
p02 = -0.029%
p3d= 0.016
p21= 0.0253
pl2 = -0.045§
pi3=  0.112

Goodness of fit:

SSE: 3.665
R-square: 0.7785
Adjusted R-square
RMSE: 0.1404

Goodness of validati
55E: 2.33863
RMSE : 0.157731

T
1 Palynamial
* TS N, Y
H*  Excluded zvs. x, y
QO zvve wY, Yy

0. —* Polynomial - residuals
—k Excluded 7 vs. ¥, y
ial - validation residuals

-0.4 ' i i R,
i 500 1000 1500 2000
4 3 4 »
X
Smoothing regression = IPonnomiaI ® ‘ﬂ
Table of R ET
Fitname : |Data Fit type SSE R-square DFE Adj R-sg RMSE # Coeff ¥ 1 55E 1
[d Smoothi... [z vs. x, v lowess 2.4233 0.8684 177.1000 0.8529 0.1170 21)zv vs. xv, yv |1.7669 0.1371
[l Polynomial [z vs. x, v poly33 3.6655 0.7785 136 0.7678 0. 1404 10(zv vs. xv, yv |2.3386 0.1577
&

18 Review the information in the Table of Fits. Compare goodness of fit

statistics for all fits in your session to determine which is best.
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19 To save your interactive surface fitting session, select File > Save Session.
You can save and reload sessions to access multiple fits. The session file
contains all the fits and variables in your session and remembers your
layout.

20 After interactively creating and comparing fits, you can generate code for all
fits and plots in your Surface Fitting Tool session. Select File > Generate
Code.

The Surface Fitting Tool generates code from your session and displays
the file in the MATLAB Editor. The file includes all fits and plots in your
current session.

21 Save the file with the default name, createSurfaceFits.m.

22 You can recreate your fits and plots by calling the file from the command
line (with your original data or new data as input arguments). In this case,
your original variables still appear in the workspace.

¢ Highlight and evaluate the first line of the file (excluding the word
function). Either right-click and select Evaluate, press F9, or copy and
paste the following to the command line:

[fitresult, gof] = createSurfaceFits(x, y, z, xv, yv, zv)

¢ The function creates a figure window for each fit you had in your session.
Observe that the polynomial fit figure shows both the surface and
residuals plots that you created interactively in the Surface Fitting Tool.

¢ If you want you can use the generated code as a starting point to change
the surface fits and plots to fit your needs. For a list of methods you can
use, see “Surface Fit Methods” on page 15-5.

For more information on all fit settings and tools for comparing fits, see:

e “Selecting Fit Settings” on page 3-30
e “Fitting Multiple Surfaces ” on page 3-37
® “Comparing Surface Fits” on page 3-39
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Biopharmaceutical Interactive Surface Fitting
Example

Curve Fitting Toolbox software provides some example data for an anesthesia
drug interaction study. You can use Surface Fitting Tool to fit response
surfaces to this data to analyze drug interaction effects. Response surface
models provide a good method for understanding the pharmacodynamic
interaction behavior of drug combinations.

This data is based on the results found in the following paper:

Kern SE, Xie G, White JL, Egan TD. Opioid-hypnotic synergy: A response
surface analysis of propofol-remifentanil pharmacodynamic interaction in
volunteers. Anesthesiology 2004; 100: 1373-81.

Anesthesia is typically at least a two-drug process, consisting of an opioid
and a sedative hypnotic. This example uses Propofol and Reminfentanil

as drug class prototypes. Their interaction is measured by four different
measures of the analgesic and sedative response to the drug combination.
Algometry, Tetany, Sedation, and Laryingoscopy comprise the four measures
of surrogate drug effects at various concentration combinations of Propofol
and Reminfentanil.

Perform the following steps to interactively create response surfaces for this
drug combination:

1 Use the Current Folder browser to locate and view the folder
matlab\toolbox\curvefit\curvefit.

2 Right-click the file OpioidHypnoticSynergy.txt, and select Import Data.
The Import Wizard appears.

a Click Next to accept the default column separator (tab).

b Click the option button labeled Create vectors from each column
using column names. Review the six variables selected for import:
Algometry, Laryingoscopy, Propofol, Reminfentanil, Sedation, and
Tetany.

¢ Click Finish to import the dose-response data into the MATLAB
workspace.
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Alternatively you can import the data programmatically. Enter the
following code to read the dose-response data from the file into the

MATLAB workspace.

data = importdata(
data.
data.
data.
data.
data.
data.

Propofol =
Remifentanil
Algometry =
Tetany =
Sedation =
Laryingoscopy =

data(:
data(:
data(:
data(:
data(:
data(:

313
12) 3
33) 3
4) 3
39) 3
16) 3

'OpioidHypnoticSynergy.txt' );

3 To create response surfaces you must select the two drugs for the X and
Y inputs, and one of the four effects for the Z output. After you load the
variables into your workspace, you can either open the tool and select
variables interactively, or specify the initial fit variables with the sftool

command.

Enter the following to open Surface Fitting Tool (if necessary) and create a
new response surface for Algometry:

sftool(Propofol, Remifentanil, Algometry)

Review the Surface Fitting Tool X, Y, and Z input and output controls.
The tool displays the selected variables Propofol, Remifentanil and
Algometry, with a surface fit. The default fit is an interpolating surface
that passes through the data points.
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) Surface Fitting Tool : i ]
File Fit View Tools Desktop Window Help k] | A X
B IR EEE BOEa0
Fit name: Iuntitled fit 1| I Interpolant LI v Auto fit
X input: IPropofaI '] Method: ILinear LI Fit

¥ input: IRemifentanil 'l ¥ Center and scale Stop |
2Z output: IAIgometry - l

-

Weights: |(none)

—T—

untitled fit 1

Algornetry ws. Propofol, Remifentanil

Results
Duplicate x-y data points g

sl e ,

Linear interpolant:
fx,y) = piecewise line
where x is normalized |
and where y is normali ]
Coeffidents: fone D
p = coefficent structu

Algametry

20

Goodness of fit: _ILI 5
i 1 : Rermifentanil uo Propofal
5 [untted fit 1 7
e e T R T T e R R T L P S e e e e e S S s ml
Fit... + |Data Fit type |SSE R-sguare | DFE AdjR-sg |RMSE # Coeff |valida... |validat...|valida...
[d unti... [Algome. .. [inearin... |2.2039... [1 0 MNak Mah 396
A

4 Create a copy of the current surface fit by either:
a Selecting Fit > Duplicate "Current Fit Name".
b Right-clicking a fit in the Table of Fits, and selecting Duplicate.

5 Select the Custom Equation fit type from the drop-down list to define
your own equation to fit the data.

6 Select and delete the example custom equation text in the edit box.

You can use the custom equation edit box to enter MATLAB code to define
your model. The equation that defines the model must depend on the input
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variables x and y and a list of fixed parameters, estimable parameters,
or both.

The model from the paper is:

n
Emax.[ Ca + Cp +a Ca Cr )
E_

1C50,  IC505  IC50, IC50g

n
o Ca , CB , Ca Cp
150, T 1C505 7 1C50, IC504

where C, and Cj; are the drug concentrations, and IC50A, IC50B, alpha,
and n are the coefficients to be estimated.

You can define this in MATLAB code as

Effect = Emax*( CA/IC50A + CB/IC50B + alpha*( CA/IC50A )...
.* ( CB/IC50B ) ).”"n ./(( CA/IC50A + CB/IC50B + ...
alpha*( CA/IC50A ) .* ( CB/IC50B ) )."n + 1);

Telling the tool which variables to fit and which parameters to estimate,
requires rewriting the variable names CA and CB to x, and y. You must
include x and y when you enter a custom equation in the edit box. Assume
Emax = 1 because the effect output is normalized.

Enter the following text in the custom equation edit box, and click Fit.
( x/IC50A + y/IC50B + alpha*( x/IC50A ) .* ( y/IC50B ) )."n

./(( x/IC50A + y/IC50B + alpha*( x/IC50A ) .*
( y/IC50B ) )."n + 1);

Surface Fitting Tool fits a surface to the data using the custom equation
model.
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) Surface Fitting Tool i ] [

File Fit View Tools Desktop Window Help k] | A X

B IR EEE BODE&0
¥ Auto fit
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8 Set some of the fit options by clicking Fit Options under your custom

equation.

In the Fit Options dialog box:

a Set Robust to Lar
b Set the alpha Start Point to 1 and lower bound to —5.
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) Fit Options

Method: MorlinearLeastSguares
Robust: Lar -
Algorithm: I Trust-Region ;I
DiffMinChange: | 1.0e-8
DiffMaxChange: I 0.1
MaxFunEvals: I a00
ManIter: | 400
TolFun: I 1.0e-5
Tolx: | 1.0e-6
LInknowns StartPoint Lower Upper
IC50A 0.4719 -Inf Inf
IC50B 0.4225 -Inf Inf
alpha 1 -5 Inf
n 0.8455 -Inf Inf

Close |

¢ Leave the other defaults, and click Close.

9 In Surface Fitting Tool, click Fit to refit with your new options.

10 Review the Results pane. View (and, optionally, copy) any of these results:

® The model equation

e The values of the estimated coefficients

¢ The goodness of fit statistics

11 Display the residuals plot to check the distribution of points relative to the

surface by clicking the toolbar button |"E:li or selecting View > Residuals

Plot.
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— e
B Costom
; Algometry ve. Propofal, Remifentanil
fa O
T ]
= ] )
S 05w
EO
20 =
0 o
Remifentanil Propofol
~—*® Custom - residualsJ
fa
T
=
(=]
=
=
Remifentanil Propofol

12 To generate code for all fits and plots in your Surface Fitting Tool session,
select File > Generate Code.

The Surface Fitting Tool generates code from your session and displays
the file in the MATLAB Editor. The file includes all fits and plots in your

current session.

13 Save the file with the default name, createSurfaceFits.m.

14 You can re-create your fits and plots by calling the file from the command
line (with your original data or new data as input arguments). In this case,

your original data still appears in the workspace.
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15

Highlight the first line of the file (excluding the word function), and

evaluate it by either right-clicking and selecting Evaluate, pressing F9, or

copying and pasting the following to the command line:

[fitresult, gof] = createSurfaceFits(Propofol,...
Remifentanil, Algometry)

The function creates a figure window for each fit you had in your session.
The custom fit figure shows both the surface and residuals plots that you
created interactively in the Surface Fitting Tool.

Create a new fit to the Tetany response instead of Algometry by entering:

[fitresult, gof] = createSurfaceFits(Propofol,...
Remifentanil, Tetany)

You need to edit the file if you want the new response label on the plots.
You can use the generated code as a starting point to change the surface
fits and plots to fit your needs. For a list of methods you can use, see
“Surface Fit Methods” on page 15-5.

To see how to programmatically fit surfaces to the same example problem,
see “Biopharmaceutical Drug Interaction Programmatic Surface Fitting
Example” on page 4-53.
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Selecting Fit Settings

In this section...

“Introduction” on page 3-30

“Selecting Fit Category” on page 3-30

“Using Center and Scale Setting” on page 3-31
“Using Interpolant Fit Category” on page 3-31
“Using Polynomial Fit Category” on page 3-32
“Using Lowess Fit Category” on page 3-34

“Using Custom Equation Fit Category” on page 3-35

Introduction

Surface Fitting Tool provides a selection of fit types and settings that you
can alter to try to improve your fit. Try the defaults first, then experiment
with other settings. This section describes how to use the available fit types
and settings.

You can try a variety of settings within a single fit tab, and you can also create
multiple fits to compare. When you create multiple fits you can compare
different fit types and settings side by side in the Surface Fitting Tool. See
“Fitting Multiple Surfaces ” on page 3-37 and “Comparing Surface Fits” on
page 3-39.

Selecting Fit Category
Select a fit category from the drop-down list in the Surface Fitting Tool:

® Interpolant — for interpolating a surface through the data points.
Interpolant is the default fit type.

® Polynomial — for linear regression

® | owess — for local smoothing regression

® Custom Equation — for nonlinear regression
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Each fit category has specific settings that appear when you choose a fit type.
The settings for each fit category are described in the following sections.

For all fit categories, look in the Results pane to see the model terms, the
values of the coefficients, and the goodness-of-fit statistics.

Tip If there are problems with your fit, messages appear in the Results pane
to help you identify better settings.

Using Center and Scale Setting

Each fit category (except Custom equation) shares the Center and scale
option. When you select the Center and scale option, the Surface Fitting
Tool refits with the data centred and scaled, by applying the Normalize
setting to the variables. Normalize is an input argument to the fitoptions
function. See the fitoptions reference page.

Generally it 1s a good idea to normalize inputs (also known as predictor data),
which can alleviate numerical problems with variables of different scales. For
example, suppose your inputs are engine speed with a range of 500—-4500
r/min and engine load with a range of 0—1. Then, Center and scale generally
improves the fit because of the great difference in scale between the two
inputs. However, if your inputs are in the same units or similar scale (e.g.,
eastings and northings for geographic data), then Center and scale is less
useful. When you normalize inputs with the Center and scale option, the
values of the fitted coefficients change when compared to the original data.

If you are fitting a surface to estimate coefficients, or the coefficients have
physical significance, clear the Center and scale check box. The Surface
Fitting Tool plots use the original scale with or without the Center and
scale option.

Using Interpolant Fit Category

The Interpolant fit category fits an interpolating surface that passes
through all the data points. This fit category uses the MATLAB GRIDDATA
function. The settings are shown below.
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Interpolant

Method: I Linear LI

W Center and scale

You can specify the Methods setting: Linear, Cubic, Nearest, or Biharmonic
(v4). For details on these methods, see the documentation for the MATLAB
GRIDDATA function.

Tip If your input variables have different scales, turn the Center and
scale option on and off to see the difference in the surface fit. Normalizing
the inputs can have a strong influence on the results of the triangle-based
(i.e., piecewise Linear and Cubic interpolation) and Nearest-neighbour
interpolation methods.

Using Polynomial Fit Category

The Polynomial fit uses the Curve Fitting Toolbox polynomial library model.
This library model is an input argument to the fit and fittype functions.
See thefitoptions reference page.

The Polynomial fit type fits a polynomial in x and y.

Degrees: x: IE ;I W Iz ;I
=

Robust: I Off
[T Center and scale

Fit Options... |
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You can specify the following options:

® The degree for the x and y inputs (maximum of 5 in each case). The degree
of the polynomial is the maximum of x and y degrees. See “Defining
Polynomial Terms for Polynomial Fit Category” on page 3-33.

® The robust linear least-squares fitting method to use (0ff, LAR, or
Bisquare). For details, see Robust on the fitoptions reference page.

® Set bounds or exclude terms by clicking Fit Options. You can exclude a
term by setting its bounds to zero.

Tip If your input variables have very different scales, turn the Center and
scale option on and off to see the difference in the surface fit.

Defining Polynomial Terms for Polynomial Fit Category

You can control the terms to include in the polynomial model by specifying
the Degrees for the x and y inputs. If i is the degree in x and j is the degree
in y, the total degree of the polynomial is the maximum of i and j. The degree
of x in each term is less than or equal to i, and the degree of y in each term is
less than or equal to .

For example, if you specify an x degree of 3 and a y degree of 2, the model
name is poly32. The model terms follow the form shown in the following table.

Degree of term | 0 1 2
0 1 y y?
1 X Xy Xy?
2 x? x%y

3 x3

The total degree of the polynomial cannot exceed the maximum of i and j. In
this example, terms such as x%y and x%y? are excluded because their degrees
sum to more than 3. In both cases, the total degree is 4.
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You can exclude any term by clicking the Fit Options button, and setting the
bounds to zero for any terms you want to remove. Look in the Results pane
to see the model terms, the values of the coefficients, and the goodness-of-fit
statistics.

Using Lowess Fit Category

The Lowess fit category uses locally weighted linear regression to smooth data.

I Lowess o |

Palynomial; I Linear LI
Span: |25 %
Robust: I OFfF LI

[# Center and scale

You can specify the following options:

e Select Linear or Quadratic in the drop-down to specify the type of

3-34

Polynomial model to use in the regression. . In Curve Fitting Toolbox,
lowess fitting uses a linear polynomial, while loess fitting uses a quadratic
polynomial. For more information on these two types of smoothing fit, see
“Local Regression Smoothing” on page 5-7.

The Span as a percentage of the total number of data points in the data
set. The toolbox uses neighboring data points defined within the span to
determine each smoothed value. This role of neighboring points is the
reason why the smoothing process is called “local.”

Tip Increase the span to make the surface smoother. Reduce the span to
make the surface follow the data more closely.

The Robust linear least-squares fitting method you want to use (Off, LAR,
or Bisquare). The local regression uses the Robust option. Using the
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Robust weight function can make the process resistant to outliers. For
details, see Robust on the fitoptions reference page.

The fit type name lowess derives from the term "locally weighted scatter plot
smooth." The process is weighted because the toolbox defines a regression
weight function for the data points contained within the span. In addition to
the regression weight function, the Robust option is a weight function that
can make the process resistant to outliers. For more information, see “Local
Regression Smoothing” on page 5-7.

Tip If your input variables have very different scales, turn the Center and
scale option on and off to see the difference in the surface fit. Normalizing
the inputs can have a strong influence on the results of a Lowess fitting.

Using Custom Equation Fit Category

You can use the Custom Equation fit category to define your own equations.
An example i1s provided. The example custom equation displays when you
select Custom Equation from the drop-down, as shown here.

z =i Ix Jlaf )

T la + b*sinim*pi*x*y)
+ crexpi—(w*y) ~2)

Fit Options. ..

You can enter any valid MATLAB expression in terms of x and y .

You can save your custom equations as part of your saved Surface Fit Tool
sessions.

Your function may execute a number of times, both during fitting and during
preprocessing before fitting. Be aware of this if you are using functions with
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side effects such as writing data to a file, or displaying diagnostic information
to the Command Window.
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Fitting Multiple Surfaces

In this section...

“Introduction” on page 3-37
“Fitting Additional Surfaces” on page 3-37
“Duplicating a Surface Fit” on page 3-38

“Deleting a Surface Fit” on page 3-38

Introduction

After you create a single fit, it can be useful to create multiple fits to compare.
When you create multiple fits you can compare different fit types and settings
side-by-side in the Surface Fitting Tool.

Fitting Additional Surfaces

After creating a fit, you can add an additional surface using any of these
methods:

¢ (Click the New Fit button next to your fit figure tabs in the Document Bar.
¢ Right-click the Document Bar and select New Fit.

¢ Select Fit > New Fit.

Each additional fit appears as a new tab in the Surface Fitting Tool and a new

row in the Table of Fits. See “Comparing Surface Fits” on page 3-39 for
information about displaying and analyzing multiple fits.

Optionally, after you create an additional fit, you can copy your data selections
from a previous fit by selecting Fit > Use Data From > Other Fit Name.
This copies your selections for x, y, and z from the previous fit, and any
selected validation data. No fit options are changed.
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Duplicating a Surface Fit

To create a copy of the current surface fit tab, select Fit > Duplicate
"Current Fit Name". You also can right-click a fit in the Table of Fits
and select Duplicate

Each additional fit appears as a new tab in the Surface Fitting Tool.
Deleting a Surface Fit
Delete a fit from your session using one of these methods:

e Select the fit tab display and select Fit > Delete Current Fit Name.
¢ Select the fit in the Table of Fits and press Delete.
¢ Right-click the fit in the table and select Delete Current Fit Name.

3-38



Comparing Surface Fits

Comparing Surface Fits

In this section...

“Introduction” on page 3-39
“Displaying Multiple Fits Simultaneously” on page 3-39
“Displaying Surface, Residual, and Contour Plots” on page 3-41

“Using the Statistics in the Table of Fits” on page 3-43

Introduction

When you have created multiple fits you can compare different fit types

and settings side by side in the Surface Fitting Tool. You can view plots
simultaneously and you can examine the goodness-of-fit statistics to compare
your fits. This section describes how to compare multiple fits.

Displaying Multiple Fits Simultaneously

To compare plots and see multiple fits simultaneously, use the layout controls
at the top right of the Surface Fitting Tool. Alternatively, you can click
Window on the menu bar to select the number and position of tiles you want
to display. The following example shows two fit tabs displayed side by side.
You can see three fits in the session listed in the Table of Fits.
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You can close fit tab displays (with the Close button, Fit menu, or context
menu), but they remain in your session. The Table of Fits displays all your
fits (open and closed). Double-click a fit in the Table of Fits to open a fit tab
display. To remove a fit, see “Deleting a Surface Fit” on page 3-38

You can dock and undock individual fits and navigate between them using
the standard MATLAB Desktop and Window menus in the Surface Fitting
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Tool. For more information, see “Opening and Arranging Desktop Tools” in
the MATLAB Desktop Tools and Development Environment documentation.

Displaying Surface, Residual, and Contour Plots

Within each fit tab, you can display up to three plots simultaneously to
examine the fit. Use the toolbar or View menu to select the type of plot to
display: surface plot, residuals plot, or contour plot. See also “Exploring and
Customizing Plots” on page 3-10.

A e————
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TG

0.011157 -
0

099538

Surface Plot

The surface plot displays by default. For polynomial and custom fits, you also
can use the Tools menu to display Surface Prediction Bounds. When you
display Surface Prediction Bounds, two additional surfaces are plotted to
show the prediction bounds on both sides of your model fit.

Choose which bounds to display: None, 90%, 95%, 99%, or Custom. The custom
option opens a dialog box where you can enter the required confidence level.
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The following example shows prediction bounds. You can see three surfaces
on the plot. The top and bottom surfaces show the prediction bounds at the
specified confidence level on either side of your model fit surface.
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4484 375

300
i

0.99358

You can also switch your surface plot to a 2-D plot if desired. Your plot
cursor must be in rotation mode. Select Tools > Rotate 3D if necessary.
Then, right-click the plot to select X-Y, X-Z, or Y-Z view, or to select Rotate
Options. All these context menu options are standard MATLAB 3-D plot
tools. See “Rotate 3D — Interactive Rotation of 3-D Views” in the MATLAB
Graphics documentation.

Residuals Plot

On the Residuals Plot, you can view the errors between your fitted surface
and your data, and you can remove outliers. See “Removing Outliers” on page
3-8. The following example shows a residuals plot with some excluded outliers.
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Contour Plot
Use the contour plot to examine a contour map of your surface. A contour plot
makes it easier to see points that have the same height. An example is shown
in “Displaying Surface, Residual, and Contour Plots” on page 3-41.
Using the Statistics in the Table of Fits
The Table of Fits list pane shows all fits in the current session.
Table of Fits .-
Fit name ¢ |Data Type of it S5E R-square DFE Adj R-sq RMSE # Coeff
[ interp TQvs. N, L Inkerpalant 9,8023e-31 1 0 Mal WEN] 293
M polyaz  [TQvs. N, L |Polynomial  |1.3055 0,9458 279 0.9433 0,0684 14
M lowess  [TQvs.N,L  |Lowess 0.2728 0,9857 271.4667 0.9878 0.0317 21

After using graphical methods to evaluate the goodness of fit, you can examine
the goodness-of-fit statistics shown in the table to compare your fits. The
goodness-of-fit statistics help you determine how well the surface fits the data.
Click the table column headers to sort by statistics, name, fit type, and so on.

The following guidelines help you use the statistics to determine the best fit:

® SSE is the sum of squares due to error of the fit. A value closer to zero
indicates a fit that is more useful for prediction.
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® R-square is the square of the correlation between the response values and
the predicted response values. A value closer to 1 indicates that a greater
proportion of variance is accounted for by the model.

* DFE is the degree of freedom in the error.

* Adj R-sq is the degrees of freedom adjusted R-square. A value closer to 1
indicates a better fit.

® RMSE is the root mean squared error or standard error. A value closer to 0
indicates a fit that is more useful for prediction.

e # Coeff is the number of coefficients in the model. When you have several
fits with similar goodness-of-fit statistics, look for the smallest number of
coefficients to help decide which fit is best. You must trade off the number
of coefficients against the goodness of fit indicated by the statistics to avoid
overfitting.

For a more detailed explanation of the Curve Fitting Toolbox statistics, see
“Goodness-of-Fit Statistics” on page 5-31.

To compare the statistics for different surfaces and decide which fit is the
best tradeoff between over- and under-fitting, use a similar process to that
described for curve fitting in “Determining the Best Fit” on page 2-9.
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Generating Code and Exporting Fits to the Workspace

In this section...

“Introducing Programmatic Surface Fitting” on page 3-45

“Generating Code from the Surface Fitting Tool” on page 3-45

“Exporting a Fit to the Workspace” on page 3-47

Introducing Programmatic Surface Fitting

Surface Fitting Tool makes it easy to plot and analyze fits at the command
line. You can export individual fits to the workspace for further analysis,

or you can generate code to recreate all fits and plots in your session. By
generating code you can use your interactive surface fitting session to quickly
assemble code for surface fits and plots into useful programs.

For programmatic surface fitting examples, see “Programmatic Surface
Fitting” on page 4-41.

Generating Code from the Surface Fitting Tool

You can generate and use MATLAB code from an interactive session in the
Surface Fitting Tool. In this way, you can transform your interactive analysis
into reusable functions for batch processing of multiple data sets. You can
use the generated file without modification, or you can edit and customize
the file as needed.

To generate code for all fits and plots in your Surface Fitting Tool session
follow these steps:

1 Select File > Generate Code.

The Surface Fitting Tool generates code from your session and displays
the file in the MATLAB Editor. The file includes all fits and plots in your
current session. The file captures the following information:

e Names of fits and their variables

* Fit settings and options
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* Plots
e Surface fitting objects and methods used to create the fits:
= A cell-array of sfit objects representing the fits

= A structure array with goodness-of fit information.
2 Save the file.

To recreate your fits and plots, call the file from the command line with your
original data as input arguments. You also can call the file with new data.

For example, enter:

[fitresult, gof] = myFileName(a, b, C)
where a, b, and ¢ are your variable names, and myFileName is the file name.

Calling the file from the command line does not recreate your Surface Fitting
Tool GUI and session. When you call the file, you get the same plots you had
in your Surface Fitting Tool session in standard MATLAB figure windows.
There is one window for each fit. For example, if your fit in the Surface Fitting
Tool session displayed surface, residual and contour plots, all three plots
appear in a single figure window. The following example shows a fit figure
with surface and residual plots and some removed outliers.
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For more information on working with surface fitting objects and methods,
see “Programmatic Surface Fitting” on page 4-41.

Exporting a Fit to the Workspace
To export a fit to the MATLAB workspace, follow these steps:
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1 Select a fit and save it to the MATLAB workspace using one of these
methods:

e Select a fit tab in the Surface Fit Tool and select Fit > Save to
Workspace.

¢ Right-click the fit listed in the Table of Fits and select Save Fit
myfitname to Workspace
The Save Fit to MATLAB Workspace dialog box opens.

) Save Fit to MATLAB Workspace b N (=] 4|

¥ Save fit to MATLAB ohject named: Iﬂl‘tedmudel

¥ Save goodness of fit to MATLAB struct named: Ignndness

¥ Save fit output to MATLAB struct named: }‘Ju‘tput

0K Cancel I

2 Edit the names as appropriate. If you previously exported fits, the toolbox
automatically adds a numbered suffix to the default names so there is no
danger of overwriting them.

3 Choose which options you want to export by selecting the check boxes.
Check box options are as follows:

¢ Save fit to MATLAB object named fittedmodel — This option
creates an sTit object, that encapsulates the result of fitting a surface
to data. You can examine the fit coefficients at the command line, for
example:

fittedmodel
Linear model Poly22:
fittedmodeli(x,y) = p00 + p10*x + pO1*y + p20*x"2...
+ pl1*x*y + p02*y~2
Coefficients (with 95% confidence bounds):

po0 = 302.1 (247.3, 356.8)

p10 = -1395 (-1751, -1039)

po1 = 0.03525 (0.01899, 0.05151)
p20 = 1696 (1099, 2293)
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p11 = -0.1119  (-0.1624, -0.06134)
p02 2.36e-006 (-8.72e-007, 5.593e-006)

You also can treat the sfit object as a function to make predictions or
evaluate the surface at values of X and Y. See the sfit reference page.

¢ Save goodness of fit to MATLAB struct named goodness — This
option creates a structure array that contains statistical information
about the fit, for example:

goodness =
sse: 0.0234
rsquare: 0.9369
dfe: 128
adjrsquare: 0.9345
rmse: 0.0135

® Save fit output to MATLAB struct named output — This option
creates a structure array that contains information such as numbers of
observations and parameters, residuals, and so on. For example:

output =
numobs: 134
numparam: 6
residuals: [134x1 double]
Jacobian: [134x6 double]
exitflag: 1
algorithm: 'QR factorization and solve'
iterations: 1

Note Goodness of fit and Output arrays are outputs of the fit
function. See the fit reference page.

4 Click OK to save the fit options to the workspace.

For more information on working with surface fitting objects and methods at
the command line, see “Programmatic Surface Fitting” on page 4-41.
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Working with Sessions

In this section...

“Overview” on page 3-50
“Saving Sessions” on page 3-50

“Reloading Sessions” on page 3-50

“Removing Sessions” on page 3-50

Overview

You can save and reload sessions for easy access to multiple fits. The session
file contains all the fits and variables in your session and remembers your
layout.

Saving Sessions

To save your session, first select File > Save Session to open your file
browser. Next, select a name and location for your session file (with file
extension .sfit).

After you save your session once, you can use File > Save MySessionName to
overwrite that session for subsequent saves.

To save the current session under a different name, select File > Save
Session As .

Reloading Sessions

Use File > Load Session to open a file browser where you can select a saved
surface fit session file to load.

Removing Sessions

Use File > Clear Session to remove all fits from the current Surface Fitting
Tool session.



Programmatic Curve and
Surface Fitting

¢ “Introducing Programmatic Curve Fitting” on page 4-2
e “Curve Fitting Objects and Methods” on page 4-9
® “Generating Code From Curve Fitting Tool” on page 4-30

® “Programmatic Surface Fitting” on page 4-41
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Introducing Programmatic Curve Fitting

In this section...

“Using Curve Fitting Objects and Methods” on page 4-2

“Interactive Code Generation” on page 4-5

Using Curve Fitting Objects and Methods

The Curve Fitting Tool is a graphical user interface that allows convenient,
interactive use of Curve Fitting Toolbox functions, without programming.
You can, however, access Curve Fitting Toolbox functions directly, and write
programs that combine curve fitting functions with MATLAB functions and
functions from other toolboxes. This allows you to create a curve fitting
environment that is precisely suited to your needs.

Models and fits in Curve Fitting Tool are managed internally as curve
fitting objects. Objects are manipulated through a variety of functions
called methods. You can create curve fitting objects, and apply curve fitting
methods, outside of Curve Fitting Tool.

For example, the following code, using Curve Fitting Toolbox methods,
reproduces an analysis of the census data that was carried out interactively in
Curve Fitting Tool in “Interactive Curve Fitting Example” on page 2-2.

Load and plot the data in census.mat:

load census
plot(cdate,pop,'o"')
hold on
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Create a fit options structure and a fittype object for the custom nonlinear
model y = a(x—b)", where a and b are coefficients and n is a problem-dependent
parameter:

s = fitoptions('Method', 'NonlinearLeastSquares',...
"Lower',[0,0],...
"Upper',[Inf,max(cdate)],...
'Startpoint',[1 1]);

f = fittype('a*(x-b)"n', 'problem','n','options',s);

Fit the data using the fit options and a value of n = 2:

[c2,g0f2] = fit(cdate,pop,f, ' 'problem',2)

c2 =
General model:
c2(x) = a*(x-b)"n
Coefficients (with 95% confidence bounds):
a = 0.006092 (0.005743, 0.006441)
b = 1789 (1784, 1793)
Problem parameters:
n = 2
gof2 =

sse: 246.1543
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rsquare: 0.9980

dfe: 19
adjrsquare: 0.9979
rmse: 3.5994

Fit the data using the fit options and a value of n = 3:

[c3,90f3] = fit(cdate,pop,f, 'problem',3)
c3 =
General model:
c3(x) = a*(x-b)"n
Coefficients (with 95% confidence bounds):
a = 1.359e-005 (1.245e-005, 1.474e-005)

b = 1725 (1718, 1731)
Problem parameters:
n = 3

gof3 =
sse: 232.0058
rsquare: 0.9981
dfe: 19
adjrsquare: 0.9980
rmse: 3.4944

Plot the fit results with the data:

plot(c2,'m")
plot(c3,'c')
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Interactive Code Generation

You can assemble curve fitting code into an file manually, as shown in
“Curve Fitting Objects and Methods” on page 4-9, or you can generate it
automatically from an interactive session in Curve Fitting Tool, as described
in “Generating Code From Curve Fitting Tool” on page 4-30. In practice,
automatically generated code, giving the broad outlines of an analysis, can be
combined with handwritten refinements. This allows you to write functions
that are customized to your data and your analysis, without having to write
all of the basic programming structures.

For example, the following code was generated from a session in Curve Fitting
Tool that imported the data from census.mat and fit a custom nonlinear
model of the form y = a(x—b)?:

function myfit(cdate,pop)

SMYFIT Create plot of datasets and fits

MYFIT (CDATE,POP)

Creates a plot, similar to the plot in the main curve fitting
window, using the data that you provide as input. You can
apply this function to the same data you used with cftool

o® o° o°

o°
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o°

or with different data. You may want to edit the function to
customize the code and this help message.

o® o°

o°

Number of datasets: 1
Number of fits: 1

o°

o°

Data from dataset "pop vs. cdate":

% X = cdate:
% Y = pop:
% Unweighted

o°

o°

This function was automatically generated on 11-Sep-2007 01:07:11

o°

Set up figure to receive datasets and fits

f_ = clf;

figure(f_);

set(f_, 'Units', 'Pixels', 'Position',[439.6 193.6 814.4 576.8]);
legh_ = [1; legt_ = {}; % handles and text for legend

xlim_ = [Inf -Inf]; % limits of x axis

ax_ = axes;

set(ax_, 'Units', 'normalized', 'OuterPosition',[0 O 1 1]);
set(ax_, 'Box','on'");

axes(ax_); hold on;

% --- Plot data originally in dataset "pop vs. cdate"

cdate = cdate(:);

This dataset does not appear on the plot.

To add it to the plot, uncomment

the following lines and select the desired color and marker.
h_ = line(cdate,pop, 'Color','r','Marker',"'.",...

‘LineStyle', 'none');

d® o° o° o°

o°

% Nudge axis limits beyond data limits

if all(isfinite(x1lim_))
xlim_ = xlim_ + [-1 1] * 0.01 * diff(xlim_);
set(ax_, 'XLim',x1lim_)

else
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set(ax_, 'XLim',[1788, 1992]);

end
% --- Create fit "fit 1"
ok_ = isfinite(cdate) & isfinite(pop);

if ~all( ok_ )
warning( 'GenerateMFile:IgnoringNansAndInfs',
‘Ignoring NaNs and Infs in data' );
end
st_ = [0.51510504095942344 0.35210694524343056 1];
ft_ = fittype('a*(x-b)"3',...
'dependent',{'y'}, 'independent',{'x'},...
‘coefficients',{'a', 'b'});

% Fit this model using new data
cf_ = fit(cdate(ok_),pop(ok_),ft ,'Startpoint',st );

% Or use coefficients from the original fit:

if 0
cv_ = { 1.3594203554767276e-005, 1724.6959436137356};
cf_ = cfit(ft_,cv_{:});

end

% Plot this fit
h_ = plot(cf_,'fit',0.95);
legend off; % turn off legend from plot method call
set(h_(1),'Color',[1 0 O],...
'LineStyle','-"', 'LineWidth',2,...
'Marker', 'none', 'MarkerSize',6);
legh _(end+1) = h_(1);
legt {end+1} = 'fit 1';

% Done plotting data and fits. Now finish up loose ends.

hold off;

leginfo_ = {'Orientation', 'vertical', 'Location', 'NorthEast'};
h_ = legend(ax_,legh_,legt ,leginfo_{:}); % create legend
set(h_, 'Interpreter', 'none');

xlabel(ax_,"'"'); % remove x label

ylabel(ax_,"'"); % remove y label
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A quick look through the code shows that it has automatically assembled
for you many of the Curve Fitting Toolbox curve fitting methods, such as
fitoptions, fittype, fit, and plot.

A natural modification of the file would be to edit the function declaration at
the top of the file to return the cfit object created by the fit, as follows:

function cf_ = myfit(cdate,pop)

You might also modify the code to produce a variety of different plots, or
to return goodness-of-fit statistics.

Coding with curve fitting objects and methods is given complete treatment
in “Curve Fitting Objects and Methods” on page 4-9 and “Generating Code
From Curve Fitting Tool” on page 4-30.
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Curve Fitting Objects and Methods

In this section...

“Overview” on page 4-9

“Curve Fitting Objects” on page 4-10

“Curve Fitting Methods” on page 4-11

“Workflow for Object-Oriented Fitting” on page 4-13

“Examples” on page 4-15

This section describes how to use Curve Fitting Toolbox functions from the
command-line or to write programs for curve fitting applications.

For surface fitting, see “Programmatic Surface Fitting” on page 4-41.

Overview

In MATLAB programming, all workspace variables are objects of a particular
class. Familiar examples of MATLAB classes are double, char, and
function_handle. You can also create custom MATLAB classes, using
object-oriented programming.

Methods are functions that operate exclusively on objects of a particular
class. Data types package together objects and methods so that the methods
operate exclusively on objects of their own type, and not on objects of other
types. A clearly defined encapsulation of objects and methods is the goal of
object-oriented programming.

Curve Fitting Toolbox software provides you with two new MATLAB data
types for performing curve fitting:

e fittype — Objects allow you to encapsulate information describing a
parametric model for your data. Methods allow you to access and modify
that information.

e cfit — A subtype of fittype. Objects capture information from a
particular fit by assigning values to coefficients, confidence intervals, fit
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statistics, etc. Methods allow you to post-process the fit through plotting,
extrapolation, integration, etc.

fFittype
objects

Because cfit is a subtype of fittype, cfit inherits all fittype methods.
In other words, you can apply fittype methods to both fittype and cfit
objects, but cfit methods are used exclusively with cfit objects.

As an example, the fittype method islinear, which determines if a model
is linear or nonlinear, would apply equally well before or after a fit; that is,
to both fittype and cfit objects. On the other hand, the cfit methods
coeffvalues and confint, which, respectively, return fit coefficients and
their confidence intervals, would make no sense if applied to a general
fittype object which describes a parametric model with undetermined
coefficients.

Curve Fitting Objects

Curve fitting objects have properties that depend on their type, and also on
the particulars of the model or the fit that they encapsulate. For example, the
following code uses the constructor methods for the two curve fitting types

to create a fittype object f and a cfit object c:

f = fittype('a*x"2+b*exp(n*x)"')
f =
General model:
f(a,b,n,x) = a*x"2+b*exp(n*x)

4-10



Curve Fitting Objects and Methods

(@]
I

cfit(f,1,10.3,-1e2)

General model:
c(x) = a*x"2+b*exp(n*x)

Coefficients:
a = 1
b = 10.3
n = -100

Note that the display method for fittype objects returns only basic
information, piecing together outputs from formula and indepnames.

cfit and fittype objects are evaluated at predictor values x using feval.
You can call feval indirectly using the following functional syntax:

cfun(x) % cfit objects;
ffun(coefi,coef2,...,x) % fittype objects;

y
y

Curve Fitting Methods

Curve fitting methods allow you to create, access, and modify curve fitting
objects. They also allow you, through methods like plot and integrate,
to perform operations that uniformly process the entirety of information
encapsulated in a curve fitting object.

The methods listed in the following table are available for all fittype objects,
including cfit objects.

Fit Type Method Description

argnames Get input argument names

category Get fit category

coeffnames Get coefficient names

dependnames Get dependent variable name

feval Evaluate model at specified predictors
fittype Construct fittype object

formula Get formula string

indepnames Get independent variable name
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Fit Type Method

Description

islinear

Determine if model is linear

numargs

Get number of input arguments

numcoeffs

Get number of coefficients

probnames

Get problem-dependent parameter names

setoptions

Set model fit options

type

Get name of model

The methods listed in the following table are available exclusively for cfit

objects.

Curve Fit Method

Description

cfit

Construct cfit object

coeffvalues

Get coefficient values

confint

Get confidence intervals for fit coefficients

differentiate

Differentiate fit

integrate

Integrate fit

plot

Plot fit

predint

Get prediction intervals

probvalues

Get problem-dependent parameter values

A complete list of methods for a curve fitting object can be obtained with the
MATLAB methods command. For example,

f = fittype('a*x"2+b*exp(n*x)"');

methods ()

Methods for class fittype:

argnames dependnames fittype islinear probnames
category feval formula numargs setoptions
coeffnames fitoptions indepnames numcoeffs type
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Note that some of the methods listed by methods do not appear in the
tables above, and do not have reference pages in the Curve Fitting Toolbox
documentation. These additional methods are generally low-level operations

used by Curve Fitting Tool, and not of general interest when writing curve
fitting applications.

There are no global accessor methods, comparable to getfield and setfield,
available for fittype objects. Access is limited to the methods listed above.
This is because many of the properties of fittype objects are derived from
other properties, for which you do have access. For example,

f = fittype('a*cos( b*x-c )')

f =
General model:
f(a,b,c,x) = a*cos( b*x-c )
formula(f)
ans =

a*cos( b*x-c )

argnames (T)
ans =

You construct the fittype object f by giving the formula, so you do have
write access to that basic property of the object. You have read access to
that property through the formula method. You also have read access to the
argument names of the object, through the argnames method. You don’t,
however, have direct write access to the argument names, which are derived
from the formula. If you want to set the argument names, set the formula.

Workflow for Object-Oriented Fitting

Curve Fitting Toolbox software provides a variety of methods for data analysis
and modeling. In application, these methods are applied in a systematic
manner, which can be represented in a standard workflow diagram such

as the one below.
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A typical analysis using curve fitting methods proceeds as follows:

1 Import your data into the MATLAB workspace using the 1load command
(if your data has previously been stored in MATLAB variables) or any of
the more specialized MATLAB functions for reading data from particular
file types.

2 If your data is noisy, you might want to smooth it using the smooth
function. Smoothing is used to identify major trends in the data that can
assist you in choosing an appropriate family of parametric models. If a
parametric model is not evident or appropriate, smoothing can be an end in
itself, providing a nonparametric fit of the data.
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Note Smoothing estimates the center of the distribution of the response
at each predictor. It invalidates the assumption that errors in the data
are independent, and so also invalidates the methods used to compute
confidence and prediction intervals. Accordingly, once a parametric model
1s 1dentified through smoothing, the original data should be passed to the
fit function.

3 A parametric model for the data—either a Curve Fitting Toolbox library
model or a custom model that you define—is specified as a fittype
object using the fittype function. Library models are displayed with the
cflibhelp function.

4 A fit options structure can be created for the fit using the fitoptions
function. Fit options specify things like weights for the data, fitting
methods, and low-level options for the fitting algorithm.

5 An exclusion rule can be created for the fit using the excludedata function.
Exclusion rules indicate which data values will be treated as outliers and
excluded from the fit.

6 Data, a fittype object, and (optionally) a fit options structure and an
exclusion rule are all passed to the fit function to perform the fit. The fit
function returns a cfit object that encapsulates the computed coefficients
and the fit statistics.

7 cfit objects returned by the fit function can then be passed to a variety of
postprocessing functions, such as feval, differentiate, integrate, plot,
coeffvalues, probvalues, confint, and predint.

Examples

The following examples illustrate the standard workflow outlined in
“Workflow for Object-Oriented Fitting” on page 4-13. Further examples of
programmatic fitting can be found in the reference pages for individual curve
fitting methods.

¢ “Example: Smoothing Data I” on page 4-16

e “Example: Smoothing Data II” on page 4-17
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e “Example: Excluding Data” on page 4-18

e “Example: Specifying Fit Options” on page 4-21

e “Example: Robust Fitting” on page 4-22

¢ “Example: Differentiating and Integrating a Fit” on page 4-24

e “Example: Prediction Intervals” on page 4-28

Example: Smoothing Data |
Load the data in count.dat:

load count.dat

The 24-by-3 array count contains traffic counts at three intersections for
each hour of the day.

First, use a moving average filter with a 5-hour span to smooth all of the
data at once (by linear index) :

c = smOOth(COUﬂt(:));
C1 = reshape(c,24,3);

Plot the original data and the smoothed data:

subplot(3,1,1)
plot(count,':");

hold on

plot(C1,'-");

title('Smooth C1 (All Data)')

Second, use the same filter to smooth each column of the data separately:

C2 = zeros(24,3);
for I = 1:3,

C2(:,I) = smooth(count(:,I));
end

Again, plot the original data and the smoothed data:

subplot(3,1,2)
plot(count,':");
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hold on
plot(C2,"-");
title('Smooth C2 (Each Column)')

Plot the difference between the two smoothed data sets:

subplot(3,1,3)
plot(C2 - C1,'0-")
title('Difference C2 - C1')

Smoaoth C1 (Al Data)

400 . r : .
2001 .
O = = = i -
0 5 10 15 20 25
Smooth C2 (Each Column)
400 T T T .
200F .
O .-'-#J- r - - fl -
0 5 10 15 20 25
Difference C2 - C1
10 T T T T
O-—@ﬁkﬂ %Efg_
_-10 1 1 1 1
0 5 10 15 20 25

Note the additional end effects from the 3-column smooth.

Example: Smoothing Data Il
Create noisy data with outliers:

X 15*rand(150,1);
y sin(x) + 0.5*(rand(size(x))-0.5);
y(ceil(length(x)*rand(2,1))) = 3;

Smooth the data using the loess and rloess methods with a span of 10%:

yy1l = smooth(x,y,0.1,"'loess');
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yy2 = smooth(x,y,0.1,'rloess');

Plot original data and the smoothed data.

[xx,ind] = sort(x);

subplot(2,1,1)

plot(xx,y(ind), 'b."',xx,yy1(ind), " 'r-")

set(gca, 'YLim',[-1.5 3.5])

legend('Original Data', 'Smoothed Data Using '‘'loess''',...
‘Location', 'NW")

subplot(2,1,2)

plot(xx,y(ind), 'b."',xx,yy2(ind), "'r-")

set(gca, 'YLim',[-1.5 3.5])

legend('Original Data', 'Smoothed Data Using '‘'rloess''',...
‘Location', 'NW")

+  Original Data *

3

2 = Smoocthed Data Using 'loess' .
.1 - =

0

3 +  Original Data *
2 F|— Smoothed Data Using 'floess' .
0

Note that the outliers have less influence on the robust method.

Example: Excluding Data

Load the vote counts and county names for the state of Florida from the 2000
U.S. presidential election:
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load flvote2k

Use the vote counts for the two major party candidates, Bush and Gore, as
predictors for the vote counts for third-party candidate Buchanan, and plot
the scatters:

plot(bush,buchanan, 'rs')

hold on
plot(gore,buchanan, 'bo"')
legend('Bush data', 'Gore data')

3500 T 5 T 5
O Bush data
30007 C Gore data ||
2500 F -
2000 F 4
1500 F 4
1000 4
o
500 | S .
O 1
3 4
x10°

Assume a model where a fixed proportion of Bush or Gore voters choose to
vote for Buchanan:

f
f:

fittype({'x"'})

Linear model:
f(a,x) = a*x

Exclude the data from absentee voters, who did not use the controversial
“butterfly” ballot:
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absentee = find(strcmp(counties, 'Absentee Ballots'));
nobutterfly = excludedata(bush,buchanan,'indices',absentee);

Perform a bisquare weights robust fit of the model to the two data sets,
excluding absentee voters:

bushfit = fit(bush,buchanan,f,...

"Exclude’' ,nobutterfly, 'Robust','on');
fit(gore,buchanan,f,...

"Exclude’' ,nobutterfly, 'Robust','on');

gorefit

Robust fits give outliers a low weight, so large residuals from a robust fit
can be used to identify the outliers:

figure
plot(bushfit,bush,buchanan,'rs', 'residuals')
hold on
plot(gorefit,gore,buchanan, 'bo', 'residuals')

3000 . . .

O O data
zero line ||
2000} o © daa
zero ling
1500 | .

2500+

1000 .
500 .
0

-500F .
-1000 ¢ .

-1500 . : :
0

5
¥ 10

The residuals in the plot above can be computed as follows:

bushres = buchanan - feval(bushfit,bush);
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goreres = buchanan - feval(gorefit,gore);

Large residuals can be identified as those outside the range [ -500 500]:

bushoutliers excludedata(bush,bushres, 'range',[-500 500]);
goreoutliers = excludedata(gore,goreres, 'range',[-500 500]);

The outliers for the two data sets correspond to the following counties:

counties(bushoutliers)
ans =

‘Miami-Dade'

‘Palm Beach'

counties(goreoutliers)
ans =
'‘Broward’
‘Miami-Dade'
‘Palm Beach'

Miami-Dade and Broward counties correspond to the largest predictor values.
Palm Beach county, the only county in the state to use the “butterfly” ballot,
corresponds to the largest residual values.

Example: Specifying Fit Options
Create the default fit options structure and set the option to center and scale
the data before fitting:

options = fitoptions;
options.Normal = 'on';
options
options =
Normalize: 'on'
Exclude: [1x0 double]
Weights: [1x0 double]
Method: 'None’

Modifying the default fit options structure is useful when you want to set the
Normalize, Exclude, or Weights fields, and then fit your data using the same
options with different fitting methods. For example:
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load census

f1 = fit(cdate,pop, 'poly3',options);
f2 = fit(cdate,pop, 'expl1',options);
f3 = fit(cdate,pop, 'cubicsp',options);

Data-dependent fit options are returned in the third output argument of the
fit function. For example:

[f,g0f,out] fit(cdate,pop, 'smooth');

smoothparam = out.p

smoothparam
0.0089

The default smoothing parameter can be modified for a new fit:
options = fitoptions('Method', 'Smooth', 'SmoothingParam',0.0098);
[f,gof,out] = fit(cdate,pop, 'smooth',options);

Example: Robust Fitting
Create a baseline sinusoidal signal:

xdata = (0:0.1:2*pi)';
y0 = sin(xdata);

Add noise to the signal with non-constant variance:

% Response-dependent Gaussian noise
gnoise = y0.*randn(size(y0));

% Salt-and-pepper noise

spnoise = zeros(size(y0));

p = randperm(length(y0));

sppoints = p(1:round(length(p)/5));
spnoise(sppoints) = 5*sign(y0(sppoints));

ydata = y0 + gnoise + spnoise;

Fit the noisy data with a baseline sinusoidal model:

f = fittype('a*sin(b*x)"');
fit1 = fit(xdata,ydata,f,'StartPoint',[1 1]);
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Identify “outliers” as points at a distance greater than 1.5 standard deviations
from the baseline model, and refit the data with the outliers excluded:

fdata = feval(fit1,xdata);
I = abs(fdata - ydata) > 1.5*std(ydata);
outliers = excludedata(xdata,ydata, 'indices',I);

fit2 = fit(xdata,ydata,f, 'StartPoint’',[1 1], 'Exclude’',outliers);

Compare the effect of excluding the outliers with the effect of giving them

lower bisquare weight in a robust fit:

fit3 = fit(xdata,ydata,f, 'StartPoint',[1 1], 'Robust','on');

Plot the data, the outliers, and the results of the fits:

plot(fit1,'r-',xdata,ydata, 'k."',outliers, 'm*")
hold on

plot(fit2,'c--")

plot(fit3,'b:")

x1im ([0 2*pi])

g T . T T . .
#* +  data
6L * o + ¥ excluded data |
* #* fited curve
4l * fitted curve
""""" fitted curve
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Plot the residuals for the two fits considering outliers:

figure
plot(fit2,xdata,ydata,'co', 'residuals')
hold on
plot(fit3,xdata,ydata, 'bx', 'residuals')
6 T T T T T T
. X" B g daml
al zero line ||
w = data
zero line
2 % 1
H
Xx # ¥ w W o
0 X« * B wen ¥ Xxxx * 2 |
Koo w8 o
® ® x X
ot P i
4t . :
XX = X w
-6 1 1 1 1 1 1
0 1 2 3 4 5 4] 7
X

Example: Differentiating and Integrating a Fit
Create a baseline sinusoidal signal:

xdata = (0:.1:2*pi)';
y0 = sin(xdata);

Add noise to the signal:

noise = 2*y0.*randn(size(y0)); % Response-dependent noise
ydata = y0 + noise;

Fit the noisy data with a custom sinusoidal model:

f = fittype('a*sin(b*x)"');
fit1 = fit(xdata,ydata,f,'StartPoint',[1 1]);
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Find the derivatives of the fit at the predictors:

[d1,d2] = differentiate(fiti1,xdata);

Plot the data, the fit, and the derivatives:

subplot(3,1,1)

plot(fit1,xdata,ydata) % cfit plot method
subplot(3,1,2)

plot(xdata,d1,'m') % double plot method
grid on

legend('1st derivative')

subplot(3,1,3)

plot(xdata,d2,'c') % double plot method
grid on

legend('2nd derivative')
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Note that derivatives can also be computed and plotted directly with the
cfit plot method, as follows:

plot(fit1,xdata,ydata,{'fit', 'derivi', 'deriv2'})
The plot method, however, does not return data on the derivatives.

Find the integral of the fit at the predictors:
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int = integrate(fiti1,xdata,0);

Plot the data, the fit, and the integral:

subplot(2,1,1)

plot(fitl1,xdata,ydata) % cfit plot method
subplot(2,1,2)

plot(xdata,int,'m') % double plot method
grid on

legend('integral')

6 T T T T T T
al * +  data |
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=
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| 1 1 1 Lt | * 1
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Note that integrals can also be computed and plotted directly with the cfit
plot method, as follows:

plot(fiti,xdata,ydata,{'fit', 'integral'})

The plot method, however, does not return data on the integral.
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Example: Prediction Intervals
Generate data with an exponential trend:

x = (0:0.2:5)';
y 2*exp(-0.2*x) + 0.5*randn(size(x));

Fit the data using a single-term exponential:

fitresult = fit(x,y, ' 'expl');

Compute prediction intervals:

p11 = predint
pi2 predint
p21 predint
p22 = predint

fitresult,x,0.95, 'observation', 'off');
fitresult,x,0.95, 'observation','on');
fitresult,x,0.95, 'functional', 'off');
fitresult,x,0.95, 'functional','on');

—_~ o~~~

Plot the data, fit, and prediction intervals:

subplot(2,2,1)

plot(fitresult,x,y), hold on, plot(x,p11,'m--"), x1lim([O0 5])
title('Nonsimultaneous observation bounds', 'Color','m')
subplot(2,2,2)

plot(fitresult,x,y), hold on, plot(x,p12,'m--"'), x1lim([O0 5])
title('Simultaneous observation bounds', 'Color','m')
subplot(2,2,3)

plot(fitresult,x,y), hold on, plot(x,p21,'m--"), x1lim([O0 5])
title('Nonsimultaneous functional bounds', 'Color','m')
subplot(2,2,4)

plot(fitresult,x,y), hold on, plot(x,p22,'m--'), x1lim([O0 5])
title('Simultaneous functional bounds', 'Color','m')
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Monsimultaneous observation bounds
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Generating Code From Curve Fitting Tool

In this section...

“Overview” on page 4-30

“The Generated Code” on page 4-31

“Running the Generated File” on page 4-33
“Components of the Generated File” on page 4-35
“Modifying the Code” on page 4-38

This section describes how to generate and use MATLAB code from an
interactive session in Curve Fitting Tool.

For Surface Fitting Tool, see “Generating Code from the Surface Fitting Tool”
on page 3-45.

Overview

One way to quickly assemble curve fitting objects and methods into useful
programs is to generate code from a session in Curve Fitting Tool. In this
way, interactive analysis of a single data set is transformed into a reusable
function for batch processing of multiple data sets. The generated file can be
used without modification, or it can be edited and customized as needed.

To generate code from a session in Curve Fitting Tool, select the menu item
File > Generate Code.

The file captures the following information from Curve Fitting Tool:

e Names of variables, fits, and residuals

¢ Fit options, such as whether the data should be normalized, initial values
for the coefficients, and the fitting method

e Curve fitting objects and methods used to create the fit

You can recreate your Curve Fitting Tool session by calling the file from the
command line with your original data as input arguments. You can also
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call the file with new data, applying the assembled curve fitting methods
to recompute curve fitting objects.

The Generated Code

Files generated from Curve Fitting Tool are constructed from building-block
components of code, which you can analyze, modify, and reuse in your own
files. The components of the generated file provide good examples of how

to assemble curve fitting objects and methods to perform basic tasks. The
larger file shows you how to assemble those tasks into a complete analysis
of your data.

For example, the following file was generated from a session in Curve Fitting
Tool that imported the data from census.mat and fit a custom nonlinear
model of the form y = a(x—b)?:

function myfit(cdate,pop)

SMYFIT Create plot of datasets and fits

MYFIT (CDATE,POP)

Creates a plot, similar to the plot in the main curve fitting
window, using the data that you provide as input. You can
apply this function to the same data you used with cftool

or with different data. You may want to edit the function to
customize the code and this help message.

® o° % ° o° o o°

o°

Number of datasets: 1
Number of fits: 1

o°

o°

Data from dataset "pop vs. cdate":

% X = cdate:
% Y = pop:
% Unweighted

o°

o°

This function was automatically generated on 11-Sep-2007 01:07:11

o°

Set up figure to receive datasets and fits

f_ = clf;

figure(f_);

set(f_, 'Units', 'Pixels', 'Position',[439.6 193.6 814.4 576.8]);
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legh_ = [1; legt_ = {}; % handles and text for legend
xlim_ = [Inf -Inf]; % limits of x axis
ax_ = axes;

se%(ax_,'Units','normalized','OuterPosition',[O 011]);
set(ax_, 'Box','on'");
axes(ax_); hold on;

% --- Plot data originally in dataset "pop vs. cdate"
cdate = cdate(:);
pop = pop(:);

h_ = line(cdate,pop, 'Parent',ax_, 'Color',[0.333333 0 0.666667],...

'LineStyle', 'none', 'LineWidth',1,...
'Marker',"'.', 'MarkerSize',12);
xlim_(1) = min(xlim_(1),min(cdate));
xlim_(2) = max(xlim_(2),max(cdate));
legh_(end+1) = h_;
legt {end+1} = 'pop vs. cdate';

% Nudge axis limits beyond data limits
if all(isfinite(x1lim_))
xlim_ = xlim_ + [-1 1] * 0.01 * diff(xlim_);
set(ax_, 'XLim',x1lim_)
else
set(ax_, 'XLim',[1788, 1992]);

end
% --- Create fit "fit 1"
ok_ = isfinite(cdate) & isfinite(pop);

if ~all( ok_ )
warning( 'GenerateMFile:IgnoringNansAndInfs',
‘Ignoring NaNs and Infs in data' );
end
st = [0.51510504095942344 0.35210694524343056 1];
ft_ = fittype('a*(x-b)"3',...
‘"dependent',{'y'}, 'independent',{'x"'},...
‘coefficients',{'a', 'b'});

% Fit this model using new data
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cf_ = fit(cdate(ok_),pop(ok_),ft ,'Startpoint',st );

% Or use coefficients from the original fit:

if 0
cv_ = { 1.3594203554767276e-005, 1724.6959436137356};
cf_ = cfit(ft_,cv_{:});

end

% Plot this fit
h_ = plot(cf_,'fit',0.95);
legend off; % turn off legend from plot method call
set(h_(1),'Color',[1 0 O],...
'LineStyle','-"', 'LineWidth',2,...
'Marker', 'none', 'MarkerSize',6);
legh_(end+1) h _(1);
legt {end+1} = 'fit 1';

% Done plotting data and fits. Now finish up loose ends.

hold off;

leginfo_ = {'Orientation', 'vertical', 'Location', 'NorthEast'};
h_ = legend(ax_,legh_,legt ,leginfo_{:}); % create legend
set(h_, 'Interpreter', 'none');

xlabel(ax_,"'"'); % remove x label

ylabel(ax_,"'"); % remove y label

A quick look through the code shows that it has automatically assembled
for you many of the Curve Fitting Toolbox curve fitting methods, such as
fitoptions, fittype, fit, and plot.

Running the Generated File

To run the generated file without modification, and reproduce your original
Curve Fitting Tool session, type:

load census
myfit(cdate,pop)
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To run the file without modification on new data, pass the new data to the
function as input arguments:

newpop = pop + 50*randn(size(pop));
myfit(cdate,newpop)
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The file recomputes the cfit object for the fit and displays the new data
with the new fit.

Components of the Generated File

It 1s useful to take a closer look at the components of the generated file, to
understand the role that each component plays in the overall visualization
and analysis of the data. This allows you to change the file, and customize
it to your needs.

The file begins with a function declaration:

function myfit(cdate,pop)

The function accepts predictor and response data for a predefined fit type.
The inputs are called cdate and pop because those were the predictor and
response variables used in Curve Fitting Tool session that produced the file.
If you like, you can find and replace the input names here and elsewhere in
the file to indicate a more generic application of the fit.

Note that the file, as generated, returns no outputs. It simply applies the fit
to the input data and displays the results.

The next component of the file, after the help information, is the following:

% Set up figure to receive datasets and fits

f_ = clf;

figure(f_);

set(f_, 'Units', 'Pixels', 'Position',[439.6 193.6 814.4 576.8]);
legh_ = [1; legt_ = {}; % handles and text for legend

xlim_ = [Inf -Inf]; % limits of x axis

ax_ = axes;

set(ax_, 'Units', 'normalized', 'OuterPosition',[0 O 1 1]);
set(ax_, 'Box','on'");

axes(ax_); hold on;

These are Handle Graphics® methods, applied to Handle Graphics objects
that encapsulate information on the display of the figure window, the legend,
and the axes. This component of the file creates a figure for plotting that
mimics the Plotting GUI in Curve Fitting Tool. Note that at the end of this
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component hold is toggled on. This allows the input data and the fit to be
plotted together on the axes.

The next component of the file plots the input data, using Handle Graphics
methods to set properties of the line object, the axes, and the legend that
mimic the plot in Curve Fitting Tool:

% --- Plot data originally in dataset "pop vs. cdate"
cdate = cdate(:);
pop = pop(:);

h_ = line(cdate,pop, 'Parent',ax_, 'Color',[0.333333 0 0.666667],...

'LineStyle', 'none', 'LineWidth',1,...
'Marker','."', 'MarkerSize',12);
x1lim_(1) = min(xlim_(1),min(cdate));
x1lim_(2) max (xlim_(2),max(cdate));
legh_(end+1) = h_;
legt_{end+1} = 'pop vs. cdate';

The next component “nudges” the x-axis limits, leaving a space of 1% of the x
data range between the data and the vertical axes. This gives a tight plot,
while preventing data from being plotted directly onto the vertical axes, where
it would be difficult to see.

% Nudge axis limits beyond data limits

if all(isfinite(x1lim_))
xlim_ = xlim_ + [-1 1] * 0.01 * diff(xlim_);
set(ax_, 'XLim',x1lim_)

else
set(ax_, 'XLim',[1788, 1992]);

end

After all of the preliminaries, the file gets down to the business of fitting

the data. The next component of the file uses fitoptions and fittype to
create a fit options structure fo_ and a fittype object ft_that encapsulate,
respectively, information on the fitting method and the model. The inputs to
fitoptions and fittype are read from the Fitting GUI in Curve Fitting Tool.

% --- Create fit "fit 1"
ok_ = isfinite(cdate) & isfinite(pop);
if ~all( ok_ )
warning( 'GenerateMFile:IgnoringNansAndInfs',
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‘Ignoring NaNs and Infs in data' );

end
st = [0.51510504095942344 0.35210694524343056 ];
ft_ = fittype('a*(x-b)"3',...

‘"dependent',{'y'}, 'independent',{'x'},...
‘coefficients',{'a', 'b'});

The fit method is then called to fit the predefined fit type to the input data.
Note that NaNs are removed from the data before the fit, using the logical
vector ok _ defined in the previous component.

% Fit this model using new data
cf_ = fit(cdate(ok_),pop(ok_),ft_, 'Startpoint',st_);

The next component is some comments to give you the option of plotting
the new input data against a fit based on the old data (the data that was
originally imported into Curve Fitting Tool). To do so, simply uncomment
the lines (delete “%”) as the comments instruct. The modified file then uses
the cfit method to set the coefficients of the cfit object cf_ to the stored
values computed with the old data. If you do not wish to do this, leave this
component of the file alone, or delete it.

o°

Alternatively uncomment the following lines to use coefficients
from the original fit. You can use this choice to plot the
original fit against new

data.

o® o°

o°

o°

cv_ = { 4.8505588176278646e-011, 0.014739610248054504} ;
cf_ cfit(ft_,cv_{:});

o°

With the fitting complete, the file calls the plot method to plot the cfit
object cf_. Note that plot is called with the default plot type 'fit' (data
and fit), but is also passed a confidence level of 0.95. To use this confidence
level to plot prediction bounds for the fit or for new observations, change
'fit' to 'predfunc' or 'predobs’, respectively. The rest of the code in this
component of the file is more Handle Graphics, along the lines of previous
components, setting Handle Graphics object properties that mimic the plot of
the fit in Curve Fitting Tool.

% Plot this fit
h_ = plot(cf_, 'fit',0.95);
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legend off; % turn off legend from plot method call
set(h_(1),'Color',[1 0 O],...
'LineStyle','-"', 'LineWidth',2,...
'Marker', 'none', 'MarkerSize',6);
legh_(end+1) = h_(1);
legt {end+1} = 'fit 1';

Finally, the file takes care of “loose ends”: hold is toggled off to its default
behavior, the legend is positioned, and the x and y labels ('x' and 'y' by
default) are removed.

% Done plotting data and fits. Now finish up loose ends.

hold off;

leginfo_ = {'Orientation', 'vertical', 'Location', 'NorthEast'};
h_ = legend(ax_,legh_,legt ,leginfo_{:}); % create legend
set(h_, 'Interpreter', 'none');

xlabel(ax_,"'"'); % remove x label

ylabel(ax_,"'"); % remove y label

Modifying the Code

With an understanding of the components of the generated file, it is easy to
modify the code to produce a customized curve fit and display. The basic
structure of the file is already in place for you, and you can concentrate on
the details that interest you most.

A natural modification of the file would be to edit the function declaration at
the top of the file to return the cfit object cf_ created by the fit, as follows:

function cf_ = myfit2(cdate,pop)

Note the change in the function name from myfit to myfit2. The modified
file should then be saved to a file named myfit2.m.

You might also want to return goodness-of-fit statistics, which the file, by
default, does not compute. You would have to modify both the call to fit:

[cf_,gof] = fit(cdate(ok_),pop(ok_),ft_,fo_);
and the function declaration:

function [cf_,gof] = myfit2(cdate,pop)
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You might also want to alter the call to plot, say to show prediction intervals
for new observations:

h_ = plot(cf_, 'predobs',0.95);

Running the file with the above modifications on the new data from “Running
the Generated File” on page 4-33 produces the following output to the
command line:

[c,g] = myfit2(cdate,newpop)

C:
General model:
c(x) = a*(x-b)"3
Coefficients (with 95% confidence bounds):
a= 7.211e-006 (-2.389e-006, 1.681e-005)
b = 1670 (1548, 1792)
g:

sse: 5.5691e+004
rsquare: 0.6561
dfe: 19
adjrsquare: 0.6380
rmse: 54.1398

and the following display:
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Programmatic Surface Fitting

In this section...
“Surface Fitting Objects and Methods” on page 4-41

“Automotive Fuel Efficiency Programmatic Surface Fitting Example” on
page 4-42

“Biopharmaceutical Drug Interaction Programmatic Surface Fitting
Example” on page 4-53

Surface Fitting Objects and Methods

e “Overview” on page 4-41

e “Surface Fitting Objects and Methods” on page 4-41

This section describes how to use Curve Fitting Toolbox functions from the
command-line or to write programs for surface fitting applications.

Overview

One way to quickly assemble code for surface fits and plots into useful
programs is to generate an file from a session in Surface Fitting Tool. In
this way, you can transform your interactive analysis of a single data set
into a reusable function for command-line analysis or for batch processing
of multiple data sets. You can use the generated file without modification,
or edit and customize the code as needed. See “Generating Code from the
Surface Fitting Tool” on page 3-45.

Surface Fitting Objects and Methods

The surface fit object (sfit) stores the results from a surface fitting operation,
making it easy to plot and analyze fits at the command line.

Like cfit objects, sfit objects are a subclass of fittype objects, so they

inherit all the same methods of fittype. For a list of available methods,
see “Fit Type Methods” on page 15-3.
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4-42

sfit objects also provide methods exclusively for sfit objects, listed in the
table here: “Surface Fit Methods” on page 15-5.

See Chapter 15, “Function Reference” for information on all Curve Fitting
Toolbox functions, classes, and methods.

Automotive Fuel Efficiency Programmatic Surface
Fitting Example

® “Load and Preprocess Data” on page 4-43
* “Fit and Plot Surfaces of Fuel Efficiency” on page 4-44
e “Create a Table from the Surface” on page 4-48

Curve Fitting Toolbox software provides some example data generated from
a GTPOWER predictive combustion engine model. The model emulates a
naturally aspirated spark ignition, 2-liter, inline 4-cylinder engine. You can
use surface fitting methods to fit a response surface to this data to investigate
fuel efficiency.

The data set includes the following variables you need to model response
surfaces:

® Speed is in revolutions per minute (RPM) units.

e Load is the normalized cylinder air mass (the ratio of cylinder aircharge to
maximum naturally aspirated cylinder aircharge at standard temperature
and pressure).

e BSFC is the brake-specific fuel consumption in g/Kwh; that is, the energy
flow in divided by mechanical power out (fuel efficiency).

The aim is to model a response surface to find the minimum BSFC as a
function of speed and load. You can use this surface as a table, included as
part of a hybrid vehicle optimization algorithm combining the use of a motor
and your engine. To operate the engine as fuel efficiently as possible, the table
must operate the engine near the bottom of the BSFC bowl.
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Load and Preprocess Data
Follow these steps to load and process the data:

1 Load the data from the XLS spreadsheet. Use the 'basic' command
option for non- Windows® platforms.

Create a variable n that has all the numeric data in one array.

n = xls
II, Ib

read( 'Engine_Data_SI_NA 2L_I4.x1s', 'SI NA 2L I4',...
asic' );

2 Extract from the variable n the columns of interest:

SPEED =
LOAD_CM
LOAD =
BSFC

3 Process the
sweep. The

n(:,2);
D =n(:,3);
n(:,8);
n(:,22);

data before fitting, to pick out the min (BSFC) values from each
data points are organized insweeps on speed/load.

a Get a list of the speed/load sites:

SL =
nRuns

b For each

unique( [SPEED, LOAD_CMD], 'rows' );
= size( SL, 1 );

speed/load site, find the data at the site and extract the actual

measured load and the minimum BSFC.

minBS
Load
Speed
for i

i

m
L
S

end

FC = zeros( nRuns, 1 );
= zeros( nRuns, 1 );
= zeros( nRuns, 1 );
= 1:nRuns
dx = SPEED == SL(i,1) & LOAD_CMD == SL(1i,2);
inBSFC(i) = min( BSFC(idx) );
oad(1i) = mean( LOAD(idx) );
peed(1i) = mean( SPEED(idx) );
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Fit and Plot Surfaces of Fuel Efficiency
Follow these steps to fit and plot some surfaces:

1 Fit a surface to the preprocessed data.

f1 = fit( [Speed, Load], minBSFC, 'Lowess', 'Normalize', 'on'

This command results in the following output:

Locally weighted smoothing linear regression:

f1(x,y) = lowess (linear) smoothing regression

computed from p

where x is normalized by mean 3407 and std 1214

and where y is normalized by mean 0.5173 and std 0.1766
Coefficients:

p = coefficient structure

2 Plot your fit:

plot( f1, [Speed, Load], minBSFC );
xlabel( 'Speed [RPM]' );

ylabel( 'Load [%]' );

zlabel( 'Minimum BSFC [g/Kwh]' );
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3 Review the resulting plot:

¢ There are points where BSFC is negative because this data is generated
by an engine simulation.

¢ Remove those problem data points and keep points in the range [0,
Inf].

out = excludedata( Speed, minBSFC, 'Range', [0, Inf] );
f2 = fit( [Speed, Load], minBSFC, 'Lowess',
"Normalize', 'on', 'Exclude', out )

Examine the following output:

Locally weighted smoothing linear regression:
f2(x,y) = lowess (linear) smoothing regression

4-45



4 Programmatic Curve and Surface Fitting

computed from p

where x is normalized by mean 3443 and std 1187

and where y is normalized by mean 0.521 and std 0.175
Coefficients:

p = coefficient structure

4 Plot the new fit:

plot( f2, [Speed, Load], minBSFC, 'Exclude', out );
xlabel( 'Speed [RPM]' );

ylabel( 'Load [%]' );

zlabel( 'Minimum BSFC [g/Kwh]' );

5 Zoom in on the part of the z-axis of interest:

set( gca, 'ZLim', [0, max( minBSFC )] );
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6 Because you want to operate the engine efficiently, create a contour plot to
see the region where the BSFC is low. Use the plot command, and specify
the parameter/value pair 'style' 'Contour'.

plot( f2, [Speed, Load], minBSFC, 'Exclude', out,...
'Style', 'Contour' );

xlabel( 'Speed [RPM]' );

ylabel( 'Load [%]' );

colorbar

4-47



4 Programmatic Curve and Surface Fitting

4-48

) Figure 1 i ]|

File Edit View Insert Tools Desktop Window Help k'l

NS Hd2 M| RAOBDRAL -3

0.8

0.7

0.6

0.5

Load [%)]

0.4

1000 2000 3000 4000 5000
Speed [RPM]

0.2

Create a Table from the Surface
In this exercise, you generate a table from the original data using model f2.

1 Create variables for the table breakpoints.

speedbreakpoints = linspace( 1000, 5500, 17 );
loadbreakpoints = 1linspace( 0.2, 0.8, 13 );

2 To generate values for the table, evaluate the model over a grid of points.

[tSpeed, tLoad] = meshgrid( speedbreakpoints,...
loadbreakpoints );
tBSFC = f2( tSpeed, tLoad );
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3 Examine the rows and columns of the table at the command line.

tBSFC(1:2:end,1:2:end)

4 Plot the table against the original model. The grid on the model surface
shows the table breakpoints.

h = plot( f2 );
set( h, 'EdgeColor', 'none' );

hold on
mesh( tSpeed, tLoad, tBSFC,
‘LineStyle', '-', 'LineWidth', 2, 'EdgeColor', 'k',
'FaceColor', 'none', 'FaceAlpha'; 1 );
hold off

xlabel( 'Speed [RPM]' );
ylabel( 'Load [%]' );
zlabel( 'Minimum BSFC [g/Kwh]' );
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5 Check the table accuracy:

a View the difference between the model and the table by plotting the
difference between them on a finer grid.

b Then, use this difference in prediction accuracy between the table and

the model to determine the most efficient table size for your accuracy
requirements.

The following code evaluates the model over a finer grid and plots the
difference between the model and the table:

[tfSpeed, tfLoad] = meshgrid( linspace( 1000, 5500,...

8*17+1 ), linspace( 0.2, 0.8, 8*13+1 ) );
tfBSFC_model = f2( tfSpeed, tfLoad );
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tfBSFC_table = interp2( tSpeed, tLoad, tBSFC, tfSpeed,...
tfLoad, 'linear' );
tfDiff = tfBSFC_model - tfBSFC_table;

surf( tfSpeed, tfLoad, tfDiff, 'LineStyle', 'none' );
hold on
mesh( tSpeed, tLoad, zeros( size( tBSFC ) ),

'LineStyle', '-', 'LineWidth', 2, 'EdgeColor', 'k',
'FaceColor', 'none', 'FaceAlpha';, 1 );
hold off
axis tight

xlabel( 'Speed [RPM]' );

ylabel( 'Load [%]' );

zlabel( 'Difference between model and table [g/Kwh]' );

title( sprintf( 'Max difference: %g', max( abs( tfDiff(:) ) ) ) );
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6 If you have Simulink® software, you can create a Look Up Table block.

a Create a model with a 2-D Lookup Table block.

simulink

new_system('my_model')

open_system('my_model")

add_block('Simulink/Lookup Tables/2-D Lookup Table',...
‘my_model/surfaceblock')

b Populate the Lookup Table with speed breakpoints, load breakpoints,
and a lookup table.

set_param('my_model/surfaceblock',...
'BreakpointsForDimensioni', 'loadbreakpoints',...
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'BreakpointsForDimension2', 'speedbreakpoints’',...
'Table', 'tBSFC');

¢ Examine the populated Lookup Table block.

Biopharmaceutical Drug Interaction Programmatic
Surface Fitting Example

¢ “Load Data” on page 4-54

e “Create Model Fit Type” on page 4-54

¢ “Fit a Surface to Algometry” on page 4-54

¢ “Fit a Surface to Tetany” on page 4-56

¢ “Fit a Surface to Sedation” on page 4-56

¢ “Fit a Surface to Laryingoscopy” on page 4-57

Curve Fitting Toolbox provides some example data for an anesthesia drug
interaction study. You can use surface fitting methods to fit response surfaces
to this data to analyze drug interaction effects.

The following code, using Curve Fitting Toolbox methods, reproduces
the interactive surface building with Surface Fitting Tool described in
“Biopharmaceutical Interactive Surface Fitting Example” on page 3-22.

The data is based on the results in the following paper:

Kern SE, Xie G, White JL, Egan TD. Opioid-hypnotic synergy: A response
surface analysis of propofol-remifentanil pharmacodynamic interaction in
volunteers. Anesthesiology 2004; 100: 1373-81.

Anesthesia is typically at least a two-drug process, consisting of an opioid
and a sedative hypnotic. This example uses Propofol and Reminfentanil

as drug class prototypes. Their interaction is measured by four different
measures of the analgesic and sedative response to the drug combination.
Algometry, Tetany, Sedation and Laryingoscopy comprise the four measures
of surrogate drug effects at various concentration combinations of Propofol
and Reminfentanil.
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The following code models the response surfaces for this drug combination:

Load Data

Load the data from file as follows:

data = importdata( 'OpioidHypnoticSynergy.txt' );

Propofol = data.data(:,1);
Remifentanil = data.data(:,2);
Algometry = data.data(:,3);
Tetany = data.data(:,4);
Sedation = data.data(:,5);
Laryingoscopy = data.data(:,6);

Create Model Fit Type
Create the model fit type as follows:

ft = fittype( 'Emax*( CA/IC50A + CB/IC50B + alpha*( CA/IC50A
) * ( CB/IC50B ) )*n /(( CA/IC50A + CB/IC50B + alpha*(
CA/IC50A ) * ( CB/IC50B ) )"n + 1 )",

"indep', {'CA', 'CB'}, 'depend', 'z', 'problem', 'Emax' )

Output:
ft =
General model:
ft(IC50A,IC50B,alpha,n,Emax,CA,CB) = Emax*...
( CA/IC50A + CB/IC50B + alpha*(CA/IC50A )...

* ( CB/IC50B ) )"n /(( CA/IC50A + CB/IC50B...
+ alpha*( CA/IC50A ) * ( CB/IC50B ) )*n + 1)

Assume Emax =1

Emax = 1;

Fit a Surface to Algomeiry
Set fit options as follows:
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opts = fitoptions( ft );

opts.Lower = [0 O -5 -0];

opts.Robust = 'LAR';

opts.StartPoint = [0.00893838724332152 0.706165672266879. ..
1 0.746030748284422];

Fit and plot a surface for Algometry:

[f, gof] = fit( [Propofol, Remifentanil], Algometry, ft,...
opts, 'problem', Emax )
plot( f, [Propofol, Remifentanil], Algometry );

<) Figure 1 i ]
File Edit View Insert Tools Desktop Window Help u
Jcde | 3| RATDLEL-2|0HE =l
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Fit a Surface to Tetany
Fit a surface to Tetany as follows:

[f, gof] = fit( [Propofol, Remifentanil], Tetany,
ft, opts, 'problem', Emax )
plot( f, [Propofol, Remifentanil], Tetany );

<) Figure 1 ; =lolx]
File Edit View Insert Tools Desktop Window Help u
cde | | RATDLRL- 2| 0HE 80

Fit a Surface to Sedation
Fit a surface to Sedation as follows:

[f, gof] = fit( [Propofol, Remifentanil], Sedation,
ft, opts, 'problem', Emax )
plot( f, [Propofol, Remifentanil], Sedation );
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Fit a Surface to Laryingoscopy
Fit a surface to Laryingoscopy as follows:

[f, gof] = fit( [Propofol, Remifentanil], Laryingoscopy,
ft, opts, 'problem', Emax )
plot( f, [Propofol, Remifentanil], Laryingoscopy );
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Curve Fitting Techniques

e “Data Transformations” on page 5-2

¢ “Filtering and Smoothing” on page 5-4
e “Least-Squares Fitting” on page 5-16
e “Residual Analysis” on page 5-28

¢ “Interpolants” on page 5-45
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Data Transformations

Changing variables through data transformations may lead to a simplified
relationship between the transformed predictor variable and the transformed
response. As a result, model descriptions and predictions may be simplified.

Common transformations include the logarithm In(y), and power functions

such as y2, y 1 and so on. Using these transformations, you can linearize

a nonlinear model, contract response data that spans one or more orders of
magnitude, or simplify a model so that it involves fewer coefficients.

Note You must transform variables at the MATLAB command line, and
then import those variables into Curve Fitting Tool. You cannot transform
variables using any of the graphical user interfaces.

For example, suppose you want to use the following model to fit your data.

1

y:z—
ax“ +bx+c

If you decide to use the power transform y~!, then the transformed model is
given by

y_1 =ax? +bx+c
As another example, the equation

y=ae

becomes linear if you take the log transform of both sides.

In(y) = In(a) + bx

You can now use linear least-squares fitting procedures.
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There are several disadvantages associated with performing transformations:

® For the log transformation, negative response values cannot be processed.

e For all transformations, the basic assumption that the residual variance
1s constant 1s violated. To avoid this problem, you could plot the residuals
on the transformed scale. For the power transformation shown above, the
transformed scale 1s given by the residuals

-1 ~-1
n=Yi Ui

Note that the residual plot associated with Curve Fitting Tool does not
support transformed scales.

Deciding on a particular transformation is not always obvious. However,

a scatter plot will often reveal the best form to use. In practice you can
experiment with various transforms and then plot the residuals from the
command line using the transformed scale. If the errors are reasonable
(they appear random with minimal scatter, and don’t exhibit any systematic
behavior), the transform is a good candidate.
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Filtering and Smoothing

In this section...

“Moving Average Filtering” on page 5-4
“Savitzky-Golay Filtering” on page 5-6

“Local Regression Smoothing” on page 5-7

“Smoothing Splines” on page 5-13

Moving Average Filtering

A moving average filter smooths data by replacing each data point with the
average of the neighboring data points defined within the span. This process
is equivalent to lowpass filtering with the response of the smoothing given by
the difference equation

(yi+N)+yGi+N-1D+...+ y(i—N))

. 1
=08

where y (i) is the smoothed value for the ith data point, IV is the number of
neighboring data points on either side of y (i), and 2N+1 is the span.

The moving average smoothing method used by Curve Fitting Toolbox
software follows these rules:

® The span must be odd.

® The data point to be smoothed must be at the center of the span.

® The span is adjusted for data points that cannot accommodate the specified
number of neighbors on either side.

® The end points are not smoothed because a span cannot be defined.

Note that you can use filter function to implement difference equations such
as the one shown above. However, because of the way that the end points are
treated, the toolbox moving average result will differ from the result returned
by filter. Refer to Difference Equations and Filtering in the MATLAB
documentation for more information.
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For example, suppose you smooth data using a moving average filter with a
span of 5. Using the rules described above, the first four elements of y_ are
given by

Note that y_ (1), y,(2), ...
and not necessarily the original order.

|
—_—

(1
y(
y(
y(

)
1
1)+y
2

)ty (3)+y(4)+y(5))/5
)ty (3)+y(4)+y(5)+y(6))/5

,¥.(end) refer to the order of the data after sorting,

The smoothed values and spans for the first four data points of a generated

data set are shown below.
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Plot (a) indicates that the first data point is not smoothed because a span
cannot be constructed. Plot (b) indicates that the second data point is
smoothed using a span of three. Plots (¢) and (d) indicate that a span of five
is used to calculate the smoothed value.

Savitzky-Golay Filtering

Savitzky-Golay filtering can be thought of as a generalized moving average.
You derive the filter coefficients by performing an unweighted linear
least-squares fit using a polynomial of a given degree. For this reason, a
Savitzky-Golay filter is also called a digital smoothing polynomaial filter or a
least-squares smoothing filter. Note that a higher degree polynomial makes
it possible to achieve a high level of smoothing without attenuation of data
features.

The Savitzky-Golay filtering method is often used with frequency data or
with spectroscopic (peak) data. For frequency data, the method is effective at
preserving the high-frequency components of the signal. For spectroscopic
data, the method is effective at preserving higher moments of the peak such
as the line width. By comparison, the moving average filter tends to filter
out a significant portion of the signal’s high-frequency content, and it can
only preserve the lower moments of a peak such as the centroid. However,
Savitzky-Golay filtering can be less successful than a moving average filter
at rejecting noise.

The Savitzky-Golay smoothing method used by Curve Fitting Toolbox
software follows these rules:

® The span must be odd.

¢ The polynomial degree must be less than the span.

® The data points are not required to have uniform spacing.

Normally, Savitzky-Golay filtering requires uniform spacing of the
predictor data. However, the Curve Fitting Toolbox algorithm supports
nonuniform spacing. Therefore, you are not required to perform an
additional filtering step to create data with uniform spacing.

The plot shown below displays generated Gaussian data and several attempts
at smoothing using the Savitzky-Golay method. The data is very noisy and
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the peak widths vary from broad to narrow. The span is equal to 5% of the
number of data points.

Savitzky—Golay Smoothing
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Plot (a) shows the noisy data. To more easily compare the smoothed results,
plots (b) and (c) show the data without the added noise.

Plot (b) shows the result of smoothing with a quadratic polynomial. Notice
that the method performs poorly for the narrow peaks. Plot (¢) shows the
result of smoothing with a quartic polynomial. In general, higher degree

polynomials can more accurately capture the heights and widths of narrow
peaks, but can do poorly at smoothing wider peaks.

Local Regression Smoothing

* “Lowess and Loess” on page 5-8
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® “The Local Regression Method” on page 5-8
® “Robust Local Regression” on page 5-11

Lowess and Loess

The names “lowess” and “loess” are derived from the term “locally weighted
scatter plot smooth,” as both methods use locally weighted linear regression
to smooth data.

The smoothing process is considered local because, like the moving average
method, each smoothed value is determined by neighboring data points
defined within the span. The process is weighted because a regression
weight function is defined for the data points contained within the span.

In addition to the regression weight function, you can use a robust weight
function, which makes the process resistant to outliers. Finally, the methods
are differentiated by the model used in the regression: lowess uses a linear
polynomial, while loess uses a quadratic polynomial.

The local regression smoothing methods used by Curve Fitting Toolbox
software follow these rules:

® The span can be even or odd.

® You can specify the span as a percentage of the total number of data points
in the data set. For example, a span of 0.1 uses 10% of the data points.

The Local Regression Method

The local regression smoothing process follows these steps for each data point:

1 Compute the regression weights for each data point in the span. The
weights are given by the tricube function shown below.

(]

x 1s the predictor value associated with the response value to be smoothed,
x; are the nearest neighbors of x as defined by the span, and d(x) is the

x—xi

d(x)
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distance along the abscissa from x to the most distant predictor value
within the span. The weights have these characteristics:

® The data point to be smoothed has the largest weight and the most
influence on the fit.

® Data points outside the span have zero weight and no influence on the fit.

2 A weighted linear least-squares regression is performed. For lowess, the
regression uses a first degree polynomial. For loess, the regression uses a
second degree polynomial.

3 The smoothed value is given by the weighted regression at the predictor
value of interest.

If the smooth calculation involves the same number of neighboring data points
on either side of the smoothed data point, the weight function is symmetric.
However, if the number of neighboring points is not symmetric about the
smoothed data point, then the weight function is not symmetric. Note that
unlike the moving average smoothing process, the span never changes. For
example, when you smooth the data point with the smallest predictor value,
the shape of the weight function is truncated by one half, the leftmost data
point in the span has the largest weight, and all the neighboring points are
to the right of the smoothed value.
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The weight function for an end point and for an interior point is shown below
for a span of 31 data points.

Local Regression Weight Function
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Using the lowess method with a span of five, the smoothed values and
associated regressions for the first four data points of a generated data set
are shown below.
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Notice that the span does not change as the smoothing process progresses
from data point to data point. However, depending on the number of nearest
neighbors, the regression weight function might not be symmetric about the
data point to be smoothed. In particular, plots (a) and (b) use an asymmetric
weight function, while plots (c¢) and (d) use a symmetric weight function.

For the loess method, the graphs would look the same except the smoothed
value would be generated by a second-degree polynomial.

Robust Local Regression

If your data contains outliers, the smoothed values can become distorted,
and not reflect the behavior of the bulk of the neighboring data points. To
overcome this problem, you can smooth the data using a robust procedure that
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is not influenced by a small fraction of outliers. For a description of outliers,
refer to “Marking Outliers” on page 2-39.

Curve Fitting Toolbox software provides a robust version for both the lowess
and loess smoothing methods. These robust methods include an additional
calculation of robust weights, which is resistant to outliers. The robust
smoothing procedure follows these steps:

1 Calculate the residuals from the smoothing procedure described in the
previous section.

2 Compute the robust weights for each data point in the span. The weights
are given by the bisquare function,

2
o = 1(1-(; /6MAD))", Iril < 6MAD,
l
0, |ril > 6 MAD,
where r; is the residual of the ith data point produced by the regression
smoothing procedure, and MAD is the median absolute deviation of the
residuals,

MAD = median (|r]).

The median absolute deviation is a measure of how spread out the residuals
are. If r, is small compared to 6 MAD, then the robust weight is close to 1.
If r; is greater than 6MAD, the robust weight is 0 and the associated data
point is excluded from the smooth calculation.

3 Smooth the data again using the robust weights. The final smoothed value
1s calculated using both the local regression weight and the robust weight.

4 Repeat the previous two steps for a total of five iterations.

The smoothing results of the lowess procedure are compared below to the
results of the robust lowess procedure for a generated data set that contains a
single outlier. The span for both procedures is 11 data points.



Filtering and Smoothing

Robust Lowess Smoothing
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Plot (a) shows that the outlier influences the smoothed value for several
nearest neighbors. Plot (b) suggests that the residual of the outlier is greater
than six median absolute deviations. Therefore, the robust weight is zero for
this data point. Plot (c) shows that the smoothed values neighboring the
outlier reflect the bulk of the data.

Smoothing Splines

If your data is noisy, you might want to fit it using a smoothing spline.
Alternatively, you can use one of the smoothing methods described in
“Smoothing Data” on page 2-29.

The smoothing spline s is constructed for the specified smoothing parameter p
and the specified weights w,. The smoothing spline minimizes
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2
2
pri (¥ - s(xi))2 + (1—p)'[(%] dx
i X

If the weights are not specified, they are assumed to be 1 for all data points.

p 1s defined between 0 and 1. p = 0 produces a least-squares straight-line
fit to the data, while p = 1 produces a cubic spline interpolant. If you do
not specify the smoothing parameter, it is automatically selected in the
“Interesting range.” The interesting range of p is often near 1/(1+h3/6) where
h 1s the average spacing of the data points, and it is typically much smaller
than the allowed range of the parameter. Because smoothing splines have
an associated smoothing parameter, you might consider these fits to be
parametric in that sense. However, smoothing splines are also piecewise
polynomials like cubic spline or shape-preserving interpolants and are
considered a nonparametric fit type in this guide.

Note The Curve Fitting Toolbox smoothing spline algorithm is based on the
csaps function.

The nuclear reaction data from the file carbonl2alpha.mat is shown below
with three smoothing spline fits. The default smoothing parameter (p = 0.99)
produces the smoothest curve. The cubic spline curve (p = 1) goes through
all the data points, but is not quite as smooth. The third curve (p = 0.95)
misses the data by wide margin and illustrates how small the “interesting
range” of p can be.
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In this section...

“Introduction” on page 5-16

“Error Distributions” on page 5-17
“Linear Least Squares” on page 5-18
“Weighted Least Squares” on page 5-21
“Robust Least Squares” on page 5-23

“Nonlinear Least Squares” on page 5-25

Introduction

Curve Fitting Toolbox software uses the method of least squares when fitting
data. Fitting requires a parametric model that relates the response data to
the predictor data with one or more coefficients. The result of the fitting
process is an estimate of the model coefficients.

To obtain the coefficient estimates, the least-squares method minimizes the
summed square of residuals. The residual for the ith data point r, is defined as

the difference between the observed response value y; and the fitted response
value y,, and is identified as the error associated with the data.

n=Y-Y
residual=data —fit

The summed square of residuals is given by
S=2r =2(% %)

where n is the number of data points included in the fit and S is the sum of
squares error estimate. The supported types of least-squares fitting include:

¢ Linear least squares
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* Weighted linear least squares
® Robust least squares

® Nonlinear least squares

Error Distributions

When fitting data that contains random variations, there are two important
assumptions that are usually made about the error:

® The error exists only in the response data, and not in the predictor data.

® The errors are random and follow a normal (Gaussian) distribution with
zero mean and constant variance, o2.

The second assumption is often expressed as
error [ N(0,0'z)

The errors are assumed to be normally distributed because the normal
distribution often provides an adequate approximation to the distribution
of many measured quantities. Although the least-squares fitting method
does not assume normally distributed errors when calculating parameter
estimates, the method works best for data that does not contain a large
number of random errors with extreme values. The normal distribution is
one of the probability distributions in which extreme random errors are
uncommon. However, statistical results such as confidence and prediction
bounds do require normally distributed errors for their validity.

If the mean of the errors is zero, then the errors are purely random. If the
mean is not zero, then it might be that the model is not the right choice for
your data, or the errors are not purely random and contain systematic errors.

A constant variance in the data implies that the “spread” of errors is constant.
Data that has the same variance is sometimes said to be of equal quality.

The assumption that the random errors have constant variance is not implicit
to weighted least-squares regression. Instead, it is assumed that the weights
provided in the fitting procedure correctly indicate the differing levels of
quality present in the data. The weights are then used to adjust the amount
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of influence each data point has on the estimates of the fitted coefficients to
an appropriate level.

Linear Least Squares

Curve Fitting Toolbox software uses the linear least-squares method to fit a
linear model to data. A linear model is defined as an equation that is linear in
the coefficients. For example, polynomials are linear but Gaussians are not.
To illustrate the linear least-squares fitting process, suppose you have n data
points that can be modeled by a first-degree polynomial.

Yy =p1x+p2

To solve this equation for the unknown coefficients p, and p,, you write
S as a system of n simultaneous linear equations in two unknowns. If n
is greater than the number of unknowns, then the system of equations is
overdetermined.

S= (y;—(p1a; + o))’
-1

14

Because the least-squares fitting process minimizes the summed square of
the residuals, the coefficients are determined by differentiating S with respect
to each parameter, and setting the result equal to zero.

oS 2

——=-2)" % (3~ (p1%; + pp)) =0
9Py i=1

oS L

—=-23 (y; —(p12; + pg)) =0
dpy i=1

The estimates of the true parameters are usually represented by b.
Substituting b, and b, for p, and p,, the previous equations become

> x; (y; —(byx; +b9)) =0
Y (7 = (Byx; +by)) =0
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where the summations run from i = 1 to n. The normal equations are defined
as

bIin2+b22xi :inyi
blzxi+nb2 :Zyi

Solving for b,

by = nzxiyi _inzyi
Y -(Tu)

Solving for b, using the b, value

by = %(Zyi ~b; ) %;)

As you can see, estimating the coefficients p, and p, requires only a few
simple calculations. Extending this example to a higher degree polynomial is
straightforward although a bit tedious. All that is required is an additional
normal equation for each linear term added to the model.

In matrix form, linear models are given by the formula
y=XB+e¢
where

® yis an n-by-1 vector of responses.

® B is a m-by-1 vector of coefficients.

¢ Xis the n-by-m design matrix for the model.
® ¢is an n-by-1 vector of errors.

For the first-degree polynomial, the n equations in two unknowns are
expressed in terms of y, X, and B as
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(1] [%1]
Y2 x91
Y3 x31
~ {m }
= X
Dy
ECAEEY

The least-squares solution to the problem is a vector b, which estimates the
unknown vector of coefficients B. The normal equations are given by

XX)b = Xy
where X7 is the transpose of the design matrix X. Solving for b,
b=X"X)" Xy

Use the MATLAB backslash operator (mldivide) to solve a system of
simultaneous linear equations for unknown coefficients. Because inverting
X"X can lead to unacceptable rounding errors, the backslash operator uses QR
decomposition with pivoting, which is a very stable algorithm numerically.
Refer to Arithmetic Operators in the MATLAB documentation for more
information about the backslash operator and @R decomposition.

You can plug b back into the model formula to get the predicted response
values, 3.

9y =Xb=Hy

H=XX"X)" XT
A hat (circumflex) over a letter denotes an estimate of a parameter or a
prediction from a model. The projection matrix H is called the hat matrix,

because it puts the hat on y.

The residuals are given by

r=y-y=(~1-H)y


../../techdoc/ref/arithmeticoperators.html
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Weighted Least Squares

It is usually assumed that the response data is of equal quality and, therefore,
has constant variance. If this assumption is violated, your fit might be unduly
influenced by data of poor quality. To improve the fit, you can use weighted
least-squares regression where an additional scale factor (the weight) is
included in the fitting process. Weighted least-squares regression minimizes
the error estimate

4 2
SZZwi(yi—Yi)

=1

where w; are the weights. The weights determine how much each response
value influences the final parameter estimates. A high-quality data point
influences the fit more than a low-quality data point. Weighting your data
is recommended if the weights are known, or if there is justification that
they follow a particular form.

The weights modify the expression for the parameter estimates b in the
following way,

b=p=XTwx) 1 xTwy
where W is given by the diagonal elements of the weight matrix w.

You can often determine whether the variances are not constant by fitting the
data and plotting the residuals. In the plot shown below, the data contains
replicate data of various quality and the fit is assumed to be correct. The poor
quality data 1s revealed in the plot of residuals, which has a “funnel” shape
where small predictor values yield a bigger scatter in the response values
than large predictor values.
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The weights you supply should transform the response variances to a constant
value. If you know the variances of the measurement errors in your data,
then the weights are given by

wl-:l/diz

Or, if you only have estimates of the error variable for each data point, it
usually suffices to use those estimates in place of the true variance. If you

do not know the variances, it suffices to specify weights on a relative scale.
Note that an overall variance term is estimated even when weights have been
specified. In this instance, the weights define the relative weight to each point
in the fit, but are not taken to specify the exact variance of each point.

For example, if each data point is the mean of several independent
measurements, it might make sense to use those numbers of measurements
as weights.
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Robust Least Squares

It is usually assumed that the response errors follow a normal distribution,
and that extreme values are rare. Still, extreme values called outliers do occur.

The main disadvantage of least-squares fitting is its sensitivity to outliers.
Outliers have a large influence on the fit because squaring the residuals
magnifies the effects of these extreme data points. To minimize the influence
of outliers, you can fit your data using robust least-squares regression. The
toolbox provides these two robust regression methods:

¢ Least absolute residuals (LAR) — The LAR method finds a curve that
minimizes the absolute difference of the residuals, rather than the squared
differences. Therefore, extreme values have a lesser influence on the fit.

¢ Bisquare weights — This method minimizes a weighted sum of squares,
where the weight given to each data point depends on how far the point
is from the fitted line. Points near the line get full weight. Points farther
from the line get reduced weight. Points that are farther from the line than
would be expected by random chance get zero weight.

For most cases, the bisquare weight method is preferred over LAR because
it simultaneously seeks to find a curve that fits the bulk of the data using
the usual least-squares approach, and it minimizes the effect of outliers.

Robust fitting with bisquare weights uses an iteratively reweighted
least-squares algorithm, and follows this procedure:

1 Fit the model by weighted least squares.

2 Compute the adjusted residuals and standardize them. The adjusted
residuals are given by

Tygi =
“w ok

r; are the usual least-squares residuals and A, are leverages that adjust
the residuals by down-weighting high-leverage data points, which have a
large effect on the least-squares fit. The standardized adjusted residuals
are given by
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Ks

K is a tuning constant equal to 4.685, and s is the robust variance given by
MADI0.6745 where MAD is the median absolute deviation of the residuals.

3 Compute the robust weights as a function of u. The bisquare weights are
given by

2
w = (1=@?) | <1

Note that if you supply your own regression weight vector, the final weight
is the product of the robust weight and the regression weight.

4 If the fit converges, then you are done. Otherwise, perform the next
iteration of the fitting procedure by returning to the first step.

The plot shown below compares a regular linear fit with a robust fit using

bisquare weights. Notice that the robust fit follows the bulk of the data and is
not strongly influenced by the outliers.
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Instead of minimizing the effects of outliers by using robust regression, you
can mark data points to be excluded from the fit. Refer to “Excluding and
Sectioning Data” on page 2-37 for more information.

Nonlinear Least Squares

Curve Fitting Toolbox software uses the nonlinear least-squares formulation
to fit a nonlinear model to data. A nonlinear model is defined as an equation
that is nonlinear in the coefficients, or a combination of linear and nonlinear
in the coefficients. For example, Gaussians, ratios of polynomials, and power
functions are all nonlinear.

In matrix form, nonlinear models are given by the formula

y=fXp) te

where
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® yis an n-by-1 vector of responses.
® fis a function of B and X.

® B1is a m-by-1 vector of coefficients.

X is the n-by-m design matrix for the model.

® ¢1s an n-by-1 vector of errors.

Nonlinear models are more difficult to fit than linear models because the
coefficients cannot be estimated using simple matrix techniques. Instead, an
iterative approach is required that follows these steps:

1 Start with an initial estimate for each coefficient. For some nonlinear
models, a heuristic approach is provided that produces reasonable starting
values. For other models, random values on the interval [0,1] are provided.

2 Produce the fitted curve for the current set of coefficients. The fitted
response value y is given by

y = f(X,b)

and involves the calculation of the Jacobian of f(X,b), which is defined as a
matrix of partial derivatives taken with respect to the coefficients.

3 Adjust the coefficients and determine whether the fit improves. The
direction and magnitude of the adjustment depend on the fitting algorithm.
The toolbox provides these algorithms:

¢ Trust-region — This is the default algorithm and must be used if
you specify coefficient constraints. It can solve difficult nonlinear
problems more efficiently than the other algorithms and it represents an
improvement over the popular Levenberg-Marquardt algorithm.

¢ Levenberg-Marquardt — This algorithm has been used for many years
and has proved to work most of the time for a wide range of nonlinear
models and starting values. If the trust-region algorithm does not
produce a reasonable fit, and you do not have coefficient constraints, you
should try the Levenberg-Marquardt algorithm.

® Gauss-Newton — This algorithm is potentially faster than the other
algorithms, but it assumes that the residuals are close to zero. It’s
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included with the toolbox for pedagogical reasons and should be the last
choice for most models and data sets.

4 Iterate the process by returning to step 2 until the fit reaches the specified
convergence criteria.

You can use weights and robust fitting for nonlinear models, and the fitting
process is modified accordingly.

Because of the nature of the approximation process, no algorithm is foolproof
for all nonlinear models, data sets, and starting points. Therefore, if you do
not achieve a reasonable fit using the default starting points, algorithm, and
convergence criteria, you should experiment with different options. Refer to
“Specifying Fit Options” on page 2-58 for a description of how to modify the
default options. Because nonlinear models can be particularly sensitive to the
starting points, this should be the first fit option you modify.
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In this section...

“Introduction” on page 5-28
“Computing Residuals” on page 5-29
“Goodness-of-Fit Statistics” on page 5-31

“Confidence and Prediction Bounds” on page 5-34

“Example: Residual Analysis” on page 5-39

Introduction

After fitting data with one or more models, you should evaluate the goodness
of fit. A visual examination of the fitted curve displayed in Curve Fitting Tool
should be your first step. Beyond that, the toolbox provides these methods to
assess goodness of fit for both linear and nonlinear parametric fits:

® Residual analysis
® Goodness of fit statistics
¢ (Confidence and prediction bounds

As 1s common in statistical literature, the term goodness of fit is used here
in several senses: A “good fit” might be a model

e that your data could reasonably have come from, given the assumptions of
least-squares fitting

® in which the model coefficients can be estimated with little uncertainty

® that explains a high proportion of the variability in your data, and is able
to predict new observations with high certainty

A particular application might dictate still other aspects of model fitting that
are important to achieving a good fit, such as a simple model that is easy to
interpret. The methods described here can help you determine goodness of
fit in all these senses.
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These methods group into two types: graphical and numerical. Plotting
residuals and prediction bounds are graphical methods that aid visual
interpretation, while computing goodness-of-fit statistics and coefficient
confidence bounds yield numerical measures that aid statistical reasoning.

Generally speaking, graphical measures are more beneficial than numerical
measures because they allow you to view the entire data set at once, and they
can easily display a wide range of relationships between the model and the
data. The numerical measures are more narrowly focused on a particular
aspect of the data and often try to compress that information into a single
number. In practice, depending on your data and analysis requirements, you
might need to use both types to determine the best fit.

Note that it is possible that none of your fits can be considered suitable for
your data, based on these methods. In this case, it might be that you need

to select a different model. It is also possible that all the goodness-of-fit
measures indicate that a particular fit is suitable. However, if your goal is to
extract fitted coefficients that have physical meaning, but your model does
not reflect the physics of the data, the resulting coefficients are useless. In
this case, understanding what your data represents and how it was measured
1s just as important as evaluating the goodness of fit.

Computing Residuals

The residuals from a fitted model are defined as the differences between the
response data and the fit to the response data at each predictor value.

residual = data — fit

You display the residuals in Curve Fitting Tool by selecting the menu item
View > Residuals.

Mathematically, the residual for a specific predictor value is the difference
between the response value y and the predicted response value j.

r=y-y
Assuming the model you fit to the data is correct, the residuals approximate

the random errors. Therefore, if the residuals appear to behave randomly, it
suggests that the model fits the data well. However, if the residuals display
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a systematic pattern, it is a clear sign that the model fits the data poorly.
Always bear in mind that many results of model fitting, such as confidence
bounds, will be invalid should the model be grossly inappropriate for the data.

A graphical display of the residuals for a first degree polynomial fit is shown
below. The top plot shows that the residuals are calculated as the vertical
distance from the data point to the fitted curve. The bottom plot displays the
residuals relative to the fit, which is the zero line.
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The residuals appear randomly scattered around zero indicating that the
model describes the data well.
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A graphical display of the residuals for a second-degree polynomial fit is
shown below. The model includes only the quadratic term, and does not
include a linear or constant term.
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The residuals are systematically positive for much of the data range indicating
that this model is a poor fit for the data.

Goodness-of-Fit Statistics
After using graphical methods to evaluate the goodness of fit, you should

examine the goodness-of-fit statistics. Curve Fitting Toolbox software
supports these goodness-of-fit statistics for parametric models:

¢ The sum of squares due to error (SSE)

® R-square

® Adjusted R-square

® Root mean squared error (RMSE)
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For the current fit, these statistics are displayed in the Results list box in the
Fit Editor. For all fits in the current curve-fitting session, you can compare
the goodness-of-fit statistics in the Table of fits.

Sum of Squares Due to Error

This statistic measures the total deviation of the response values from the
fit to the response values. It is also called the summed square of residuals
and is usually labeled as SSE.

n
A \2
SSE = Zwi (yl _yi)
=1

A value closer to 0 indicates that the model has a smaller random error
component, and that the fit will be more useful for prediction.

R-Square

This statistic measures how successful the fit is in explaining the variation of
the data. Put another way, R-square is the square of the correlation between
the response values and the predicted response values. It is also called the
square of the multiple correlation coefficient and the coefficient of multiple
determination.

R-square is defined as the ratio of the sum of squares of the regression (SSR)
and the total sum of squares (SST). SSR is defined as

n

~ —\2

SSR =2wi (%, -9)
i=1

SST is also called the sum of squares about the mean, and is defined as

n
SST = Zwi (yl —y)Z
=1

where SST = SSR + SSE. Given these definitions, R-square is expressed as
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SSR _, _SSE

R-square=——=1-——
SST SST

R-square can take on any value between 0 and 1, with a value closer to 1
indicating that a greater proportion of variance is accounted for by the model.
For example, an R-square value of 0.8234 means that the fit explains 82.34%
of the total variation in the data about the average.

If you increase the number of fitted coefficients in your model, R-square will
increase although the fit may not improve in a practical sense. To avoid this
situation, you should use the degrees of freedom adjusted R-square statistic
described below.

Note that it is possible to get a negative R-square for equations that do not
contain a constant term. Because R-square is defined as the proportion of

variance explained by the fit, if the fit is actually worse than just fitting a

horizontal line then R-square is negative. In this case, R-square cannot be
interpreted as the square of a correlation. Such situations indicate that a

constant term should be added to the model.

Degrees of Freedom Adjusted R-Square

This statistic uses the R-square statistic defined above, and adjusts it based
on the residual degrees of freedom. The residual degrees of freedom is defined
as the number of response values n minus the number of fitted coefficients m
estimated from the response values.

v=n—-m

v indicates the number of independent pieces of information involving the

n data points that are required to calculate the sum of squares. Note that

if parameters are bounded and one or more of the estimates are at their
bounds, then those estimates are regarded as fixed. The degrees of freedom is
increased by the number of such parameters.

The adjusted R-square statistic is generally the best indicator of the fit quality
when you compare two models that are nested — that is, a series of models
each of which adds additional coefficients to the previous model.
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adjusted R-square =1- SSE( -1)
SST(v)

The adjusted R-square statistic can take on any value less than or equal to
1, with a value closer to 1 indicating a better fit. Negative values can occur
when the model contains terms that do not help to predict the response.

Root Mean Squared Error

This statistic is also known as the fit standard error and the standard error
of the regression. It is an estimate of the standard deviation of the random
component in the data, and is defined as

RMSE =s=+MSE

where MSE is the mean square error or the residual mean square

SSE
v

MSE =

Just as with SSE, an MSE value closer to 0 indicates a fit that is more useful
for prediction.

Confidence and Prediction Bounds

Curve Fitting Toolbox software lets you calculate confidence bounds for the
fitted coefficients, and prediction bounds for new observations or for the fitted
function. Additionally, for prediction bounds, you can calculate simultaneous
bounds, which take into account all predictor values, or you can calculate
nonsimultaneous bounds, which take into account only individual predictor
values. The coefficient confidence bounds are presented numerically, while
the prediction bounds are displayed graphically and are also available
numerically.

The available confidence and prediction bounds are summarized below.
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Types of Confidence and Prediction Bounds

Interval Type Description

Fitted coefficients Confidence bounds for the fitted coefficients

New observation Prediction bounds for a new observation (response
value)

New function Prediction bounds for a new function value

Note Prediction bounds are also often described as confidence bounds because
you are calculating a confidence interval for a predicted response.

Confidence and prediction bounds define the lower and upper values of the
associated interval, and define the width of the interval. The width of the
interval indicates how uncertain you are about the fitted coefficients, the
predicted observation, or the predicted fit. For example, a very wide interval
for the fitted coefficients can indicate that you should use more data when
fitting before you can say anything very definite about the coefficients.

The bounds are defined with a level of certainty that you specify. The level of
certainty is often 95%, but it can be any value such as 90%, 99%, 99.9%, and
so on. For example, you might want to take a 5% chance of being incorrect
about predicting a new observation. Therefore, you would calculate a 95%
prediction interval. This interval indicates that you have a 95% chance

that the new observation is actually contained within the lower and upper
prediction bounds.

Calculating and Displaying Confidence Bounds
The confidence bounds for fitted coefficients are given by

C=b+tJS
where b are the coefficients produced by the fit, ¢ depends on the confidence
level, and is computed using the inverse of Student’s ¢ cumulative distribution

function, and S is a vector of the diagonal elements from the estimated
covariance matrix of the coefficient estimates, (X7X) 's%. In a linear fit, X is
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the design matrix, while for a nonlinear fit X is the Jacobian of the fitted
values with respect to the coefficients. X7 is the transpose of X, and s? is the
mean squared error.

The confidence bounds are displayed in the Results list box in the Fit Editor
using the following format.

pl = 1.275 (1.113, 1.437)

The fitted value for the coefficient p1 is 1.275, the lower bound is 1.113,

the upper bound is 1.437, and the interval width is 0.324. By default, the
confidence level for the bounds is 95%. You can change this level to any value
with the View > Confidence Level menu item in Curve Fitting Tool.

You can calculate confidence intervals at the command line with the confint
function.

Calculating and Displaying Prediction Bounds

As mentioned previously, you can calculate prediction bounds for a new
observation or for the fitted curve. In both cases, the prediction is based on
an existing fit to the data. Additionally, the bounds can be simultaneous
and measure the confidence for all predictor values, or they can be
nonsimultaneous and measure the confidence only for a single predetermined
predictor value. If you are predicting a new observation, nonsimultaneous
bounds measure the confidence that the new observation lies within the
interval given a single predictor value. Simultaneous bounds measure the
confidence that a new observation lies within the interval regardless of the
predictor value.

The nonsimultaneous prediction bounds for a new observation at the predictor
value x are given by

P o=yt t\s% + xSxT

where s? is the mean squared error, ¢t depends on the confidence level, and is
computed using the inverse of Student’s ¢ cumulative distribution function,
and S is the covariance matrix of the coefficient estimates, (X7X)1s2. Note
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that x 1s defined as a row vector of the design matrix or Jacobian evaluated at
a specified predictor value.

The simultaneous prediction bounds for a new observation and for all
predictor values are given by

P, = y+ fys? +xSxT

where f depends on the confidence level, and is computed using the inverse of
the F cumulative distribution function.

The nonsimultaneous prediction bounds for the function at a single predictor
value x are given by

P =yt txSxT

The simultaneous prediction bounds for the function and for all predictor
values are given by

P r= yJ_rf\/xSxT

You can graphically display prediction bounds two ways: using Curve
Fitting Tool or using the Analysis GUI. With Curve Fitting Tool, you can
display nonsimultaneous prediction bounds for new observations with
View > Prediction Bounds. By default, the confidence level for the bounds
is 95%. You can change this level to any value with View > Confidence
Level. With the Analysis GUI, you can display nonsimultaneous prediction
bounds for the function or for new observations. Additionally, you can view
prediction bounds in the Results box of the Analysis GUI.

You can display numerical prediction bounds of any type at the command line
with the predint function.

To understand the quantities associated with each type of prediction interval,
recall that the data, fit, and residuals are related through the formula

data = fit + residuals
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where the fit and residuals terms are estimates of terms in the formula
data = model + random error

Suppose you plan to take a new observation at the predictor value x Call

the new observation y, ,,(x,,,) and the associated error ¢,,,. Then

n+l*

Yn1sr) = fX,00) + €,
where f(x,,,) is the true but unknown function you want to estimate at x,, .
The likely values for the new observation or for the estimated function are

provided by the nonsimultaneous prediction bounds.

If instead you want the likely value of the new observation to be associated
with any predictor value, the previous equation becomes

V(@) = flx) + &

The likely values for this new observation or for the estimated function are
provided by the simultaneous prediction bounds.

The types of prediction bounds are summarized below.

Types of Prediction Bounds

Simultaneous or

Type of Bound Non-simultaneous Associated Equation
Observation Non-simultaneous Vo1 (%40

Simultaneous ¥, ®), for all x
Function Non-simultaneous fx,.1)

Simultaneous f(x), for all x

The nonsimultaneous and simultaneous prediction bounds for a new
observation and the fitted function are shown below. Each graph contains
three curves: the fit, the lower confidence bounds, and the upper confidence
bounds. The fit is a single-term exponential to generated data and the bounds
reflect a 95% confidence level. Note that the intervals associated with a

new observation are wider than the fitted function intervals because of the
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additional uncertainty in predicting a new response value (the curve plus
random errors).

Monsimultaneous observation bounds Simultaneous observation bounds
3 3
+«  data - +  data
e _ -
L fitted curve LA fitted curve

X ¥
Monsimultaneous functional bounds Simultaneous functional bounds
25 25
\} . + data + +  data
2 fitted curve | * fitted curve (4
N 2

Example: Residual Analysis

This example fits several polynomial models to generated data and evaluates
how well those models fit the data and how precisely they can predict. The
data is generated from a cubic curve, and there is a large gap in the range of
the x variable where no data exist.

x
1l

[1:0.1:3 9:0.1:10]";
= [2.5 -0.5 1.3 -0.1];

(@]
|
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y = c(1) + c(2)*x + ¢c(3)*x."2 + ¢c(4)*x.”3 + (rand(size(x))-0.5);

After you import the data, fit it using a cubic polynomial and a fifth degree
polynomial. The data, fits, and residuals are shown below. You display the
residuals in Curve Fitting Tool with the View > Residuals menu item.

-} Curve Fitting Tool

=] 3
File | Wiew Tools ‘Window Help
JJ Prediction Baunds

Confidence Level

Residuals

More clude. .. | Flatting... Analysis... |

Scatker Plok
Lata and Fits

Clear Plot

Both fits appear fo
model the data well.

The residuals for both
—— fits appear to be
randomly distributed.

Both models appear to fit the data well, and the residuals appear to be
randomly distributed around zero. Therefore, a graphical evaluation of the
fits does not reveal any obvious differences between the two equations.
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The numerical fit results are shown below.

Results
Linear model Poly3:

£(x) = pl*x"3 + P2*x*Z + p3*x + p4
Coefficients (with 95% confidence bounds):

pl = -0.09837 (-0.1095, -0.08729)
pZ = 1.275 (1.113, 1.437)
Results
p3 = -0.4351 (-1.092, 0.2222)
pd = 2.56  (1.787, 3.332) Linear model Poly5:

pl
The quintic fit coefficients B2

p3
are not accurately known. i
ps
pa

0.001389
-0.03441
0.15934
0.2733
1.013
1.835

fix) = pl*x*5 4+ pZ*xtd + p3¥x*3 4+ pdPut2 + pStu
Coefficients (with 95% confidence bounds):
(-0,
L1601, 0.09125)
L9131, 1.3
LG56, 4.402)
.785, T.611)

167, 5.837) _l_vl
| »

The cubic fit coefficients are
accurately known.

-

003589, 0.006367)

As expected, the fit results for poly3 are reasonable because the generated
data follows a cubic curve. The 95% confidence bounds on the fitted coefficients
indicate that they are acceptably precise. However, the 95% confidence
bounds for poly5 indicate that the fitted coefficients are not known precisely.

The goodness-of-fit statistics are shown in the Table of Fits. By default, the
adjusted R-square and RMSE statistics are not displayed in the table. To
display these statistics, click the Table options button and select Adj R-sq

and RMSE, as shown below.
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The statistics do not reveal a substantial difference between the two equations.

The 95% nonsimultaneous prediction bounds for new observations are
shown below. To display prediction bounds in Curve Fitting Tool, select

the View > Prediction Bounds menu item. Alternatively, you can view
prediction bounds for the function or for new observations using the Analysis

} Table Options

Check to view column in Table of Fits:

¥ [@ Status [ DFE
M Fit name W AdjR-3g
W Data set W RMSE

W Equation name [ # Coeff
v S5E ™ Type of fit

W R-square

Close

Help

GUL
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) Curve Fitting Tool -0l x|
File | view Tools Window Help

2

Residuals * | Fitting... | Exclude... Platting... Analysis... |
Clear Plat:
Data and Fits
30+
0+ O oywsox
— poly3
Pred bnds {paly3)
10 --= polys i
Pred bnds (paly)
1 1 1 1 1 1 1 1 1 1
1 2 3 4 3 5 7 g a 10
Residuals
1 T T
—— poly3
nsl — polyd ||

The prediction bounds for poly3 indicate that new observations can be
predicted with a small uncertainty throughout the entire data range. This is
not the case for poly5. It has wider prediction bounds in the area where no
data exist, apparently because the data does not contain enough information
to estimate the higher degree polynomial terms accurately. In other words, a
fifth-degree polynomaial overfits the data. You can confirm this by using the
Analysis GUI to compute bounds for the functions themselves.

The 95% prediction bounds for the fitted function using poly5 are shown
below. As you can see, the uncertainty in predicting the function is large in
the center of the data. Therefore, you would conclude that more data must
be collected before you can make precise predictions using a fifth-degree
polynomial.
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Fitto analyze:

palys &y vs. x 'l

Analyze atXi=[1:0.9:10

v Evaluate fit at ¥
Frediction bounds:
" None
& Forfunction
© For new ohseration

Level | 95 %

=10l

[ 15t derivative at ¥i
[ 2nd derivative atXi

[ Integrate to Xi
& Start fraom ming<i

 Startfrom I

V! Plot results
¥ Plot data set yvs x

= 5|
Hi lower Ty Tixil upper fixi)
1 2.85085 3.28175 3.71256
1.9 5.44536 5.65871 5.87207
2.8 8.92368 9.1831 9.44374
37 126762 13.634 14.5918
4.6 16.3488 18.58541 20.75945
5.8 -} Curve Fitting Analysis
S; File Edit Wiew Insert Tools Window Help
.2 |DSH& XA A/ 2ED
9110 Analysis of fit "polya” for dataset "y vs. x"
35 T T T T
—— poly5 B S
30 ¢ | ---- 95% prediction bounds . 1
%y E. ¥ ’
= 25f
=
=
o
=
= 20t
=
&=
& 15t
=
=
= 10r
5 L
D 1 1 1 1
a 2 4 g g

In conclusion, you should examine all available goodness-of-fit measures
before deciding on the fit that is best for your purposes. A graphical
examination of the fit and residuals should always be your initial approach.
However, some fit characteristics are revealed only through numerical fit

results, statistics, and prediction bounds.
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Interpolants

Interpolation is a process for estimating values that lie between known data
points. The supported interpolant methods are shown below.

Interpolant Methods

Method Description

Linear Linear interpolation. This method fits a different
linear polynomial between each pair of data points.

Nearest neighbor Nearest neighbor interpolation. This method sets
the value of an interpolated point to the value of the
nearest data point. Therefore, this method does not
generate any new data points.

Cubic spline Cubic spline interpolation. This method fits a
different cubic polynomial between each pair of data
points.

Shape-preserving Piecewise cubic Hermite interpolation (PCHIP). This
method preserves monotonicity and the shape of the
data.

The type of interpolant you should use depends on the characteristics of the
data being fit, the required smoothness of the curve, speed considerations,
post-fit analysis requirements, and so on. The linear and nearest neighbor
methods are fast, but the resulting curves are not very smooth. The cubic
spline and shape-preserving methods are slower, but the resulting curves
are often very smooth.

For example, the nuclear reaction data from the file carbon12alpha.mat is
shown below with a nearest neighbor interpolant fit and a shape-preserving
(PCHIP) interpolant fit. Clearly, the nearest neighbor interpolant does not
follow the data as well as the shape-preserving interpolant. The difference
between these two fits can be important if you are interpolating. However,
if you want to integrate the data to get a sense of the total strength of the
reaction, then both fits provide nearly identical answers for reasonable
integration bin widths.
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350 T T T T T L= T

T
a3 C12Alpha
} — nearmst
-—- pchip

300~

250

200

counts

150~

100

S0

45

Note Goodness-of-fit statistics, prediction bounds, and weights are not
defined for interpolants. Additionally, the fit residuals are always zero (within
computer precision) because interpolants pass through the data points.

Interpolants are defined as piecewise polynomials because the fitted curve is
constructed from many “pieces.” For cubic spline and PCHIP interpolation,
each piece is described by four coefficients, which are calculated using a cubic
(third-degree) polynomial. Refer to the spline function for more information
about cubic spline interpolation. Refer to the pchip function for more
information about shape-preserving interpolation, and for a comparison of
the two methods.

It is possible to fit a single “global” polynomial interpolant to data, with a
degree one less than the number of data points. However, such a fit can
have wildly erratic behavior between data points. In contrast, the piecewise
polynomials described here always produce a well-behaved fit, and thus they
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are more flexible than parametric polynomials and can be effectively used for
a wider range of data sets.
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Introducing Spline Fitting

In this section...

“Spline Overview” on page 6-2
“Interactive Spline Fitting” on page 6-2

“Programmatic Spline Fitting” on page 6-3

Spline Overview

The Curve Fitting Toolbox spline functions are a collection of tools for
creating, viewing, and analyzing spline approximations of data. Splines are
smooth piecewise polynomials that can be used to represent functions over
large intervals, where it would be impractical to use a single approximating
polynomial.

The spline functionality includes a graphical user interface (GUI) that
provides easy access to functions for creating, visualizing, and manipulating
splines. The toolbox also contains functions that enable you to evaluate,
plot, combine, differentiate, and integrate splines. Because all toolbox
functions are implemented in the open MATLAB language, you can inspect
the algorithms, modify the source code, and create your own custom functions.

Key spline features:
e GUIs that let you create, view, and manipulate splines and manage and

compare spline approximations

® Functions for advanced spline operations, including differentiation,
integration, break/knot manipulation, and optimal knot placement

® Support for piecewise polynomial form (ppform) and basis form (B-form)
splines

® Support for tensor-product splines and rational splines (including NURBS)

Interactive Spline Fitting

You can access all spline functions from the splinetool GUI You can use
the GUI to:
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Vary spline parameters and tolerances

® View and modify data, breaks, knots, and weights

View the error of the spline, or the spline’s first or second derivative

Observe the toolbox commands that generated your spline

Create and import data and save splines to the workspace
See splinetool.

Programmatic Spline Fitting

To programmatically fit splines, see:

® Subsequent chapters in this section (Spline Fitting on page 1) for
descriptions of types of splines and numerous code examples.

® List of Spline Functions

6-3
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Curve Fitting Toolbox Splines and MATLAB Splines

In this section...

“Curve Fitting Toolbox Splines” on page 6-4
“MATLAB Splines” on page 6-5

Curve Fitting Toolbox Splines

Curve Fitting Toolbox spline functions contain versions of the essential
MATLAB programs of the B-spline package (extended to handle also
vector-valued splines) as described in A Practical Guide to Splines, (Applied
Math. Sciences Vol. 27, Springer Verlag, New York (1978), xxiv + 392p;
revised edition (2001), xviii+346p), hereafter referred to as PGS. The toolbox
makes it easy to create and work with piecewise-polynomial functions.

The typical use envisioned for this toolbox involves the construction and
subsequent use of a piecewise-polynomial approximation. This construction
would involve data fitting, but there is a wide range of possible data that
could be fit. In the simplest situation, one is given points (¢i,yi) and is looking
for a piecewise-polynomial function f that satisfies f(¢1) = yi, all i, more or less.
An exact fit would involve interpolation, an approximate fit might involve
least-squares approximation or the smoothing spline. But the function to be
approximated may also be described in more implicit ways, for example as the
solution of a differential or integral equation. In such a case, the data would
be of the form (Af)(t1), with A some differential or integral operator. On the
other hand, one might want to construct a spline curve whose exact location is
less important than is its overall shape. Finally, in all of this, one might be
looking for functions of more than one variable, such as tensor product splines.

Care has been taken to make this work as painless and intuitive as possible.
In particular, the user need not worry about just how splines are constructed
or stored for later use, nor need the casual user worry about such items as
“breaks” or “knots” or “coefficients”. It is enough to know that each function
constructed is just another variable that is freely usable as input (where
appropriate) to many of the commands, including all commands beginning
with fn, which stands for function. At times, it may be also useful to know
that, internal to the toolbox, splines are stored in different forms, with the
command fn2fm available to convert between forms.
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At present, the toolbox supports two major forms for the representation of
piecewise-polynomial functions, because each has been found to be superior
to the other in certain common situations. The B-form is particularly useful
during the construction of a spline, while the ppform is more efficient when
the piecewise-polynomial function is to be evaluated extensively. These two
forms are almost exactly the B-representation and the pp representation
used in A Practical Guide to Splines.

But, over the years, the Curve Fitting Toolbox spline functions have gone
beyond the programs in A Practical Guide to Splines. The toolbox now
supports the ‘scattered translates’ form, or stform, in order to handle the
construction and use of bivariate thin-plate splines, and also two ways to
represent rational splines, the rBform and the rpform, in order to handle
NURBS.

Splines can be very effective for data fitting because the linear systems to be
solved for this are banded, hence the work needed for their solution, done
properly, grows only linearly with the number of data points. In particular,
the MATLAB sparse matrix facilities are used in the Curve Fitting Toolbox
spline functions when that is more efficient than the toolbox’s own equation
solver, slvblk, which relies on the fact that some of the linear systems here
are even almost block diagonal.

All polynomaial spline construction commands are equipped to produce
bivariate (or even multivariate) piecewise-polynomial functions as tensor
products of the univariate functions used here, and the various fn...
commands also work for these multivariate functions.

There are various examples, all accessible through the Demos tab in the
MATLAB Help browser. You are strongly urged to have a look at some of
them, or at the GUI splinetool, before attempting to use this toolbox, or
even before reading on.

MATLAB Splines

The MATLAB technical computing environment provides spline
approximation via the command spline. If called in the form cs =
spline(x,y), it returns the ppform of the cubic spline with break sequence
x that takes the value y (i) at x(i), all i, and satisfies the not-a-knot

end condition. In other words, the command cs = spline(x,y) gives
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the same result as the command ¢cs = csapi(x,y) available in the

Curve Fitting Toolbox spline functions. But only the latter also works
when x,y describe multivariate gridded data. In MATLAB, cubic spline
interpolation to multivariate gridded data is provided by the command
interpn(x1,...,xd,v,y1,...,yd, 'spline') which returns values of the
interpolating tensor product cubic spline at the grid specified by y1,...,yd.

Further, any of the Curve Fitting Toolbox spline fn... commands can be
applied to the output of the MATLAB spline(x,y) command, with simple
versions of the Curve Fitting Toolbox spline commands fnval, ppmak, fnbrk
available directly in MATLAB, as the commands ppval, mkpp, unmkpp,
respectively.
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Expected Background

The Curve Fitting Toolbox spline functions started out as an extension of the
MATLAB environment of interest to experts in spline approximation, to aid
them in the construction and testing of new methods of spline approximation.
Such people will have mastered the material in A Practical Guide to Splines.

However, the basic commands for constructing and using spline
approximations are set up to be usable with no more knowledge than it takes
to understand what it means to, say, construct an interpolant or a least
squares approximant to some data, or what it means to differentiate or
integrate a function.

With that in mind, there are sections, like Chapter 7, “Some Simple Spline
Examples”, that are meant even for the novice, while sections devoted to

a detailed example, like the one on constructing a Chebyshev spline or on
constructing and using tensor products, are meant for users interested in
developing their own spline commands.

A “Glossary” at the end of this guide provides definitions of almost all the
mathematical terms used in this document.
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Technical Conventions

® “Vectors” on page 6-8
¢ “Naming Conventions” on page 6-8

® “Arguments for Curve Fitting Toolbox Spline Functions” on page 6-9

Vectors

The Curve Fitting Toolbox spline functions can handle vector-valued splines,
i.e., splines whose values lie in R4. Since MATLAB started out with just one
variable type, that of a matrix, there is even now some uncertainty about how
to deal with vectors, 1.e., lists of numbers. MATLAB sometimes stores such a
list in a matrix with just one row, and other times in a matrix with just one
column. In the first instance, such a I-row matrix is called a row-vector;

in the second instance, such a I-column matrix is called a column-vector.
Either way, these are merely different ways for storing vectors, not different
kinds of vectors.

In this toolbox, vectors, i.e., lists of numbers, may also end up stored in a
1-row matrix or in a 1-column matrix, but with the following agreements.

A point in RY, i.e., a d-vector, is always stored as a column vector. In
particular, if you want to supply an n-list of d-vectors to one of the commands,
you are expected to provide that list as the n columns of a matrix of size [d,n].

While other lists of numbers (e.g., a knot sequence or a break sequence) may
be stored internally as row vectors, you may supply such lists as you please,
as a row vector or a column vector.

Naming Conventions

Most of the spline commands in this toolbox have names that follow one of
the following patterns:

cs... commands construct cubic splines (in ppform)
sp... commands construct splines in B-form
fn... commands operate on spline functions
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..2.. commands convert something
.api commands construct an approximation by interpolation
.aps commands construct an approximation by smoothing
.ap2 commands construct a least-squares approximation

.. .knt commands construct (part of) a particular knot sequence

...dem commands are demonstrations now reached via the Demos tag in
the MATLAB Help browser.

Some of these naming conventions are the result of a discussion with Jorg
Peters, then a graduate student in Computer Sciences at the University of
Wisconsin-Madison.

Note See the “Glossary” for information about notation used in this book.

Arguments for Curve Fitting Toolbox Spline Functions

For ease of use, most Curve Fitting Toolbox spline functions have default
arguments. In the reference entry under Syntax, we usually first list the
function with all necessary input arguments and then with all possible

input arguments. When there is more than one optional argument, then,
sometimes, but not always, their exact order is immaterial. When their order
does matter, you have to specify every optional argument preceding the one(s)
you are interested in. In this situation, you can specify the default value for
an optional argument by using [ ] (the empty matrix) as the input for it. The
description in the reference page tells you the default value for each optional
input argument.

As in MATLAB, only the output arguments explicitly specified are returned
to the user.

6-9
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Introduction

These examples provide some simple ways to make use of the commands in
this toolbox. More complicated examples are given in later sections. Other
examples are available in the various demos, all of which can be reached by
the Demos tab in the MATLAB Help browser. In addition, the command
splinetool provides a graphical user interface (GUI) for you to try several of
the basic spline interpolation and approximation commands from this toolbox
on your data; it even provides various instructive data sets.

Check the reference pages if you have specific questions about the use of the
commands mentioned. Check the Glossary if you have specific questions
about the terminology used; a look into the Index may help.
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Cubic Spline Interpolation

In this section...

“Cubic Spline Interpolant of Smooth Data” on page 7-3
“Periodic Data” on page 7-4

“Other End Conditions” on page 7-5

“General Spline Interpolation” on page 7-5

“Knot Choices” on page 7-7

“Smoothing” on page 7-8

“Least Squares” on page 7-10

Cubic Spline Interpolant of Smooth Data

Suppose you want to interpolate some smooth data, e.g., to
rand('seed',6), x = (4*pi)*[0 1 rand(1,15)]; y = sin(x);
You can use the cubic spline interpolant obtained by
CsS = csapi(x,y);
and plot the spline, along with the data, with the following code:
fnplt(cs);
hold on
plot(x,y,'0")

legend('cubic spline', 'data')
hold off

This produces a figure like the following.
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Cubic Spline Interpolant of Smooth Data

This is, more precisely, the cubic spline interpolant with the not-a-knot end
conditions, meaning that it is the unique piecewise cubic polynomial with two
continuous derivatives with breaks at all interior data sites except for the
leftmost and the rightmost one. It is the same interpolant as produced by the
MATLAB spline command, spline(x,y).

Periodic Data

The sine function is 2m-periodic. To check how well your interpolant does on
that score, compute, e.g., the difference in the value of its first derivative
at the two endpoints,

diff(fnval(fnder(cs),[0 4*pi]))



Cubic Spline Interpolation

ans = -.0100

which is not so good. If you prefer to get an interpolant whose first and second
derivatives at the two endpoints, 0 and 4*pi, match, use instead the command
csape which permits specification of many different kinds of end conditions,
including periodic end conditions. So, use instead

pcs = csape(x,y, 'periodic');
for which you get

diff(fnval(fnder(pcs),[0 4*pi]))

Output is ans = 0 as the difference of end slopes. Even the difference in end
second derivatives is small:

diff(fnval(fnder(pcs,2),[0 4*pi]))

Output is ans = -4.6074e-015.

Other End Conditions

Other end conditions can be handled as well. For example,
Cs = csape(x,[S,y,-4],[1 2]);

provides the cubic spline interpolant with breaks at the =2} and with its slope
at the leftmost data site equal to 3, and its second derivative at the rightmost
data site equal to -4.

General Spline Interpolation

If you want to interpolate at sites other than the breaks and/or by splines
other than cubic splines with simple knots, then you use the spapi command.
In its simplest form, you would say sp = spapi(k,x,y); in which the first
argument, k, specifies the order of the interpolating spline; this is the number
of coefficients in each polynomial piece, i.e., 1 more than the nominal degree of
its polynomial pieces. For example, the next figure shows a linear, a quadratic,
and a quartic spline interpolant to your data, as obtained by the statements

sp2 = spapi(2,x,y); fnplt(sp2,2), hold on

7-5
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sp3 = spapi(3,x,y); fnplt(sp3,2,'k--'), set(gca, ' 'Fontsize',16)
sp5 = spapi(5,x,y); fnplt(sp5,2,'r-."), plot(x,y,'0")
legend('linear', 'quadratic', 'quartic', 'data'), hold off

—linear
0.8r - - -quadraticj

- - quartic
0.6F o data

0.4r

0.2

-0.2

-0.4}

-0.6f

Spline Interpolants of Various Orders of Smooth Data

Even the cubic spline interpolant obtained from spapi is different from the
one provided by csapi and spline. To emphasize their difference, compute
and plot their second derivatives, as follows:

fnplt(fnder(spapi(4,x,y),2)), hold on, set(gca, 'Fontsize',16)
fnplt(fnder(csapi(x,y),2),2,'k--"),plot(x,zeros(size(x)),'o0")
legend('from spapi', 'from csapi','data sites'), hold off

This gives the following graph:
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Second Derivative of Two Cubic Spline Interpolants of the Same Smooth Data

Since the second derivative of a cubic spline is a broken line, with vertices
at the breaks of the spline, you can see clearly that csapi places breaks at
the data sites, while spapi does not.

Knot Choices

It is, in fact, possible to specify explicitly just where the spline interpolant
should have its breaks, using the command sp = spapi(knots,x,y); in
which the sequence knots supplies, in a certain way, the breaks to be used.
For example, recalling that you had chosen y to be sin(x), the command

ch = spapi(augknt(x,4,2),[x x],[y cos(x)]);

provides a cubic Hermite interpolant to the sine function, namely the
piecewise cubic function, with breaks at all the x(i)’s, that matches the sine
function in value and slope at all the x(i)’s. This makes the interpolant
continuous with continuous first derivative but, in general, it has jumps across
the breaks in its second derivative. Just how does this command know which
part of the data value array [y cos(x)] supplies the values and which the
slopes? Notice that the data site array here is given as [x Xx], i.e., each data
site appears twice. Also notice that y (i) is associated with the first occurrence
of x(1), and cos(x (1)) is associated with the second occurrence of x(i).
The data value associated with the first appearance of a data site is taken
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to be a function value; the data value associated with the second appearance
1s taken to be a slope. If there were a third appearance of that data site, the
corresponding data value would be taken as the second derivative value to
be matched at that site. See Chapter 10, “The B-form” for a discussion of the
command augknt used here to generate the appropriate "knot sequence".

Smoothing

What if the data are noisy? For example, suppose that the given values are
noisy =y + .3*(rand(size(x))-.5);

Then you might prefer to approximate instead. For example, you might try
the cubic smoothing spline, obtained by the command

SCS = csaps(x,noisy);
and plotted by

fnplt(scs,2), hold on, plot(x,noisy,'o'), set(gca, ' 'Fontsize',16)
legend('smoothing spline', 'noisy data'), hold off

This produces a figure like this:

smoothing spline
o noisy data

0.5r

-15
0

Cubic Smoothing Spline of Noisy Data
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If you don’t like the level of smoothing done by csaps(x,y), you can change
it by specifying the smoothing parameter, p, as an optional third argument.
Choose this number anywhere between 0 and 1. As p changes from 0 to

1, the smoothing spline changes, correspondingly, from one extreme, the
least squares straight-line approximation to the data, to the other extreme,
the "natural" cubic spline interpolant to the data. Since csaps returns the
smoothing parameter actually used as an optional second output, you could
now experiment, as follows:

[scs,p] = csaps(x,noisy); fnplt(scs,2), hold on
fnplt(csaps(x,noisy,p/2),2,'k--"'), set(gca, 'Fontsize',16)
fnplt(csaps(x,noisy, (1+p)/2),2,'r:"'), plot(x,noisy,'o"')
legend( 'smoothing spline', 'more smoothed','less smoothed',...
'noisy data'), hold off

This produces the following picture.

——smoothing spline
- - -more smoothed
- less smoothed

o noisy data

0.5r

-15
0

Noisy Data More or Less Smoothed

At times, you might prefer simply to get the smoothest cubic spline sp
that is within a specified tolerance tol of the given data in the sense that
norm(noisy - fnval(sp,x))"2 <= tol. You create this spline with the
command sp = spaps(x,noisy,tol) for your defined tolerance tol.
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Least Squares

If you prefer a least squares approximant, you can obtain it by the statement
sp = spap2(knots,k,x,y); in which both the knot sequence knots and the
order k of the spline must be provided.

The popular choice for the order is 4, and that gives you a cubic spline. If you
have no clear idea of how to choose the knots, simply specify the number of
polynomial pieces you want used. For example,

sp = spap2(3,4,X,Y);

gives a cubic spline consisting of three polynomial pieces. If the resulting
error is uneven, you might try for a better knot distribution by using newknt
as follows:

sp = spap2(newknt(sp),4,X,VY);



Using the Spline Fits

Using the Spline Fits

You can use the following commands with any example spline, such as the cs,
ch and sp examples constructed in the section “Cubic Spline Interpolation”
on page 7-3.

First construct a spline, for example:
sp = spmak(1:6,0:2)
To display a plot of the spline:
fnplt(sp)
To get the value at a, use the syntax fnval(f,a), for example:
fnval(sp,4)
To construct the spline’s second derivative:
DDf = fnder(fnder(sp))
An alternative way to construct the second derivative:
DDf = fnder(sp,2);

To obtain the spline’s definite integral over an interval [a..b], in this example
from 2 to 5:

diff(fnval(fnint(sp),[2;5]1))

To compute the difference between two splines, use the form
fncemb(spl, ' -',sp2), for example:

fncmb(sp, '-',DDf);
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Vector-Valued Functions

The toolbox supports vector-valued splines. For example, if you want a spline
curve through given planar points (%) ¥i)), i =1, ....n then the following
code defines some data and then creates and plots such a spline curve,
using chord-length parametrization and cubic spline interpolation with the
not-a-knot end condition.

x=[19 43 62 88 114 120 130 129 113 76 135 182 232 298

348 386 420 456 471 485 463 444 414 348 275 192 106 ...

30 48 83 107 110 109 92 66 45 23 22 30 40 55 55 52 34 20 16];
y=[306 272 240 215 218 237 275 310 368 424 425 427 428

397 353 302 259 200 148 105 77 47 28 17 10 12 23 41 43

77 96 133 155 164 157 148 142 162 181 187 192 202 217 245 266 303];

xy = [x;y]; df = diff(xy,1,2);

t = cumsum ([0, sqrt([1 1]*(df.*df))]);

cv = csapi(t,xy);

fnplt(cv), hold on, plot(x,y,'o'), hold off
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If you then wanted to know the area enclosed by this curve, you would want to

evaluate the integral J y(E)dx(z) = J y(@)Dx(£)d2 , with (x{£),¥(#)) the point

on the curve corresponding to the parameter value #. For the spline curve in
cv just constructed, this can be done exactly in one (somewhat complicated)
command:

area = diff(fnval(fnint(
fncmb (fnemb(cv, [0 1]1),'*',fnder(fncmb(cv,[1 0])))
), fnbrk(cv, 'interval')));

To explain, y=fncmb(cv, [0 1]) picks out the second component of the curve
in cv, Dx=fnder (fncmb(cv,[1 0])) provides the derivative of the first
component, and yDx=fncmb(y, '*',Dx) constructs their pointwise product.
Then IyDx=fnint (yDx) constructs the indefinite integral of yDx and, finally,
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diff(fnval(IyDx,fnbrk(cv,'interval'))) evaluates that indefinite
integral at the endpoints of the basic interval and then takes the difference of
the second from the first value, thus getting the definite integral of yDx over
its basic interval. Depending on whether the enclosed area is to the right or to
the left as the curve point travels with increasing parameter, the resulting
number is either positive or negative.

Further, all the values Y (if any) for which the point (X,Y) lies on the spline
curve in cVv just constructed can be obtained by the following (somewhat
complicated) command:

X=250; %Define a value of X
Y = fnval(fncmb(cv,[0 1]),
mean (fnzeros(fncmb(fncmb(cv,[1 0]1),'-"',X))))

To explain: x = fncmb(cv,[1 0]) picks out the first component of the
curve in cv; xmX = fncmb(x,'-',X) translates that component by X; t

= mean(fnzeros(xmX)) provides all the parameter values for which xmX

is zero, i.e., for which the first component of the curve equals X; y =
fncmb(cv,[0,1]) picks out the second component of the curve in cv; and,
finally, Y = fnval(y,t) evaluates that second component at those parameter
sites at which the first component of the curve in cv equals X.

As another example of the use of vector-valued functions, suppose that
you have solved the equations of motion of a particle in some specified

force field in the plane, obtaining, at discrete times t_r' =tj.i= l:ﬂ,

the position (020,502 )35 well as the velocity (X200 stored in the
4-vector z(i.J), as you would if, in the standard way, you had solved the
equivalent first-order system numerically. Then the following statement,
which uses cubic Hermite interpolation, will produce a plot of the particle

path:fnplt(spapi(augknt(t,4,2),t,reshape(z,2,2*n)).



Fitting Values at N-D Grid

Fitting Values at N-D Grid

Vector-valued splines are also used in the approximation to gridded

data, in any number of variables, using tensor-product splines. The

same spline-construction commands are used, only the form of the input
differs. For example, if x is an m-vector, y is an n-vector, and z is an array
of size [m,n], then cs = csapi({x,y},z); describes a bicubic spline f
satisfying f(x(i),y(j))=z(i,j) for i=1:m, j=1:n. Such a multivariate spline can be
vector-valued. For example,

X = 0:4; y=-2:2; s2 = 1/sqrt(2);
z(3,:,:) =[01s20 -s2 -1 0]."*[11111];
z(2,:,:) = [10s21s20 -1].'"*[01 0 -1 0];

z(1,:,1) [10s21s20 -1].'*[1 0 -1 0 1];
sph = csape({x,y},z,{'clamped', 'periodic'});
fnplt(sph), axis equal, axis off

gives a perfectly acceptable sphere. Its projection onto the (% Z)-plane is
plotted by

fnplt(fncmb(sph,[1 0 0; 0 0 1])), axis equal, axis off

Both plots are shown below.
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A Sphere Made by a 3-D-Valued Bivariate Tensor Product Spline
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Fitting Values at Scattered 2-D Sites

Tensor-product splines are good for gridded (bivariate and even multivariate)
data. For work with scattered bivariate data, the toolbox provides the
thin-plate smoothing spline. Suppose you have given data values y(j) at
scattered data sites x(:,j), j=1:N, in the plane. To give a specific example,

n = 65; t = linspace(0,2*pi,n+1);
[cos(t);sin(t)]; x(:,end) = [0;0];

provides 65 sites, namely 64 points equally spaced on the unit circle, plus the
center of that circle. Here are corresponding data values, namely noisy values
of the very nice function (%) = (x(1)+ 1/2)*2 + (x(2)+ 1/2)"2

y = (x(1,:)+.5).72 + (x(2,:)+.5)."2;
noisy =y + (rand(size(y))-.5)/3;

Then you can compute a reasonable approximation to these data by
st = tpaps(x,noisy);
and plot the resulting approximation along with the noisy data by

fnplt(st); hold on
plot3(x(1,:),x(2,:),noisy, 'wo', 'markerfacecolor','k"')
hold off

and so produce the following picture:
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Introduction

This chapter provides a quick overview of the mathematics that underlies
the various commands in the Curve Fitting Toolbox spline functions. In the
process, the technical terms and notation used throughout this documentation
(and in the online help for individual commands) are introduced. Another
source of information about the latter is the Splines Glossary on page 1.



Polynomials vs. Splines

Polynomials vs. Splines

Polynomials are the approximating functions of choice when a smooth function
1s to be approximated locally. For example, the truncated Taylor series

(x—a) Dif(a)/i!

Ma

~
1l
(=)

provides a satisfactory approximation for f(x) if f is sufficiently smooth and x
1s sufficiently close to a. But if a function is to be approximated on a larger
interval, the degree, n, of the approximating polynomial may have to be
chosen unacceptably large. The alternative is to subdivide the interval
[a..b] of approximation into sufficiently small intervals [§j..§j w1, with a =

g, <+ <., = b, so that, on each such interval, a polynomial p; of relatively
low degree can provide a good approximation to f. This can even be done

in such a way that the polynomial pieces blend smoothly, i.e., so that the
resulting patched or composite function s(x) that equals pj(x) for xe[éj §j ), all
J, has several continuous derivatives. Any such smooth piecewise polynomial
function is called a spline. 1.J. Schoenberg coined this term because a twice
continuously differentiable cubic spline with sufficiently small first derivative
approximates the shape of a draftsman’s spline.

There are two commonly used ways to represent a polynomial spline, the
ppform and the B-form. In this toolbox, a spline in ppform is often referred
to as a piecewise polynomial, while a piecewise polynomial in B-form is often
referred to as a spline. This reflects the fact that piecewise polynomials and
(polynomial) splines are just two different views of the same thing.
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ppform

The ppform of a polynomial spline of order k provides a description in terms of
its breaks §,..§,,; and the local polynomial coefficients ¢ of its [ pieces.

5 ki
pj(x)=2(x=&;) e j=1:1

=1
For example, a cubic spline is of order 4, corresponding to the fact that
it requires four coefficients to specify a cubic polynomial. The ppform is
convenient for the evaluation and other uses of a spline.



B-form

B-form

The B-form has become the standard way to represent a spline during its
construction, because the B-form makes it easy to build in smoothness
requirements across breaks and leads to banded linear systems. The B-form
describes a spline as a weighted sum

n
D Bjxa;
=1

of B-splines of the required order &, with their number, n, at least as big as

k—1 plus the number of polynomial pieces that make up the spline. Here, Bj’k =
B (:1t;, ...,t;;) 1s the jth B-spline of order k for the knot sequence ¢ <t,<"<t,,,.
In particular, Bj,k is piecewise-polynomial of degree < k, with breaks by ety s

1s nonnegative, is zero outside the interval [tj, ..tj+k], and 1s so normalized that

n
Y Bjp(x)=1 on [ty.ty]
=

8-5



8 Types of Splines

8-6

Knot Multiplicity

The multiplicity of the knots governs the smoothness, in the following way:
If the number t occurs exactly r times in the sequence t,,...t,,,, then B;, and
its first k-r-1 derivatives are continuous across the break t, while the (k-r)th
derivative has a jump at t. You can experiment with all these properties of the
B-spline in a very visual and interactive way using the command bspligui.



B-Spline Properties

B-Spline Properties

Because B;, is nonzero only on the interval (¢;..t,,,), the linear system for
the B-spline coefficients of the spline to be determined, by interpolation or
least squares approximation, or even as the approximate solution of some
differential equation, is banded, making the solving of that linear system
particularly easy. For example, to construct a spline s of order & with knot

sequence t; <t,<--<t . sothat s(x)=y, for i=1, ..., n, use the linear system
n
sz,k(xi)aj =y, i=1:n
J=1

for the unknown B-spline coefficients a; in which each equation has at most &
nonzero entries.

Also, many theoretical facts concerning splines are most easily stated and/or
proved in terms of B-splines. For example, it is possible to match arbitrary

data at sites x; <--- < x, uniquely by a spline of order £ with knot sequence
(ty, ... t,y) if and only if B; k(xj);EO for all j (Schoenberg-Whitney Conditions).
Computations with B-splines are facilitated by stable recurrence relations

x—t; i —x
Bj,k(x):ﬁBj,k—l(x)"'%
Jtk-1"1%j J+k T Yj+l

Bji1p-1(%)
which are also of help in the conversion from B-form to ppform. The dual
functional

aj(s):=Y (-D)* ¥ (¢)D's(z)

i<k

provides a useful expression for the jth B-spline coefficient of the spline s in
terms of its value and derivatives at an arbitrary site v between ¢, and ¢, and
with 1pj(t):=(tj+1—t) (tj+k71—t)/(k—1)! It can be used to show that aj(s) is closely
related to s on the interval [¢,..¢;,,], and seems the most efficient means for
converting from ppform to B-form.
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The above constructive approach is not the only avenue to splines. In the
variational approach, a spline is obtained as a best interpolant, e.g., as the
function with smallest mth derivative among all those matching prescribed
function values at certain sites. As it turns out, among the many such
splines available, only those that are piecewise-polynomials or, perhaps,
piecewise-exponentials have found much use. Of particular practical interest
is the smoothing spline s = s, which, for given data (x,y,) with xe[a..b], all

i, and given corresponding positive weights w,, and for given smoothing
parameter p, minimizes

pYwilyi—f(x) +(1-p) Ij‘Dmf(t)‘z dt

over all functions f with m derivatives. It turns out that the smoothing spline
s is a spline of order 2m with a break at every data site. The smoothing
parameter, p, is chosen artfully to strike the right balance between wanting
the error measure

E(S)=Zwi|yi—3(xi)

|2

small and wanting the roughness measure

F(Dms) = Jf Dms(t)‘2 dt

small. The hope is that s contains as much of the information, and as little
of the supposed noise, in the data as possible. One approach to this (used in
spaps) is to make F(D™f) as small as possible subject to the condition that E(f)
be no bigger than a prescribed tolerance. For computational reasons, spaps
uses the (equivalent) smoothing parameter p=p/(1-p), i.e., minimizes pE(f) +
F(D™f). Also, it is useful at times to use the more flexible roughness measure

F(D™s)= Jj/l(t)‘Dms(t)‘z dt



Constructive vs. Variational

with A a suitable positive weight function.
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Multivariate splines can be obtained from univariate splines by the tensor
product construct. For example, a trivariate spline in B-form is given by

uv w
f(x’y’z) = z Z Z Bu,k (x)Bv,l (y)Bw,m (Z)au,v,w

u=lv=1w=1

with B, ,,B, B, ,, univariate B-splines. Correspondingly, this spline is of
order % in x, of order [ in y, and of order m in z. Similarly, the ppform of a
tensor-product spline is specified by break sequences in each of the variables
and, for each hyper-rectangle thereby specified, a coefficient array. Further,
as in the univariate case, the coefficients may be vectors, typically 2-vectors

or 3-vectors, making it possible to represent, e.g., certain surfaces in R3.

A very different bivariate spline is the thin-plate spline. This is a function of
the form

n-3

f(x)= %T(x—cj)aj +x(1)a,_9+x(2)a,1 +a,

with w(x)=|x|%log|x|? the thin-plate spline basis function, and |x| denoting
the Euclidean length of the vector x. Here, for convenience, denote the
independent variable by x, but x is now a vector whose two components, x(1)
and x(2), play the role of the two independent variables earlier denoted x and
y. Correspondingly, the sites ¢; are points in R2.

Thin-plate splines arise as bivariate smoothing splines, meaning a thin-plate
spline minimizes

n-3

Py

=1

2
Yi —fci

+(1—p)J.(|D1D1f|2 +2|D1D2f|2 +|D2D2f|2)

over all sufficiently smooth functions f. Here, the y, are data values given at
the data sites c,, p is the smoothing parameter, and Djf denotes the partial
derivative of f with respect to x(j). The integral is taken over the entire R2.



Multivariate Splines

The upper summation limit, n—3, reflects the fact that 3 degrees of freedom of
the thin-plate spline are associated with its polynomial part.

Thin-plate splines are functions in stform, meaning that, up to certain
polynomial terms, they are a weighted sum of arbitrary or scattered translates
W(--c) of one fixed function, W. This so-called basis function for the thin-plate
spline is special in that it is radially symmetric, meaning that W(x) only
depends on the Euclidean length, | x|, of x. For that reason, thin-plate splines
are also known as RBFs or radial basis functions. See Chapter 13, “The
stform” for more information.
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A rational spline is any function of the form r(x) = s(x)/w(x), with both s
and w splines and, in particular, w a scalar-valued spline, while s often
is vector-valued.

Rational splines are attractive because it is possible to describe various basic
geometric shapes, like conic sections, exactly as the range of a rational spline.
For example, a circle can so be described by a quadratic rational spline with
just two pieces.

In this toolbox, there is the additional requirement that both s and w be of
the same form and even of the same order, and with the same knot or break
sequence. This makes it possible to store the rational spline r as the ordinary
spline R whose value at x is the vector [s(x);w(x)]. Depending on whether the
two splines are in B-form or ppform, such a representation is called here the
rBform or the rpform of such a rational spline.

It is easy to obtain r from R. For example, if v is the value of R at x, then
v(1:end-1)/v(end) is the value of r at x. There are corresponding ways to
express derivatives of r in terms of derivatives of R.
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¢ “Introduction” on page 9-2
e “ppform” on page 9-3
¢ “Construction” on page 9-4

® “Available Commands” on page 9-6
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Introduction

A univariate piecewise polynomial f is specified by its break sequence breaks
and the coefficient array coefs of the local power form (see equation in
“ppform” on page 9-3) of its polynomial pieces; see Chapter 11, “Tensor
Product Splines” for a discussion of multivariate piecewise-polynomials.
The coefficients may be (column-)vectors, matrices, even ND-arrays. For
simplicity, the present discussion deals only with the case when the
coefficients are scalars.

The break sequence is assumed to be strictly increasing,

breaks (1)
< breaks(2) < ... < breaks(1l+1)

with 1 the number of polynomial pieces that make up f.

While these polynomials may be of varying degrees, they are all recorded as
polynomials of the same order k, i.e., the coefficient array coefs is of size
[1,k], with coefs(j,:) containing the k coefficients in the local power
form for the jth polynomial piece, from the highest to the lowest power; see
equation in “ppform” on page 9-3.
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ppform

The items breaks, coefs, 1, and k, make up the ppform of f, along with the
dimension d of its coefficients; usually d equals 1. The basic interval of this
form is the interval [breaks(1) .. breaks(1+1)]. It is the default interval
over which a function in ppform is plotted by the plot command fnplt.

In these terms, the precise description of the piecewise-polynomial fis

f(t) = polyval(coefs(j,:), t - breaks(j)) (9-1)
for breaks(j)<t<breaks(j+1).

Here, polyval(a,x) is the MATLAB function; it returns the number

This defines f(t) only for ¢ in the half-open interval [breaks(1)..breaks(1+1)).
For any other ¢, f(t) is defined by

1,¢ < breaks(1)

t) = polyval ,:),t —breaks(j)) Jj=
f (t) = polyva (coefs(J,), rea S(J)) J l,t > breaks(l+1)

i.e., by extending the first, respectively last, polynomial piece. In this way, a
function in ppform has possible jumps, in its value and/or its derivatives, only
across the interior breaks, breaks(2:1). The end breaks, breaks([1,1+1]),
mainly serve to define the basic interval of the ppform.
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Construction

A piecewise-polynomial is usually constructed by some command, through a
process of interpolation or approximation, or conversion from some other form
e.g., from the B-form, and is output as a variable. But it is also possible to
make one up from scratch, using the statement

pp
= ppmak(breaks,coefs)

For example, if you enter pp=ppmak(-5:-1,-22:-11), or, more explicitly,

breaks = -5:-1;
coefs = -22:-11; pp = ppmak(breaks,coefs);

you specify the uniform break sequence -5:-1 and the coefficient sequence
-22:-11. Because this break sequence has 5 entries, hence 4 break intervals,
while the coefficient sequence has 12 entries, you have, in effect, specified a
piecewise-polynomial of order 3 (= 12/4). The command

fnbrk(pp)

prints out all the constituent parts of this piecewise-polynomial, as follows:

breaks(1:1+1)
-5 -4 -3 -2 -1
coefficients(d*1l,k)

-22 -21 -20
-19 -18 -17
-16 -15 -14
-13 -12 -11
pieces number 1
4
order k

3
dimension d of target
1

Further, fnbrk can be used to supply each of these parts separately. But the
point of Curve Fitting Toolbox spline functionality is that you usually need
not concern yourself with these details. You simply use pp as an argument



Construction

to commands that evaluate, differentiate, integrate, convert, or plot the
piecewise-polynomial whose description is contained in pp.
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Available Commands

Here are some operations you can perform on a piecewise-polynomial.

v = fnval(pp,x) Evaluates

dpp = fnder(pp) Differentiates

dirpp = fndir(pp,dir) Differentiates in the direction dir

ipp = fnint(pp) Integrates

fnmin(pp,[a,b]) Finds the minimum value in given
interval

fnzeros(pp,[a,b]) Finds the zeros in the given interval

pj = fnbrk(pp,j) Pulls out the jth polynomial piece

pc = fnbrk(pp,[a b]) Restricts/extends to the interval
[a..b]

po = fnxtr(pp,order) Extends outside its basic interval by
polynomial of specified order

fnplt(pp,[a,b]) Plots on given interval

sp = fn2fm(pp, 'B-') Converts to B-form

pr = fnrfn(pp,morebreaks) Inserts additional breaks

Inserting additional breaks comes in handy when you want to add two
piecewise-polynomials with different breaks, as is done in the command fncmb.

To illustrate the use of some of these commands, execute the following
commands to create and plot the particular piecewise-polynomial described in

the “Construction” on page 9-4 section.

1 Create the piecewise-polynomial with break sequence -5: -1 and coefficient
sequence -22:-11:

pp=ppmak(-5:-1,-22:-11)

2 Create the basic plot:
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x = linspace(-5.5,-.5,101);
plot(x, fnval(pp,x),'x")

3 Add the break lines to the plot:

breaks=fnbrk(pp,'b'); yy=axis; hold on
for j=1:fnbrk(pp,'1l"')+1

plot(breaks([j j1),yy(3:4))
end

4 Superimpose the plot of the polynomial that supplies the third polynomial
piece:

plot(x,fnval(fnbrk(pp,3),x), 'linew',1.3)
set(gca, 'ylim',[-60 -10]), hold off
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A Piecewise-Polynomial Function, Its Breaks, and the Polynomial Giving
Its Third Piece

The figure above is the final picture. It shows the piecewise-polynomial as

a sequence of points and, solidly on top of it, the polynomial from which its
third polynomial piece is taken. It is quite noticeable that the value of a
piecewise-polynomial at a break is its limit from the right, and that the value
of the piecewise-polynomial outside its basic interval is obtained by extending
its leftmost, respectively its rightmost, polynomial piece.

9-7
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While the ppform of a piecewise-polynomial is efficient for evaluation, the
construction of a piecewise-polynomial from some data is usually more
efficiently handled by determining first its B-form, i.e., its representation
as a linear combination of B-splines.



The B-form

¢ “Introduction” on page 10-2

e “B-form” on page 10-3

e “B-Splines” on page 10-4

e “Knot Multiplicity” on page 10-5

® “Choice of Knots” on page 10-7

e “Splines” on page 10-8

¢ “Construction” on page 10-9

¢ “Example: A Spline Curve” on page 10-10
® “Available Commands” on page 10-12
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Introduction

A univariate spline f is specified by its nondecreasing knot sequence t and
by its B-spline coefficient sequence a. See Chapter 11, “Tensor Product
Splines” for a discussion of multivariate splines. The coefficients may be
(column-)vectors, matrices, even ND-arrays. When the coefficients are
2-vectors or 3-vectors, fis a curve in R? or R? and the coefficients are called
the control points for the curve.

Roughly speaking, such a spline is a piecewise-polynomial of a certain
order and with breaks t(). But knots are different from breaks in that
they may be repeated, i.e., t need not be strictly increasing. The resulting
knot multiplicities govern the smoothness of the spline across the knots, as
detailed below.

With [d,n] = size(a), and n+k = length(t), the spline is of order k. This
means that its polynomial pieces have degree < k. For example, a cubic
spline is a spline of order 4 because it takes four coefficients to specify a cubic
polynomial.

10-2
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B-form
These four items, ¢, a, n, and k, make up the B-form of the spline f.

This means, explicitly, that

f =Y B a(i)

=1

with B, ,=B("|¢(i:i+k)) the ith B-spline of order k for the given knot sequence
t, i.e., the B-spline with knots t(i),...,t(i+k). The basic interval of this B-form
is the interval [¢(1)..t(n+k)]. It is the default interval over which a spline in
B-form is plotted by the command fnplt. Note that a spline in B-form is zero
outside its basic interval while, after conversion to ppform via fn2fm, this is
usually not the case because, outside its basic interval, a piecewise-polynomial
is defined by extension of its first or last polynomial piece. In particular, a
function in B-form may have jumps in value and/or one of its derivative not
only across its interior knots, i.e., across #(i) with #(1)<t(i)<t(n+k), but also
across its end knots, t(1) and t(n+k).

10-3
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B-Splines

The building blocks for the B-form of a spline are the B-splines. A B-Spline
of Order 4, and the Four Cubic Polynomials from Which It Is Made on page
10-4 shows a picture of such a B-spline, the one with the knot sequence [0
1.5 2.3 4 5], hence of order 4, together with the polynomials whose pieces
make up the B-spline. The information for that picture could be generated
by the command

bspline([0 1.5 2.3 4 5])

|V -

ydah -

A B-Spline of Order 4, and the Four Cubic Polynomials from Which It Is Made

To summarize: The B-spline with knots t(i)<:--< t(i+k) is positive on the
interval (t(7)..t(i+k))and is zero outside that interval. It is piecewise-polynomial
of order k with breaks at the sites t(i),...,t(i+k). These knots may coincide,
and the precise multiplicity governs the smoothness with which the two
polynomial pieces join there.
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Knot Multiplicity

The rule is

knot multiplicity + condition multiplicity = order

BN

All Third-Order B-Splines for a Certain Knot Sequence with Various Knot
Multiplicities

For example, for a B-spline of order 3, a simple knot would mean two
smoothness conditions, i.e., continuity of function and first derivative, while a
double knot would only leave one smoothness condition, i.e., just continuity,
and a triple knot would leave no smoothness condition, i.e., even the function
would be discontinuous.

All Third-Order B-Splines for a Certain Knot Sequence with Various Knot
Multiplicities on page 10-5 shows a picture of all the third-order B-splines
for a certain mystery knot sequence t. The breaks are indicated by vertical
lines. For each break, try to determine its multiplicity in the knot sequence
(it 1s 1,2,1,1,3), as well as its multiplicity as a knot in each of the B-splines.
For example, the second break has multiplicity 2 but appears only with
multiplicity 1 in the third B-spline and not at all, i.e., with multiplicity O, in
the last two B-splines. Note that only one of the B-splines shown has all its
knots simple. It is the only one having three different nontrivial polynomial
pieces. Note also that you can tell the knot-sequence multiplicity of a knot

10-5
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by the number of B-splines whose nonzero part begins or ends there. The
picture is generated by the following MATLAB statements, which use the
command spcol from this toolbox to generate the function values of all these
B-splines at a fine net x.

t=[0,1,1,3,4,6,6,6]; x=linspace(-1,7,81);
c=spcol(t,3,x);[1l,m]=size(c);
c=c+ones(l,1)*[0:m-1];

axis([-1 7 0 m]); hold on

for tt=t, plot([tt tt],[0 m],'-"'), end
plot(x,c, 'linew',2), hold off, axis off

Further illustrated examples are provided by the demo “Intro to B-form”
available on the Demos tag in the MATLAB Help browser. You can also
use the GUI bspligui to study the dependence of a B-spline on its knots
experimentally.
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Choice of Knots

The rule “knot multiplicity + condition multiplicity = order” has the following
consequence for the process of choosing a knot sequence for the B-form of

a spline approximant. Suppose the spline s is to be of order %k, with basic
interval [a..b], and with interior breaks §,< - <§,. Suppose, further, that, at
&, the spline is to satisfy pn;, smoothness conditions, i.e.,

jumpéiDjs:zDjs(§i+)—Djs(§i_)=0, 0<j<y, 1=2,..,1

Then, the appropriate knot sequence ¢ should contain the break §; exactly & —
n, times, i=2,...,/. In addition, it should contain the two endpoints, a and b, of
the basic interval exactly k& times. This last requirement can be relaxed, but
has become standard. With this choice, there is exactly one way to write each
spline s with the properties described as a weighted sum of the B-splines of
order & with knots a segment of the knot sequence ¢. This is the reason for the
B in B-spline: B-splines are, in Schoenberg’s terminology, basic splines.

For example, if you want to generate the B-form of a cubic spline on the
interval [1 .. 3], with interior breaks 1.5, 1.8, 2.6, and with two continuous
derivatives, then the following would be the appropriate knot sequence:

t=11, 1,1, 1, 1.5, 1.8, 2.6, 3, 3, 3, 3];
This i1s supplied by augknt([1, 1.5, 1.8, 2.6, 3], 4). If you wanted,
instead, to allow for a corner at 1.8, i.e., a possible jump in the first derivative
there, you would triple the knot 1.8, i.e., use

t=[1,1,1,1, 1.5, 1.8, 1.8, 1.8, 2.6, 3, 3, 3, 31];

and this is provided by the statement

t = augknt([1, 1.5, 1.8, 2.6, 3], 4, [1, 3, 1] );

10-7
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Splines

The shorthand

f € Sk,t

1s one of several ways to indicate that fis a spline of order k with knot sequence
t, i.e., a linear combination of the B-splines of order k for the knot sequence t.

A word of caution: The term B-spline has been expropriated by the
Computer-Aided Geometric Design (CAGD) community to mean what is
called here a spline in B-form, with the unhappy result that, in any discussion
between mathematicians/approximation theorists and people in CAGD, one
now always has to check in what sense the term is being used.
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Construction

Usually, a spline is constructed from some information, like function values
and/or derivative values, or as the approximate solution of some ordinary
differential equation. But it is also possible to make up a spline from scratch,
by providing its knot sequence and its coefficient sequence to the command
spmak.

For example, if you enter
sp = spmak(1:10,3:8);

you supply the uniform knot sequence 1:10 and the coefficient sequence 3: 8.
Because there are 10 knots and 6 coefficients, the order must be 4(= 10 — 6),
1.e., you get a cubic spline. The command

fnbrk(sp)

prints out the constituent parts of the B-form of this cubic spline, as follows:

knots(1:n+k)
12345678910
coefficients(d,n)

345678

number n of coefficients
6

order k
4

dimension d of target
1

Further, fnbrk can be used to supply each of these parts separately.
But the point of the Curve Fitting Toolbox spline functionality is that there
shouldn’t be any need for you to look up these details. You simply use sp as

an argument to commands that evaluate, differentiate, integrate, convert, or
plot the spline whose description is contained in sp.

10-9
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Example: A Spline Curve

As another simple example,

points = .95*[0 -1 0 1;1 0 -1 O];
sp = spmak(-4:8,[points points]);

provides a planar, quartic, spline curve whose middle part is a pretty good
approximation to a circle, as the plot on the next page shows. It is generated
by a subsequent

plot(points(1,:),points(2,:),'x"'), hold on
fnplt(sp,[0,4]), axis equal square, hold off

Insertion of additional control points (£0.95,+0.95)/+1.9 would make a
visually perfect circle.

Here are more details. The spline curve generated has the form Es‘lej,sa(:,
J), with -4:8 the uniform knot sequence, and with its control points a(:,j) the
sequence (0,a),(-a,0),(0,—a),(a,0),(0,a),(—a,0),(0,—a),(a,0) with a=0.95. Only the
curve part between the parameter values 0 and 4 is actually plotted.

To get a feeling for how close to circular this part of the curve actually is,
compute its unsigned curvature. The curvature x(¢) at the curve point y(¢) =
(x(2), y(¢)) of a space curve y can be computed from the formula

2., ’ ”l

| y-yx
_(x72+y72)3/2

K
in which x’, X", y’, and y” are the first and second derivatives of the curve with
respect to the parameter used (f). Treat the planar curve as a space curve in

the (x,y)-plane, hence obtain the maximum and minimum of its curvature at
21 points as follows:

t = linspace(0,4,21);zt = zeros(size(t));

dsp = fnder(sp); dspt = fnval(dsp,t); ddspt = fnval(fnder(dsp),t);

kappa = abs(dspt(1,:).*ddspt(2,:)-dspt(2,:).*ddspt(1,:))./...
(sum(dspt.~2))."(3/2);

[min(kappa) ,max(kappa)]

10-10



Example: A Spline Curve

ans =
1.6747 1.8611

So, while the curvature is not quite constant, it is close to 1/radius of the
circle, as you see from the next calculation:

1/norm(fnval(sp,0))

ans =
1.7864

0.8 B

0.6 B

0.2 J

-1
-1 -0.5 0 0.5 1

Spline Approximation to a Circle; Control Points Are Marked x
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Available Commands

10-12

The following commands are available for spline work. There is spmak and
fnbrk to make up a spline and take it apart again. Use fn2fm to convert from
B-form to ppform. You can evaluate, differentiate, integrate, minimize, find
zeros of, plot, refine, or selectively extrapolate a spline with the aid of fnval,
fnder, fndir, fnint, fnmin, fnzeros, fnplt, fnrfn, and fnxtr.

There are five commands for generating knot sequences:
¢ augknt for providing boundary knots and also controlling the multiplicity
of interior knots

® brk2knt for supplying a knot sequence with specified multiplicities

e aptknt for providing a knot sequence for a spline space of given order that
1s suitable for interpolation at given data sites

® optknt for providing an optimal knot sequence for interpolation at given
sites

® newknt for a knot sequence perhaps more suitable for the function to be
approximated

In addition, there is:

® aveknt to supply certain knot averages (the Greville sites) as recommended
sites for interpolation

e chbpnt to supply such sites

® knt2brk and knt2mlt for extracting the breaks and/or their multiplicities
from a given knot sequence

To display a spline curve with given two-dimensional coefficient sequence and
a uniform knot sequence, use spcrv.

You can also write your own spline construction commands, in which

case you will need to know the following. The construction of a spline
satisfying some interpolation or approximation conditions usually requires a
collocation matrix, i.e., the matrix that, in each row, contains the sequence
of numbers D’Bj,k(t), 1.e., the rth derivative at t of the jth B-spline, for

all j, for some r and some site t. Such a matrix is provided by spcol. An
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optional argument allows for this matrix to be supplied by spcol in a
space-saving spline-almost-block-diagonal-form or as a MATLAB sparse
matrix. It can be fed to slvblk, a command for solving linear systems with
an almost-block-diagonal coefficient matrix. If you are interested in seeing
how spcol and slvblk are used in this toolbox, have a look at the commands
spapi, spap2, and spaps.

In addition, there are routines for constructing cubic splines. csapi and
csape provide the cubic spline interpolant at knots to given data, using the
not-a-knot and various other end conditions, respectively. A parametric cubic
spline curve through given points is provided by cscvn. The cubic smoothing
spline is constructed in csaps.

The remaining commands involving the B-form are utilities, of no interest to
the casual user.
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* “ppform” on page 11-5
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Introduction

The toolbox provides (polynomial) spline functions in any number of variables,
as tensor products of univariate splines. These multivariate splines come in
both standard forms, the B-form and the ppform, and their construction and
use parallels entirely that of the univariate splines discussed in previous
sections, Chapter 9, “The ppform” and Chapter 10, “The B-form” The same
commands are used for their construction and use.

For simplicity, the following discussion deals just with bivariate splines.
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B-form

The tensor-product idea is very simple. If fis a function of x, and g is a
function of y, then their tensor-product p (x,y): = f (x)g(y) is a function of x and
¥, l.e., a bivariate function. More generally, with s=(s,...,s,,.,) and {=(t,,...,¢,.;)
knot sequences and aji:i=1,...,m;j=1,...n) a corresponding coefficient array, you
obtain a bivariate spline as

m n
flx,y) = ZZB(x | si,...,si+h)B(y | tj,...,tj+k)aij
i=1j=1

The B-form of this spline comprises the cell array {s,t} of its knot sequences,
the coefficient array a, the numbers vector [m,n], and the orders vector [Ah,k].
The command

sp = spmak({s,t},a);
constructs this form. Further, fnplt, fnval, fnder, fndir, fnrfn, and fn2fm

can be used to plot, evaluate, differentiate and integrate, refine, and convert
this form.
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Construction and Use

You are most likely to construct such a form by looking for an interpolant
or approximant to gridded data. For example, if you know the values
z(i,))=g(x(i),y(j)),i=1:m, j=1:n, of some function g at all the points in a
rectangular grid, then, assuming that the strictly increasing sequence x
satisfies the Schoenberg-Whitney conditions with respect to the above
knot sequence s, and that the strictly increasing sequence y satisfies the
Schoenberg-Whitney conditions with respect to the above knot sequence
t, the command

sp=spapi({s,t}, [h,k],{x,y},2);

constructs the unique bivariate spline of the above form that matches

the given values. The command fnplt(sp) gives you a quick plot of this
interpolant. The command pp = fn2fm(sp, 'pp') gives you the ppform of
this spline, which is probably what you want when you want to evaluate the
spline at a fine grid ((xx(1i),yy(j)) for i=1:M, j=1:N), by the command:

values = fnval(pp, {xx,yy});
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ppform

The ppform of such a bivariate spline comprises, analogously, a cell array of
break sequences, a multidimensional coefficient array, a vector of number
pieces, and a vector of polynomial orders. Fortunately, the toolbox is set up
in such a way that there is usually no reason for you to concern yourself
with these details of either form. You use interpolation, approximation, or
smoothing to construct splines, and then use the fn... commands to make
use of them.
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Example: The Mobius Band

Here is an example of a surface constructed as a 3-D-valued bivariate spline.
The surface is the famous Mobius band, obtainable by taking a longish strip
of paper and gluing its narrow ends together, but with a twist. The figure is
obtained by the following commands:

X = 0:1; y = 0:4; h=1/4; 02 = 1/sqrt(2); s = 2; ss = 4;
V(3,:,:) h*ro, -1, -o2, 0, o2, 1, 0;0, 1, o2, 0, -02, -1, 0];
HI [ss, 0, s-h*02, 0, -s-h*02, 0, sS;...
ss, 0, s+h*o02, 0,-s+h*02, 0, ss];
s*[0, 1, 0, -1+h, O, 1, O0; O, 1, O, -1-h, O, 1, 0];

<
\V]
1l

v(1,:,1)

cs = csape({x,vy},v,{'variational', 'clamped'});

fnplt(cs), axis([-2 2 -2.5 2.5 -.5 .5]), shading interp
axis off, hold on

values = squeeze(fnval(cs,{1,linspace(y(1),y(end),51)}));
plot3(values(1,:), values(2,:), values(3,:),'k', " 'linew',2)
view(-149,28), hold off

A Mébius Band Made by Vector-Valued Bivariate Spline Interpolation
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Introduction

A rational spline is, by definition, any function that is the ratio of two splines:
r(x)=s(x)/w(x)

This requires w to be scalar-valued, but s is often chosen to be vector-valued.
Further, it is desirable that w(x) be not zero for any x of interest.

Rational splines are popular because, in contrast to ordinary splines, they can
be used to describe certain basic design shapes, like conic sections, exactly.
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Example: Circle

For example,

circle = rsmak('circle');

provides a rational spline whose values on its basic interval trace out the unit
circle, 1.e., the circle of radius 1 with center at the origin, as the command

fnplt(circle), axis square

readily shows; the resulting output is the circle in the figure A Circle and an
Ellipse, Both Given by a Rational Spline on page 12-4.

It is easy to manipulate this circle to obtain related shapes. For example, the
next commands stretch the circle into an ellipse, rotate the ellipse 45 degrees,
and translate it by (1,1), and then plot it on top of the circle.

ellipse = fncmb(circle,[2 0;0 1]);

s45 = 1/sqrt(2);

rtellipse = fncmb(fncmb(ellipse, [s45 -s45;s45 s45]), [1;1] );
hold on, fnplt(rtellipse), hold off

As a further example, the "circle" just constructed is put together from four
pieces. To highlight the first such piece, use the following commands:

quarter = fnbrk(fn2fm(circle,'rp'),1);
hold on, fnplt(quarter,3), hold off

In the first command, fn2fm is used to change forms, from one based on the
B-form to one based on the ppform, and then fnbrk is used to extract the
first piece, and this piece is then plotted on top of the circle in A Circle and
an Ellipse, Both Given by a Rational Spline on page 12-4, with linewidth 3
to make it stand out.
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Example: Sphere

As a surface example, the command rsmak('southcap') provides a 3-vector
valued rational bicubic polynomial whose values on the unit square [-1 .. 1]*2
fill out a piece of the unit sphere. Adjoin to it five suitable rotates of it and
you get the unit sphere exactly. For illustration, the following commands
generate two-thirds of that sphere, as shown in Part of a Sphere Formed by
Four Rotates of a Quartic Rational on page 12-5.

southcap = rsmak('southcap'); fnplt(southcap)

xpcap = fncmb(southcap,[0 O -1;0 1 0;1 0 0]);

ypcap = fncmb(xpcap,[0 -1 0; 1 0 0; 0 0 1]);

northcap = fncmb(southcap,-1);

hold on, fnplt(xpcap), fnplt(ypcap), fnplt(northcap)

axis equal, shading interp, view(-115,10), axis off, hold off

Part of a Sphere Formed by Four Rotates of a Quartic Rational
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rsform: rpform, rBform

Offhand, the two splines, s and w, in the rational spline r(x)=s(x)/w(x) need
not be related to one another. They could even be of different forms. But,
in the context of this toolbox, it is convenient to restrict them to be of the
same form, and even of the same order and with the same breaks or knots.
For, under that assumption, you can represent such a rational spline by the
(vector-valued) spline function

R(x)= [s(x),w(x)]

whose values are vectors with one more entry than the values of the rational
spline r, and call this the rsform of the rational spline, or, more precisely, the
rpform or rBform, depending on whether s and w are in ppform or in B-form.
Internally, the only thing that distinguishes these rational forms from their
corresponding ordinary spline forms, rpform and B-form, is their form part,
1.e., the string obtained via fnbrk(r, 'form'). This is enough to alert the
fn... commands to act appropriately on a function in one of the rsforms.

For example, as is done in fnval, it is very easy to obtain r(x) from R(x). If v
1s the value of R at x, then v(1:end-1)/v(end) is the value of r at x. If, in
addition, dv is DR(x), then (dv(1:end-1)-dv(end)*v(1:end-1))/v(end) is
Dr(x). More generally, by Leibniz’s formula,

D’s=D’ (wr)= E[J JDLwDJ_‘r
=0

i
15
Therefore,

Dir= DJs_z[J, )DleJ_lr Jw

=1\

This shows that you can compute the derivatives of r inductively, using the
derivatives of s and w (i.e., the derivatives of R) along with the derivatives of r
of order less than j to compute the jth derivative of r. This inductive scheme
1s used in fntlr to provide the first so many derivatives of a rational spline.



rsform: rpform, rBform

There is a corresponding formula for partial and directional derivatives for
multivariate rational splines.
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Available Commands

Having chosen to represent the rational spline r = s/w in this way by the
ordinary spline R=[s;w] makes it is easy to apply to a rational spline all
the fn... commands in the Curve Fitting Toolbox spline functions, with
the following exceptions. The integral of a rational spline need not be a
rational spline, hence there is no way to extend fnint to rational splines. The
derivative of a rational spline is again a rational spline but one of roughly
twice the order. For that reason, fnder and fndir will not touch rational
splines. Instead, there is the command fntlr for computing the value at
a given x of all derivatives up to a given order of a given function. If that
function is rational, the needed calculation is based on the considerations
given in the preceding paragraph.

The command r = rsmak(shape) provides rational splines in rBform that
describe exactly certain standard geometric shapes , like 'circle', 'arc’',
‘cylinder', 'sphere', 'cone', 'torus'. The command fncmb(r,trans)
can be used to apply standard transformations to the resulting shape. For
example, if trans is a column-vector of the right length, the shape would be
translated by that vector while, if trans is a suitable matrix like a rotation,
the shape would be transformed by that matrix.

The command r = rscvn(p) constructs the quadratic rBform of a
tangent-continuous curve made up of circular arcs and passing through the
given sequence, p, of points in the plane.

A special rational spline form, called a NURBS, has become a standard tool in
CAGD. A NURBS is, by definition, any rational spline for which both s and w
are in the same B-form, with each coefficient for s containing explicitly the
corresponding coefficient for w as a factor:

s= ZBiv(i)a(:,i), w= ZBiU(i)

The normalized coefficients a(:,i) for the numerator spline are more readily
used as control points than the unnormalized coefficients v(i)a(:,i) used in the
rBform. Nevertheless, this toolbox provides no special NURBS form, but only
the more general rational spline, but in both B-form (called rBform internally)
and in ppform (called rpform internally).



Available Commands

The rational spline circle used earlier is put together in rsmak by code like
the following.

x=[110-1-1-1 0 11];y=[01T1 1 0-1-1-10];
s45 = 1/sqrt(2); w =[1 s45 1 s45 1 s45 1 s45 1];
circle = rsmak(augknt(0:4,3,2), [w.*X;w.*y;w]);

Note the appearance of the denominator spline as the last component. Also
note how the coefficients of the denominator spline appear here explicitly

as factors of the corresponding coefficients of the numerator spline. The
normalized coefficient sequence [Xx;y] is very simple; it consists of the vertices
and midpoints, in proper order, of the "unit square". The resulting control
polygon is tangent to the circle at the places where the four quadratic pieces
that form the circle abut.

For a thorough discussion of NURBS, see [G. Farin, NURBS, 2nd ed.,

AKPeters Ltd, 1999] or [Les Piegl and Wayne Tiller, The NURBS Book, 2nd
ed., Springer-Verlag, 1997].

12-9



12 NURBS and Other Rationdl Splines

12-10



The stform

¢ “Introduction” on page 13-2
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Introduction

A multivariate function form quite different from the tensor-product construct
is the scattered translates form, or stform for short. As the name suggests,

it uses arbitrary or scattered translates w(- —cj) of one fixed function w,

in addition to some polynomial terms. Explicitly, such a form describes a
function

n—k

f(x)= Zu/(x—cj)aj +p(x)

J=1

in terms of the basis function Wy, a sequence (cj) of sites called centers and a
corresponding sequence (aj) of n coefficients, with the final % coefficients,
Q,, pi10+q,, involved in the polynomial part, p.

When the basis function is radially symmetric, meaning that y(x) depends
only on the Euclidean length | x| of its argument, x, then y is called a radial
basis function, and, correspondingly, fis then often called an RBF.

At present, the toolbox works with just one kind of stform, namely a bivariate
thin-plate spline and its first partial derivatives. For the thin-plate spline,
the basis function is w(x) = @(|x|?), with @(¢) = tlogt, i.e., a radial basis
function. Its polynomial part is a linear polynomial, i.e., p(x)=x(1)a, ,+x(2)a,
_,%a,. The first partial derivative with respect to its first argument uses,
correspondingly, the basis function w(x)=@(|x|?), with @(t) = (D,t) (logt+1)
and D;t = D,t(x) = 2x(1), and p(x) = a,,.
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Properties of the stform

A function in stform can be put together from its center sequence centers
and its coefficient sequence coefs by the command

f = stmak(centers, coefs, type);

with the string type one of 'tp00', 'tp10"', 'tp01"', to indicate, respectively,
a thin-plate spline, a first partial of a thin-plate spline with respect to the
first argument, and a first partial of a thin-plate spline with respect to the
second argument. There is one other choice, 'tp'; it denotes a thin-plate
spline without any polynomial part and is likely to be used only during the
construction of a thin-plate spline, as in tpaps.

A function f in stform depends linearly on its coefficients, meaning that
n
fx)=Yv;(x)a;
j=1

with Y, either a translate of the basis function W or else some polynomial.
Suppose you wanted to determine these coefficients a; so that the function

f matches prescribed values at prescribed sites x;. Then you would need

the collocation matrix (mj(xi)). You can obtain this matrix by the command
stcol(centers,x,type). In fact, because the stform has a; as the jth column,
coefs(:,]), of its coefficient array, it is worth noting that stcol can also
supply the transpose of the collocation matrix. Thus, the command

values = coefs*stcol(centers,x,type,'tr');

would provide the values at the entries of x of the st function specified by
centers and type

The stform is attractive because, in contrast to piecewise polynomial forms,
its complexity is the same in any number of variables. It is quite simple,
yet, because of the complete freedom in the choice of centers, very flexible
and adaptable.

On the negative side, the most attractive choices for a radial basis function
share with the thin-plate spline that the evaluation at any site involves

13-3



1 3 The stform

13-4

all coefficients. For example, plotting a scalar-valued thin-plate spline via
fnplt involves evaluation at a 51-by-51 grid of sites, a nontrivial task when
there are 1000 coefficients or more. The situation is worse when you want
to determine these 1000 coefficients so as to obtain the stform of a function
that matches function values at 1000 data sites, as this calls for solving a
full linear system of order 1000, a task requiring O(1079) flops if done by a
direct method. Just the construction of the collocation matrix for this linear
system (by stcol) takes O(1076) flops.

The command tpaps, which constructs thin-plate spline interpolants and
approximants, uses iterative methods when there are more than 728 data
points, but convergence of such iteration may be slow.



Available Commands

Available Commands

After you have constructed an approximating or interpolating thin-plate
spline st with the aid of tpaps (or directly via stmak), you can use the
following commands:

fnbrk to obtain its parts or change its basic interval,
fnval to evaluate it
fnplt to plot it

fnder to construct its two first partial derivatives, but no higher order
derivatives as they become infinite at the centers.

This is just one indication that the stform is quite different in nature from
the other forms in this toolbox, hence other fn... commands by and large
don’t work with stforms. For example, it makes no sense to use fnjmp, and
fnmin or fnzeros only work for univariate functions. It also makes no
sense to use fnint on a function in stform because such functions cannot
be integrated in closed form.

The command Ast = fncmb(st,A) can be used on st, provided A is
something that can be applied to the values of the function described by
st. For example, A might be 'sin', in which case Ast is the stform of the
function whose coefficients are the sine of the coefficients of st. In effect,
Ast describes the function obtained by composing A with st. But, because
of the singularities in the higher-order derivatives of a thin-plate spline,
there seems little point to make fndir or fntlr applicable to such a st.
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Advanced Spline Examples

® “Least-Squares Approximation by “Natural” Cubic Splines” on page 14-2
® “A Nonlinear ODE” on page 14-8

¢ “Construction of the Chebyshev Spline” on page 14-14

e “Approximation by Tensor Product Splines” on page 14-20
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Least-Squares Approximation by “Natural” Cubic Splines

The construction of a least-squares approximant usually requires that one
have in hand a basis for the space from which the data are to be approximated.
As the example of the space of “natural” cubic splines illustrates, the explicit
construction of a basis is not always straightforward.

This section makes clear that an explicit basis is not actually needed; it is
sufficient to have available some means of interpolating in some fashion from
the space of approximants. For this, the fact that the Curve Fitting Toolbox
spline functions support work with vector-valued functions is essential.

This section discusses these aspects of least-squares approximation by
“natural” cubic splines.

® “Problem” on page 14-2

® “General Resolution” on page 14-2

® “Need for a Basis Map” on page 14-3

e “A Basis Map for “Natural” Cubic Splines” on page 14-3

¢ “The One-line Solution” on page 14-4

¢ “The Need for Proper Extrapolation” on page 14-4

e “The Correct One-Line Solution” on page 14-6

® “Least-Squares Approximation by Cubic Splines” on page 14-7

Problem

You want to construct the least-squares approximation to given data (x,y) from
the space S of “natural” cubic splines with given breaks b(1) <..<b(1+1).

General Resolution

If you know a basis, (f1,f2,...,fm), for the linear space S of all “natural” cubic
splines with break sequence b, then you have learned to find the least-squares
approximation in the form ¢ (1)f1+ ¢(2)f2+ ... + ¢(m)fm, with the vector c
the least-squares solution to the linear system A*c = y, whose coefficient
matrix is given by



Least-Squares Approximation by “Natural” Cubic Splines

A(i,j) = fj(x(i)), i=1:length(x), j=1:m .

In other words, ¢ = A\y.

Need for a Basis Map

The general solution seems to require that you know a basis. However, in
order to construct the coefficient sequence ¢, you only need to know the matrix
A. For this, it is sufficient to have at hand a basis map, namely a function F
say, so that F(c) returns the spline given by the particular weighted sum
c(1)fl+c(2)f2+... +c(m)fm. For, with that, you can obtain, for j=1:m, the
j-th column of A as fnval(F(ej),x), with ej the j-th column of eye(m),

the identity matrix of order m.

Better yet, the Curve Fitting Toolbox spline functions can handle
vector-valued functions, so you should be able to construct the basis map F

to handle vector-valued coefficients ¢ (i) as well. However, by agreement, in
this toolbox, a vector-valued coefficient is a column vector, hence the sequence
¢ is necessarily a row vector of column vectors, i.e., a matrix. With that,
F(eye(m)) is the vector-valued spline whose i-th component is the basis
element fi, i=1:m. Hence, assuming the vector x of data sites to be a row
vector, fnval(F(eye(m)),x) is the matrix whose (i, j)-entry is the value of
fi at x(j), 1.e., the transpose of the matrix A you are seeking. On the other
hand, as just pointed out, your basis map F expects the coefficient sequence

¢ to be a row vector, i.e., the transpose of the vector A\y. Hence, assuming,
correspondingly, the vector y of data values to be a row vector, you can obtain
the least-squares approximation from S to data (x,y) as

F(y/fnval(F(eye(m)),x))

To be sure, if you wanted to be prepared for x and y to be arbitrary vectors (of
the same length), you would use instead

F(y(:).'/fnval(F(eye(m)),x(:)."))

A Basis Map for “Natural” Cubic Splines

What exactly is required of a basis map F for the linear space S of “natural”
cubic splines with break sequence b(1) < ... < b(1+1)? Assuming the
dimension of this linear space is m, the map F should set up a linear one-to-one
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correspondence between m-vectors and elements of S. But that is exactly what
csape(b, . ,'var') does.

To be explicit, consider the following function F:

function s = F(c)
s = csape(b,c, 'var');

For given vector ¢ (of the same length as b), it provides the unique “natural”
cubic spline with break sequence b that takes the value c(i) at b(i),
i=1:1+1. The uniqueness is key. It ensures that the correspondence between
the vector ¢ and the resulting spline F(c) is one-to-one. In particular, m equals
length(b). More than that, because the value f(#) of a function f at a point

t depends linearly on f, this uniqueness ensures that F(c) depends linearly
on ¢ (because ¢ equals fnval(F(c),b) and the inverse of an invertible linear
map is again a linear map).

The One-line Solution
Putting it all together, you arrive at the following code

csape(b,y(:).'/fnval(csape(b,eye(length(b)),'var'),x(:)."),...
'var')

for the least-squares approximation by “natural” cubic splines with break
sequence b.

The Need for Proper Extrapolation

Let’s try it on some data, the census data, say, which is provided in MATLAB
by the command

load census

and which supplies the years, 1790:10:1990, as cdate and the values as pop.
Use the break sequence 1810:40:1970.

b 1810:40:1970;

S csape (b,
pop(:)'/fnval(csape(b,eye(length(b)),'var'),cdate(:)"'), " 'var');
fnplt(s, [1750,2050],2.2);
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hold on
plot(cdate,pop,‘'or');
hold off

Have a look at Least-Squares Approximation by “Natural” Cubic Splines With
Three Interior Breaks on page 14-6 which shows, in thick blue, the resulting
approximation, along with the given data.

This looks like a good approximation, -- except that it doesn’t look like a
“natural” cubic spline. A “natural” cubic spline, to recall, must be linear to the
left of its first break and to the right of its last break, and this approximation
satisfies neither condition. This is due to the following facts.

The “natural” cubic spline interpolant to given data is provided by csape

in ppform, with the interval spanned by the data sites its basic interval.

On the other hand, evaluation of a ppform outside its basic interval is
done, in MATLAB ppval or Curve Fitting Toolbox spline function fnval,

by using the relevant polynomial end piece of the ppform, i.e., by full-order
extrapolation. In case of a “natural” cubic spline, you want instead
second-order extrapolation. This means that you want, to the left of the first
break, the straight line that agrees with the cubic spline in value and slope
at the first break. Such an extrapolation is provided by fnxtr. Because the
“natural” cubic spline has zero second derivative at its first break, such an
extrapolation is even third-order, i.e., it satisfies three matching conditions.
In the same way, beyond the last break of the cubic spline, you want the
straight line that agrees with the spline in value and slope at the last break,
and this, too, is supplied by fnxtr.
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Least-Squares Approximation by “Natural” Cubic Splines With Three Interior
Breaks

The Correct One-Line Solution

The following one-line code provides the correct least-squares approximation
to data (x,y) by “natural” cubic splines with break sequence b:

fnxtr(csape(b,y(:).'/ ...
fnval(fnxtr(csape(b,eye(length(b)),'var')),x(:)."'), " 'var'))

But it is, admittedly, a rather long line.

The following code uses this correct formula and plots, in a thinner, red

line, the resulting approximation on top of the earlier plots, as shown in
Least-Squares Approximation by “Natural” Cubic Splines With Three Interior
Breaks on page 14-6.

ss = fnxtr(csape(b,pop(:)"'/
fnval(fnxtr(csape(b,eye(length(b)),'var')),cdate(:)"'), " 'var'));

hold on, fnplt(ss,[1750,2050],1.2,'r"'),grid, hold off

legend('incorrect approximation', 'population’,

‘correct approximation')
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Least-Squares Approximation by Cubic Splines

The one-line solution works perfectly if you want to approximate by the space
S of all cubic splines with the given break sequence b. You don’t even have to
use the Curve Fitting Toolbox spline functions for this because you can rely
on the MATLAB spline. You know that, with ¢ a sequence containing two
more entries than does b, spline(b,c) provides the unique cubic spline with
break sequence b that takes the value ¢ (i+1) at b(i), all i, and takes the
slope ¢c(1) at b(1), and the slope c(end) at b(end). Hence, spline(b,.)

is a basis map for S.

More than that, you know that spline(b,c,xi) provides the value(s) at
x1i of this interpolating spline. Finally, you know that spline can handle
vector-valued data. Therefore, the following one-line code constructs the
least-squares approximation by cubic splines with break sequence b to data

(x,y) :

spline(b,y(:)'/spline(b,eye(length(b)),x(:)"'))
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A Nonlinear ODE

This section discusses these aspects of a nonlinear ODE problem:

¢ “Problem” on page 14-8

* “Approximation Space” on page 14-8

¢ “Discretization” on page 14-9

¢ “Numerical Problem” on page 14-9

¢ “Linearization” on page 14-10

¢ “Linear System to Be Solved” on page 14-10
e “Iteration” on page 14-11

You can run the example via the demo “Solving a Nonlinear ODE with a
Boundary Layer by Collocation”.

Problem
Consider the nonlinear singularly perturbed problem:

£D2g(x)+(g(x))2=1 on [0.1]

Approximation Space

Seek an approximate solution by collocation from C! piecewise cubics with a
suitable break sequence; for instance,

breaks = (0:4)/4;
Because cubics are of order 4, you have
k = 4;

Obtain the corresponding knot sequence as
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knots = augknt(breaks,k,2);

This gives a quadruple knot at both 0 and 1, which is consistent with the fact
that you have cubics, i.e., have order 4.

This implies that you have

length(knots)-k;
n = 10;

1.e., 10 degrees of freedom.

Discretization

You collocate at two sites per polynomial piece, i.e., at eight sites altogether.
This, together with the two side conditions, gives us 10 conditions, which
matches the 10 degrees of freedom.

Choose the two Gaussian sites for each interval. For the standard interval
[-0.5,0.5] of length 1, these are the two sites

gauss = .5773502692*[-1/2; 1/2];

From this, you obtain the whole collection of collocation sites by

ninterv = length(breaks)-1;

temp ((breaks(2:ninterv+1)+breaks(1:ninterv))/2);
temp = temp([1 1],:) + gauss*diff(breaks);

colsites = temp(:)."';

Numerical Problem

With this, the numerical problem you want to solve is to find y € Sy pp0s
that satisfies the nonlinear system

Dy(0)=0
(y(x))2 +eD? y(x)=1for x € colsites
y1) =0
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Linearization

If y is your current approximation to the solution, then the linear problem for
the supposedly better solution z by Newton’s method reads

Dz(0)=0
wo (x)z(x) + eD?2(x) = b(x) for x e colsites
2(1)=0

with w,(x)=2y(x),b(x)=(y(x))?>+1. In fact, by choosing

Wo (1) = 1, w1(0) =1
wy(x) =0, we(x) :=¢ for xe colsites

and choosing all other values of w,w,,w,, b not yet specified to be zero, you
can give your system the uniform shape

wo (x)z(x) +wy (x) Dz(x) +wy (x) D%2(x) = b(x), for x e sites

with

sites = [0,colsites,1];

Linear System to Be Solved

Because zeS, > convert this last system into a system for the B-spline
coefficients of z. This requires the values, first, and second derivatives at
every xesites and for all the relevant B-splines. The command spcol was
expressly written for this purpose.

Use spcol to supply the matrix

colmat = ...
spcol(knots,k,brk2knt(sites,3));

From this, you get the collocation matrix by combining the row triple of colmat
for x using the weights w,(x),w,(x),w,(x) to get the row for x of the actual
matrix. For this, you need a current approximation y. Initially, you get it by
interpolating some reasonable initial guess from your piecewise-polynomial
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space at the sites. Use the parabola x>~1, which satisfies the end conditions
as the initial guess, and pick the matrix from the full matrix colmat. Here it
1s, in several cautious steps:

intmat = colmat([2 1+(1:(n-2))*3,1+(n-1)*3],:);
coefs = intmat\[0 colsites.*colsites-1 0].';
y = spmak(knots,coefs."');

Plot the initial guess, and turn hold on for subsequent plotting:

frplt(y,'g");

legend('Initial Guess (x"2-1)','location', 'NW'");
axis([-0.01 1.01 -1.01 0.01]);

hold on

Iteration

You can now complete the construction and solution of the linear system for
the improved approximate solution z from your current guess y. In fact, with
the initial guess y available, you now set up an iteration, to be terminated
when the change z—y is small enough. Choose a relatively mild ¢ = .1.

tolerance = 6.e-9;
epsilon = .1;
while 1
vtau = fnval(y,colsites);
weights=[0 1 O;
[2*vtau.' zeros(n-2,1) repmat(epsilon,n-2,1)];

1 0 0];
colloc = zeros(n,n);
for j=1:n
colloc(j,:) = weights(j,:)*colmat(3*(j-1)+(1:3),:);

end
coefs = colloc\[O0 vtau.*vtau+1 0].';
z = spmak(knots,coefs.');
fnplt(z,'k');
maxdif = max(max(abs(z.coefs-y.coefs)));
fprintf('maxdif = %g\n',maxdif)
if (maxdif<tolerance), break, end
% now reiterate

y = 2
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end
legend({'Initial Guess (x"2-1)' 'Iterates'},'location', 'NW');

The resulting printout of the errors is:

maxdif 0.206695
maxdif 0.01207
maxdif = 3.95151e-005
maxdif 4.43216e-010

If you now decrease ¢, you create more of a boundary layer near the right
endpoint, and this calls for a nonuniform mesh.

Use newknt to construct an appropriate finer mesh from the current
approximation:

knots newknt(z, ninterv+1); breaks = knt2brk(knots);
knots augknt (breaks,4,2);
n = length(knots)-k;

From the new break sequence, you generate the new collocation site sequence:

ninterv = length(breaks)-1;

temp = ((breaks(2:ninterv+1)+breaks(1:ninterv))/2);
temp = temp([1 1], :) + gauss*diff(breaks);

colpnts = temp(:).';

sites = [0,colpnts,1];

Use spcol to supply the matrix

colmat = spcol(knots,k,sort([sites sites sites]));

and use your current approximate solution z as the initial guess:

intmat = colmat([2 1+(1:(n-2))*3,1+(n-1)*3],:);
y = spmak(knots,[0 fnval(z,colpnts) 0O]/intmat."');

Thus set up, divide £ by 3 and repeat the earlier calculation, starting with
the statements

tolerance=1.e-9;
while 1
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vtau=fnval(y,colpnts);

Repeated passes through this process generate a sequence of solutions, for ¢ =
1/10, 1/30, 1/90, 1/270, 1/810. The resulting solutions, ever flatter at 0 and
ever steeper at 1, are shown in the demo plot. The plot also shows the final
break sequence, as a sequence of vertical bars. To view the plots, run the
demo “Solving a Nonlinear ODE with a Boundary Layer by Collocation”.

In this example, at least, newknt has performed satisfactorily.
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This section discusses these aspects of the Chebyshev spline construction:

* “What Is a Chebyshev Spline?” on page 14-14
® “Choice of Spline Space” on page 14-14
e “Initial Guess” on page 14-15

* “Remez Iteration” on page 14-16

What Is a Chebyshev Spline?

The Chebyshev spline C=C=C,,, of order k for the knot sequence =(¢;: i=1:n+k)
is the unique element of S/« . of max-norm 1 that maximally oscillates on

the interval [¢,..t,,,] and is positive near ¢,,,. This means that there is a
unique strictly increasing n-sequence Tt so that the function C=CS, ; given by
C(t)=(-1)"~1, all i, has max-norm 1 on [¢,..t,,,]. This implies that t,=t,,t,=t, .,
and that ¢, <T,<t¢,,, for all i. In fact, ¢,_, <t,<¢,, ,, all i. This brings up the
point that the knot sequence is assumed to make such an inequality possible,
1.e., the elements of Sk’t are assumed to be continuous.

In short, the Chebyshev spline C looks just like the Chebyshev polynomial. It
performs similar functions. For example, its extreme sites t are particularly
good sites to interpolate at from S, ; because the norm of the resulting
projector is about as small as can be; see the toolbox command chbpnt.

In this example, which you can run via the demo Construction of a Chebyshev
Spline, you try to construct C for a particular knot sequence &.

Choice of Spline Space

You deal with cubic splines, i.e., with order
k = 4;
and use the break sequence

breaks = [01 1.1 35 5.57 7.1 7.2 8];
1p1 = length(breaks);
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and use simple interior knots, i.e., use the knot sequence

t
n

breaks([ones(1,k) 2:(1p1-1) 1p1(:,ones(1,k))]);
length(t)-k;

Note the quadruple knot at each end. Because k = 4, this makes [0..8]

= [breaks(1)..breaks(1p1)] the interval [¢t,..¢,,,] of interest, with n =
length(t)-k the dimension of the resulting spline space S ;. The same knot
sequence would have been supplied by

t=augknt (breaks,Kk);

Initial Guess
As the initial guess for the T, use the knot averages

t; = (ti+1 +...+ ti+k—1)/(k -1)
recommended as good interpolation site choices. These are supplied by
tau=aveknt(t,k);

Plot the resulting first approximation to C, i.e., the spline ¢ that satisfies
c(t)=(-1)~7, all i:

b cumprod(repmat(-1,1,n)); b = b*b(end);
c spapi(t,tau,b);

fnplt(c,'-.")

grid

Here is the resulting plot.
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First Approximation to a Chebyshev Spline

Remez lteration

Starting from this approximation, you use the Remez algorithm to produce
a sequence of splines converging to C. This means that you construct new <
as the extrema of your current approximation ¢ to C and try again. Here
is the entire loop.

You find the new interior T, as the zeros of Dc, i.e., the first derivative of c,
in several steps. First, differentiate:

Dc = fnder(c);

Next, take the zeros of the control polygon of Dc as your first guess for the
zeros of Dc. For this, you must take apart the spline Dc.

[knots,coefs,np,kp] = fnbrk(Dc, 'knots', 'coefs','n','order');
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The control polygon has the vertices (tstar(i),coefs(i)), with tstar the
knot averages for the spline, provided by aveknt:

tstar = aveknt(knots,kp);

Here are the zeros of the resulting control polygon of Dc:

npp = (1:np-1);
guess = tstar(npp) -coefs(npp).*(diff(tstar)./diff(coefs));

This provides already a very good first guess for the actual zeros.

Refine this estimate for the zeros of Dc by two steps of the secant method,
taking tau and the resulting guess as your first approximations. First,
evaluate Dc at both sets:

sites = tau(ones(4,1),2:n-1);

sites(1,:) = guess;

values = zeros(4,n-2);

values(1:2,:) = reshape(fnval(Dc,sites(1:2,:)),2,n-2);

Now come two steps of the secant method. You guard against division by zero
by setting the function value difference to 1 in case it is zero. Because Dc is
strictly monotone near the sites sought, this is harmless:

for j=2:3
rows = [j,j-1]1;Dcd=diff(values(rows,:));
Dcd(find(Dcd==0)) = 1;
sites(j+1,:) = sites(j,:)
-values(j,:).*(diff(sites(rows,:))./Dcd);
values(j+1,:) = fnval(Dc,sites(j+1,:));
end

The check

max (abs(values.'))
ans = 4.1176 5.7789 0.4644 0.1178

shows the improvement.

Now take these sites as your new tau,
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tau = [tau(1) sites(4,:) tau(n)];
and check the extrema values of your current approximation there:

extremes = abs(fnval(c, tau));

The difference

max (extremes)-min(extremes)
ans = 0.6905

is an estimate of how far you are from total leveling.

Construct a new spline corresponding to the new choice of tau and plot it
on top of the old:

c = spapi(t,tau,b);

sites = sort([tau (0:100)*(t(n+1)-t(k))/100]);
values = fnval(c,sites);

hold on, plot(sites,values)

The following code turns on the grid and plots the locations of the extrema.

grid on

plot( tau(2:end-1), zeros( 1, np-1 ), 'o' )

hold off

legend( 'Initial Guess', 'Current Guess', 'Extreme Locations'
"location', 'NorthEastOutside' );

Following is the resulting figure (legend not shown).
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A More Nearly Level Spline

If this is not close enough, one simply reiterates the loop. For this example,
the next iteration already produces C to graphic accuracy.
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Because the toolbox can handle splines with vector coefficients, it is easy to
implement interpolation or approximation to gridded data by tensor product
splines, as the following illustration is meant to show. This example can also
be run via the demo “Bivariate Tensor Product Splines”.

To be sure, most tensor product spline approximation to gridded data can be
obtained directly with one of the spline construction commands, like spapi
or csape, in this toolbox, without concern for the details discussed in this
example. Rather, this example is meant to illustrate the theory behind the
tensor product construction, and this will be of help in situations not covered
by the construction commands in this toolbox.

This section discusses these aspects of the tensor product spline problem:

“Choice of Sites and Knots” on page 14-20

® “Least Squares Approximation as Function of y” on page 14-21
* “Approximation to Coefficients as Functions of x” on page 14-22
* “The Bivariate Approximation” on page 14-27

® “Switch in Order” on page 14-25

e “Approximation to Coefficients as Functions of y” on page 14-26
¢ “The Bivariate Approximation” on page 14-27

¢ “Comparison and Extension” on page 14-28

Choice of Sites and Knots

Consider, for example, least squares approximation to given data
2(1,))=f(x(i),y())),i=1:Nx,j=1:Ny. You take the data from a function used
extensively by Franke for the testing of schemes for surface fitting (see R.
Franke, “A critical comparison of some methods for interpolation of scattered
data,” Naval Postgraduate School Techn. Rep. NPS-53-79-003, March 1979).
Its domain is the unit square. You choose a few more data sites in the
x-direction than the y-direction; also, for a better definition, you use higher
data density near the boundary.

x = sort([(0:10)/10,.03 .07, .93 .97]);
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y = sort([(0:6)/6,.03 .07, .93 .97]1);
[xx,yy] = ndgrid(x,y); z = franke(xx,yy);

Least Squares Approximation as Function of y

Treat these data as coming from a vector-valued function, namely, the
function of y whose value at y(j) is the vector z(:,j), all j. For no particular
reason, choose to approximate this function by a vector-valued parabolic
spline, with three uniformly spaced interior knots. This means that you
choose the spline order and the knot sequence for this vector-valued spline as

ky = 3; knotsy = augknt([0,.25,.5,.75,1],ky);
and then use spap2 to provide the least squares approximant to the data:
sp = spap2(knotsy,ky,y,z);

In effect, you are finding simultaneously the discrete least squares

approximation from Syy . knotsy t0 €ach of the Nx data sets

(v(3)2(60)) 3 i=1: N

In particular, the statements

yy = -.1:.05:1.1;
vals = fnval(sp,Vyy);

provide the array vals, whose entry vals(i,j) can be taken as an
approximation to the value f(x(i),yy(j))of the underlying function f at
the mesh-point x(i),yy(j) because vals(:,j) is the value at yy(j) of the
approximating spline curve in sp.

This is evident in the following figure, obtained by the command:
mesh(x,yy,vals.'), view(150,50)
Note the use of vals. ', in the mesh command, needed because of the MATLAB

matrix-oriented view when plotting an array. This can be a serious problem
in bivariate approximation because there it is customary to think of z(i, j) as
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the function value at the point (x(7), ¥(j)), while MATLAB thinks of z(i, j) as
the function value at the point (x(j), y(7)).

A Family of Smooth Curves Pretending to Be a Surface

Note that both the first two and the last two values on each smooth curve are
actually zero because both the first two and the last two sites in yy are outside
the basic interval for the spline in sp.

Note also the ridges. They confirm that you are plotting smooth curves in
one direction only.

Approximation to Coefficients as Functions of x

To get an actual surface, you now have to go a step further. Look at the
coefficients coefsy of the spline in sp:

coefsy = fnbrk(sp, 'coefs');
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Abstractly, you can think of the spline in sp as the function

y|- zcoefsy(:,r)Br,ky (v)

with the ith entry coefsy(i,r) of the vector coefficient coefsy(:,r)
corresponding to x(i), for all i. This suggests approximating each coefficient
vector coefsy(q,:) by a spline of the same order kx and with the same
appropriate knot sequence knotsx. For no particular reason, this time use
cubic splines with four uniformly spaced interior knots:

kx = 4; knotsx = augknt([0:.2:1],kx);
sp2 = spap2(knotsx,kx,x,coefsy."');

Note that spap2(knots, k, x, fx) expects fx(:,j) to be the datum at x(j), i.e.,

expects each column of £x to be a function value. To fit the datum coefsy(q,
:) at x(q), for all ¢, present spap2 with the transpose of coefsy.

The Bivariate Approximation

Now consider the transpose of the coefficients cxy of the resulting spline curve:
coefs = fnbrk(sp2, 'coefs').';

It provides the bivariate spline approximation

(x,y) |_> zzcoefs(q’r)Bq,kx (x)Br,ky (y)
q r
to the original data
(x(2),y(J)) = z(x(i),y(j)),i =1:Nx,j=1:Ny

To plot this spline surface over a grid, e.g., the grid
Xxv = 0:.025:1; yv = 0:.025:1;

you can do the following:
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values = spcol(knotsx,kx,xv)*coefs*spcol(knotsy,ky,yv).";
mesh(xv,yv,values."'), view(150,50);

This results in the following figure.
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Spline Approximation to Franke’s Function

This makes good sense because spcol (knotsx,kx,xv) is the matrix whose

(i,q)th entry equals the value B q’kx(xv(i)) at xv(i) of the qth B-spline of order kx
for the knot sequence knotsx.

Because the matrices spcol (knotsx,kx,xv) and spcol(knotsy,ky,yv) are
banded, it may be more efficient, though perhaps more memory-consuming,
for large xv and yv to make use of fnval, as follows:

value2 = ...
fnval (spmak (knotsx,fnval(spmak(knotsy,coefs),yv)."'),xv).";

This is, in fact, what happens internally when fnval is called directly with a
tensor product spline, as in

value2 = fnval(spmak({knotsx,knotsy},coefs),{xv,yv});

Here is the calculation of the relative error, i.e., the difference between the

given data and the value of the approximation at those data sites as compared
with the magnitude of the given data:



Approximation by Tensor Product Splines

errors = z - spcol(knotsx,kx,x)*coefs*spcol(knotsy,ky,y).";
disp( max(max(abs(errors)))/max(max(abs(z))) )

The output is 0.0539, perhaps not too impressive. However, the coefficient
array was only of size 8 6

disp(size(coefs))

to fit a data array of size 15 11.

disp(size(z))

Switch in Order

The approach followed here seems biased, in the following way. First think of
the given data z as describing a vector-valued function of y, and then treat
the matrix formed by the vector coefficients of the approximating curve as
describing a vector-valued function of x.

What happens when you take things in the opposite order, i.e., think of z
as describing a vector-valued function of x, and then treat the matrix made
up from the vector coefficients of the approximating curve as describing a
vector-valued function of y?

Perhaps surprisingly, the final approximation is the same, up to roundoff.
Here is the numerical experiment.

Least Squares Approximation as Function of x

First, fit a spline curve to the data, but this time with x as the independent
variable, hence it is the rows of z that now become the data values.
Correspondingly, you must supply z. ', rather than z, to spap2,

spb = spap2(knotsx,kx,x,z."');

thus obtaining a spline approximation to all the curves (x ; z (;, j)). In
particular, the statement

valsb = fnval(spb,xv)."';
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provides the matrix valsb, whose entry valsb(i, j) can be taken as an
approximation to the value f(xv(i),y(j)) of the underlying function f at the
mesh-point (xv(7),y(j)). This is evident when you plot valsb using mesh:

mesh(xv,y,valsb.'), view(150,50)
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Another Family of Smooth Curves Pretending to Be a Surface

Note the ridges. They confirm that you are, once again, plotting smooth curves
in one direction only. But this time the curves run in the other direction.

Approximation to Coefficients as Functions of y

Now comes the second step, to get the actual surface. First, extract the
coefficients:

coefsx = fnbrk(spb, 'coefs');

Then fit each coefficient vector coefsx(r, :) by a spline of the same order ky
and with the same appropriate knot sequence knotsy:

spb2 = spap2(knotsy,ky,y,coefsx."');

Note that, once again, you need to transpose the coefficient array from spb,
because spap2 takes the columns of its last input argument as the data values.



Approximation by Tensor Product Splines

Correspondingly, there is now no need to transpose the coefficient array
coefsb of the resulting curve:

coefsb = fnbrk(spb2,'coefs');

The Bivariate Approximation

The claim is that coefsb equals the earlier coefficient array coefs, up to
round-off, and here is the test:

disp( max(max(abs(coefs - coefsb))) )
The output is 1.4433e-15.

The explanation is simple enough: The coefficients ¢ of the spline s contained
in sp = spap2(knots,k,x,y) depend linearly on the input values y. This
implies, given that both ¢ and y are 1-row matrices, that there is some matrix
A=A so that

knots,k,x

Cc= yAknots,k,x

for any data y. This statement even holds when y is a matrix, of size d-by-N,
say, in which case each datum y(:,j) is taken to be a point in R¢, and the
resulting spline is correspondingly d-vector-valued, hence its coefficient array
¢ is of size d-by-n, with n = length(knots) -k.

In particular, the statements

sp = spap2(knotsy,ky,y,z);
coefsy =fnbrk(sp, 'coefs');

provide us with the matrix coefsy that satisfies

coefsy = Z-Aknotsy,ky,y

The subsequent computations

sp2 = spap2(knotsx,kx,x,coefsy."');
coefs = fnbrk(sp2, 'coefs').';
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generate the coefficient array coefs, which, taking into account the two
transpositions, satisfies

coefs = ((ZAknotsy,ky,y )"AknOtSX,kX,X ),

= (Aknotsx,kx,x )’ 'Z'Aknotsy,ky,y

In the second, alternative, calculation, you first computed

spb = spap2(knotsx,kx,x,z."');
coefsx = fnbrk(spb, 'coefs');

hence coefsx=z".A The subsequent calculation

knotsx, kx,x*

spb2 = spap2(knotsy,ky,y,coefsx."');
coefsb = fnbrk(spb, 'coefs');

then provided
coefsb = coefsx.’.Aknotsy’ky,y = (Aknotsx,kx,x )"'Z'Aknotsy,ky y

Consequently, coefsb = coefs.

Comparison and Extension

The second approach is more symmetric than the first in that transposition
takes place in each call to spap2 and nowhere else. This approach can be used
for approximation to gridded data in any number of variables.

If, for example, the given data over a three-dimensional grid are contained in
some three-dimensional array v of size [Nx,Ny,Nz], with v(i,j,k) containing
the value f(x(2),y(j),z(k)), then you would start off with

coefs = reshape(v,Nx,Ny*Nz);

Assuming that nj = knotsj - kj, for j = x,y,z, you would then proceed as
follows:

sp = spap2(knotsx,kx,x,coefs."');
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coefs = reshape(fnbrk(sp, 'coefs'),Ny,Nz*nx);
sp = spap2(knotsy,ky,y,coefs."');
coefs = reshape(fnbrk(sp, 'coefs'),Nz,nx*ny);
sp = spap2(knotsz,kz,z,coefs.');
coefs = reshape(fnbrk(sp, 'coefs'),nx,ny*nz);

See Chapter 17 of PGS or [C. de Boor, “Efficient computer manipulation
of tensor products,” ACM Trans. Math. Software 5 (1979), 173-182;
Corrigenda, 525] for more details. The same references also make clear
that there is nothing special here about using least squares approximation.
Any approximation process, including spline interpolation, whose resulting
approximation has coefficients that depend linearly on the given data, can
be extended in the same way to a multivariate approximation process to
gridded data.

This is exactly what is used in the spline construction commands csapi,

csape, spapi, spaps, and spap2, when gridded data are to be fitted. It is also
used in fnval, when a tensor product spline is to be evaluated on a grid.
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Splines Glossary

The Glossary consists of these sections:

¢ “Introduction” on page A-2

e “List of Terms” on page A-3
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Introduction

This glossary provides brief definitions of the basic mathematical terms and
notation used in this guide. But, in contrast to standard glossaries, the terms
do not appear here in alphabetical order. This is not much of a disadvantage
because the glossary is quite short (and all the terms appear in the Index

in any case). The order is carefully chosen to have the explanation of each
term only use terms discussed earlier.

In this way, you may, the first time around, choose to read the entire glossary
from start to finish, for a cohesive introduction to these terms.
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List of Terms

Intervals
Because MATLAB uses the notation [a,b] to indicate a matrix with the
two columns, a and b, this guide uses the notation [a .. b] to indicate the
closed interval with endpoints a and b. This guide does the same for
open and half-open intervals. For example, [a .. b) denotes the interval
that includes its left endpoint, a, and excludes its right endpoint, b.

Vectors
A d-vector is a list of d real numbers, i.e., a point in R% In MATLAB,
a d-vector 1s stored as a matrix of size [1,d], i.e., as a row-vector, or
as a matrix of size [d,1], i.e., as a column-vector. In the Curve Fitting
Toolbox spline functions, vectors are column vectors.

Functions

In this toolbox, the term function is used in its mathematical sense,
and so describes any rule that associates, to each element of a certain
set called its domain, some element in a certain set called its target.
Common examples in this toolbox are polynomials and splines. But
even a point x in R, i.e., a d-vector, may be thought of as a function,
namely the function, with domain the set {1,...,d} and target the real
numbers R, that, for i = 1,...,d, associates to i the real number x(7).

The range of a function is the set of its values.

There are scalar-valued, vector-valued, matrix-valued, and ND-valued
splines. Scalar-valued functions have the real numbers R (or, more
generally, the complex numbers) as their target, while d-vector-valued
functions have R? as their target; if, more generally, d is a vector of
positive integers, then d-valued functions have the d-dimensional real
arrays as their target. Curve Fitting Toolbox spline functions can deal
with univariate and multivariate functions. The former have some real
interval, or, perhaps, all of R as their domain, while m-variate functions
have some subset, or perhaps all, of ®™ as their domain.

Placeholder notation
If f is a bivariate function, and y is some specific value of its second
variable, then
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f(’y)

is the univariate function whose value at x is f(x,y).

Curves and surfaces vs. functions
In this toolbox, the term function usually refers to a scalar-valued
function. A vector-valued function is called here a:

curve if its domain is some interval
surface if its domain is some rectangle

To be sure, to a mathematician, a curve is not a vector-valued function
on some interval but, rather, the range of such a (continuous) function,
with the function itself being just one of infinitely many possible
parametrizations of that curve.

Tensor products
A bivariate tensor product is any weighted sum of products of a function
in the first variable with a function in the second variable, 1.e., any
function of the form

fx,) =Y al, )g;(h;().
i

More generally, an m-variate tensor product is any weighted sum of
products g,(x,)8,(x,)...g,,(x,) of m univariate functions.

Polynomials
A univariate scalar-valued polynomial is specified by the list of its
polynomial coefficients. The length of that list is the order of that
polynomial, and, in this toolbox, the list is always stored as a row vector.
Hence an m-list of polynomials of order k is always stored as a matrix
of size [m,k].

The coefficients in a list of polynomial coefficients are listed from
"highest" to "lowest", to conform to the MATLAB convention, as in the
command polyval(a,x). To recall: assuming that x is a scalar and that
a has k entries, this command returns the number

a1+ a@x"2 4+ alb=Dx +alk).
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In other words, the command treats the list a as the coefficients in a
power form. For reasons of numerical stability, such a coefficient list is
treated in this toolbox, more generally, as the coefficients in a shifted,
or, local power form, for some given center c. This means that the
value of the polynomial at some point x is supplied by the command
polyval(a,x-c).

A vector-valued polynomial is treated in exactly the same way, except
that now each polynomial coefficient is a vector, say a d-vector.
Correspondingly, the coefficient list now becomes a matrix of size [d,k].

Multivariate polynomials appear in this toolbox mainly as tensor
products. Assuming first, for simplicity, that the polynomial in question
is scalar-valued but m-variate, this means that its coefficient “list” a is
an m-dimensional array, of size [k,,...,k, ] say, and its value at some
m-vector x 1s, correspondingly, given by

by ko . . C Wi . . Wk,
zz a(zl,...,lm)(x(ll)—c(Ll)) ! -'-(x(lm)—c(zm)) mmn
S |

for some "center" c.

Piecewise-polynomials

B-splines

A piecewise-polynomial function refers to a function put together from
polynomial pieces. If the function is univariate, then, for some strictly
increasing sequence ¢, < ... < ¢, and for i = 1:/, it agrees with some
polynomial p, on the interval [{; .. ¢, ;). Outside the interval [, .. &, ),
its value 1s given by its first, respectively its last, polynomial piece. The
¢; are its breaks. All the multivariate piecewise-polynomials in this
toolbox are tensor products of univariate ones.

In this toolbox, the term B-spline is used in its original meaning only,
as given to it by its creator, I. J. Schoenberg, and further amplified in
his basic 1966 article with Curry, and used in PGS and many other
books on splines. According to Schoenberg, the B-spline with knots

Ly oo Ty, 1s given by the following somewhat obscure formula (see, e.g.,
IX(1) in PGS):
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Splines

Bj (@)= B(x 1)yt un) = (¢uk =t )£t jun ] @ =47

To be sure, this is only one of several reasonable normalizations of the
B-spline, but it is the one used in this toolbox. It is chosen so that

n

Y Bj @) =1, t, Sx<t,,;.

j=1
But, instead of trying to understand the above formula for the B-spline,
look at the reference pages for the GUI bspligui for some of the basic
properties of the B-spline, and use that GUI to gain some firsthand
experience with this intriguing function. Its most important property
for the purposes of this toolbox is also the reason Schoenberg used the
letter B in its name:

Every space of (univariate) piecewise-polynomials of a given order has a
Basis consisting of B-splines (hence the “B” in B-spline).

Consider the set

S = Hé”k

of all (scalar-valued) piecewise-polynomials of order £ with breaks

& <..<¢,, that, for i = 2...[, may have a jump across ¢ in its y,th
derivative but have no jump there in any lower order derivative. This
set is a linear space, in the sense that any scalar multiple of a function
in Sis again in S, as is the sum of any two functions in S.

Accordingly, S contains a basis (in fact, infinitely many bases), that is, a
sequence f,,...,f, so that every fin S can be written uniquely in the form

n
f@=Y fj@a;,
J=1
for suitable coefficients ;. The number n appearing here is the
dimension of the linear space S. The coefficients a; are often referred to
as the coordinates of f with respect to this basis.

In particular, according to the Curry-Schoenberg Theorem, our space
S has a basis consisting of B-splines, namely the sequence of all
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B-splines of the form B(- | tj,...,tj+k) ,j = 1...n, with the knot sequence ¢
obtained from the break sequence ¢ and the sequence u by the following
conditions:

® Have both ¢, and ¢, ; occur in ¢ exactly % times
® For each i = 2:/, have ¢, occur in ¢ exactly k — u; times

e Make sure the sequence is nondecreasing and only contains elements
from &

Note the correspondence between the multiplicity of a knot and the
smoothness of the spline across that knot. In particular, at a simple
knot, that is a knot that appears exactly once in the knot sequence, only
the (k — 1)st derivative may be discontinuous.

Rational splines
A rational spline is any function of the form r(x) = s(x)/w(x), with both s
and w splines and, in particular, w a scalar-valued spline, while s often
is vector-valued. In this toolbox, there is the additional requirement
that both s and w be of the same form and even of the same order,
and with the same knot or break sequence. This makes it possible to
store the rational spline r as the ordinary spline R whose value at x is
the vector [s(x);w(x)]. It is easy to obtain r from R. For example, if v is
the value of R at x, then v(1:end-1)/v(end) is the value of r at «x.
As another example, consider getting derivatives of r from those of R.
Because s = wr, Leibniz’ rule tells us that

m (o . .
D™s = 2( . JDJme_Jr.

=0\J
Hence, if v(:,j) contains D' ''R(x), j = 1...m + 1, then

m
(v@:end-1,m+1)- E [m ]v(end, j+1v(d:end-1,j+1) | /u(end,1)
i\ J
Jj=1

provides the value of D™R(x).
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Thin-plate splines
A bivariate thin-plate spline is of the form

n-3
2
f@=Y (p(|x ¢ )aj +x(Da,_g +x2(2)a,_; +a,,

Jj=1
with @(¢) = tlogt a univariate function, and ||y|| denoting the Euclidean
length of the vector y. The sites ¢; are called the centers, and the radially
symmetric function w(x) := @(|x|?2) is called the basis function, of this
particular stform.

Interpolation
Interpolation is the construction of a function f that matches given data
values, y,, at given data sites, x;, in the sense that f(x,) =y,, all i.

The interpolant, f, is usually constructed as the unique function of the
form

f(x) =Y fix)a;
J

that matches the given data, with the functions f, chosen
“appropriately”’. Many considerations might enter that choice. One
of these considerations is sure to be that one can match in this way
arbitrary data. For example, polynomial interpolation is popular
because, for arbitrary n data points (x;y;) with distinct data sites,
there is exactly one polynomial of order n — 1 that matches these data.
Explicitly, choose the f] in the above “model” to be

fj(x) = H(X—xi),
i#]
which is an n — 1 degree polynomial for each j. /;-(xi) =0 for every i # J,
but fi(x)) # 0 as long as the x; are all distinct. Set a; = y/f(x) so that

flx) = f(x)a, =y, for all j.

In spline interpolation, one chooses the f; to be the n consecutive
B-splines Bj(x) = B(x|¢,,...t;,;), ] = 1in, of order & for some knot sequence
t, <t,<..<t, ., Forthis choice, there is the following important
theorem.
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Schoenberg-Whitney Theorem
Let x; <x, < ... <x,. For arbitrary corresponding values y,, i = 1...n,
there exists exactly one spline f of order & with knot sequence Ly
J = l..n+k, so that f(x,) = y,, i = 1...n if and only if the sites satisfy the
Schoenberg-Whitney conditions of order k£ with respect to that knot
sequence t, namely

b, <x,<t,,1=1.n,

with equality allowed only if the knot in question has multiplicity &, i.e.,
appears k times in ¢. In that case, the spline being constructed may
have a jump discontinuity across that knot, and it is its limit from the
right or left at that knot that matches the value given there.

Least-squares approximation
In least-squares approximation, the data may be matched only
approximately. Specifically, the linear system

f(xi)Zij(xi)aj =y;, 1=1..n,
J

1s solved in the least-squares sense. In this, some weighting is involved,
i.e., the coefficients aj are determined so as to minimize the error
measure
2
E(f) =Y w;|y; = F (%)
i
for certain nonnegative weights w; at the user’s disposal, with the
default being to have all these weights the same.

Smoothing
In spline smoothing, one also tries to make such an error measure
small, but tries, at the same time, to keep the following roughness
measure small,

F(D"f)= [ aw|pm ol ax,

X
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with 1 a nonnegative weight function that is usually just the constant
function 1, and D™f the mth derivative of f. The competing claims of
small E(f) and small F(D™f) are mediated by a smoothing parameter,
for example, by minimizing

pE(f)+F(D™f) or pE(f)+1-p)F(D™f),

for some choice of p or of p, and over all f for which this expression
makes sense.

Remarkably, if the roughness weight A is constant, then the unique
minimizer [ is a spline of order 2m, with knots only at the data sites,
and all the interior knots simple, and with its derivatives of orders
m,...,2m—2 equal to zero at the two extreme data sites, the so-called
“natural” end conditions. The larger the smoothing parameter p > 0 or
p ¢ [0..1] used, the more closely f matches the given data, and the larger
is its mth derivative.

For data values y, at sites c, in the plane, one uses instead the error
measure and roughness measure

B =Yy~ f () F(D?f)=[(|Duaf +2/Draf P +|Doof )

and, correspondingly, the minimizer of the sum pE(f) + F(D?%f) is not a
polynomial spline, but is a thin-plate spline.

Note that the unique minimizer of pE(f) + F(D?) for given 0 < p < o is
also the unique minimizer of pE(f) + (1 — p)F(D?f) for p=p/(1 +p) ¢ (0 .. 1)
and vice versa.

2D, 3D, ND

A-10

Terms such as “a 2D problem” or “a 3D problem” are not used in this
toolbox, because they are not well defined. For example a 2D problem
could be any one of the following:

¢ Points on some curve, where you must construct a spline curve, 1.e., a
vector-valued spline function of one variable.

¢ Points on the graph of some function, where you must construct a
scalar-valued spline function of one variable.
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¢ Data sites in the plane, where you must construct a bivariate
scalar-valued spline function.

A “3D problem” is similarly ambiguous. It could involve a curve, a
surface, a function of three variables, ... . Better to classify problems by
the domain and target of the function(s) to be constructed.

Almost all the spline construction commands in this toolbox can deal
with ND-valued data, meaning that the data values are ND-arrays. If d
is the size of such an array, then the resulting spline is called d-valued.

A-11



A Advanced Spline Examples

A-12



Function Reference

Fitting Curves and Surfaces (p. 15-2)
Fitting Splines (p. 15-8)



1 5 Function Reference

Fitting Curves and Surfaces

15-2

In this section...

“Data Preprocessing” on page 15-2
“Data Fitting” on page 15-2

“Fit Type Methods” on page 15-3
“Curve Fit Methods” on page 15-4
“Surface Fit Methods” on page 15-5
“Fit Postprocessing” on page 15-6
“Information and Help” on page 15-7

Data Preprocessing

cftool
excludedata

smooth

Data Fitting

cftool

fit
fitoptions
fittype
get

prepareSurfaceData

set
sftool

Open Curve Fitting Tool
Exclude data from fit

Smooth response data

Open Curve Fitting Tool

Fit curve or surface to data

Create or modify fit options structure
Fit type for curve and surface fitting

Get fit options structure property
names and values

Prepare data inputs for surface
fitting
Assign values in fit options structure

Open Surface Fitting Tool
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Fit Type Methods

argnames
category
coeffnames
dependnames
feval

fittype

formula
indepnames
islinear
numargs
numcoeffs
probnames

setoptions

type

Input argument names of cfit,
sfit, or fittype object

Category of fit of cfit, sfit, or
fittype object

Coefficient names of cfit, sfit, or
fittype object

Dependent variable of cfit, sfit, or
fittype object

Evaluate cfit, sfit, or fittype
object

Fit type for curve and surface fitting

Formula of cfit, sfit, or fittype
object

Independent variable of cfit, sfit,
or fittype object

Determine if cfit, sfit, or fittype
object is linear

Number of input arguments of cfit,
sfit, or fittype object

Number of coefficients of cfit, sfit,
or fittype object

Problem-dependent parameter
names of cfit, sfit, or fittype
object

Set model fit options

Name of cfit, sfit, or fittype
object
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15-4

Curve Fit Methods

argnames
category

cfit

coeffnames
coeffvalues
confint
dependnames

differentiate

feval
formula
indepnames

integrate

islinear
numargs
numcoeffs

plot
predint

Input argument names of cfit,
sfit, or fittype object

Category of fit of cfit, sfit, or
fittype object

Constructor for cfit object

Coefficient names of cfit, sfit, or
fittype object

Coefficient values of cfit or sfit,
object

Confidence intervals for fit
coefficients of cfit or sfit object

Dependent variable of cfit, sfit, or
fittype object

Differentiate cfit or sfit object

Evaluate cfit, sfit, or fittype
object

Formula of cfit, sfit, or fittype
object

Independent variable of cfit, sfit,
or fittype object

Integrate cfit object

Determine if cfit, sfit, or fittype
object is linear

Number of input arguments of cfit,
sfit, or fittype object

Number of coefficients of cfit, sfit,
or fittype object

Plot cfit or sfit object

Prediction intervals for cfit or sfit
object
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probnames Problem-dependent parameter
names of cfit, sfit, or fittype
object

probvalues Problem-dependent parameter
values of cfit or sfit object

setoptions Set model fit options

type Name of cfit, sfit, or fittype
object

Surface Fit Methods

argnames Input argument names of cfit,
sfit, or fittype object

category Category of fit of cfit, sfit, or
fittype object

coeffnames Coefficient names of cfit, sfit, or
fittype object

coeffvalues Coefficient values of cfit or sfit,
object
confint Confidence intervals for fit

coefficients of cfit or sfit object

dependnames Dependent variable of cfit, sfit, or
fittype object

differentiate Differentiate cfit or sfit object

feval Evaluate cfit, sfit, or fittype
object

formula Formula of cfit, sfit, or fittype
object

indepnames Independent variable of cfit, sfit,

or fittype object

islinear Determine if cfit, sfit, or fittype
object is linear
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numargs Number of input arguments of cfit,
sfit, or fittype object

numcoeffs Number of coefficients of cfit, sfit,
or fittype object

plot Plot cfit or sfit object

predint Prediction intervals for cfit or sfit
object

probnames Problem-dependent parameter
names of cfit, sfit, or fittype
object

probvalues Problem-dependent parameter
values of cfit or sfit object

quadad Numerically integrate sfit object

setoptions Set model fit options

sfit Constructor for sfit object

type Name of cfit, sfit, or fittype
object

Fit Postprocessing

cftool Open Curve Fitting Tool

coeffvalues Coefficient values of cfit or sfit,
object

confint Confidence intervals for fit

coefficients of cfit or sfit object

differentiate Differentiate cfit or sfit object

feval Evaluate cfit, sfit, or fittype
object

integrate Integrate cfit object

plot Plot cfit or sfit object
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predint

probvalues

Information and Help

cflibhelp

datastats

Prediction intervals for cfit or sfit
object

Problem-dependent parameter
values of cfit or sfit object

Information on library models

Data statistics
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Fitting Splines

In this section...

“Spline GUI Access” on page 15-8

“Spline Construction” on page 15-8

“Spline Operators” on page 15-9

“Spline Breaks, Knots, and Sites” on page 15-10

“Spline Utilities” on page 15-10

Spline GUI Access

bspligui Experiment with B-spline as
function of its knots

splinetool Experiment with some spline
approximation methods

Spline Construction

csape Cubic spline interpolation with end
conditions

csapi Cubic spline interpolation

csaps Cubic smoothing spline

cscvn “Natural” or periodic interpolating
cubic spline curve

getcurve Interactive creation of cubic spline
curve

ppmak Put together spline in ppform

rpmak Put together rational spline

rscvn Piecewise biarc Hermite
interpolation
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rsmak

spap2
spapi
spaps
spcrv
spmak
stmak

tpaps

Spline Operators

fn2fm
fnbrk
fnchg
fncmb
fnder
fndir
fnint
fnjmp

fnmin

fnplt
fnrfn
fntlr
fnval
fnxtr

fnzeros

Put together rational spline for
standard geometric shapes

Least-squares spline approximation
Spline interpolation

Smoothing spline

Spline curve by uniform subdivision
Put together spline in B-form

Put together function in stform

Thin-plate smoothing spline

Convert to specified form

Name and part(s) of form
Change part(s) of form
Arithmetic with function(s)
Differentiate function
Directional derivative of function
Integrate function

Jumps, i.e., f(x+)-f(x-)

Minimum of function in given
interval

Plot function

Refine partition of form

Taylor coefficients or polynomial
Evaluate function

Extrapolate function

Find zeros of function in given
interval
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Spline Breaks, Knots, and Sites

aptknt Acceptable knot sequence

augknt Augment knot sequence

aveknt Provide knot averages

brk2knt Convert breaks with multiplicities
into knots

chbpnt Good data sites, Chebyshev-Demko
points

knt2brk, knt2mlt Convert knots to breaks and their
multiplicities

newknt New break distribution

optknt Knot distribution “optimal” for
interpolation

sorted Locate sites with respect to mesh
sites

Spline Utilities

bkbrk Part(s) of almost block-diagonal
matrix

bspline Plot B-spline and its polynomial
pieces

franke Franke’s bivariate test function

slvblk Solve almost block-diagonal linear
system

spcol B-spline collocation matrix

splpp, sprpp Taylor coefficients from local

B-coefficients

spterms Explain spline terms
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stcol

subplus

titanium

Scattered translates collocation
matrix

Positive part

Titanium test data
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aptknt

16-2

Purpose

Syntax

Description

Examples

Algorithms

Acceptable knot sequence

knots = aptknt(tau,k)
[knots,k] = aptknt(tau,k)

knots = aptknt(tau,k) returns a knot sequence suitable for
interpolation at the data sites tau by splines of order k with that knot
sequence, provided tau has at least k entries, 1s nondecreasing, and
satisfies tau(i)<tau(i+k-1) for all i. In that case, there is exactly one
spline of order k with knot sequence knots that matches given values at
those sites. This is so because the sequence knots returned satisfies the
Schoenberg-Whitney conditions

knots(i) < tau(i) < knots(i+k), i=1:1length(tau)

with equality only at the extreme knots, each of which occurs with exact
multiplicity k.

If tau has fewer than k entries, then k is reduced to the value
length(tau). An error results if tau fails to be nondecreasing and/or
tau(i) equals tau(i+k-1) for some i.

[knots,k] = aptknt(tau,k) also returns the actual k used (which
equals the smaller of the input k and length(tau)).

If tau is equally spaced, e.g., equal to linspace(a,b,n) for some
n>=4, and y is a sequence of the same size as tau, then sp =
spapi(aptknt(tau,4),tau,y) gives the cubic spline interpolant with
the not-a-knot end condition. This is the same cubic spline as produced
by the command spline(tau,y), but in B-form rather than ppform.

The (k-1)-point averages sum(tau(i+1:i+k-1))/(k-1) of the sequence
tau, as supplied by aveknt (tau, k), are augmented by a k-fold tau(1)
and a k-fold tau(end). In other words, the command gives the same
result as augknt ([tau(1),aveknt(tau,k),tau(end)],k), provided
tau has at least k entries and k is greater than 1.



aptknt
|

Cautionary If tau is very nonuniform, then use of the resulting knot sequence for
Note interpolation to data at the sites tau may lead to unsatisfactory results.
See Also augknt | aveknt | newknt | optknt
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Purpose
Syntax

Description

Examples

See Also

Input argument names of cfit, sfit, or fittype object

args = argnames(fun)

args argnames (fun) returns the input argument (variable and
coefficient) names of the cfit, sfit, or fittype object fun as an n-by-1
cell array of strings args, where n = numargs(fun).

f = fittype('a*x"2+b*exp(n*x)"');
nargs = numargs(f)
nargs =

args
args =

argnames (f)

fittype | formula | numargs



augknt

Purpose

Syntax

Description

Examples

Augment knot sequence

augknt (knots, k)
augknt (knots,k,mults)
[augknot,addl] = augknt(...)

augknt (knots, k) returns a nondecreasing and augmented knot
sequence that has the first and last knot with exact multiplicity k. (This
may actually shorten the knot sequence.) )

augknt(knots,k,mults) makes sure that the augmented knot
sequence returned will, in addition, contain each interior knot mults
times. If mults has exactly as many entries as there are interior
knots, then the jth one will appear mults(j) times. Otherwise, the
uniform multiplicity mults (1) is used. If knots is strictly increasing,
this ensures that the splines of order k with knot sequence augknot
satisfy k-mults(j) smoothness conditions across knots(j+1),
j=1:1length(knots)-2.

[augknot,addl] = augknt(...) also returns the number addl of knots
added on the left. (This number may be negative.)

If you want to construct a cubic spline on the interval [a. .b], with two
continuous derivatives, and with the interior break sequence xi, then
augknt([a,b,xi],4) 1s the knot sequence you should use.

If you want to use Hermite cubics instead, i.e., a cubic spline with
only one continuous derivative, then the appropriate knot sequence is
augknt([a,xi,b],4,2).

augknt([1 2 3 3 31,2) returns the vector [1 1 2 3 3], as does
augknt([3 2 3 1 31,2). In either case, addl would be 1.
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Purpose
Syntax

Description

Examples

See Also

Provide knot averages

tstar = aveknt(t,k)

tstar = aveknt(t,k) returns the averages of successive k-1 knots,
1.e., the sites

ti*iz(ti+1 +"'+ti+k_1)/(k—1), i=1:n

which are recommended as good interpolation site choices when

n+k

interpolating from splines of order k with knot sequence ¢ = (¢; )i:1 .

aveknt([1 2 3 3 3]1,3) returns the vector [2.5000 3.0000], while
aveknt([1 2 31,3) returns the empty vector.

With k and the strictly increasing sequence breaks given, the
statements

t = augknt(breaks,k); x = aveknt(t);
sp = spapi(t,x,sin(x));

provide a spline interpolant to the sine function on the interval
[breaks(1)..breaks(end)].

For sp the B-form of a scalar-valued univariate spline function, and
with tstar and a computed as

tstar = aveknt(fnbrk(sp, 'knots'),fnbrk(sp,'order'));
a = fnbrk(sp, 'coefs');

the points (tstar(i), a(i)) constitute the control points of the spline, i.e.,
the vertices of the spline’s conitrol polygon.

aptknt | chbpnt | optknt
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Purpose

Syntax

Description

References

See Also

Part(s) of almost block-diagonal matrix

[nb,rows,ncols,last,blocks]
bkbrk(blokmat)

bkbrk(blokmat)

[nb,rows,ncols,last,blocks] bkbrk(blokmat) returns the
details of the almost block-diagonal matrix contained in blokmat,
with rows and last nb-vectors, and blocks a matrix of size
[sum(rows),ncols].

This utility program is not likely to be of interest to the casual user. It
is used in s1lvblk to decode the information, provided by spcol, about

a spline collocation matrix in an almost block diagonal form especially

suited for splines. But bkbrk can also decode the almost block-diagonal
form used in [1].

bkbrk(blokmat) returns nothing, but the details are printed out. This
is of use when trying to understand what went wrong with such a
matrix.

[1] C. de Boor and R. Weiss. “SOLVEBLOK: A package for solving
almost block diagonal linear systems.” ACM Trans. Mathem. Software
6 (1980), 80-817.

slvblk | spcol
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Purpose
Syntax

Description

Examples

See Also

Convert breaks with multiplicities into knots

[knots,index] = brk2knt(breaks,mults)

[knots,index] brk2knt (breaks,mults) returns the sequence
knots that is the sequence breaks but with breaks (i) occurring
mults(i) times, all i. In particular, breaks (i) will not appear unless
mults(i)>0. If, as one would expect, breaks is a strictly increasing
sequence, then knots contains each breaks (i) exactly mults(i) times.

If mults does not have exactly as many entries as does breaks, then all
mults(i) are set equal to mults(1).

If, as one would expect, breaks is strictly increasing and all
multiplicities are positive, then, for each i, index (i) is the first place
in knots at which breaks (i) appears.

The statements

t=[112223455];
[xi,m] = knt2brk(t);
tt = brk2knt(xi,m)

give [1 2 3 4 5] forxi, [2 3 1 1 2] for m, and, finally, t for tt.

augknt
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Purpose
Syntax

Description

Experiment with B-spline as function of its knots

bspligui

bspligui starts a graphical user interface (GUI) for exploring how a
B-spline depends on its knots. As you add, move, or delete knots, you
see the B-spline and its first three derivatives change accordingly.

You observe the following basic facts about the B-spline with knot

sequence fy < <1y

The B-spline is positive on the open interval (¢,..t,). It is zero at the
end knots, ¢, and ¢,, unless they are knots of multiplicity k. The
B-spline is also zero outside the closed interval [¢,..t,], but that part
of the B-spline is not shown in the GUI.

Even at its maximum, the B-spline is never bigger than 1. It reaches
the value 1 inside the interval (Z,..t,) only at a knot of multiplicity at
least k—1. On the other hand, that maximum cannot be arbitrarily
small; it seems smallest when there are no interior knots.

The B-spline is piecewise polynomial of order &, i.e., its polynomial
pieces all are of degree <k. For k = 1:4, you can even observe that all
its nonzero polynomial pieces are of exact degree k — 1, by looking at
the first three derivatives of the B-spline. This means that the degree
goes up/down by 1 every time you add/delete a knot.

Each knot 2 is a break for the B-spline, but it is permissible for
several knots to coincide. Therefore, the number of nontrivial
polynomial pieces is maximally £ (when all the knots are different)
and minimally 1 (when there are no “interior” knots), and any
number between 1 and k& is possible.

The smoothness of the B-spline across a break depends on the
multiplicity of the corresponding knot. If the break occurs in the
knot sequence m times, then the (k—m)th derivative of the B-spline
has a jump across that break, while all derivatives of order lower
than (k—m) are continuous across that break. Thus, by varying the
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See Also
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multiplicity of a knot, you can control the smoothness of the B-spline
across that knot.

As one knot approaches another, the highest derivative that is
continuous across both develops a jump and the higher derivatives
become unbounded. But nothing dramatic happens in any of the
lower-order derivatives.

The B-spline is bell-shaped in the following sense: if the first
derivative is not identically zero, then it has exactly one sign change
in the interval (¢,..t,), hence the B-spline itself is unimodal, meaning
that it has exactly one maximum. Further, if the second derivative
1s not identically zero, then it has exactly two sign changes in that
interval. Finally, if the third derivative is not identically zero, then it
has exactly three sign changes in that interval. This illustrates the
fact that, for j = 0:k — 1, if the jth derivative is not identically zero,
then it has exactly j sign changes in the interval (¢,..t,); it is this
property that is meant by the term “bell-shaped”. For this claim to be
strictly true, one has to be careful with the meaning of “sign change”
in case there are knots with multiplicities. For example, the (k—1)st
derivative is piecewise constant, hence it cannot have k-1 sign
changes in the straightforward sense unless there are k polynomial
pieces, 1.e., unless all the knots are simple.

bspline | chbpnt | spcol
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Purpose

Syntax

Description

Examples

See Also

Plot B-spline and its polynomial pieces

bspline(t)
bspline(t,window)
pp = bspline(t)

bspline(t) plots the B-spline with knot sequence t, as well as the
polynomial pieces of which it is composed.

bspline(t,window) does the plotting in the subplot window specified
by window; see the MATLAB command subplot for details.

pp = bspline(t) plots nothing but returns the ppform of the B-spline.

The statement pp=fn2fm(spmak(t,1), 'pp') has the same effect as the
statement pp=bspline(t).

bspligui
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category

Purpose
Syntax

Description

Examples

See Also
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Category of fit of cfit, sfit, or fittype object
cname = category(fun)

cname = category(fun) returns the fit category cname of the
cfit, sfit, or fittype object fun, where cname is one of 'custom',
‘interpolant', 'library', or 'spline’.

f1 = fittype('a*x"2+b*exp(n*x)"');
category(f1)

ans =

custom

f2 = fittype('pchipinterp');
category(f2)

ans =

interpolant

f3 = fittype('fourierd4');
category(f3)

ans =

library

f4 = fittype('smoothingspline');
category(f4)

ans =

spline

fittype | type | cflibhelp



cfit

Purpose
Syntax

Description

Examples

See Also

Constructor for cfit object

cfun = cfit(ffun,coeff1,coeff2,...)

cfun cfit(ffun,coeff1,coeff2,...) constructs the cfit object
cfun using the model type specified by the fittype object ffun and the
coefficient values coeff1, coeff2, etc.

Note cfit is called by the fit function when fitting fittype objects to
data. To create a cfit object that is the result of a regression, use fit.

You should only call cfit directly if you want to assign values to
coefficients and problem parameters of a fittype object without
performing a fit.

f = fittype('a*x"2+b*exp(n*x)"')

General model:
f(a,b,n,x) = a*x"2+b*exp(n*x)
¢ = cfit(f,1,10.3,-1e2)

General model:
c(x) = a*x"2+b*exp(n*x)

Coefficients:
a = 1
b = 10.3
n = -100

fit | fittype | feval
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cflibhelp

Purpose

Syntax

Description

16-14

Information on library models

cflibhelp

cflibhelp libtype
help cflibhelp

Enter cflibhelp to display the names, equations, and descriptions of
all models in the Curve Fitting Library. The Curve Fitting Library

is a library of models for data fitting with the fit function. You use
library names as input arguments in the fit, fitoptions, and fittype
functions. To find out what input arguments you can use, enter:

cflibhelp libtype

Where 1ibtype is a library type listed in the tables below.

cflibhelp libtype displays the names, equations, and descriptions for
the library models of the specified type, 1ibtype.

Enter help cflibhelp to display only the list of library types.

For Curves:

libtype Description

distribution Distribution models such as Weibull. See
“Weibull Distribution” on page 2-58.

exponential Exponential function and sum of two
exponential functions. See “Exponentials” on
page 2-54.

fourier Up to eight terms of Fourier series. See
“Fourier Series” on page 2-54.

gaussian Sum of up to eight Gaussian models. See
“Gaussian” on page 2-55.

power Power function and sum of two power functions.

See “Power Series” on page 2-56.
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For Curves:

libtype Description

rational Rational equation models, up to 5th degree/5th
degree(i.e., up to degree 5 in both the numerator
and the denominator). See “Rationals” on page
2-56.

sin Sum of up to eight sin functions. See “Sum of
Sines” on page 2-57.

polynomial Polynomial models, up to degree nine. See
“Polynomials” on page 2-55.

spline Cubic spline and smoothing spline models. See
“Nonparametric Fitting” on page 2-106.

interpolant Interpolating models, including linear, nearest

neighbor, cubic spline, and shape-preserving
cubic spline. See “Nonparametric Fitting” on
page 2-106.

For more information on library models for curves, refer to the “Library
Models” on page 2-53 section of the User’s Guide.

For Surfaces:
libtype

Description

interpolant

Interpolating models, including linear, nearest
neighbor, cubic spline, and biharmonic
interpolation. See “Using Interpolant Fit
Category” on page 3-31 for Surface Fitting Tool.

polynomial

Polynomial models, up to degree five. See
“Using Polynomial Fit Category” on page 3-32
for Surface Fitting Tool.

lowess

Lowess smoothing models. See “Using Lowess
Fit Category” on page 3-34 for Surface Fitting
Tool.
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For more information on library models for surfaces, refer to the
“Selecting Fit Settings” on page 3-30 section for Surface Fitting Tool
in the User’s Guide.

Examples To list only the model equations for the polynomial libtype group,
type cflibhelp followed by the group name, for example:

cflibhelp polynomial

POLYNOMIAL MODELS

MODELNAME EQUATION
Curves:
poly1 Y = p1*x+p2
poly2 Y = p1*x"2+p2*x+p3
poly3 Y = p1*x"3+p2*x"2+...+p4
poly9 Y = p1*x"9+p2*x~8+...+p10
Surfaces:

Model names for polynomial surfaces are 'polyij',
where i is the degree in x and j is the degree in y.
The maximum for both i and j is five. The degree of
the polynomial is the maximum of i and j. The degree
of x in each term will be less than or equal to i,
and the degree of y in each term will be less than or
equal to j. For example:

poly21 Z = p00 + p10*x + pO1*y + p20*x~2 + p1i1*x*y
poly13 Z = p00 + p10*x + pO1*y + pli*x*y + p02*y~2
+ pl2*x*y~2 + p03*y"3
poly55 Z = p00 + pi10*x + pO1*y +...+ pld*x*y~4
+ p05*y~5

The following commands display the model equations for each specified
libtype group. Output for each command is shown.
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cflibhelp distribution
DISTRIBUTION MODELS

MODELNAME
weibull

cflibhelp exponential
EXPONENTIAL MODELS

MODELNAME

expi
exp2

cflibhelp fourier
FOURIER SERIES

MODELNAME

fourier1

fourier2
+a2*cos(2*x*p)+b2*sin(2*x*p)

fourier3
+a3*cos(3*x*p)+b3*sin(3*x*p)

fouriers8
+a8*cos(8*x*p)+b8*sin(8*x*p)

EQUATION

Y = a*b*x”(b-1)*exp(-a*x"b)

EQUATION
Y = a*exp(b*x)
Y = a*exp(b*x)+c*exp(d*x)

EQUATION

Y = a0+ail*cos(x*p)+b1*sin(x*p)

Y = a0+ai*cos(x*p)+bi*sin(x*p)...
Y = a0+ail*cos(x*p)+bi*sin(x*p)...
Y = a0+ail*cos(x*p)+bi1*sin(x*p)...

where p = 2*pi/(max(xdata)-min(xdata)).

cflibhelp gaussian

GAUSSIAN SUMS (Peak fitting)

MODELNAME

gauss1

EQUATION

Y = at*exp(-((x-b1)/c1)"2)

16-17



cflibhelp
|

gauss2 alt*exp(-((x-b1)/c1)~2)+a2*...

)
at*exp(-((x-b1)/c1)"2)+...
+a3*exp (- ((x-b3)/c3)"2)

NI

Y
exp(-((x-b2)/c2)"
gauss3
)

gauss8 Y = at*exp(-((x-b1)/c1)*2)+...
+a8*exp (- ((x-b8)/c8)"2)

cflibhelp power
POWER MODELS

MODELNAME EQUATION
poweri Y = a*x"b
power2 Y = a*x"b+c

cflibhelp rational
RATIONAL MODELS

Rational Models are polynomials over polynomials with
the leading coefficient of the denominator set to 1.
Model names are 'ratij', where i is the degree of the
numerator and j is the degree of the denominator.
The degrees go up to five for
both the numerator and the denominator. For example:

MODELNAME EQUATION
rat02 Y = (p1)/(x"2+q1*x+q2)
rat21 Y = (p1*x"2+p2*x+p3)/ (x+ql)
rat55 Y = (p1*x"5+...+p6)/(Xx"5+...+05)

cflibhelp sin
SUM OF SINE FUNCTIONS

MODELNAME EQUATION

16-18



cflibhelp

sini Y = ail*sin(bi1*x+c1)

sin2 Y = ail*sin(bi1*x+c1)+a2*sin...
(b2*x+c2)

sin3 Y = ail*sin(bi1*x+ct1)+...

+a3*sin(b3*x+c3)

sin8 Y = al*sin(bi1*x+ct1)+...
+a8*sin(b8*x+c8)

cflibhelp spline
SPLINES

Spline models are only supported for curve fitting,
not for surface fitting

SPLINETYPE DESCRIPTION
cubicspline cubic interpolating spline
smoothingspline smoothing spline

cflibhelp interpolant
INTERPOLANT

INTERPTYPE DESCRIPTION

Curves & Surfaces:

linearinterp linear interpolation
nearestinterp nearest neighbor interpolation
cubicinterp cubic spline interpolation

Curves Only:
pchipinterp shape-preserving (pchip)
interpolation

Surfaces Only:
biharmonicinterp biharmonic (MATLAB 4 griddata)
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interpolation

cflibhelp lowess
LOWESS

Lowess models are only supported for surface fitting,
not for curve fitting

MODELNAME DESCRIPTION

lowess local linear regression

loess local quadratic regression
See Also fit | fittype
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Purpose Open Curve Fitting Tool

Syntax cftool
cftool(x,y)
cftool(x,y,w)

Description cftool opens Curve Fitting Tool, an interactive environment for fitting
curves to one-dimensional data.

cftool(x,y) opens Curve Fitting Tool with predictor data x and
response data y. x and y must be vectors of the same size. Infs, NaNs,
and imaginary parts of complex numbers are ignored in the data.

cftool(x,y,w) also imports the weight vector w into Curve Fitting Tool
for weighting data in subsequent fits. w must be the same length as
x and vy.

Tips The Curve Fitting Tool is an interactive environment presented in the
form of a graphical user interface. It allows you to
¢ Import data from the MATLAB workspace
e Explore the data graphically
® Preprocess the data for fitting using exclusion rules and smoothing
® Fit a variety of library or custom models to the data
® Generate relevant regression statistics

® Post-process the fit through interpolation, extrapolation,
differentiation, and integration

e Export results back to the MATLAB workspace for further analysis
and visualization

The main Curve Fitting Tool interface is shown below.
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Clicking the Data, Fitting, Exclude, Plotting, or Analysis buttons
opens associated GUIs, described below.

In the figure above, data was imported from the MAT-file census using
the Data GUI and fit with a quadratic polynomial using the Fitting
GUI. Residuals were displayed in the subplot by selecting View >
Residuals > Line Plot.

For a complete example that uses many of these GUIs, refer to
“Interactive Curve Fitting Example” on page 2-2.

The Data GUI
The Data GUI allows you to

® Import, name, preview, and delete data sets
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® Smooth data using a variety of methods

The Data GUI 1s shown below with the census data loaded.

Data Sets | Smggthl

Import workspace vectors:

X Data: chate 'I
Y Data: nop hd
Weights: (none) =

Data set name: Ipop vs. cdate
Create data set |

Diata sets:

iR | Rename | Delete |

Preview

g [m[ .5

Close | Help |

Refer to “Preprocessing Data” on page 2-22 for more information about

the Data GUI.
The Fitting GUI

The Fitting GUI allows you to

¢ Compare coefficients and goodness of fit statistics from different

models

Fit your data using parametric or nonparametric models

Set algorithm options for nonlinear fits

Keep track of all data sets and fits in the current session
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The Fitting GUI is shown below with the results of fitting the census
data.

= |0 %

d Exclusion nue: |{rI:ne]
=] F Center and scale x datm

I_IL (LY L4}

I Immedate gpply Cance Appty

Linear model Poly5: -
F{x) = pl*x~5 + p2=x~4 + p3*x"3 + pd*x~2 + p5*x + pé

where ¥ iz notmalized by mean 1ES0 and =td &£2.05
Cozfficients (with 93% confidence bounds):

Pl = 0D.5877 ({=Z.305, 3.48)

Pz = 0D.7047 ({-1.6B4, 3.0%4)

p3 = -0.5153 {-10.1%, B.356)

pd = 23.47 (17.42, 29.52)

P2 = T4.27  {gB.37, Bl.oT)

pg = 62.23 (5%9.51, G64.93) :I
Table of Fits
S | Ftrams Data set Equastion riame S5E R-sguans
[] 6 vz, cdate Polys 1065.927557939... [0L.95913462847...
@ pokys pop vs. cdate Pohy4 145.568924373... |1.9589 156642 1.,
E pol3 ws, cdate Poly3 142768724181, [0.22878721213...
7] 2 i, cdate Foh2 155029299176, [0.9587 1256577.,

Delete it | Sawe toworkepace,. | Tabe cpters,., |

_Gose | e |
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The Exclude GUI

The Exclude GUI allows you to create exclusion rules for a data set. An
exclusion rule identifies data to be excluded while fitting. The excluded

data can be individual data points, or a section of predictor or response
data.

The Exclude GUI is shown below with the first two points of the census
data marked for exclusion.

I gl
Exclusion rule name: |exc1 Existing exlusion rules:
- Exclude Point
Select data set: Ipop Vs, cdate - Exclude graphically |
Checkto exclude point:
Index kS s
¥ 1 1790 3.9 =
|2 1600 53
mlE 1810 T2 =l
~Exclude Section
Exclude X |<: -I Exclude X == = |
Exclude ¥ [== <] Exclude Y [== =] | o pr— |
Create exclusion rule | Renarme | Delete |
o |

The Plotting GUI

The Plotting GUI allows you to determine the data sets and fits
displayed by Curve Fitting Tool.

The Plotting GUI is shown below with the census data and the fit
poly2 checked for display.
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ST

Plot data sets Plot fits

I Data set I Fit Data set

[V|pop vs. cdate | naky2 pop v, cdate

[ poly3 pop vs. cate

[ paly4 pop vs. cdate

[ palys pop vs. cdate

| palys pop vs. cdate

expl pop vs. cdate

[~ Clear associated fits when clearing data sets.

o |

The Analysis GUI
The Analysis GUI allows you to

* Interpolate, extrapolate, differentiate, or integrate a fit
¢ Display the results of your analysis numerically or in a plot
The Analysis GUI is shown below with a numerical display of the

results of extrapolating the census data from the year 2000 to the year
2050 in 10-year increments.
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Fitto analyze: |poly2 {pop vs I

Analyze at i = |2000:10:2050

[+ Evaluate fit at i
Frediction bounds:
& Maone
" Forfunction

© For new ohseration

Level | 595 %

[ 15t derivative at Xi
[ 2nd derivative at i

[ Integrate to Xi
& Start from ming:i)

 Startfrom I

¥ Plotresults
V! Plot data set: pop vs. cdate

=] |
Hi Tl
2000 274,622
2010 301.824
2020 330,334
2030 360,152
2040 391.279
2050 423714
Save to workspace... | Apply | Close |

Refer to “Analyzing the Fit” on page 2-16 for an example that uses the

Analysis GUI.
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Purpose

Syntax

Description

Examples
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Good data sites, Chebyshev-Demko points

tau = chbpnt(t,k)
chbpnt (t,k,tol)
[tau,sp] = chbpnt(...)

tau = chbpnt(t,k) are the extreme sites of the Chebyshev spline

of order k with knot sequence t. These are particularly good sites at
which to interpolate data by splines of order k with knot sequence t
because the resulting interpolant is often quite close to the best uniform
approximation from that spline space to the function whose values at
tau are being interpolated.

chbpnt(t,k,tol) also specifies the tolerance tol to be used in the
iterative process that constructs the Chebyshev spline. This process is
terminated when the relative difference between the absolutely largest
and the absolutely smallest local extremum of the spline is smaller than
tol. The default value for tol is .001.

[tau,sp] = chbpnt(...) alsoreturns, in sp, the Chebyshev spline.

chbpnt([-ones(1,k),ones(1,k)]1,k) provides (approximately) the
extreme sites on the interval [-1 .. 1] of the Chebyshev polynomial of
degree k-1.

If you have decided to approximate the square-root function on the
interval [0 .. 1] by cubic splines, with knot sequence t as given by

k =4; n=10; t = augknt(((0:n)/n)."8,k);

then a good approximation to the square-root function from that specific
spline space is given by

x = chbpnt(t,k); sp = spapi(t,x,sqrt(x));

as is evidenced by the near equi-oscillation of the error.



chbpnt
|

Algorithms The Chebyshev spline for the given knot sequence and order is
constructed iteratively, using the Remez algorithm, using as initial
guess the spline that takes alternately the values 1 and —1 at the
sequence aveknt (t,k). The demo “Constructing the Chebyshev Spline”
gives a detailed discussion of one version of the process as applied to a
particular example.

See Also aveknt
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coeffnames

Purpose
Syntax

Description

Examples

See Also
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Coefficient names of cfit, sfit, or fittype object

coeffs = coeffnames(fun)

coeffs = coeffnames(fun) returns the coefficient (parameter) names
of the cfit, sfit, or fittype object fun as an n-by-1 cell array of
strings coeffs, where n = numcoeffs(fun).

f = fittype('a*x"2+b*exp(n*x)"');
ncoeffs = numcoeffs(f)
ncoeffs

3
coeffs = coeffnames(T)
coeffs =

g

Y

N

fittype | formula | numcoeffs | probnames | coeffvalues



coeffvalues

Purpose Coefficient values of cfit or sfit, object
Syntax coeffvals = coeffvalues(fun)
Description coeffvals = coeffvalues(fun) returns the values of the coefficients

(parameters) of the cfit object fun as a 1-by-n vector coeffvals, where
n = numcoeffs(fun).

Examples load census

f = fittype('poly2');
coeffnames(f)

ans =
Ip1l
Ip2I
Ip3I
formula(f)
ans =

p1*x°2 + p2*x + p3

¢ = fit(cdate,pop,f);
coeffvalues(c)
ans =
1.0e+004 *
0.0000 -0.0024 2.1130

See Also coeffnames | confint | predint | probvalues
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confint

Purpose

Syntax

Description

Tips

Examples
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Confidence intervals for fit coefficients of cfit or sfit object

ci = confint(fitresult)
ci confint(fitresult,level)

ci confint(fitresult) returns 95% confidence bounds ci on

the coefficients associated with the cfit or sfit object fitresult.
fitresult must be an output from the fit function to contain

the necessary information for ci. ci is a 2-by-n array where n =
numcoeffs(fitresult). The top row of ci contains the lower bound for
each coefficient; the bottom row contains the upper bound.

ci = confint(fitresult,level) returns confidence bounds at the
confidence level specified by level. level must be between 0 and 1.
The default value of level is 0.95.

To calculate confidence bounds, confint uses R! (the inverse R factor
from @R decomposition of the Jacobian), the degrees of freedom

for error, and the root mean squared error. This information is
automatically returned by the fit function and contained within
fitresult.

If coefficients are bounded and one or more of the estimates are at
their bounds, those estimates are regarded as fixed and do not have
confidence bounds.

Note that you cannot calculate confidence bounds if
category(fitresult) is 'spline' or 'interpolant'.

load census

fitresult = fit(cdate,pop, 'poly2"')
fitresult =
Linear model Poly2:
fitresult(x) = p1*x"2 + p2*x + p3
Coefficients (with 95% confidence bounds):
p1 = 0.006541 (0.006124, 0.006958)
p2 = -23.51 (-25.09, -21.93)
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p3 = 2.113e+004 (1.964e+004, 2.262e+004)

ci = confint(fitresult,0.95)

ci =
0.0061242 -25.086 19641
0.0069581 -21.934 22618

Note that fit and confint display the confidence bounds in slightly
different formats.

See Also fit | predint
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Purpose

Syntax

Description

16-34

Cubic spline interpolation with end conditions

pp = csape(x,y)
pp csape(x,y,conds)

pp = csape(x,y) isthe ppform of a cubic spline s with knot sequence
x that satisfies s(x(j)) = y(:,j) for all j, as well as an additional
end condition at the ends (meaning the leftmost and at the rightmost
data site), namely the default condition listed below. The data values
y(:,j) may be scalars, vectors, matrices, even ND-arrays. Data values
at the same data site are averaged.

pp = csape(x,y,conds) lets you choose the end conditions to be used,
from a rather large and varied catalog, by proper choice of conds. If
needed, you supply the corresponding end condition values as additional
data values, with the first (last) data value taken as the end condition
value at the left (right) end. In other words, in that case, s(x(j))
matches y(:,j+1) for all j, and the variable endcondvals used in the
detailed description below is set to y(:,[1 end]). For some choices

of conds, these end condition values need not be present and/or are
ignored when present.

conds may be a siring whose first character matches one of the
following: 'complete' or 'clamped', 'not-a-knot', 'periodic’,
'second', 'variational', with the following meanings.

‘complete' or Match endslopes (as given, with default as under
‘clamped' “default”).
‘not-a-knot' Make second and second-last sites inactive knots

(ignoring end condition values if given).

'periodic' Match first and second derivatives at left end with
those at right end.

'second’ Match end second derivatives (as given, with
default [0 0], i.e., as in 'variational').
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'variational' Set end second derivatives equal to zero (ignoring
end condition values if given).
default Match endslopes to the slope of the cubic that

matches the first four data at the respective end
(i.e., Lagrange).

By giving conds as a 1-by-2 matrix instead, it is possible to specify
different conditions at the two ends. Explicitly, the ith derivative, D's,
is given the value endcondvals(:,j) at the left (j is 1) respectively right
(j is 2) end in case conds(j) is i,i = 1:2. There are default values for
conds and/or endcondvals.

Available conditions are:

clamped Ds(e) = endcondvals(;,j) | if conds(j) == 1

curved D?s(e) = endcondvals(;,j) | if conds(j) == 2

Lagrange Ds(e) = Dp(e) default

periodic D7s(a) =D’s(b), r=1,2 if conds == [0 O]

variational D3?s(e) =0 if conds(j) == 2 &
endcondvals(;,j) == 0

Here, e is a (e is b), i.e., the left (right) end, in case j is 1 (j is 2), and (in
the Lagrange condition) P is the cubic polynomial that interpolates to
the given data at e and the three sites nearest e.

If conds(j) is not specified or is different from 0, 1, or 2, then it is
taken to be 1 and the corresponding endcondvals(:,j) is taken to be
the corresponding default value.

The default value for endcondvals(:,j) is the derivative of the cubic
interpolant at the nearest four sites in case conds(j) is 1, and is 0
otherwise.

It is also possible to handle gridded data, by having x be a cell array
containing m univariate meshes and, correspondingly, having y be an
m-dimensional array (or an m+r-dimensional array if the function is to
be r-valued). Correspondingly, conds is a cell array with m entries,

16-35



csape

Examples
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and end condition values may be correspondingly supplied in each of
the m variables. This, as the last example below, of bicubic spline
interpolation, makes clear, may require you to supply end conditions
for end conditions.

This command calls on a much expanded version of the Fortran routine
CUBSPL in PGS.

csape(x,y) provides the cubic spline interpolant with the Lagrange
end conditions, while csape(x,y,[2 2]) provides the variational,

or natural cubic spline interpolant, as does csape(x,y,'v').
csape([-1 1]1,[3 -1 1 6]1,[1 2]) provides the cubic polynomaial p
for which Dp(-1) = 3, p(-1) = -1, p(1) = 1, D?>p(1) = 6, i.e., p(x) = x°.
Finally, csape([-1 1]1,[-1 1]) provides the straight line p for which
p(x1l) = £1, 1.e., p(x) = x.

End conditions other than the ones listed earlier can be handled along
the following lines. Suppose that you want to enforce the condition

A(s) :=aDs(e) + szs(e) =c

for given scalars a, b, and ¢, and with e equal to x(1). Then one could
compute the cubic spline interpolant s, to the given data using the
default end condition as well as the cubic spline interpolant s, to zero
data and some (nontrivial) end condition at e, and then obtain the
desired interpolant in the form

s=s1+((c—2A)s1))/ Asg)sg

Here are the (not inconsiderable) details (in which the first polynomial
piece of s; and s, is pulled out to avoid differentiating all of s, and s):

% Data: x and y
[x, y] = titanium();

o°

Scalars a, b, and c
= _2;
= _1;

(o}
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c = 0;

o°

End condition at left
= X(1);

@

o°

The cubic spline interpolant s1 to the
given data using the default end
condition

1 = csape(x,Y);

o® o°

(]

o°

The cubic spline interpolant sO to

zero data and some (nontrivial) end

% condition at e

s0 = csape(x,[1,zeros(1,1length(y)),0],[1,0]1);

o°

% Compute the derivatives of the first
% polynomial piece of s1 and sO

ds1 = fnder(fnbrk(s1,1));

dso fnder(fnbrk(s0,1));

% Compute interpolant with desired end conditions
lam1 = a*fnval(dsi,e) + b*fnval(fnder(dsl),e);
lam0 = a*fnval(dsO,e) + b*fnval(fnder(ds0),e);

pp = fncmb(s0, (c-lam1)/lam0,s1);

Plot to see the results:

fnplt( pp, [594, 632] )

hold on

fnplt( s1, 'b--', [594, 632] )

plot( x, y, 'ro', 'MarkerFaceColor', 'r' )
hold off

axis( [594, 632, 0.62, 0.655] )

legend 'Desired end-conditions'

'‘Default end-conditions' 'Data’
Location SouthEast
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As a multivariate vector-valued example, here is a sphere, done as a
parametric bicubic spline, 3D-valued, using prescribed slopes in one
direction and periodic end conditions in the other:

x
|

= 0:4; y=-2:2; s2 = 1/sqrt(2);

v = zeros( 3, 7, 5 );

[10s21s20 -1].'"*[1 0 -1 0 1];
[10s21s20 -1].'"*[0 1 0 -1 0];
[01s20 -s2 -1 0]."*[1 111 1];

< <
IO
o

<
w
I}

sph = csape({x,y},v,{'clamped', 'periodic'});
values = fnval(sph,{0:.1:4,-2:.1:2});

surf( squeeze(values(1,:,:)),
squeeze(values(2,:,:)), squeeze(values(3,:,:)) );

axis equal
axis off

The lines involving fnval and surf could have been replaced by

the simple command: fnplt(sph). Note that v is a 3-dimensional
array, with v(:,i+1,j) the 3-vector to be matched at (x(i),y(j)),
i=1:5, j=1:5. Note further that, in accordance with conds{1} being
‘clamped', size(Vv,2) is 7 (and not 5), with the first and last entry of
v(r,:,j) specifying the end slopes to be matched.

Here is a bivariate example that shows the need for supplying end
conditions of end conditions when supplying end conditions in both
variables. You reproduce the bicubic polynomial g(x,y) = x*3y”3 by
complete bicubic interpolation. You then derive the needed data,
including end condition values, directly from g in order to make it
easier for you to see just how the end condition values must be placed.
Finally, you check the result.

sites = {[0 1],[0 2]}; coefs = zeros(4, 4); coefs(1,1) = 1;

g = ppmak(sites,coefs);
Dxg = fnval(fnder(g,[1 0]),sites);

16-38



csape

Algorithms

Cautionary
Note

See Also

Dyg = fnval(fnder(g,[0 1]),sites);
Dxyg = fnval(fnder(g,[1 1]),sites);

f = csape(sites,[Dxyg(1,1), Dxg(1,:), Dxyg(1,2);
Dyg(:,1), fnval(g,sites), Dyg(:,2) ;
Dxyg(2,1), Dxg(2,:), Dxyg(2,2)],

{'complete', 'complete'});
if any(squeeze(fnbrk(f,'c'))-coefs)
disp( 'this is wrong' )
end

The relevant tridiagonal linear system is constructed and solved using
the sparse matrix capabilities of MATLAB.

csape recognizes that you supplied explicit end condition values by the
fact that you supplied exactly two more data values than data sites. In
particular, even when using different end conditions at the two ends,
if you wish to supply an end condition value at one end, you must also
supply one for the other end.

csapi | spapi | spline
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Purpose

Syntax

Description

Examples
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Cubic spline interpolation

pp=csapi(x,y)
values = csapi(X,y,Xx)

pp=csapi(x,y) returns the ppform of a cubic spline s with knot
sequence X that takes the value y(:,j) at x(j) for j=1:1length(x).
The values y(:,j) can be scalars, vectors, matrices, even ND-arrays.
Data points with the same data site are averaged and then sorted by
their sites. With x the resulting sorted data sites, the spline s satisfies
the not-a-knot end conditions, namely jumpx(Z)D3s =0= jumpx(end_l)D?’s
(with D3s the third derivative of s).

If x is a cell array, containing sequences x1, ..., xm, of lengths n1, ..., nm
respectively, then y is expected to be an array, of size [n1,...,nm]

(or of size [d,n1,...,nm] if the interpolant is to be d-valued). In that
case, pp is the ppform of an m-cubic spline interpolant s to such data. In
particular, now s(x1(i,), ..., xm(i)) equals y(:,i, ..., i) for i; = Linl, ...,

i, = linm.

You can use the structure pp, in fnval, fnder, fnplt, etc, to evaluate,
differentiate, plot, etc, this interpolating cubic spline.

values = csapi(x,y,xx) 1isthe same as fnval(csapi(x,y),xx),le.,
the values of the interpolating cubic spline at the sites specified by
xx are returned.

This command is essentially the MATLAB function spline, which, in
turn, is a stripped-down version of the Fortran routine CUBSPL in PGS,
except that csapi (and now also spline) accepts vector-valued data and
can handle gridded data.

See the demo “Spline Interpolation” for various examples.

Up to rounding errors, and assuming that x is a vector with at least four
entries, the statement pp = csapi(x,y) should put the same spline
into pp as does the statement

pp = fn2fm(spapi(augknt(x([1 3:(end-2) end]),4),x,y), 'pp');
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except that the description of the spline obtained this second way will
use no break at x(2) and x(n-1).

Here 1s a simple bivariate example, a bicubic spline interpolant to the
Mexican Hat function being plotted:

X =.0001+[-4:.2:4]; y = -3:.2:83;
[yy,xx] = meshgrid(y,x); r = pi*sqrt(xx.”2+yy."2); z = sin(r)./r;
bcs = csapi( {x,y}, z ); fnplt( bcs ), axis([-5 5 -5 5 -.5 1])

Note the reversal of x and y in the call to meshgrid, needed because
MATLAB likes to think of the entry z(i,j) as the value at (x(j),y(1))
while this toolbox follows the Approximation Theory standard of
thinking of z(i,j) as the value at (x(i),y(j)). Similar caution has to
be exerted when values of such a bivariate spline are to be plotted with
the aid of the MATLAB mesh function, as is shown here (note the use of
the transpose of the matrix of values obtained from fnval).

xf = linspace(x(1),x(end),41); yf = linspace(y(1),y(end),41);
mesh(xf, yf, fnval( bcs, {xf, yf}).')

Algorithms The relevant tridiagonal linear system is constructed and solved, using
the MATLAB sparse matrix capability.

The not-a-knot end condition is used, thus forcing the first and
second polynomaial piece of the interpolant to coincide, as well as the
second-to-last and the last polynomial piece.

See Also csape | spapi | spline
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Description
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Cubic smoothing spline

pp = csaps(x,y)

csaps(x,y,p)

[...,p] = csaps(...)
csaps(x,y,p,[1,w)

values = csaps(X,y,p,XxX)
csaps(X,Y,P,XX,w)

[...] = csaps({x1,...,xm},y,...)

pp = csaps(x,y) returns the ppform of a cubic smoothing spline

f to the given data x,y, with the value of f at the data site x(j)
approximating the data value y(:,j), for j=1:1ength(x). The values
may be scalars, vectors, matrices, even ND-arrays. Data points with the
same site are replaced by their (weighted) average, with its weight the
sum of the corresponding weights.

This smoothing spline f minimizes

PY w(i|y, - FaI? +a- p[a@lD? fo)l? ae
j=1

Here, | z|? stands for the sum of the squares of all the entries of z, n is
the number of entries of x, and the integral is over the smallest interval
containing all the entries of x. The default value for the weight vector
w in the error measure is ones(size(x)). The default value for the
piecewise constant weight function A in the roughness measure is the
constant function 1. Further, D?f denotes the second derivative of the
function f. The default value for the smoothing parameter, p, is chosen
in dependence on the given data sites x.

If the smoothing spline is to be evaluated outside its basic interval, it
must first be properly extrapolated, by the command pp = fnxtr(pp),
to ensure that its second derivative is zero outside the interval spanned
by the data sites.
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csaps(x,y,p) lets you supply the smoothing parameter. The
smoothing parameter determines the relative weight you would like to
place on the contradictory demands of having f be smooth vs having f be
close to the data. For p = 0, fis the least-squares straight line fit to the
data, while, at the other extreme, 1.e., for p = 1, f is the variational, or
‘natural’ cubic spline interpolant. As p moves from 0 to 1, the smoothing
spline changes from one extreme to the other. The interesting range
for p is often near 1/(1 + A%/6), with h the average spacing of the data
sites, and it is in this range that the default value for p is chosen. For
uniformly spaced data, one would expect a close following of the data
for p = 1(1 + A%/60) and some satisfactory smoothing for p = 1/(1 +
h3/0.6). You can input a p > 1, but this leads to a smoothing spline even
rougher than the variational cubic spline interpolant.

If the input p is negative or empty, then the default value for p is used.

[...,p] = csaps(...) also returns the value of p actually used
whether or not you specified p. This is important for experimentation
which you might start with [pp,p]l=csaps(x,y) in order to obtain a
‘reasonable’ first guess for p.

If you have difficulty choosing p but have some feeling for the size of
the noise in y, consider using instead spaps(x,y,tol) which, in effect,
chooses p in such a way that the roughness measure

| 0| D2s)|2de

1s as small as possible subject to the condition that the error measure

S w(D]yC, ) -s(x())?

does not exceed the specified tol. This usually means that the error
measure equals the specified tol.

The weight function A in the roughness measure can, optionally, be

specified as a (nonnegative) piecewise constant function, with breaks at
the data sites x , by inputing for p a vector whose ith entry provides the
value of A on the interval (x (i-1) .. x(i)) for i=2:1ength(x). The first
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entry of the input vector p continues to be used as the desired value of
the smoothness parameter p. In this way, it is possible to insist that the
resulting smoothing spline be smoother (by making the weight function
larger) or closer to the data (by making the weight functions smaller)
in some parts of the interval than in others.

csaps(x,y,p,[1,w) lets you specify the weights w in the error
measure, as a vector of nonnegative entries of the same size as x.

values = csaps(x,y,p,xx) isthe same as fnval(csaps(x,y,p),Xx).
csaps(x,y,p,xx,w) is the same as fnval(csaps(x,y,p,[]1,W),Xxx).

[...]1 = csaps({x1,...,xm},y,...) provides the ppform of an
m-variate tensor-product smoothing spline to data on a rectangular
grid. Here, the first argument is a cell-array, containing the vectors
x1, ..., xm, of lengths n1, ..., nm, respectively. Correspondingly, y is an
array of size [n1,...,nm] (or of size [d,n1,...,nm] in case the data
are d-valued), with y(;,i;, ...,i,)) the given (perhaps noisy) value at the
grid site x1(z,), ...,xm(,).

In this case, p if input must be a cell-array with m entries or else an
m-vector, except that it may also be a scalar or empty, in which case it
is taken to be the cell-array whose m entries all equal the p input. The
optional second output argument will always be a cell-array with m
entries.

Further, w if input must be a cell-array with m entries, with w{i} either
empty, to indicate the default choice, or else a nonnegative vector of
the same size as xi.

Example 1.

x = linspace(0,2*pi,21); y = sin(x)+(rand(1,21)-.5)*.1;
pp = csaps(x,y, .4, [], [ones(1,10), repmat(5,1,10), O]

returns a smooth fit to the (noisy) data that is much closer to the data
in the right half, because of the much larger error weight there, except
for the last data point, for which the weight is zero.
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pp1 = csaps(x,y, [.4,0ones(1,10),repmat(.2,1,10)1, [1,
[ones(1,10), repmat(5,1,10), 0]);

uses the same data, smoothing parameter, and error weight but chooses
the roughness weight to be only .2 in the right half of the interval and
gives, correspondingly, a rougher but better fit there, except for the
last data point, which is ignored.

A plot showing both examples for comparison can now be obtained by

fnplt(pp); hold on, fnplt(ppl,'r--'), plot(x,y,'ok'), hold off
title(['cubic smoothing spline, with right half treated ',...
‘differently:'])
xlabel([ 'blue: larger error weights; ',
‘red dashed: also smaller roughness weights'])

The resulting plot is shown below.

cubic smoothing spline, with right half treated differently:
15 T T T T

-15 L L L L I I
0 1

blue: larger error weights; red dashed: also smaller roughness weights
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Example 2. This bivariate example adds some uniform noise, from
the interval [-1/2 .. 1/2], to values of the MATLAB peaks function on

a 51-by-61 uniform grid, obtain smoothed values for these data from
csaps, along with the smoothing parameters chosen by csaps, and then
plot these smoothed values.

{linspace(-2,3,51),linspace(-3,3,61)};
[xx,yy] = ndgrid(x{1},x{2}); y = peaks(xx,yy);
rand('state',0), noisy = y+(rand(size(y))-.5);
[smooth,p] = csaps(x,noisy,[],X);
surf(x{1},x{2},smooth."'), axis off

Note the need to transpose the array smooth. For a somewhat smoother
approximation, use a slightly smaller value of p than the one, .9998889,
used above by csaps. The final plot is obtained by the following:

smoother = csaps(x,noisy, .996,X);
figure, surf(x{1},x{2},smoother.'), axis off
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Algorithms

See Also
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csaps is an implementation of the Fortran routine SMOOTH from PGS.

The default value for p is determined as follows. The calculation of
the smoothing spline requires the solution of a linear system whose
coefficient matrix has the form p*A + (1-p)*B, with the matrices A
and B depending on the data sites x. The default value of p makes
p*trace(A) equal (1-p)*trace(B).

csape | spap2 | spaps | tpaps
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“Natural” or eriodic inter olatin cubic S line curve
p p g p v
curve = cscvn(points)

curve = cscvn(points) returns a parametric variational, or natural,
cubic spline curve (in ppform) passing through the given sequence
points(y), j = 1:end. The parameter value ¢(j) for the jth point is chosen
by Eugene Lee’s [1] centripetal scheme, i.e., as accumulated square
root of chord length:

2 \/"points(:,i +1) — points (:,7)[|y

i<j

If the first and last point coincide (and there are no other repeated
points), then a periodic cubic spline curve is constructed. However,
double points result in corners.

The following provides the plot of a questionable curve through some
points (marked as circles):

points=[0 1 10 -1 -1 00; 001210 -1 -2];

fnplt(cscvn(points)); hold on,
plot(points(1,:),points(2,:),'o"'), hold off

Here is a closed curve, good for 14 February, with one double point:

c=fnplt(cscvn([0O .82 .92 0 0 -.92 -.82 0; .66 .9 0 ...
-.83 -.83 0 .9 .66]1)); fill(c(1,:),c(2,:),'r"'), axis equal

The break sequence t is determined as
t = cumsum([O; ((diff(points.')."2)*ones(d,1)).~(1/4)1).";

and csape (with either periodic or variational end conditions) is used to
construct the smooth pieces between double points (if any).
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References [1] E. T. Y. Lee. “Choosing nodes in parametric curve interpolation.”
Computer-Aided Design 21 (1989), 363-370.

See Also csape | fnplt | getcurve
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Data statistics

xds = datastats(x)
[xds,yds] = datastats(x,y)

xds = datastats(x) returns statistics for the column vector x to the
structure xds. Fields in xds are listed in the table below.

Field Description

num The number of data values

max The maximum data value

min The minimum data value

mean The mean value of the data
median The median value of the data
range The range of the data

std The standard deviation of the data

[xds,yds] = datastats(x,y) returns statistics for the column vectors
x and y to the structures xds and yds, respectively. xds and yds contain
the fields listed in the table above. x and y must be of the same size.

If x or y contains complex values, only the real parts are used in
computing the statistics. Data containing Inf or NaN are processed
using the usual MATLAB rules.

Compute statistics for the census data in census.mat:

load census
[xds,yds] = datastats(cdate,pop)

xds =
num: 21
max: 1990
min: 1790
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mean:
median:
range:
std:

num:
max:
min:
mean:
median:
range:
std:

See Also

1890
1890
200
62.048

21
248.7
3.9
85.729
62.9
244.8
78.601

excludedata, smooth
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Purpose
Syntax

Description

Examples

See Also
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Dependent variable of cfit, sfit, or fittype object

dep = dependnames(fun)

dep = dependnames(fun) returns the (single) dependent variable
name of the cfit, sfit, or fittype object fun as a 1-by-1 cell array
of strings dep.

f1 = fittype('a*x"2+b*exp(n*x)"');
dep1t dependnames (1)
dep1

y

f2 = fittype('a*x"2+b*exp(n*x) "', 'dependent', 'power');
dep2 = dependnames(f2)
dep2

"power’

indepnames | fittype | formula
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Purpose

Syntax

Description

Differentiate cfit or sfit object

fx = differentiate(FO, X)

[fx, fxx] = differentiate(...)

[fx, fyl differentiate(FO, X, Y)

[fx, fy] = differentiate(FO, [x, V])

[fx, fy, fxx, fxy, fyy] = differentiate(FO, ...)

For Curves

fx = differentiate(FO, X) differentiates the cfit object FO at the
points specified by the vector X and returns the result in fx.

[fx, fxx] = differentiate(...) also returns the second derivative
in fxx.

All return arguments are the same size and shape as X.
For Surfaces

[fx, fy] = differentiate(FO, X, Y) differentiates the surface FO
at the points specified by X and Y and returns the result in fx and fy.

FO is a surface fit (sfit) object generated by the fit function.

X and Y must be double-precision arrays and the same size and shape as
each other.

All return arguments are the same size and shape as X and Y.

If FO represents the surface z = f(x,y), then FX contains the derivatives
. . df . .. )
with respect to x, that is, Ix and FY contains the derivatives with
x

respect to y, that is, ?

[fx, fy] = differentiate(FO, [x, y]), where X and Y are column
vectors, allows you to specify the evaluation points as a single argument.

[fx, fy, fxx, fxy, fyy] = differentiate(FO, ...) computes the
first and second derivatives of the surface fit object FO.
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fxx contains the second derivatives with respect to x, that is, —=.

o%f
oxc2

O*f
oxdy

fxy contains the mixed second derivatives, that is,

2
fyy contains the second derivatives with respect to y, that is, g—g .
y
Tips For library models with closed forms, the toolbox calculates derivatives
analytically. For all other models, the toolbox calculates the first
derivative using the centered difference quotient

%z flx+ Ax) — fx — Ax)
dx 2Ax

where x i1s the value at which the toolbox calculates the derivative, Ax

(x + Ax)

is a small number (on the order of the cube root of eps), f is fun

evaluated at ¥ +A% and fla—xA) is fun evaluated at * —Ax

The toolbox calculates the second derivative using the expression

d’f _ [+ Ax) + flx = Ax) + 2 (x)

dx? (Ax)?
The toolbox calculates the mixed derivative for surfaces using the
expression
a2f (x.y) = flx+Ax,y+Ay)—flx—Ax,y +Ay) — f(x + Ax,y — Ay) + f(x — Ax, y — Ay)
oxdy 4AxAy
Examples For Curves

Create a baseline sinusoidal signal:
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xdata = (0:.1:2*pi)"';
y0 = sin(xdata);

Add noise to the signal:

noise = 2*y0.*randn(size(y0)); % Response-dependent
% Gaussian noise
ydata = y0 + noise;

Fit the noisy data with a custom sinusoidal model:

f = fittype('a*sin(b*x)"');
fit1 = fit(xdata,ydata,f, 'StartPoint',[1 1]);

Find the derivatives of the fit at the predictors:

[d1,d2] = differentiate(fitl,xdata);

Plot the data, the fit, and the derivatives:

subplot(3,1,1)

plot(fitl1,xdata,ydata) % cfit plot method
subplot(3,1,2)

plot(xdata,d1,'m') % double plot method
grid on

legend('1st derivative')

subplot(3,1,3)

plot(xdata,d2,'c') % double plot method
grid on

legend('2nd derivative')

16-55



differentiate
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You can also compute and plot derivatives directly with the cfit plot
method, as follows:

plot(fit1,xdata,ydata,{'fit', 'derivi"', 'deriv2'})

The plot method, however, does not return data on the derivatives,
unlike the differentiate method.
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For Surfaces

You can use the differentiate method to compute the gradients of a
fit and then use the quiver function to plot these gradients as arrows.
The following example plots the gradients over the top of a contour plot.

X = [0.64;0.95;0.21;0.71;0.24;0.12;0.61;0.45;0.46; ...
0.66;0.77;0.35;0.66];

y = [0.42;0.84;0.83;0.26;0.61;0.58;0.54;0.87;0.26;...
0.32;0.12;0.94;0.65];

z = [0.49;0.051;0.27;0.59;0.35;0.41;0.3;0.084;0.6;...
0.58;0.37;0.19;0.191];

fo = fit( [x, yl, z, 'poly32', 'normalize', 'on' );
[xx, yy] = meshgrid( 0:0.04:1, 0:0.05:1 );

[fx, fy] = differentiate( fo, xx, yy );

plot( fo, 'Style’, 'Contour' );

hold on

h = quiver( xx, yy, fx, fy, 'r', 'LineWidth', 2 );
hold off

colormap( copper )
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0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9

If you want to use derivatives in an optimization, you can, for example,
implement an objective function for fmincon as follows.

function [z, g, H] = objectiveWithHessian( xy )

% The input xy represents a single evaluation point

z=f(xy);

if nargout > 1
[fx, fy, fxx, fxy, fyy]l = differentiate( f, xy );
g = [fx, fyl;
H = [fxx, fxy; fxy, fyyl;

end

end

See Also fit | plot | integrate
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Purpose Exclude data from fit
Syntax outliers = excludedata(xdata,ydata,MethodName,MethodValue)
Descripl‘ion outliers = excludedata(xdata,ydata,MethodName ,MethodValue)

identifies data to be excluded from a fit using the specified MethodName
and MethodValue. outliers is a logical vector, with 1 marking
predictors (xdata) to exclude and 0 marking predictors to include.
Supported MethodName and MethodValue pairs are given in the table
below.

MethodName MethodValue

"box' A four-element vector specifying the edges of a closed
box in the xy-plane, outside of which data is to be
excluded from a fit. The vector has the form [xmin
xmax ymin ymax].

"domain' A two-element vector specifying the endpoints of a
closed interval on the x-axis, outside of which data is
to be excluded from a fit. The vector has the form
[xmin xmax].

'indices' A vector of indices specifying the data points to be
excluded.
'range’ A two-element vector specifying the endpoints of a

closed interval on the y-axis, outside of which data is
to be excluded from a fit. The vector has the form
[ymin ymax].

Tips You can combine data exclusion rules using logical operators. For
example, to exclude data inside the box [-1 1 -1 1] or outside the
domain [-2 2], use:

outliers1i = excludedata(xdata,ydata, 'box',[-1 1 -1 1]);
outliers2 = excludedata(xdata,ydata, 'domain',[-2 2]);
outliers = ~outliersi|outliers2;
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You can visualize the combined exclusion rule using random data:

xdata -3 + 6*rand(1,1e4);

ydata = -3 + 6*rand(1,1e4);
plot(xdata(~outliers),ydata(~outliers),'.")
axis ([-3 3 -3 3])

axis square

3 2 0 1 2 3

Examples Load the vote counts and county names for the state of Florida from
the 2000 U.S. presidential election:

load flvote2k

Use the vote counts for the two major party candidates, Bush and Gore,
as predictors for the vote counts for third-party candidate Buchanan,
and plot the scatters:

plot(bush,buchanan,'rs')
hold on
plot(gore,buchanan, 'bo")
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legend('Bush data', 'Gore data')
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Assume a model where a fixed proportion of Bush or Gore voters choose
to vote for Buchanan:

f
f =

fittype({'x'})

Linear model:
f(a,x) = a*x

Exclude the data from absentee voters, who did not use the controversial
“butterfly” ballot:

absentee = find(strcmp(counties, 'Absentee Ballots'));
nobutterfly = excludedata(bush,buchanan,...
'indices',absentee);

Perform a bisquare weights robust fit of the model to the two data sets,
excluding absentee voters:
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bushfit

fit(bush,buchanan,f,...

"Exclude’ ,nobutterfly, 'Robust','on');
gorefit = fit(gore,buchanan,f,...
"Exclude’ ,nobutterfly, 'Robust','on');

Robust fits give outliers a low weight, so large residuals from a robust
fit can be used to identify the outliers:

figure
plot(bushfit,bush,buchanan,'rs', 'residuals')
hold on
plot(gorefit,gore,buchanan, 'bo', 'residuals')
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The residuals in the plot above can be computed as follows:

bushres = buchanan - feval(bushfit,bush);
goreres = buchanan - feval(gorefit,gore);

Large residuals can be identified as those outside the range [ -500 500]:
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bushoutliers = excludedata(bush,bushres,...

'range',[-500 500]);
goreoutliers = excludedata(gore,goreres,...

‘range',[-500 500]);

The outliers for the two data sets correspond to the following counties:

counties(bushoutliers)
ans =

'‘Miami-Dade’

'Palm Beach'

counties(goreoutliers)
ans =
'‘Broward’
'‘Miami-Dade’
'Palm Beach'

Miami-Dade and Broward counties correspond to the largest predictor
values. Palm Beach county, the only county in the state to use the
“butterfly” ballot, corresponds to the largest residual values.

See Also fit | fitoptions
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Purpose

Syntax

Tips

Description
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Evaluate cfit, sfit, or fittype object

y = feval(cfun,x)

z = feval(sfun,[x,y])

z = feval(sfun,x,y)

y = feval(ffun,coeffi,coeff2,...,x)

z = feval(ffun,coeffl1,coeff2,...,x,y)

You can also treat fit objects as functions and call feval indirectly
using the following syntax:

y = cfun(x) % cfit objects;

z = sfun(x,y) % sfit objects

z = sfun([x, y]) % sfit objects

y = ffun(coefi1,coef2,...,x) % curve fittype objects;

z = ffun(coefl1,coef2,...,x,y) % surface fittype objects;

This simpler syntax is recommended to evaluate these objects, instead
of calling feval directly.

Use the feval method to evaluate the estimated function, either at your
original data points, or at new locations. The latter is often referred to
as interpolation or prediction, depending on the type of model. You can
also use feval to extrapolate the estimated function’s value at new
locations that are not within the range of the original data.

y = feval(cfun,x) evaluates the cfit object cfun at the predictor
values in the column vector x and returns the response values in the
column vector vy.

z = feval(sfun,[x,y]) evaluates the sfit object sfun at the predictor
values in the two column matrix [x,y] and returns the response values
in the column vector z.

z = feval(sfun,x,y) evaluates the sfit object sfun at the predictor
values in the matrices x and y that must be the same size. It
returns the response values in the matrix z that will be the same size
as x and y.
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y = feval(ffun,coeff1,coeff2,...,x) assigns the coefficients
coeff1, coeff2, etc. to the fittype object ffun, evaluates it at the
predictor values in the column vector x, and returns the response values
in the column vector y. ffun cannot be a cfit object in this syntax. To
evaluate cfit objects, use the first syntax.

z = feval(ffun,coeffi,coeff2,...,x,y) achieves a similar result
for a fittype object for a surface.

Examples f = fittype('a*x"2+b*exp(n*x)"');
c = cfit(f,1,10.3,-1e2);
X = rand(2)
X =
0.0579 0.8132
0.3529 0.0099
y1 = feval(f,1,10.3,-1e2,X)
y1 =

0.0349  0.6612
0.1245  3.8422
y1 = £(1,10.3,-1e2,X)
y1 =
0.0349  0.6612
0.1245  3.8422

y2 feval(c,X)
0.0349
0.1245
0.6612
3.8422

y2 = c(X)

y2 =
0.0349
0.1245
0.6612
3.8422
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See Also fit | fittype | cfit
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Purpose

Syntax

Description

Fit curve or surface to data

fitobject = fit
fitobject = fit
fitobject = fit
fitobject = fit
fitobject = fit

x,y,fitType)

[x,y],z, fitType)

..., Name, Value,...)
X,Y,libname,options)

..., problem',vals)

fitobject = fit(x,y,fitType,..., 'Weight', Weights)
[fitobject,gof] = fit(...)

[cfun,gof,output] = fit(...)

~ e~~~ o~ o~

fitobject = fit(x,y,fitType) fits the data in x and y with the
library model, anonymous function or fittype object specified by
fitType.

® x must be a matrix with either one (curve fitting) or two (surface
fitting) columns. For surface fitting, if your data is in separate
vectors, then you can use the syntax: fitobject = fit([x,y],z,
fitType).

® y must be a column vector with the same number of rows as x.

¢ x and y cannot contain Inf or NaN. Only the real parts of complex
data are used in the fit.

e fitType can be a string, anonymous function, or a fittype object
specifying the model to fit. If a string, you can specify library model
names. String choices include:

LIBNAME DESCRIPTION

‘polyt!’ Linear polynomial curve

‘poly11’ Linear polynomial surface

‘poly2’ Quadratic polynomial curve
‘linearinterp’ Piecewise linear interpolation
‘cubicinterp’ Piecewise cubic interpolation
"smoothingspline' Smoothing spline (curve)

"lowess'’ Local linear regression (surface)
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or any of the names of library models described in cflibhelp. Type
cflibhelp to display names and descriptions of all library models.

To fit custom models, use an anonymous function or create a fittype
with the fittype function and use this as the fitType argument.

e fitobject is the fit result, a cfit (for curves) or sfit (for surfaces)
object.

fitobject = fit(..., Name, Value,...) fits the data using the
problem and algorithm options specified in the name-value pair
arguments . You can display the supported property names and default
values for specific library models with the fitoptions function. For
example:

fitoptions( 'cubicinterp' )
fitoptions( 'poly1' )

fitobject = fit(x,y,libname,options) fits the data using the
algorithm options specified by the fitoptions object options. This is
an alternative syntax to specifying the property-value pairs. For help
on constructing options, see the fitoptions function.

fitobject = fit(...,'problem',vals) assigns vals to the
problem-dependent constants. vals is a cell array with one element
per problem dependent constant. See fittype for more information
on problem dependent constants.

fitobject = fit(x,y,fitType,..., 'Weight', Weights) creates a
weighted fit using the given Weights. Weights must be a vector the
same size asy.

[fitobject,gof] = fit(...) returns goodness-of-fit statistics to
the structure gof. The gof structure includes the fields shown in the
table below.
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Field Value

sse Sum of squares due to error

R2 Coefficient of determination

adjustedR2 Degree-of-freedom adjusted coefficient of
determination

stdError Root mean squared error (standard error)

[cfun,gof,output]

fit(...) returns the structure output, which

contains information associated with the fitting algorithm. Fields
depend on the algorithm. For example, the output structure for
nonlinear least-squares algorithms has the fields shown in the table

below.

Field Value

numobs Number of observations (response values)

numparam Number of unknown parameters (coefficients)
to fit

residuals Vector of residuals

Jacobian Jacobian matrix

exitflag Describes the exit condition of the algorithm.
Positive flags indicate convergence, within
tolerances. Zero flags indicate that the
maximum number of function evaluations
or iterations was exceeded. Negative flags
indicate that the algorithm did not converge
to a solution.

iterations Number of iterations

funcCount Number of function evaluations

firstorderopt Measure of first-order optimality (absolute
maximum of gradient components)

algorithm Fitting algorithm employed
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For rational and Weibull models, and all custom nonlinear models,
the toolbox selects default initial values for coefficients uniformly at
random from the interval (0,1).

As a result, multiple fits using the same data and model may lead
to different fitted coefficients. To avoid this, specify initial values
for coefficients with fitoptions structure or a vector value for the
StartPoint property.

Fit a cubic interpolating spline through x and y:

[curve, goodness] = fit( x, y, 'pchipinterp' );

Fit a polynomial surface of degree 2 in x and degree 3 in y using the
least absolute residual robust (LAR) method:

sf = fit( [x, yl, z, 'poly23', 'Robust', 'LAR' );

Fit the 1st equation in the curve fitting library of exponential models (a
single-term exponential), overriding the starting point to be pO:

curve = fit( x, y, 'exp1l', 'StartPoint', p0 );

Load data and fit using an anonymous function:

1 Load data and set Emax to 1 before defining your anonymous function:

data = importdata( 'OpioidHypnoticSynergy.txt' );
Propofol = data.data(:,1);

Remifentanil = data.data(:,2);
Algometry = data.data(:,3);
Emax = 1;
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2 Define the model equation as an anonymous function:

Effect = @(IC50A, IC50B, alpha, n, x, y) ...
Emax*( x/IC50A + y/IC50B + alpha*( x/IC50A )...
.* (y/IC50B ) ).”n ./(( x/IC50A + y/IC50B + ...
alpha*( x/IC50A ) .* ( y/IC50B ) ).”"n + 1);

3 Use the anonymous function Effect as an input to the fit function,
and plot the results:

AlgometryEffect = fit( [Propofol, Remifentanil], Algometry, Effec
‘StartPoint', [2, 10, 1, 0.8],
'Lower', [-Inf, -Inf, -5, -Inf],
'Robust', 'LAR' )

plot( AlgometryEffect, [Propofol, Remifentanil], Algometry )

See “Biopharmaceutical Interactive Surface Fitting Example” on
page 3-22 for more information on this example.

Load and plot data, create fit options and fit type, then create and
plot fit:

1 Load and plot the data in census.mat:
load census

plot(cdate,pop,'0"')
hold on
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2 Create a fit options structure and a fittype object for the custom
nonlinear model y = a(x—b)", where a and b are coefficients and n is a
problem-dependent parameter:

S fitoptions('Method', 'NonlinearlLeastSquares',...
"Lower',[0,0],...
"Upper',[Inf,max(cdate)],...
'Startpoint',[1 1]);

f = fittype('a*(x-b)"n', 'problem','n', 'options',s);
3 Fit the data using the fit options and a value of n = 2:

[c2,g0f2] = fit(cdate,pop,f, ' 'problem',2)
c2 =
General model:
c2(x) = a*(x-b)"n
Coefficients (with 95% confidence bounds):
a = 0.006092 (0.005743, 0.006441)
b = 1789 (1784, 1793)
Problem parameters:
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sse: 246.1543
rsquare: 0.9980
dfe: 19
adjrsquare: 0.9979

rmse: 3.5994

4 Fit the data using the fit options and a value of n = 3:

[c3,90f3] = fit(cdate,pop,f, 'problem',3)

c3 =
General model:
c3(x) = a*(x-b)"n
Coefficients (with 95% confidence bounds):
a = 1.359e-005 (1.245e-005, 1.474e-005)
b = 1725 (1718, 1731)
Problem parameters:
n = 3
gof3 =

sse: 232.0058
rsquare: 0.9981
dfe: 19
adjrsquare: 0.9980

rmse: 3.4944

5 Plot the fit results with the data:

plot(c2,'m")
plot(c3,'c')
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See Also cflibhelp | fittype | fitoptions | feval | plot
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Purpose

Syntax

Description

Create or modify fit options structure

options =
options =
options =
options =
options

fitoptions

fitoptions(model)
fitoptions(model,fldi,vall,fld2,val2,...)
fitoptions('Method',method)

fitoptions('Method',method,fld1,vall,fld2,val2,...)

newoptions
newoptions

options =

= fitoptions(options,fldi,vall,fld2,val2,...)
fitoptions(optionsi,options2)

fitoptions creates the default fit options structure

options. Properties in the options structure, listed in the table below
with their default values, are supported by all fitting methods.

Property

Name Values

Normalize | Specifies whether the data is centered and scaled.
Values are 'off' or 'on'. The default is 'off"'.

Exclude A logical vector indicating data points to exclude from
the fit. The excludedata function can be used to create
this vector. The default is empty.

Weights A vector of weights the same size as the response data.

The default is empty.
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Property

Name Values

Method The fitting method. A complete list of supported fitting
methods is given below. The default is 'None"'.
'NearestInterpolant' Nearest neighbor

interpolation

'LinearInterpolant' Linear interpolation
'"PchipInterpolant’ Piecewise cubic Hermite

interpolation (curves only)

'CubicSplineInterpolant| Cubic spline interpolation

'BiharmonicInterpolant' | Biharmonic surface

interpolation
'SmoothingSpline’ Smoothing spline
'LowessFit!' Lowess smoothing

(surfaces only)

'LinearLeastSquares' Linear least squares

'NonlinearlLeastSquares' | Nonlinear least squares

options = fitoptions(model) creates the default fit options structure
for the library or custom model specified by the string model. You can
display library model names with the cflibhelp function.

options = fitoptions(model,fld7,vall,fld2,val2,...) creates
a fit options structure for the specified model with the properties
specified by the strings f1d1, f1d2, ... set to the values vali, val2,
..., respectively.

options = fitoptions('Method',method) creates the default fit
options structure for the fitting method specified by the string method.
Supported fitting methods are listed in the table above.

options =
fitoptions('Method',method,fld1,vall,fld2,val2,...) creates
the default fit options structure for the fitting method specified by the
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Tips

string method with the properties specified by the strings f1d17, f1d2, ...
set to the values vali, val2, ..., respectively.

newoptions = fitoptions(options,fldi,vall,fld2,val2,...)
modifies the existing fit options structure options by setting the
properties specified by the strings f1d7, f1d2, ... set to the values
vali, val2, ..., respectively. The new options structure is returned in
newoptions.

newoptions = fitoptions(optionsi,options2) combines the input
fit options structures options1 and options2 to create the output fit
options structure newoptions. If the input structures have Method
properties set to the same value, the nonempty values for the properties
in options2 override the corresponding values in options1 in the
output structure. If the input structures have Method properties set

to different values, the output structure will have the same Method

as options1, and only the values of the Normalize, Exclude, and
Weights properties of options2 will override the corresponding values
in optionsi.

Property values in a fit options structure can be referenced with the get
method and assigned with the set method. For example:

options = fitoptions('fouriert');
get(options, '‘Method')
ans =
NonlinearlLeastSquares
get(options, 'MaxIter')
ans =

400
set(options, 'Maxiter',1e3);
get(options, 'MaxIter')
ans =

1000

Property values can also be referenced and assigned using the dot
notation. For example:
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options.MaxIter
ans =
1000
options.MaxIter = 500;
options.MaxIter
ans =
500

Additional Fit Options

Some fitting methods have additional properties in the fit options
structure, beyond the default properties Normalize, Exclude, Weights,
and Method.

There are no additional parameters if Method is:

® 'NearestInterpolant'
® 'LinearInterpolant’

e 'PchipInterpolant'

‘CubicSplineInterpolant’

‘BiharmonicInterpolant'

If the Method is SmoothingSpline, the SmoothingParam property is
available to configure the smoothing parameter. Its value must be
between 0 and 1. The default value depends on the data set.

If the Method is LowessFit, then the Span property is available to
configure the proportion of data points to be used in local regressions. It
must be a scalar in [0,1], and the default is 0.25.

If the Method property has the value LinearLeastSquares, the
additional properties available in the fit options structure are listed
in the table below.
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Property

Description

Robust

Specifies the robust linear least-squares fitting
method to be used. Values are 'on', 'off', 'LAR',
or 'Bisquare'. The default is 'off'. 'LAR'
specifies the least absolute residual method and
'Bisquare' specifies the bisquare weights method.
'on' is equivalent to 'Bisquare’, the default
method.

Lower

A vector of lower bounds on the coefficients to

be fitted. The default value is an empty vector,
indicating that the fit is unconstrained by lower
bounds. If bounds are specified, the vector length
must equal the number of coefficients. Individual
unconstrained lower bounds can be specified by
-Inf.

Upper

A vector of upper bounds on the coefficients to

be fitted. The default value is an empty vector,
indicating that the fit is unconstrained by upper
bounds. If bounds are specified, the vector length
must equal the number of coefficients. Individual
unconstrained upper bounds can be specified by Inf.

If the Method property has the value NonlinearLeastSquares, the
additional properties available in the fit options structure are listed
in the table below.

16-79



fitoptions

Property

Description

Robust

Specifies the robust linear least-squares
fitting method to be used. Values are 'on',
‘off', 'LAR', or 'Bisquare'. The default

is 'off'. 'LAR' specifies the least absolute
residual method and 'Bisquare' specifies the
bisquare weights method. 'on' is equivalent
to 'Bisquare’, the default method.

Lower

A vector of lower bounds on the coefficients
to be fitted. The default value is an empty
vector, indicating that the fit is unconstrained
by lower bounds. If bounds are specified,

the vector length must equal the number of
coefficients. Individual unconstrained lower
bounds can be specified by -Inf.

Upper

A vector of upper bounds on the coefficients
to be fitted. The default value is an empty
vector, indicating that the fit is unconstrained
by upper bounds. If bounds are specified,

the vector length must equal the number of
coefficients. Individual unconstrained upper
bounds can be specified by Inf.

StartPoint

A vector of initial values for the coefficients.
The default value of StartPoint is an empty
vector. If the default value is passed to

the fit function, starting points for some
library models are determined heuristically.
For other models, the values are selected
uniformly at random on the interval (0,1).

Algorithm

The algorithm used for the fitting procedure.
Values are 'Levenberg-Marquardt',
'Gauss-Newton', or 'Trust-Region'. The
default is 'Trust-Region'.
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Property Description

DiffMaxChange The maximum change in coefficients for finite
difference gradients. The default is 0.1.

DiffMinChange The minimum change in coefficients for finite
difference gradients. The default is 10-5.

Display Controls the display in the command window.
‘notify', the default, displays output only if
the fit does not converge. 'final' displays
only the final output. 'iter' displays output
at each iteration. 'off' displays no output.

MaxFunEvals The maximum number of evaluations of the
model allowed. The default is 600.

MaxIter The maximum number of iterations allowed
for the fit. The default is 400.

TolFun The termination tolerance on the model value.
The default is 106,

TolX The termination tolerance on the coefficient

values. The default is 1075.

16-81



fitoptions

Note For the properties Upper, Lower, and StartPoint, the order of
the entries in the vector value is the order of the coefficients returned
by the coeffnames method. For example, if

f = fittype('b*x"2+c*x+a');
coeffnames(T)
ans =

g

"y

o

then setting

options.StartPoint = [1 3 5];

assigns initial values to the coefficients as follows: a = 1, b = 3,¢c =
5. Note that this is not the order of the coefficients in the expression
used to create f with fittype.

Examples Create the default fit options structure and set the option to center
and scale the data before fitting:

options = fitoptions;
options.Normal = 'on';
options
options =
Normalize: 'on'
Exclude: [1x0 double]
Weights: [1x0 double]
Method: 'None’

Modifying the default fit options structure is useful when you want
to set the Normalize, Exclude, or Weights properties, and then fit
your data using the same options with different fitting methods. For
example:
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Examples

load census

f1 = fit(cdate,pop, 'poly3',options);
f2 fit(cdate,pop, 'expl1',options);

3 fit(cdate,pop, 'cubicsp',options);

Data-dependent fit options are returned in the third output argument
of the fit function. For example:

[f,g0f,out]

smoothparam

smoothparam =
0.0089

fit(cdate,pop, 'smooth');
out.p

The default smoothing parameter can be modified for a new fit:

options = fitoptions('Method', 'Smooth',...
‘SmoothingParam',0.0098);
[f,gof,out] = fit(cdate,pop, 'smooth',options);

Create a noisy sum of two Gaussian peaks—one with a small width,
and one with a large width:

al = 1; bt = -1; c1 = 0.05;

a2 = 1; b2 = 1; c2 = 50;

X = (-10:0.02:10) ';

gdata = at*exp(-((x-b1)/c1).72) + ...
a2*exp(-((x-b2)/c2).72) + ...
0.1*(rand(size(x))-.5);

plot(x,gdata)
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Fit the data using the two-term Gaussian library model:

f = fittype('gauss2');
gfit = fit(x,gdata,f)
gfit =
General model Gauss2:
gfit(x) = at*exp(-((x-b1)/c1)"2) +
a2*exp(-((x-b2)/c2)"2)
Coefficients (with 95% confidence bounds):

al = -0.05388 (-0.136, 0.02826)
b1 = -2.651 (-2.718, -2.584)
cl = 0.05373 (-0.04106, 0.1485)
a2 = 1.012 (1.006, 1.018)

b2 = 0.6703 (0.06681, 1.274)
c2 = 41.2 (36.54, 45.85)

The algorithm is having difficulty, as indicated by the wide confidence
intervals for some of the coefficients. To help the algorithm, we could
specify lower bounds for the nonnegative amplitudes a1, a2 and widths
c1, c2:
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options = fitoptions('gauss2');
options.Lower = [0 -Inf O O -Inf 0];

Recompute the fit with the bound constraints on the coefficients:

gfit = fit(x,gdata,ftype,options)
gfit =
General model Gauss2:
gfit(x) = at*exp(-((x-b1)/c1)"2) +
a2*exp(-((x-b2)/c2)"~2)
Coefficients (with 95% confidence bounds):

al = 1.003 (0.9641, 1.042)

b1 = -1 (-1.002, -0.9987)
cl = 0.04972 (0.04748, 0.05197)
a2 = 1.002 (0.999, 1.004)

b2 = 1.136 (0.725, 1.547)

c2 = 48.89 (45.32, 52.47)

This is a much better fit. The fit can be further improved by assigning
reasonable values to other properties in the fit options structure.

See Also cflibhelp | fit | get | set | setoptions
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Purpose

Syntax

Description

16-86

Fit type for curve and surface fitting

ffun = fittype(libname)

ffun = fittype(expr)

ffun = fittype({expri,...,exprn})

ffun = fittype(expr, Name, Value,...)

ffun = fittype({expri,...,exprn}, Name, Value,...)

ffun = fittype(libname) constructs the fittype object ffun for the

library model specified by 1ibname. Display library model names using
the cflibhelp function. See “Using Library Models” on page 16-86.

ffun = fittype(expr) constructs ffun for the custom model specified
by the expression expr. The expression can be a string, cell array, or
anonymous function. See “Using Custom Models” on page 16-87.

ffun = fittype({expri,...,exprn}) constructs a custom linear
model with terms specified by the cell array of expressions in the strings
expri, expr2, ... , exprn. See “Using Linear Models” on page 16-88.

ffun = fittype(expr, Name, Value,...) or ffun =
fittype({expri,...,exprn}, Name, Value,...) constructs the
fittype using specified name-value pair arguments specifying values
other than the default values. For supported names-value pair
arguments, see “Input Arguments” on page 16-90.

Using Library Models

ffun = fittype(libname) constructs the fittype for the library
model 1ibname. Choices for libname include any of the names of
library models described in cflibhelp. The following table shows some
common examples.

libname Description

'poly1’ Linear polynomial curve
"poly11’ Linear polynomial surface
'poly2' Quadratic polynomial curve
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libname Description
'linearinterp' Piecewise linear interpolation
‘cubicinterp' Piecewise cubic interpolation

‘smoothingspline| Smoothing spline (curve)

'lowess' Local linear regression (surface)

Using Custom Models

ffun = fittype(expr) constructs a custom model fittype for the
MATLAB expression contained in the string, cell array, or anonymous
function expr.

The fittype automatically determines input arguments by searching
expr for variable names. The fittype assumes x is the independent
variable, y is the dependent variable, and all other variables are
coefficients of the model. x is used if no variable exists. See “Dependent
and Independent Variables” on page 16-89.

All coefficients must be scalars. You cannot use the following coefficient
names in the expression string expr: i, j, pi, inf, nan, and eps.

If expr is a string or anonymous function, then the toolbox uses

a nonlinear fitting algorithm to fit the model to data (see Using
Anonymous Functions on page 87). To use a linear fitting algorithm,
use a cell array of terms (see “Using Linear Models” on page 16-88).
Using Anonymous Functions

If expr is an anonymous function, then the order of inputs must be
correct. The input order enables the fittype class to determine which
inputs are coefficients to estimate, problem-dependent parameters
and independent variables. The order of the input arguments to the
anonymous function must be:

EXPR = @(coefficients, problemparameters, x, y) expression

You need at least one coefficient. The problem parameters and y are
optional. The last arguments, x and y, represent the independent
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variables: just x for curves, but x and y for surfaces. If you don’t want to
use x and/or y as the names of the independent variables, then specify
different names using the 'independent' argument name-value pair.
However, whatever name or names you choose, these arguments must
be the last arguments to the anonymous function.

Anonymous functions make it easier to pass other data into the
fittype and fit functions. For example, to create a fittype using an
anonymous function and a variable value (c) from the workspace:

c=1;
o] fittype( @(a, b, x) a*x.”"2+b*x+c )

The fittype can use the variable values in your workspace at the time
you create the fittype. To pass in new data from the workspace, create
the fittype again, e.g.,

c=5 % Change value of c

g = fittype( @(a, b, x) a*x."2+b*x+c )

In this case the value of ¢ is fixed when you create the fittype. To
specify the value of ¢ at the time you call fit, you can use problem
parameters. For example, to make a fit with ¢ = 2 and then a new
fit with ¢ = 3:

g = fittype( @(a,b,x) a*x."2+b*x+c, 'problem', 'c' )
f1 = fit( xdata, ydata, g, 'problem', 2 )
f2 = fit( xdata, ydata, g, 'problem', 3 )

See “Examples” on page 16-91.

Using Linear Models

To use a linear fitting algorithm, specify expr as a cell array of terms,
as follows: ffun = fittype({expri,...,exprn}). Specify the model
terms by the expressions in the strings expr1, expr2, ... , exprn. Do
not include coefficients in the expressions for the terms. If there is a
constant term, use '1' as the corresponding expression in the cell array.

To specify a linear model of the following form:
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coeff1 * term1 + coeff2 * term2 + coeff3 * term3 + ...

(where no coefficient appears within any of termi, term2, etc.), use a
cell array where each term, without coefficients, is specified in a cell
of expr, as follows:

EXPR = {'term1', 'term2', 'term3', ... }

For example, the model

a*x + b*sin(x) + ¢

1s linear in a, b and c¢. It has three terms x, sin(x) and 1 (because
c¢=c*1) and so expr is

EXPR = {'x','sin(x)"',"'1"'}

Dependent and Independent Variables

To determine what are dependent and independent variables and
coefficients, consider this equation:

y=fx)=a+®B*x)+(*x?)

® yis the dependent variable.

® xis the independent variable.

® g, b, and c are the coefficients.

The 'independent' variable is what you control. The 'dependent'
variable is what you measure, 1.e., it depends on the independent

variable. The 'coefficients' are the parameters that the fitting
algorithm estimates.

For example, if you have census data, then the year is the independent
variable because it does not depend on anything. Population is the
dependent variable, because its value depends on the year in which the
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Input
Arguments
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census is taken. If a parameter like growth rate is part of the model, if
the fitting algorithm estimates it, then it is one of the 'coefficients'.

See “Examples” on page 16-91 for how to specify an independent
variable and coefficient names.
libname

Library model name. Display choices using the cflibhelp
function.

expr

Custom model expression. The expression can be a string, cell
array, or anonymous function.

You can specify any MATLAB command and therefore any .m file.

Name-Value Pair Arguments

Optional comma-separated pairs of Name,Value arguments, where Name
1s the argument name and Value is the corresponding value. Name must
appear inside single quotes (' '). You can specify several name-value
pair arguments in any order as Name1,Valuel, ,NameN,ValueN.
coefficients

The coefficient names. Use a cell array for multiple names.
You can use multicharacter symbol names. You cannot use the
following names: i, j, pi, inf, nan, eps.

dependent

The dependent (response) variable name.
Default: y

independent

The independent (predictor) variable name.

Default: x
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options
The default fit options for the object.
problem

The problem-dependent (fixed) parameter names. Use a cell array
for multiple names.

Default: None

Output ffun

Arguments fittype object. You can use a fittype object as an input to the
fit function.

Examples Construct a fittype object for the rat33 library model:

f = fittype('rat33')
f:
General model Rat33:
f(p1,p2,p3,p4,91,02,93,x) =
(p1*x"3 + p2*x*2 + p3*Xx + p4)/
(x*3 + q1*x"2 + g2*x + 3)

Construct a fittype object for a custom nonlinear model, designating n
as a problem-dependent parameter and u as the independent variable:

g = fittype('a*u+b*exp(n*u)',...
‘problem','n',...
"independent','u')

General model:
g(a,b,n,u) = a*u+b*exp(n*u)
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Construct a fittype object for a custom linear model, specifying the
coefficient names:

h
h =

fittype({'cos(x)',"'1"'}, 'coefficients',{'al1','a2'})

Linear model:
h(al,a2,x) = al*cos(x) + a2

Fit a curve defined by a file:

1 Define a function in a MATLAB file:

function y = piecewiselLine( x, a, b, ¢, d, k)
PIECEWISELINE A line made of two pieces
that is not continuous.

o°

o°

= zeros( size( x ) );

<

o°

This example includes a for-loop and if statement
purely for demonstration purposes.
for i = 1:length( x )

o°

if x(i) < Kk,
y(i) = a + b.* x(1);
else
y(i) = c + d.* x(1);
end
end
end

2 Define some data, create a fittype specifying the function
piecewiseline, create a fit using the fittype, and plot the results:

= [0.81;0.91;0.13;0.91;0.63;0.098;0.28;0.55;...
.96;0.96;0.16;0.97;0.96] ;

= [0.17;0.12;0.16;0.0035;0.37;0.082;0.34;0.56; . ..
.15;-0.046;0.17;-0.091;-0.071];
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ft = fittype( 'piecewiselLine( x, a, b, ¢, d, k )' )
f = fit( x, y, ft, 'StartPoint', [1, O, 1, O, 0.5] )
plot( f, x, y )

Create a fittype using an anonymous function:

g = fittype( @(a, b, ¢, x) a*x."2+b*x+c )

Create a fittype for a surface using an anonymous function and
specifying independent and dependent parameters:

g = fittype( @(a, b, ¢, d, x, y) a*x."2+b*x+c*exp...
( -(y-d).”2 ), 'independent', {'x', 'yv'},...
'dependent', 'z' );

Create a fittype for a surface using an anonymous function and
specifying independent and dependent parameters, and problem
parameters that you will specify later when you call fit:

g = fittype( @(a,b,c,d,x,y) a*x. 2+b*x+c*exp( -(y-d)."2 ),
‘problem', {'c','d'}, 'independent', {'x', 'y'},
‘dependent', 'z' );

Use an anonymous function to pass workspace data into the fittype
and fit functions.

1 Create and plot an S-shaped curve. In later steps you will stretch and
move this curve to fit to some data.

% Breakpoints

xs = (0:0.1:1).";
% Height of curve at breakpoints
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ys = [0; O; 0.04; 0.1; 0.2; 0.5; 0.8; 0.9; 0.96; 1; 1];

% Plot S-shaped curve

xi = linspace( 0, 1, 241 );

plot( xi, interp1( xs, ys, xi, 'pchip' ), 'LineWidth', 2 )
hold on

plot( xs, ys, 'o', 'MarkerFaceColor', 'r' )

hold off

title S-curve

2 Create a fittype using an anonymous function, taking the values
from the workspace for the curve breakpoints (xs) and the height
of the curve at the breakpoints (ys). Coefficients are b (base) and
h (height).

ft = fittype( @(b, h, x) interpi1( xs, b+h*ys, x, 'pchip' ) )

3 Plot the fittype specifying example coefficients of base b=1.1 and
height h=-0.8.

plot( xi, ft( 1.1, -0.8, xi ), 'LineWidth', 2 )
title 'Fittype with b=1.1 and h=-0.8'

4 Load and fit some data, using the fittype ft created using
workspace values:

% Load some data

xdata = [0.012;0.054;0.13;0.16;0.31;0.34;0.47;0.53;0.53;...
0.57;0.78;0.79;0.93];

ydata = [0.78;0.87;1;1.1;0.96;0.88;0.56;0.5;0.5;0.5;0.63;...
0.62;0.39];

% Fit the curve to the data

f = fit( xdata, ydata, ft, 'Start', [0, 1] )

% Plot fit

plot( f, xdata, ydata )

title 'Fitted S-curve'
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The following example demonstrates the differences between using
anonymous functions with problem parameters and workspace variable
values.

1 Load data, create a fittype for a curve using an anonymous function
with problem parameters, and call fit specifying the problem
parameters:

% Load some random data:

xdata = [0.098;0.13;0.16;0.28;0.55;0.63;0.81;0.91;0.91;...
0.96;0.96;0.96;0.97];

ydata = [0.52;0.53;0.53;0.48;0.33;0.36;0.39;0.28;0.28;...
0.21;0.21;0.21;0.2];

% Create a fittype that has a problem parameter:
g = fittype( @(a,b,c,x) a*x."2+b*x+c, 'problem', 'c' )

% Examine coefficients. Observe c¢ is not a coefficient.
coeffnames( g )

% Examine arguments. Observe that c is an argument.
argnames( g )

% Call fit and specify the value of c:
f1 = fit( xdata, ydata, g, 'problem', 0, 'start’, [1, 2] )

o°

Note: specify start points in the calls to fit to
avoid warning messages about random start points
and to ensure repeatability of results.

o°

o°

% Call fit again and specify a different value of c,

% to get a new fit:

f2 = fit( xdata, ydata, g, 'problem', 1, ‘'start’, [1, 2] )
% Plot results. Note example specified c constants
% do not make a good fit.
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plot( f1, xdata, ydata )
hold on

plot( f2, 'b' )

hold off

2 Modify the example above to create the same fits using workspace
values for variables, instead of using problem parameters. Using the
same data, create a fittype for a curve using an anonymous function
with a workspace value for variable c:

% Remove c¢ from the argument list:
ry
g = fittype( @(a,b,x) a*x."2+b*x+c )
catch e
disp( e.message )

~+

% Observe error because now ¢ is undefined.
% Define c and create fittype:
:O'

c ;
gl = fittype( @(a,b,x) a*x."2+b*x+c )

% Call fit (now no need to specify problem parameter)
1 = fit( xdata, ydata, g1, 'start', [1, 2] )

Note that this f1 is the same as the f1 above.

To change the value of c, create the fittype again:
:1;

2 = fittype( @(a,b,x) a*x."2+b*x+c ) % uses ¢ = 1

2 = fit( xdata, ydata, g2, 'start', [1, 2] )

% Note that this f2 is the same as the f2 above.

s Plot results

plot( f1, xdata, ydata )

hold on

plot( f2, 'b' )

hold off

o° —h

Q@ O o°

°

Here are other examples using fittype:
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g = fittype('a*x"2+b*x+c')

g = fittype('a*x"2+b*x+c','coeff',{'a','b','c'})

g = fittype('a*time~2+b*time+c', 'indep', 'time")

g = fittype('a*time~2+b*time+c', 'indep', 'time', 'depen', 'height')

g = fittype('a*x+n*b', 'problem','n")

g = fittype({'cos(x)','1'}) % linear

g = fittype({'cos(x)','1'}, 'coefficients', {'a','b'}) % linear
See Also cflibhelp | fit | fitoptions | cfit | sfit
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Purpose

Syntax

Description
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Convert to specified form

g = fn2fm(f,form)
sp = fn2fm(f, 'B-',sconds)
fn2fm(f)

g = fn2fm(f,form) describes the same function as is described by f,
but in the form specified by the string form. Choices for form are 'B-',
'pp', 'BB', 'rB', 'rp', for the B-form, the ppform, the BBform, and the
two rational spline forms, respectively.

The B-form describes a function as a weighted sum of the B-splines
of a given order k for a given knot sequence, and the BBform (or,
Bernstein-Bézier form) is the special case when each knot in that
sequence appears with maximal multiplicity, k. The ppform describes
a function in terms of its local polynomial coefficients. The B-form is
good for constructing and/or shaping a function, while the ppform is
cheaper to evaluate.

Conversion from a polynomial form to the corresponding rational form
is possible only if the function in the polynomial form is vector-valued,
in which case its last component is designated as the denominator.
Converting from a rational form to the corresponding polynomial form
simply reverses this process by reinterpreting the denominator of

the function in the rational form as an additional component of the
piecewise polynomial function.

Conversion to or from the stform is not possible at present.

If formis 'B-' (and f is in ppform), then the actual smoothness of
the function in f across each of its interior breaks has to be guessed.
This is done by looking, for each interior break, for the first derivative
whose jump across that break is not small compared to the size of that
derivative nearby. The default tolerance used in thisis 1.e-12.

sp = fn2fm(f, 'B-',sconds) permits you to supply, as the input
argument sconds, a tolerance (strictly between 0 and 1) to be used in
the conversion from ppform to B-form.
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Examples

Algorithms

Alternatively, you can input sconds as a vector with integer entries,
with at least as many entries as the ppform in f has interior breaks.
In that case, sconds (i) specifies the number of smoothness conditions
to be used across the ith interior break. If the function in f is a tensor
product, then sconds, if given, must be a cell array.

fn2fm(f) converts a possibly old version of a form into its present
version.

sp = fn2fm(spline(x,y), 'B-"') gives the interpolating cubic spline
provided by the MATLAB command spline, but in B-form rather than
in ppform.

po = ppmak([0 1],[3 0 0]);
p1 fn2fm(fn2fm(fnrfn(p0,[.4 .61),'B-"'),'pp');

gives p1 identical to p0 (up to round-off in the coefficients) since the
spline has no discontinuity in any derivative across the additional
breaks introduced by fnrfn, hence conversion to B-form ignores these
additional breaks, and conversion to ppform does not retain any knot
multiplicities (like the knot multiplicities introduced, by conversion to
B-form, at the endpoints of the spline’s basic interval).

For a multivariate (tensor-product) function, univariate algorithms are
applied in each variable.

For the conversion from B-form (or BBform) to ppform, the utility
command sprpp is used to convert the B-form of all polynomial pieces
to their local power form, using repeated knot insertion at the left
endpoint.

The conversion from B-form to BBform is accomplished by inserting
each knot enough times to increase its multiplicity to the order of the
spline.

The conversion from ppform to B-form makes use of the dual functionals
discussed in Chapter 8, “T'ypes of Splines” Without further information,
such a conversion has to ascertain the actual smoothness across each
interior break of the function in f.

16-99



fn2fm

Cautionary When going from B-form to ppform, any jump discontinuity at the

Note first and last knot, t(1) or t(end), will be lost since the ppform
considers f to be defined outside its basic interval by extension of
the first, respectively, the last polynomial piece. For example, while
sp=spmak ([0 1],1) gives the characteristic function of the interval

[0..1], pp=fn2fm(spmak ([0 1]1,1),'pp') is the constant polynomial,
x| —1.

See Also ppmak | spmak | rsmak | stmak
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Purpose

Syntax

Description

Name and part(s) of form

[outl,...,outn] = fnbrk(f,partt,...,partm)
fnbrk(f,interval)
fnbrk(pp,7j)

fnbrk(f)
[outl,...,outn] = fnbrk(f,partl,...,partm) returns the part(s)
of the form in f specified by parti1,...,partn (assuming that n<=m).

These are the parts used when the form was put together, in spmak or
ppmak or rpmak or rsmak or stmak, but also other parts derived from
these.

You only need to specify the beginning character(s) of the relevant
string.

Regardless of what particular form f is in, parti can be one of the
following.

‘form' The particular form used

'variables' The dimension of the function’s domain
'dimension' The dimension of the function’s target
'coefficients' The coefficients in that particular form
'interval' The basic interval of that form

Depending on the form in f, additional parts may be asked for.

If f 1s in B-form (or BBform or rBform), then additional choices for
parti are

'knots' The knot sequence
'coefficients' The B-spline coefficients

"number' The number of coefficients
‘order' The polynomial order of the spline
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If f is in ppform (or rpform), then additional choices for parti are

'breaks' The break sequence

'coefficients' The local polynomial coefficients

'pieces' The number of polynomial pieces

‘order' The polynomial order of the spline

'guide’ The local polynomial coefficients, but in the
form needed for PPVALU in PGS

If the function in f is multivariate, then the corresponding multivariate
parts are returned. This means, e.g., that knots, breaks, and the basic
interval, are cell arrays, the coefficient array is, in general, higher than
two-dimensional, and order, number and pieces are vectors.

If f is in stform, then additional choices for parti are

'centers' The centers

‘coefficients' The coefficients

"number' Number of coefficients or terms
"type' The particular type

fnbrk(f,interval) with interval a 1-by-2 matrix [a b] with a<b
does not return a particular part. Rather, it returns a description of
the univariate function described by f and in the same form but with
the basic interval changed, to the interval given. If, instead, interval
is [ 1, T 1s returned unchanged. This is of particular help when the
function in f i1s m-variate, in which case interval must be a cell array
with m entries, with the ith entry specifying the desired interval in
the ith dimension. If that ith entry is [ ], the basic interval in the ith
dimension is unchanged.

fnbrk(pp,j), with pp the ppform of a univariate function and j a
positive integer, does not return a particular part, but returns the
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Examples

See Also

ppform of the jth polynomial piece of the function in pp. If pp is the
ppform of an m-variate function, then j must be a cell array of length
m. In that case, each entry of j must be a positive integer or else an
interval, to single out a particular polynomaial piece or else to specify the
basic interval in that dimension.

fnbrk(f) returns nothing, but a description of the various parts of the
form is printed at the command line instead.

If p1 and p2 contain the B-form of two splines of the same order, with
the same knot sequence, and the same target dimension, then

piplusp2 = spmak(fnbrk(p1,'k"),fnbrk(p1,'c')+fnbrk(p2,'c'));

provides the (pointwise) sum of those two functions.

If pp contains the ppform of a bivariate spline with at least four
polynomial pieces in the first variable, then ppp=fnbrk(pp, {4,[ -1
1]1}) gives the spline that agrees with the spline in pp on the rectangle
[b4 .. b5] x [-1.. 1], where b4, b5 are the fourth and fifth entry in the
break sequence for the first variable.

ppmak | rpmak | rsmak | spmak | stmak
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Description

Examples

See Also
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Change part(s) of form

—
1}

fnchg(f,part,value)

f = fnchg(f,part,value) returns the given function description f
but with the specified part changed to the specified value.

The string part can be (the beginning character(s) of) :

'dimension' The dimension of the function’s target

"interval' The basic interval of that form

The specified value for part is not checked for consistency with the
rest of the description in f in case the string part terminates with the
letter z.

fndir(f,directions) returns a vector-valued function even when the
function described by f is ND-valued.You can correct this by using
fnchg as follows:

fdir = fnchg( fndir(f,directions),...
‘dim', [fnbrk(f,'dim'),size(directions,2)] );

fnbrk
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Purpose

Syntax

Description

Arithmetic with function(s)

fn = fncmb(function,operation)

f = fncmb(function,function)

fncmb (function,matrix,function)

fncmb (function,matrix,function,matrix)
f = fncmb(function,op,function)

The intent is to make it easy to carry out the standard linear operations
of scaling and adding within a spline space without having to deal
explicitly with the relevant parts of the function(s) involved.

fn = fncmb(function,operation) returns (a description of) the function
obtained by applying to the values of the function in function the
operation specified by operation. The nature of the operation depends
on whether operation is a scalar, a vector, a matrix, or a string, as
follows.

Scalar Multiply the function by that scalar.

Vector Add that vector to the function’s values; this
requires the function to be vector-valued.

Matrix Apply that matrix to the function’s
coefficients.

String Apply the function specified by that string to

the function’s coefficients.

The remaining options only work for univariate functions. See
Limitations for more information.

f = fncmb(function,function) returns (a description of) the pointwise
sum of the two functions. The two functions must be of the same form.
This particular case of just two input arguments is not included in the
above table since it only works for univariate functions.

fncmb (function,matrix,function) is the same as
fncmb (fnemb (function,matrix),function).
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fncmb (function,matrix,function,matrix) is the same as
fnemb ((fnemb (function,matrix),fncmb(function,matrix)).

f = fncmb(function,op,function) returns the ppform of the spline
obtained by the pointwise combining of the two functions, as specified
by the string op. op can be one of the strings '+"', '-', '*' If the
second function is to be a constant, it is sufficient simply to supply
here that constant.

Examples fncmb (fn,3.5) multiplies (the coefficients of) the function in fn by 3.5.

fncmb(f,3,9,-4) returns the linear combination, with weights 3 and
—4, of the function in f and the function in g.

fncmb (f,3,9) adds 3 times the function in f to the function in g.

If the function f in f happens to be scalar-valued, then

f3=fncmb (f,[1;2;3]) contains the description of the function whose
value at x is the 3-vector (f(x), 2f(x), 3f(x)). Note that, by the convention
throughout this toolbox, the subsequent statement fnval(f3, x) returns
a l-column-matrix.

If £ describes a surface in R?, i.e., the function in f is 3-vector-valued
bivariate, then f2 = fncmb(f,[1 0 0;0 0 1]) describes the projection
of that surface to the (x, z)-plane.

The following commands produce the picture of a ... spirochete?

c = rsmak('circle');
fnplt(fncmb(c,diag([1.5,1]1))); axis equal, hold on
sc = fncmb(c,.4);

fnplt(fncmb(sc,-[.2;-.5]))
fnplt(fncmb(sc,-[.2,-.5]))

hold off, axis off

If t is a knot sequence of length n+k and a is a matrix with n columns,
then fncmb (spmak (t,eye(n)),a) is the same as spmak(t,a).

fncmb (spmak([0:4],1),"'+',ppmak([-1 5],[1 -1])) 1s the
piecewise-polynomial with breaks -1:5 that, on the interval [0 .. 4],
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Algorithms

Limitations

agrees with the function x| — B(x|0,1,2,3,4) + x (but has no active break
at 0 or 1, hence differs from this function outside the interval [0 .. 4]).

fncmb (spmak([0:4],1),'-"',0) has the same effect as
fn2fm(spmak([0:4],1), 'pp"').

Assuming that sp describes the B-form of a spline of order <k, the
output of

fn2fm(fncmb(sp, '+',ppmak(fnbrk(sp, 'interv'),zeros(1,k))), 'B-")
describes the B-form of the same spline, but with its order raised to k.

The coefficients are extracted (via fnbrk) and operated on by

the specified matrix or operation (and, possibly, added), then
recombined with the rest of the function description (via ppmak,
spmak, rpmak, rsmak, stmak). To be sure, when the function is rational,
the matrix is only applied to the coefficients of the numerator. Again,
if we are to translate the function values by a given vector and the
function is in ppform, then only the coefficients corresponding to
constant terms are so translated.

If there are two functions input, then they must be of the same type (see
Limitations, below) except for the following.

fnemb (f1,0p,f2) returns the ppform of the function

x|—> f1(x) op f2(x)
with oponeof '+', '-', '*' and f1, f2 of arbitrary polynomial form.
If, in addition, f2 is a scalar or vector, it is taken to be the function that
1s constantly equal to that scalar or vector.

fncmb only works for univariate functions, except for the case
fncmb (function,operation), i.e., when there is just one function in
the input.

Further, if two functions are involved, then they must be of the same
type. This means that they must either both be in B-form or both be in
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ppform, and, moreover, have the same knots or breaks, the same order,
and the same target. The only exception to this is the command of the
form fncmb(function,op,function).
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Description
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Differentiate function

fprime = fnder(f,dorder)
fnder(f)

fprime = fnder(f,dorder) is the description of the dorderth
derivative of the function whose description is contained in f. The
default value of dorder is 1. For negative dorder, the particular
|dorder | th indefinite integral is returned that vanishes |dorder |-fold
at the left endpoint of the basic interval.

The output is of the same form as the input, i.e., they are both ppforms
or both B-forms or both stforms. fnder does not work for rational
splines; for them, use fntlr instead. fnder works for stforms only in a
limited way: if the type is tp00, then dorder can be [1,0] or [0,1].

fnder(f) is the same as fnder(f,1).

If the function in f is multivariate, say m-variate, then dorder must be
given, and must be of length m.

If f is in ppform, or in B-form with its last knot of sufficiently high
multiplicity, then, up to rounding errors, f and fnder (fnint(f)) are
the same.

If f is in ppform and fa is the value of the function in f at the

left end of its basic interval, then, up to rounding errors, f and
fnint(fnder(f),fa) are the same, unless the function described by f
has jump discontinuities.

If f contains the B-form of f, and ¢, is its leftmost knot, then, up to
rounding errors, fnint(fnder(f)) contains the B-form of f — f(z,).
However, its leftmost knot will have lost one multiplicity (if it had
multiplicity > 1 to begin with). Also, its rightmost knot will have full
multiplicity even if the rightmost knot for the B-form of fin f doesn’t.

Here is an illustration of this last fact. The spline in sp = spmak([0 0
1], 1) is, on its basic interval [0..1], the straight line that is 1 at 0 and
0 at 1. Now integrate its derivative: spdi = fnint(fnder(sp)). As
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you can check, the spline in spdi has the same basic interval, but, on
that interval, it agrees with the straight line that is 0 at 0 and -1 at 1.

See the demos “Intro to B-form” and “Intro to ppform” for examples.

For differentiation of either polynomial form, the derivatives are found
in the piecewise-polynomial sense. This means that, in effect, each
polynomial piece is differentiated separately, and jump discontinuities
between polynomial pieces are ignored during differentiation.

For the B-form, the formulas [PGS; (X.10)] for differentiation are used.
For the stform, differentiation relies on knowing a formula for the

relevant derivative of the basis function of the particular type.

fndir | fnint | fnplt | fnval



fndir

Purpose
Syntax

Description
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Directional derivative of function

df

fndir(f,y)

df = fndir(f,y) is the ppform of the directional derivative, of the
function fin f, in the direction of the (column-)vector y. This means

that df describes the function Dyf(x) =1limy o (flae+ty)—fx) /¢

If y is a matrix, with n columns, and fis d-valued, then the function in
df is prod(d) *n-valued. Its value at x, reshaped to be of size [d,n], has
in its jth “column” the directional derivative of f at x in the direction of
the jth column of y. If you prefer df to reflect explicitly the actual size
of f, use instead

df = fnchg( fndir(f,y), 'dim',[fnbrk(f,'dim'),size(y,2)] );

Since fndir relies on the ppform of the function in f, it does not work
for rational functions nor for functions in stform.

For example, if T describes an m-variate d-vector-valued function and
X is some point in its domain, then, e.g., with this particular ppform f
that describes a scalar-valued bilinear polynomial,

f = ppmak({0:1,0:1},[1 0;0 1]); x = [0;0];
[d,m] = fnbrk(f,'dim', 'var');
jacobian = reshape(fnval(fndir(f,eye(m)),x),d,m)

is the Jacobian of that function at that point (which, for this particular
scalar-valued function, is its gradient, and it is zero at the origin).

As a related example, the next statements plot the gradients of (a good
approximation to) the Franke function at a regular mesh:

xx = linspace(-.1,1.1,13); yy = linspace(0,1,11);
[X,y] = ndgrid(xx,yy); z = franke(x,y);

pp2dir = fndir(csapi({xx,yy},z),eye(2));

grads = reshape(fnval(pp2dir,[x(:) y(:)1."'),
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[2,1ength(xx),length(yy)]);
quiver(x,y,squeeze(grads(1,:,:)),squeeze(grads(2,:,:)))

Here is the resulting plot.
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Algorithms The function in f is converted to ppform, and the directional derivative

of its polynomial pieces is computed formally and in one vector
operation, and put together again to form the ppform of the directional
derivative of the function in f.

See Also fnchg | fnder | fnint | franke
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Integrate function

intgrf = fnint(f,value)
fnint ()

intgrf = fnint(f,value) is the description of an indefinite integral
of the univariate function whose description is contained in f. The
integral is normalized to have the specified value at the left endpoint of
the function’s basic interval, with the default value being zero.

The output is of the same type as the input, i.e., they are both ppforms
or both B-forms. fnint does not work for rational splines nor for
functions in stform.

fnint(f) 1s the same as fnint(f,0).

Indefinite integration of a multivariate function, in coordinate directions
only, is available via fnder (f,dorder) with dorder having nonpositive
entries.

The statement diff(fnval(fnint(f),[a b])) provides the definite
integral over the interval [a .. b] of the function described by f.

If f is in ppform, or in B-form with its last knot of sufficiently high
multiplicity, then, up to rounding errors, f and fnder (fnint (f)) are
the same.

If f is in ppform and fa is the value of the function in f at the

left end of its basic interval, then, up to rounding errors, f and
fnint(fnder(f),fa) are the same, unless the function described by f
has jump discontinuities.

If f contains the B-form of f, and ¢, is its leftmost knot, then, up to
rounding errors, fnint(fnder(f)) contains the B-form of f — f(z,).
However, its leftmost knot will have lost one multiplicity (if it had
multiplicity > 1 to begin with). Also, its rightmost knot will have full
multiplicity even if the rightmost knot for the B-form of fin f doesn’t.

Here is an illustration of this last fact. The spline in sp = spmak([0 0
1], 1) is, on its basic interval [0..1], the straight line that is 1 at 0 and
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0 at 1. Now integrate its derivative: spdi = fnint(fnder(sp)). As
you can check, the spline in spdi has the same basic interval, but, on
that interval, it agrees with the straight line that is 0 at 0 and -1 at 1.

See the demos “Intro to B-form” and “Intro to ppform” for examples.
For the B-form, the formula [PGS; (X.22)] for integration is used.

fnder | fnplt | fnval
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Jumps, i.e., f(x+)-f(x-)

jumps = fnjmp(f,x)

jumps = fnjmp(f,x) islike fnval(f,x) except that it returns the
jump f(x+) — f(x—) across x (rather than the value at x) of the function f
described by f and that it only works for univariate functions.

This is a function for spline specialists.

fnjmp(ppmak(1:4,1:3),1:4) returns the vector [0,1,1,0] since the
pp function hereis lon[1.. 2],20n [2.. 3], and 3 on [3 .. 4], hence has
zero jump at 1 and 4 and a jump of 1 across both 2 and 3.

If xi1s cos([4:-1:0]1*pi/4), then fnjmp(fnder(spmak(x,1),3),Xx)
returns the vector [12 -24 24 -24 12] (up to round-off). This is
consistent with the fact that the spline in question is a so called perfect
cubic B-spline, 1.e., has an absolutely constant third derivative (on its
basic interval). The modified command

fnjmp(fnder (fn2fm(spmak(x,1), 'pp'),3),X)

returns instead the vector [0 -24 24 -24 0], consistent with the
fact that, in contrast to the B-form, a spline in ppform does not have

a discontinuity in any of its derivatives at the endpoints of its basic
interval. Note that fnjmp(fnder(spmak(x,1),3),-x) returns the
vector [12,0,0,0,12] since -X, though theoretically equal to x, differs
from x by roundoff, hence the third derivative of the B-spline provided
by spmak (x,1) does not have a jump across -x(2),-x(3), and -x(4).
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Minimum of function in given interval

fnmin(f)
fnmin(f,interv)
[minval,minsite] = fnmin(f,...)

fnmin(f) returns the minimum value of the scalar-valued univariate
spline in f on its basic interval.

fnmin(f,interv) returns the minimum value on the interval [a..b]
specified by interv.

[minval,minsite] = fnmin(f,...) alsoreturns alocation, minsite,
at which the function in f takes that minimum value, minval.

Example 1. We construct and plot a spline f with many local extrema,
then compute its maximum as the negative of the minimum of —f. We

indicate this maximum value by adding a horizontal line to the plot at
the height of the computed maximum.

rand('seed',21);

f = spmak(1:21,rand(1,15)-.5);

fnplt(f)

maxval = -fnmin(fncmb(f,-1));

hold on, plot(fnbrk(f,'interv'),maxval([1 1])), hold off
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Algorithm

0.3

0.2

Example 2. Since spmak(1:5,-1) provides the negative of the cubic
B-spline with knot sequence 1:5, we expect the command

[y,x] = fnmin(spmak(1:5,-1))
to return -2/3 for y and 3 for x.

fnmin first changes the basic interval of the function to the given
interval, if any. On the interval, fnmin then finds all local extrema
of the function as left and right limits at a jump and as zeros of the
function’s first derivative. It then evaluates the function at these
extrema and at the endpoints of the interval, and determines the
minimum over all these values.
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Purpose Plot function

Syntax fnplt(f)
fnplt(f,argl,arg2,arg3,arg4)
points = fnplt(f,...)
[points, t] = fnplt(f,...)
Description fnplt(f) plots the function, described by f, on its basic interval.

If f is univariate, the following is plotted:

e If fis scalar-valued, the graph of f is plotted.

e [f fis 2-vector-valued, the planar curve is plotted.

e If fis d-vector-valued with d > 2, the space curve given by the first
three components of fis plotted.

If f is bivariate, the following is plotted:

e [f fis scalar-valued, the graph of fis plotted (via surf).

e [f fis 2-vector-valued, the image in the plane of a regular grid in its
domain is plotted.

e [f fis d-vector-valued with d > 2, then the parametric surface given

by the first three components of its values is plotted (via surf).

If fis a function of more than two variables, then the bivariate function,
obtained by choosing the midpoint of the basic interval in each of the
variables other than the first two, is plotted.

fnplt(f,argl,arg2,arg3,arg4) permits you to modify the plotting
by the specification of additional input arguments. You can place these
arguments in whatever order you like, chosen from the following list:

* A string that specifies a plotting symbol, such as '-."' or '*'; the
default is '-".

® A scalar to specify the linewidth; the default value is 1.
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Cautionary
Note

® A string that starts with the letter 'j' to indicate that any jump in
the univariate function being plotted should actually appear as a
jump. The default is to fill in any jump by a (near-)vertical line.

® A vector of the form [a,b], to indicate the interval over which to plot
the univariate function in f. If the function in f is m-variate, then
this optional argument must be a cell array whose ith entry specifies
the interval over which the ith argument is to vary. In effect, for
this arg, the command fnplt(f,arg,...) has the same effect as
the command fnplt(fnbrk(f,arg),...). The default is the basic
interval of f.

* An empty matrix or string, to indicate use of default(s). You will
find this option handy when your particular choice depends on some
other variables.

points = fnplt(f,...) plots nothing, but the two-dimensional
points or three-dimensional points it would have plotted are returned
instead.

[points, t] = fnplt(f,...) also returns, for a vector-valued f, the
corresponding vector t of parameter values.

The univariate function f described by f is evaluated at 101 equally
spaced sites x filling out the plotting interval. If f is real-valued, the
points (x,f(x)) are plotted. If fis vector-valued, then the first two or

three components of f(x) are plotted.

The bivariate function f described by f is evaluated on a 51-by-51
uniform grid if f is scalar-valued or d-vector-valued with d > 2 and
the result plotted by surf. In the contrary case, fis evaluated along
the meshlines of a 11-by-11 grid, and the resulting planar curves are
plotted.

The basic interval for fin B-form is the interval containing all the knots.
This means that, e.g., f is sure to vanish at the endpoints of the basic
interval unless the first and the last knot are both of full multiplicity &,
with & the order of the spline f. Failure to have such full multiplicity

is particularly annoying when fis a spline curve, since the plot of that

16-119



fnplt

See Also

16-120

curve as produced by fnplt is then bound to start and finish at the
origin, regardless of what the curve might otherwise do.

Further, since B-splines are zero outside their support, any function
in B-form is zero outside the basic interval of its form. This is very
much in contrast to a function in ppform whose values outside the
basic interval of the form are given by the extension of its leftmost,
respectively rightmost, polynomial piece.

fnder | fnint | fnval
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See Also

Refine partition of form

«
1}

fnrfn(f,addpts)

g fnrfn(f,addpts) describes the same function as does f, but
uses more terms to do it. This is of use when the sum of two or more
functions of different forms is wanted or when the number of degrees
of freedom in the form is to be increased to make fine local changes
possible. The precise action depends on the form in f.

If the form in f is a B-form or BBform, then the entries of addpts

are inserted into the existing knot sequence, subject to the following
restriction: The multiplicity of no knot exceed the order of the spline.
The equivalent B-form with this refined knot sequence for the function
given by f is returned.

If the form in f is a ppform, then the entries of addpts are inserted into
the existing break sequence, subject to the following restriction: The
break sequence be strictly increasing. The equivalent ppform with this
refined break sequence for the function in f is returned.

fnrfn does not work for functions in stform.

If the function in f is m-variate, then addpts must be a cell array,
{addptsi,..., addptsm}, and the refinement is carried out in each of
the variables. If the ith entry in this cell array is empty, then the knot
or break sequence in the ith variable is unchanged.

See fncmb for the use of fnrfn to refine the knot or break sequences of
two splines to a common refinement before forming their sum.

The standard knot insertion algorithm is used for the calculation of
the B-form coefficients for the refined knot sequence, while Horner’s
method is used for the calculation of the local polynomial coefficients at
the additional breaks in the refined break sequence.

fncmb | ppmak | spmak
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Taylor coefficients or polynomial

taylor = fntlr(f,dorder,x)
p = fntlr(f,dorder,x,interv)

taylor = fntlr(f,dorder,x) returns the unnormalized Taylor
coefficients, up to the given order dorder and at the given x, of the
function described in f .

For a univariate function and a scalar x, this is the vector

T(f,dorder, x) := [f(x); Df (x);...; DI 1 £(x)]

If, more generally, the function in f is d-valued with d>1 or

even prod(d)>1 and/or is m-variate for some m>1, then dorder is
expected to be an m-vector of positive integers, X is expected to

be a matrix with m rows, and, in that case, the output is of size
[prod(d)*prod(dorder),size(x,2)], with its j-th column containing

T(f,dorder, x(:, ))il,...,im) = Dy"* 71D, ™ f(x(:, 7))

for i1=1:dorder (1), ..., im=1:dorder(m). Here, Df is the partial
derivative of f with respect to its ith argument.

p = fntlr(f,dorder,x,interv) returns instead a ppform of the
Taylor polynomial at x of order dorder for the function described by f.
The basic interval for this ppform is as specified by interv. In this case
and assuming that the function described by f is m-variate, x is expected
to be of size [m, 1], and interv is either of size [m,2] or else a cell array
of length m containing m vectors of size [1,2].

If f contains a univariate function and x is a scalar or a 1-row matrix,
then fntlr(f,3,x) produces the same output as the statements

df = fnder(f); [fnval(f,x); fnval(df,x); fnval(fnder(df),x)];
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As a more complicated example, look at the Taylor vectors of order 3
at 21 equally spaced points for the rational spline whose graph is the
unit circle:

ci = rsmak('circle'); in = fnbrk(ci, 'interv');
t = linspace(in(1),in(2),21); t(end)=[];
v = fntlr(ci,3,t);

We plot ci along with the points v(1:2,:), to verify that these are,
indeed, points on the unit circle.

fnplt(ci), hold on, plot(v(1l,:),v(2,:),'0")

Next, to verify that v(3:4,j) is a vector tangent to the circle at the
point v(1:2,j), we use the MATLAB quiver command to add the
corresponding arrows to our plot:

quiver(v(1,:),v(2,:),v(3,:),v(4,:))

Finally, what about v(5:6,:)? These are second derivatives, and we
add the corresponding arrows by the following quiver command, thus
finishing First and Second Derivative of a Rational Spline Giving a
Circle on page 16-124.

quiver(v(1,:),v(2,:),v(5,:),v(6,:)), axis equal, hold off
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First and Second Derivative of a Rational Spline Giving a Circle

Now, our curve being a circle, you might have expected the 2nd
derivative arrows to point straight to the center of that circle, and that
would have been indeed the case if the function in ci had been using
arclength as its independent variable. Since the parameter used is not
arclength, we use the formula, given in “Example: A Spline Curve” on
page 10-10, to compute the curvature of the curve given by ci at these
selected points. For ease of comparison, we switch over to the variables
used there and then simply use the commands from there.

dspt = v(3:4,:); ddspt = v(5:6,:);

kappa = abs(dspt (1
(sum(dspt.~2))."7(3/2);

max (abs (kappa-1))

ans = 2.2204e-016

The numerical answer is reassuring: at all the points tested, the
curvature is 1 to within roundoff.

16-124
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The Function 1/(1+x*2+y*2) and lts Taylor Polynomial of Order [3,3]
at the Origin

As a final example, we start with a bivariate version of the Runge
function, obtaining, for variety, a ppform for its denominator, 1 + x? +
y2, by bicubic spline interpolation:

w = csapi({-1:1,-1:1},[3 2 352 1 2;3 2 3]);

Next, we make up the coefficient array for the numerator, 1, using
exactly the same size, and put the two together into a rational spline:

wcoefs = fnbrk(w, 'coef');
scoefs = zeros(size(wcoefs)); scoefs(end)=1;
runge2 rpmak (fnbrk(w, 'breaks'),[scoefs;wcoefs]);

Then we enlarge the basic interval for this rational spline, plot it and
plot, on top of it, its Taylor polynomial at (0,0) of order [3,3].

fnplt(fnbrk(runge2,{[-2 2],[-2 2]})); shading interp, hold on
fnplt(fntlr(runge2,[3 3],[0;0],[-.7 .7; -.7 .7]))
axis off, hold off
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Since we shaded the function but not the Taylor polynomial, we can
easily distinguish the two in the previous figure. We can also see that,
in contrast to the function, the Taylor polynomaial fails to be rotationally
symmetric. This is due to the fact that it is a polynomial of order [3,3]
rather than a polynomial of total order 3.

To obtain the Taylor polynomial of order 3, we get the Taylor polynomial
of order [3,3], but with (0,0) the left point of its basic interval, set all
its coefficients of total order bigger than 3 equal to zero, and then
reconstruct the polynomial, and plot it, choosing a different view in
order to show off the Taylor polynomial better. Here are the commands
and the resulting figure.

taylor = fntlr(runge2,[3 3],[0;0],[0 1;0 1]);

tcoef = fnbrk(taylor,'coe'); tcoef([1 2 4]) = 0;

taylor2 = fnbrk(ppmak(fnbrk(taylor,'br'),tcoef),{[-1 1],[-1
111);

fnplt(fnbrk(runge2,{[-2 2],[-2 2]})); shading interp, hold on
fnplt(taylor2), view(-28,-26), axis off, hold off
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The Function 1/(1+x*2+y*2) and Its Taylor Polynomial of Order 3 at
the Origin

See Also fnder | fndir
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Evaluate function

v = fnval(f,x)
fnval(x,T)
fnval(...,'1l")

v = fnval(f,x) andv = fnval(x,f) both provide the value f(x) at
the points in x of the function f whose description is contained in f.

Roughly speaking, the output v is obtained by replacing each entry of x
by the value of f at that entry. This is literally true in case the function
in f is scalar-valued and univariate, and is the intent in all other cases,
except that, for a d-valued m-variate function, this means replacing
m-vectors by d-vectors. The full details are as follows.

For a univariate f :

e If fis scalar-valued, then v is of the same size as x.

e Iffis [d1,...,dr]-valued, and x has size [n1,...,ns], then v has
size [d1,...,dr, n1,...,ns],withv(:,...,:, j1,...,js) the
value of fat x(j1,...,js), — except that

(1) n1 is ignored if it is 1 and s is 2, i.e., if X is a row vector; and

(2) MATLAB ignores any trailing singleton dimensions of x.

For an m-variate f with m>1, with f [d1,...,dr]-valued, x may be either

an array, or else a cell array {x1,...,xm}.

e If x is an array, of size [n1,...,ns] say, then n1 must equal m, and v
has size [d1,...,dr, n2,...,ns],withv(:,...,:, j2,...,]s)
the value of fat x(:,j2,...,js), — except that
(1) d1, ..., dr is ignored in case f is scalar-valued, i.e., both r and n1
are 1;

(2) MATLAB ignores any trailing singleton dimensions of x.

e If x is a cell array, then it must be of the form {x1,...,xm}, with
Xj a vector, of length nj, and, in that case, v has size [d1,...,dr,
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nt,...,nm],withv(:,...,:, j1,...,jm) the value of f at (x1(j1),
..., Xxm(jm)), — except that d1, ..., dr is ignored in case f is scalar-valued,
1.e., both r and n1 are 1.

If f has a jump discontinuity at x, then the value f(x +), i.e., the limit
from the right, is returned, except when x equals the right end of the
basic interval of the form; for such x, the value f(x-), i.e., the limit from
the left, is returned.

fnval(x,f) is the same as fnval(f,x).

fnval(...,'l') treats f as continuous from the left. This means that
if f has a jump discontinuity at x, then the value f(x-), i.e., the limit
from the left, is returned, except when x equals the left end of the basic
interval; for such x, the value f(x +) is returned.

If the function is multivariate, then the above statements concerning
continuity from the left and right apply coordinatewise.

The statement fnval(csapi(x,y),xx) has the same effect as the
statement csapi(x,y,xx).

For each entry of x, the relevant break- or knot-interval is determined
and the relevant information assembled. Depending on whether f is in
ppform or in B-form, nested multiplication or the B-spline recurrence
(see, e.g., [PGS; X.(3)]) is then used vector-fashion for the simultaneous
evaluation at all entries of x. Evaluation of a multivariate polynomial
spline function takes full advantage of the tensor product structure.

Evaluation of a rational spline follows up evaluation of the
corresponding vector-valued spline by division of all but its last
component by its last component.

Evaluation of a function in stform makes essential use of stcol, and
tries to keep the matrices involved to reasonable size.

fnbrk | ppmak | rsmak | spmak | stmak
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Extrapolate function

g = fnxtr(f,order)
fnxtr(f)

g = fnxtr(f,order) returns the spline (in ppform) that agrees with
the spline in f on the latter’s basic interval but is a polynomial of the
given order outside it, with 2 the default for order, in such a way that
the spline in g satisfies at least order smoothness conditions at the
ends of f’s basic interval, i.e., at the new breaks.

f must be in B-form, BBform, or ppform.

While order can be any nonnegative integer, fnxtr is useful mainly
when order is positive but less than the order of f.

If order is zero, then g describes the same spline as fn2fm(f, 'B-) but
is in ppform and has a larger basic interval.

If order is at least as big as f’s order, then g describes the same pp as
fn2fm(f, 'pp') but uses two more pieces and has a larger basic interval.

If f is m-variate, then order may be an m-vector, in which case
order (i) specifies the matching order to be used in the i-th variable,
i=1m.

If order<0, then g is exactly the same as fn2fm(f, 'pp'). This unusual
option is useful when, in the multivariate case, extrapolation is to take
place in only some but not all variables.

fnxtr(f) is the same as fnxtr(f,2).

Example 1. The cubic smoothing spline for given data x,y is, like any
other ‘natural’ cubic spline, required to have zero second derivative
outside the interval spanned by the data sites. Hence, if such a spline is
to be evaluated outside that interval, it should be constructed as s =
fnxtr(csaps(x,y)). A Cubic Smoothing Spline Properly Extrapolated
on page 16-131, generated by the following code, shows the difference.

rand('seed',6); x = rand(1,21); s = csaps(x,x."3); sn = fnxtr(s);
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fnplt(s,[-.5 1.4],3), hold on, fnplt(sn,[-.5 1.4]1,.5,'r',2)
legend('cubic smoothing spline','... properly extrapolated')
set(gca, 'Fontsize',16), axis off, hold off

— cubic smoothing spline
—— ... properly extrapolated

——

A Cubic Smoothing Spline Properly Extrapolated

Example 2. Here is the plot of a bivariate B-spline, quadratically
extrapolated in the first variable and not at all extrapolated in the
second, as generated by

fnplt(fnxtr(spmak({0:3,0:4},1),[3,-1]1))
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A Bivariate B-spline Quadratically Extrapolated In One Direction

See Also ppmak | spmak | fn2fm
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Purpose

Syntax

Description

Examples

Find zeros of function in given interval

z = fnzeros(f,[a b])
fnzeros(f)

N
1}

z = fnzeros(f,[a b]) is an ordered list of the zeros of the univariate
spline f in the interval [a .. b] .

z = fnzeros(f) is a list of the zeros in the basic interval of the spline f.

A spline zero is either a maximal closed interval over which the spline
1s zero, or a zero crossing (a point across which the spline changes sign).

The list of zeros, z, is a matrix with two rows. The first row is the left
endpoint of the intervals and the second row is the right endpoint. Each
column z(:,j) contains the left and right endpoint of a single interval.

These intervals are of three kinds:

¢ If the endpoints are different, then the function is zero on the entire
interval. In this case the maximal interval is given, regardless of
knots that may be in the interior of the interval.

e If the endpoints are the same and coincident with a knot, then the
function in f has a zero at that point. The spline could cross zero,
touch zero or be discontinuous at this point.

¢ [f the endpoints are the same and not coincident with a knot, then
the spline has a zero crossing at this point.

If the spline, f, touches zero at a point that is not a knot, but does not
cross zero, then this zero may not be found. If it is found, then it may
be found twice.

Example 1. The following code constructs and plots a piecewise linear
spline that has each of the three kinds of zeros: touch zero, cross zero,
and zero for an interval. fnzeroscomputes all the zeros, and then the
code plots the results on the graph.

sp = spmak(augknt(1:7,2),[1,0,1,-1,0,0,1]);
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fnplt(sp)

z = fnzeros(sp)

nz = size(z,2);

hold on

plot(z(1,:),zeros(1,nz),'>"',z(2,:),zeros(1,nz),'<"'), hold off

This gives the following list of zeros:
Z =

2.0000 3.5000 5.0000
2.0000 3.5000 6.0000

In this simple example, even for the second kind of zero, the two
endpoints agree to all places.

0.8F

0.6

0.4

0.2r

Example 2. The following code generates and plots a spline function
with many extrema and locates all extrema by computing the zeros of
the spline function’s first derivative there.

f = spmak( 1:21, rand( 1, 15 )-0.5 );

interval = fnbrk( f, 'interval' );
z = fnzeros( fnder( f ) );
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z =z(1,:);

values = fnval( f, [interval, z] );
min( values )

fnplt(f)

hold on

plot(z,fnval(f,z),'ro")

hold off

Your plot will be different to the example following because of the use of
rand to generate random coefficients.

0.3

0.2F

01F

01F

-03r

0.5 1 1 1 1
0
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Example 3. We construct a spline with a zero at a jump discontinuity
and in B-form and find all the spline’s zeros in an interval that goes
beyond its basic interval.

sp = spmak([0 O 1 1 2],[1 O -.2]);

fnplt(sp)

z = fnzeros(sp,[.5, 2.7])

zy = zeros(1,size(z,2));

hold on, plot(z(1,:),zy,'>',z(2,:),zy,'<'), hold off

This gives the following list of zeros:

Z:
1.0000 2.0000
1.0000 2.7000

Notice the resulting zero interval [2..2.7], due to the fact that, by
definition, a spline in B-form is identically zero outside its basic
interval, [0..2].

Example 4. The following example shows the use of fnzeros with
a discontinuous function. The following code creates and plots a
discontinuous piecewise linear function, and finds the zeros.

sp = spmak([0 O 1 1 2 2],[-1 1 -1 1]);

fnplt(sp);
fnzeros(sp)

This gives the following list of zeros, in (1..2) and (0..1) and the jump
through zero at 1:

ans =

o

.5000 1.0000 1.5000
.5000 1.0000 1.5000

o
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Algorithms fnzeros first converts the function to B-form. The function performs
some preprocessing to handle discontinuities, and then uses the
algorithm of Merken and Reimers.

Reference: Knut Merken and Martin Reimers, An unconditionally
convergent method for computing zeros of splines and polynomaials,
Math. Comp. 76:845--865, 2007.

See Also fnmin | fnval
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Purpose Formula of cfit, sfit, or fittype object
Syntax formula(fun)
Description formula(fun) returns the formula of the cfit, sfit, or fittype object
fun as a character array.
Examples f = fittype('weibull');
formula(f)
ans =

a*b*x” (b-1)*exp(-a*x"~h)
g = fittype('cubicspline');
formula(g)

ans =
piecewise polynomial

See Also fittype | coeffnames | numcoeffs | probnames | coeffvalues
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Purpose
Syntax

Description

Examples

References

Franke’s bivariate test function
z = franke(x,y)

z = franke(x,y) returns the value z(1i) of Franke’s function at the
site (x(1i),y (1)), i=1:numel(x), with z of the same size as x and y
(which must be of the same size).

Franke’s function is the following weighted sum of four exponentials:

3 ~0x-27+9y-27%)/4 3 ~((9x+1)2/49-(9y+1)/10)
4 4
N %e—((9x—7)2+(9 y-32)/4 %e—((Qx—4)2—(9 y-70)

The following commands provide a plot of Franke’s function:

pts = (0:50)/50; [x,y] = ndgrid(pts,pts); z = franke(x,y);
surf(x,y,z), view(145,-2), set(gca, 'Fontsize',16)

[1] Richard Franke. “A critical comparison of some methods for
interpolation of scattered data.” Naval Postgraduate School Tech.Rep.
NPS-53-79-003, March 1979.

16-139



get

Purpose

Syntax

Description

Examples
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Get fit options structure property names and values

get(options)
s = get(options)
value = get(options,fld)

get(options) displays all property names and values of the fit options
structure options.

s = get(options) returns a copy of the fit options structure options
as the structure s.

value = get(options,fld) returns the value of the property r1d of
the fit options structure options. f1d can be a cell array of strings, in
which case value is also a cell array.

options = fitoptions('fouriert');
get(options, 'Method')
ans =
NonlinearlLeastSquares
get(options, 'MaxIter')
ans =

400
set(options, 'Maxiter',1e3);
get(options, 'MaxIter')
ans =

1000

Property values can also be referenced and assigned using the dot
notation. For example:

options.MaxIter
ans =
1000
options.MaxIter = 500;
options.MaxIter
ans =
500
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See Also fitoptions | set
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Purpose
Syntax

Description

See Also
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Interactive creation of cubic spline curve

[xy,spcv] = getcurve

[xy,spcv] = getcurve displays a gridded window and asks you for
input. As you click on points in the gridded window, the broken line
connecting these points is displayed. To indicate that you are done, click
outside the gridded window. Then a cubic spline curve, spcv, through
the point sequence, xy, is computed (via cscvn) and drawn. The point
sequence and, optionally, the spline curve are output.

If you want a closed curve, place the last point close to the initial point.
If you would like the curve to have a corner at some point, click on that

point twice (or more times) in succession.

cscvn
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Purpose
Syntax

Description

Examples

See Also

Independent variable of cfit, sfit, or fittype object
indep = indepnames(fun)

indep = indepnames(fun) returns the independent variable name or
names (indep) of the cfit, sfit, or fittype object fun. For curves
indep is a 1-by-1 cell array of strings, and for surfaces indep is a 2-by-1
cell array of strings.

f1 = fittype('a*x"2+b*exp(n*x)"');
indep1 = indepnames(f1)
indep1 =
Ty
f2 = fittype('a*x"2+b*exp(n*x) "', 'independent’','n');
indep2 = indepnames(f2)
indep2
‘n'

dependnames | fittype | formula
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Purpose
Syntax

Description

Examples
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Integrate cfit object

int = integrate(fun,x,x0)

int integrate(fun,x,x0) integrates the cfit object fun at the
points specified by the vector x, starting from x0, and returns the result
in int. int is a vector the same size as x. x0 is a scalar.

Create a baseline sinusoidal signal:

xdata = (0:.1:2*pi)"';
y0 = sin(xdata);

Add noise to the signal:

noise = 2*y0.*randn(size(y0)); % Response-dependent
% Gaussian noise

ydata y0 + noise;

Fit the noisy data with a custom sinusoidal model:

f = fittype('a*sin(b*x)"');
fit1 = fit(xdata,ydata,f, 'StartPoint',[1 1]);

Find the integral of the fit at the predictors:

int = integrate(fiti1,xdata,0);

Plot the data, the fit, and the integral:

subplot(2,1,1)

plot(fitl1,xdata,ydata) % cfit plot method
subplot(2,1,2)

plot(xdata,int,'m') % double plot method
grid on

legend('integral')
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+  data |
+ + + fited curve

0 1 2 3 4 5 5 7

Note that integrals can also be computed and plotted directly with the
cfit plot method, as follows:

plot(fiti1,xdata,ydata,{'fit', 'integral'})
The plot method, however, does not return data on the integral.

See Also fit | plot | differentiate
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Purpose Determine if cfit, sfit, or fittype object is linear
Syntax flag = islinear(fun)
Description flag = islinear(fun) returnsa flag of 1ifthe cfit, sfit, or fittype

object fun represents a linear model, and a flag of 0 if it does not.

Note islinear assumes that all custom models specified by the
fittype function using the syntax ftype = fittype('expr')
are nonlinear models. To create a linear model with

fittype that will be recognized as linear by islinear (and,
importantly, by the algorithms of fit), use the syntax ftype =
fittype({'expri','expr2',...,"'exprn'}).

Examples f = fittype('a*x+b')

General model:
f(a,b,x) = a*x+b

g = fittype({'x","1'})

Linear model:
g(a,b,x) = a*x + b

h = fittype('polyl')

h =
Linear model Polyft:
h(p1,p2,x) = p1*x + p2
islinear(f)
ans =
0
islinear(g)
ans =
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1
islinear(h)
ans =

1

See Also fittype
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knt2brk, knt2milt

Purpose

Syntax

Description

Examples
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Convert knots to breaks and their multiplicities

knt2brk (knots)

[breaks,mults] = knt2brk(knots)
m = knt2mlt(t)

[m,sortedt] = knt2mlt(t)

The commands extract the distinct elements from a sequence, as well
as their multiplicities in that sequence, with multiplicity taken in two
slightly different senses.

knt2brk(knots) returns the distinct elements in knots, and in
increasing order, hence is the same as unique (knots).

[breaks,mults] = knt2brk(knots) additionally provides, in
mults, the multiplicity with which each distinct element occurs

in knots. Explicitly, breaks and mults are of the same length,

and knt2brk is complementary to brk2knt in that, for any knot
sequence knots, the two commands [xi,mlts] = knt2brk(knots);
knots1 = brk2knt(xi,mlts); give knots1 equal to knots

m = knt2mlt(t) returns a vector of the same length as t, with m(i)
counting, in the vector sort(t), the number of entries before its ith
entry that are equal to that entry. This kind of multiplicity vector is
needed in spapi or spcol where such multiplicity is taken to specify
which particular derivatives are to be matched at the sites in t.
Precisely, if t is nondecreasing and z is a vector of the same length,
then sp = spapi(knots, t, z) attempts to construct a spline s (with
knot sequence knots) for which D"®s(t(i)) equals z(i), all i.

[m,sortedt] = knt2mlt(t) also returns the output from sort(t).

Neither knt2brk nor knt2mlt is likely to be used by the casual user
of this toolbox.

[xi,mlts]=knt2brk([1 2 3 3 1 3]) returns [1 2 3] for xi and [2
1 3] for mlts.
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|

[m,t]=knt2mlt([1 2 3 3 1 3]) returns [0 1 0 0 1 2] for m and
[1 1233 3] fort.

See Also brk2knt | spapi | spcol
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Purpose

Syntax

Description

Examples

Algorithms
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New break distribution

newknots = newknt(f,newl)
newknt ()
[...,distfn] = newknt(...)

newknots = newknt(f,newl) returns the knot sequence whose
interior knots cut the basic interval of f into newl pieces, in such a way
that a certain piecewise linear monotone function related to the high
derivative of f is equidistributed.

The intent is to choose a knot sequence suitable to the fine
approximation of a function g whose rough approximation in f is
assumed to contain enough information about g to make this feasible.

newknt (f) uses for newl its default value, namely the number of
polynomial pieces in f.

[...,distfn] = newknt(...) alsoreturns, in distfn, the ppform of
that piecewise linear monotone function being equidistributed.

If the error in the least-squares approximation sp to some data x,y by
a spline of order k seems uneven, you might try for a more equitable
distribution of knots by using

spap2 (newknt(sp),k,x,y);

For another example, see the last part of the demo “Solving an ODE
by Collocation”.

This is the Fortran routine NEWNOT in PGS. With % the order of
the piecewise-polynomial function f in pp, the function | D*f|

is approximated by a piecewise constant function obtained by
local, discrete, differentiation of the variation of D*!f. The new
break sequence is chosen to subdivide the basic interval of the
piecewise-polynomial fin such a way that
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knots(i+1) i
J.new O DR MR = const, i=k: k+newl—1

newknots(i)
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Purpose Number of input arguments of cfit, sfit, or fittype object
Syntax nargs = numargs(fun)
Description nargs = numargs(fun) returns the number of input arguments nargs

of the cfit, sfit, or fittype object fun.

Examples f = fittype('a*x"2+b*exp(n*x)');
nargs = numargs(f)
nargs =

args = argnames(f)
args =

See Also fittype | formula | argnames
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Purpose Number of coefficients of cfit, sfit, or fittype object
Syntax ncoeffs = numcoeffs(fun)
Description ncoeffs = numcoeffs(fun) returns the number of coefficients ncoeffs

of the cfit, sfit, or fittype object fun.

Examples f = fittype('a*x"2+b*exp(n*x)');

ncoeffs = numcoeffs(f)

ncoeffs =
3

coeffs = coeffnames(T)

coeffs
g
Y
N

See Also fittype | formula | coeffnames
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Purpose

Syntax

Description
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Knot distribution “optimal” for interpolation

knots = optknt(tau,k,maxiter)
optknt(tau,k)

knots = optknt(tau,k,maxiter) provides the knot sequence t that
is best for interpolation from S, ; at the site sequence tau, with 10
the default for the optional input maxiter that bounds the number
of iterations to be used in this effort. Here, best or optimal is used

in the sense of Micchelli/Rivlin/Winograd and Gaffney/Powell, and
this means the following: For any recovery scheme R that provides
an interpolant Rg that matches a given g at the sites tau(1),

..., tau(n), we may determine the smallest constant const,, for
which ||g — Rgl| < consty, || D || for all smooth functions g.

Here, ||f] [:=SUD 1) < x < taum | f®) |- Then we may look for the optimal
recovery scheme as the scheme R for which const, is as small as
possible. Micchelli/Rivlin/Winograd have shown this to be interpolation
from S 1» With t uniquely determined by the following conditions:

1t(1)= ... =1t(k)=rtau(1);
2 t(n+1) = ... = t(n+tk) = tau(n);

3 Any absolutely constant function 2 with sign changes at the sites
t(k+1), ..., t(n) and nowhere else satisfies

tau(n)
jtau(l) f)h(x)dx =0 for all f € Sy,

Gaffney/Powell called this interpolation scheme optimal since it
provides the center function in the band formed by all interpolants to
the given data that, in addition, have their kth derivative between M
and —M (for large M).

optknt(tau,k) is the same as optknt(tau,k,10).
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Examples

Algorithms

References

See Also

See the last part of the demo “Spline Interpolation” for an illustration.
For the following highly nonuniform knot sequence

t = [0, .0012+[0, 1, 2+[0,.1], 4]*1e-5, .002, 1];

the command optknt(t,3) will fail, while the command
optknt(t,3,20), using a high value for the optional parameter
maxiter, will succeed.

This is the Fortran routine SPLOPT in PGS. It is based on an algorithm
described in , for the construction of that sign function A mentioned
above. It is essentially Newton’s method for the solution of the resulting
nonlinear system of equations, with aveknt (tau, k) providing the first
guess for t(k+1), ...,t(n), and some damping used to maintain the
Schoenberg-Whitney conditions.

[1]C. de Boor, “Computational aspects of optimal recovery”, in Optimal
Estimation in Approximation Theory, C.A. Micchelli & T.J. Rivlin eds.,
Plenum Publ., New York, 1977, 69-91.

[2]P.W. Gaffney & M.J.D. Powell, “Optimal interpolation”, in Numerical
Analysis, G.A. Watson ed., Lecture Notes in Mathematics, No. 506,
Springer-Verlag, 1976, 90-99.

[3]C.A. Micchelli, T.J. Rivlin & S. Winograd, “The optimal recovery of
smooth functions”, Numer. Math. 80, (1974), 903-906.

aptknt | aveknt | newknt
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Purpose

Syntax

Description
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Plot cfit or sfit object

plot(sfit)
plot(sfit, [x, y], 2)
plot(sfit, [x, y], z, 'Exclude', ExcludeData)

H = plot(sfit, ..., 'Style', Style)

H = plot(sfit, ..., 'Level', Level)

H = plot(sfit, ..., 'XLim', XLIM)

H = plot(sfit, ..., 'YLim', YLIM)

H = plot(sfit, ...)

H = plot(sfit, ..., 'Parent', HAXES )
plot(cfit)

plot(cfit,x,y)

plot(cfit,x,y,DataLineSpec)
plot(cfit,FitLineSpec,x,y,DataLineSpec)
plot(cfit,x,y,outliers)
plot(cfit,x,y,outliers,OutlierLineSpec)
plot(...,ptype,...)
plot(...,ptype,level)

h = plot(...)

For surfaces:

® plot(sfit) plots the sfit object over the range of the current axes,
if any, or otherwise over the range stored in the fit.

® plot(sfit, [x, y], z) plots z versus x and y and plots sfit over
the range of x and y.

® plot(sfit, [x, y], z, 'Exclude', ExcludeData) plots the
excluded data in a different color. ExcludeData is a logical array
where true represents an outlier.

® H = plot(sfit, ..., 'Style', Style) selects which way to plot
the surface fit object sfit.

Style may be any of the following strings
= 'Surface' Plot the fit object as a surface (default)
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= 'PredFunc' Surface with prediction bounds for function

= 'PredObs' Surface with prediction bounds for new observation
= 'Residuals’' Plot the residuals (fit is the plane Z=0)

= 'Contour' Make a contour plot of the surface

® H = plot(sfit, ..., 'Level', Level) sets the confidence level to
be used in the plot. Level is a positive value less than 1, and has a
default of 0.95 (for 95% confidence). This option only applies to the
'PredFunc' and 'PredObs' plot styles.

® H = plot(sfit, ..., 'XLim', XLIM) andH = plot(sfit, ...,
'YLim', YLIM) sets the limits of the axes used for the plot. By
default the axes limits are taken from the data, XY. If no data is
given, then the limits are taken from the surface fit object, sfit.

® H = plot(sfit, ...) returns a vector of handles of the plotted
objects.
® H = plot(sfit, ..., 'Parent', HAXES ) plots the fit object sfit

in the axes with handle HAXES rather than the current axes. The
range is taken from these axes rather than from the fit or the data.

For curves:

® plot(cfit) plots the cfit object over the domain of the current axes,
if any. If there are no current axes, and fun is an output from the fit
function, the plot is over the domain of the fitted data.

® plot(cfit,x,y) plots cfit together with the predictor data x and
the response data vy.

® plot(cfit,x,y,DataLineSpec) plots the predictor and response
data using the color, marker symbol, and line style specified by the
DataLineSpec formatting string. DataLineSpec strings take the
same values as LineSpec strings used by the MATLAB plot function.

® plot(cfit,FitLineSpec,x,y,DataLineSpec) plots fun using the
color, marker symbol, and line style specified by the FitLineSpec
formatting string, and plots x and y using the color, marker symbol,
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and line style specified by the DataLineSpec formatting string.
FitLineSpec and DatalLineSpec strings take the same values as
LineSpec strings used by the MATLAB plot function.

plot(cfit,x,y,outliers) plots data indicated by outliers in a
different color. outliers is a logical array the same size as x and y.
outliers can be computed with the excludedata function.

plot(cfit,x,y,outliers,OutlierLineSpec) plots outliers

using the color, marker symbol, and line style specified by the
OutlierLineSpec. OutlierLineSpec strings take the same values as
LineSpec strings used by the MATLAB plot function.

plot(...,ptype,...) uses the plot type specified by ptype.
Supported plot types are:

= 'fit' — Data and fit (default)
= 'predfunc' — Data and fit with prediction bounds for the fit

= 'predobs' — Data and fit with prediction bounds for new
observations

= 'residuals' — Residuals

= 'stresiduals' — Standardized residuals (residuals divided by
their standard deviation).

= 'derivi1' — First derivative of the fit

= 'deriv2' — Second derivative of the fit

= 'integral' — Integral of the fit

plot(...,ptype,level) plots prediction intervals with a confidence
level specified by level. level must be between 0 and 1. The default
value of level is 0.95.

For both curves and surfaces:

® Plot types can be single or multiple, with multiple plot types specified

as a cell array of strings. With a single plot type, plot draws to the
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current axes and can be used with commands like hold and subplot.
With multiple plot types, plot creates subplots for each plot type.

® h = plot(...) returns a vector of handles to the plotted objects.

Examples Create a baseline sinusoidal signal:

xdata = (0:0.1:2*%*pi)’;
y0 = sin(xdata);

Add noise to the signal with non-constant variance:

% Response-dependent Gaussian noise
gnoise = yO0.*randn(size(y0));

% Salt-and-pepper noise

spnoise = zeros(size(y0));

p = randperm(length(y0));

sppoints = p(1:round(length(p)/5));
spnoise(sppoints) = 5*sign(y0(sppoints));

ydata = y0 + gnoise + spnoise;

Fit the noisy data with a baseline sinusoidal model:

f = fittype('a*sin(b*x)"');
fit1 = fit(xdata,ydata,f, 'StartPoint',[1 1]);

Identify “outliers” as points at a distance greater than 1.5 standard
deviations from the baseline model, and refit the data with the outliers
excluded:

fdata = feval(fiti1,xdata);
I = abs(fdata - ydata) > 1.5*std(ydata);
outliers = excludedata(xdata,ydata,'indices',I);

fit2 = fit(xdata,ydata,f,'StartPoint',[1 1],...
'"Exclude' ,outliers);
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Compare the effect of excluding the outliers with the effect of giving
them lower bisquare weight in a robust fit:

fit3 = fit(xdata,ydata,f, 'StartPoint',[1 1], 'Robust','on');

Plot the data, the outliers, and the results of the fits:

plot(fit1,'r-',xdata,ydata, 'k."',outliers, 'm*")
hold on

plot(fit2,'c--")

plot(fit3,'b:")

x1im ([0 2*pi])

3 T : T T . r
# +  data
6L * o N *  excluded data |
* #* fited curve
4l * fitted curve
--------- fitted curve

Plot the residuals for the two fits considering outliers:

figure
plot(fit2,xdata,ydata, 'co', 'residuals')
hold on
plot(fit3,xdata,ydata, 'bx', 'residuals')
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See Also cftool | excludedata | fit | differentiate | integrate
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Purpose

Syntax

Description
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Put together spline in ppform

ppmak (breaks,coefs)

ppmak

ppmak (breaks,coefs,d)
ppmak (breaks,coefs,sizec)

The command ppmak(...) puts together a spline in ppform from
minimal information, with the rest inferred from that information.
fnbrk provides any or all of the parts of the completed description. In
this way, the actual data structure used for the storage of the ppform is
easily modified without any effect on the various fn... commands that
use this construct. However, the casual user is not likely to use ppmak
explicitly, relying instead on the various spline construction commands
in the toolbox to construct particular splines.

ppmak (breaks,coefs) returns the ppform of the spline specified by the
break information in breaks and the coefficient information in coefs.
How that information is interpreted depends on whether the function
1s univariate or multivariate, as indicated by breaks being a sequence
or a cell array.

If breaks is a sequence, it must be nondecreasing, with its first entry
different from its last. Then the function is assumed to be univariate,
and the various parts of its ppform are determined as follows:

1 The number 1 of polynomial pieces is computed as
length(breaks)-1, and the basic interval is, correspondingly, the
interval [breaks (1) .. breaks(1+1)].

2 The dimension d of the function’s target is taken to be the number
of rows in coefs. In other words, each column of coefs is taken to
be one coefficient. More explicitly, coefs(:,i*k+j) is assumed to
contain the jth coefficient of the (i+1)st polynomial piece (with the
first coefficient the highest and the kth coefficient the lowest, or
constant, coefficient). Thus, with k1 the number of columns of coefs,
the order k of the piecewise-polynomial is computed as fix (k1/1).
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After that, the entries of coefs are reordered, by the command

coefs = reshape(permute(reshape(coefs,[d,k,1]),[1 3 2]),[d*1,k])

in order to conform with the internal interpretation of the coefficient
array in the ppform for a univariate spline. This only applies when you
use the syntax ppmak (breaks,coefs) where breaks is a sequence (row
vector), not when it is a cell-array. The permutation is not made when
you use the three-argument forms of ppmak. For the three-argument
forms only a reshape is done, not a permute.

If breaks is a cell array, of length m, then the function is assumed to
be m-variate (tensor product), and the various parts of its ppform are
determined from the input as follows:

1 The m-vector 1 has length(breaks{i})-1 as its ith entry and,
correspondingly, the m-cell array of its basic intervals has the interval
[breaks{i}(1) .. breaks{i}(end)] asits ith entry.

2 The dimension d of the function’s target and the m-vector k of
(coordinate-wise polynomial) orders of its pieces are obtained directly
from the size of coefs, as follows.

a If coefs is an m-dimensional array, then the function is taken to
be scalar-valued, i.e., d is 1, and the m-vector k is computed as
size(coefs)./1l. After that, coefs is reshaped by the command
coefs = reshape(coefs,[1,size(coefs)]).

b If coefs is an (r+m)-dimensional array, with sizec = size(c)
say, then d is set to sizec(1:r), and the vector k is computed as
sizec(r+(1:m))./1. After that, coefsisreshaped by the command
coefs = reshape(coefs,[prod(d),sizec(r+(1:m))]).

Then, coefs is interpreted as an equivalent array of

size [d,1(1),k(1),1(2),k(2),...,1(m),k(m)], with its
(:,i(1),r(1),i(2),r(2),...,i(m),r(m))th entry the coefficient of
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H (x(u) —breaks | y](i(u)))(k(u)—r(u))
u=1

in the local polynomial representation of the function on the
(hyper)rectangle with sides

[breaks | ul(i(u)) .. breaks | ul(i(u)+1)l, wu=1:m

This 1is, in fact, the internal interpretation of the coefficient array in the
ppform of a multivariate spline.

ppmak prompts you for breaks and coefs.

ppmak (breaks,coefs,d) with d a positive integer, also puts together
the ppform of a spline from the information supplied, but expects the
function to be univariate. In that case, coefs is taken to be of size
[d*1,k], with 1 obtained as length(breaks) -1, and this determines
the order, k, of the spline. With this, coefs(i*d+j,:) is taken to be the
jth components of the coefficient vector for the (i+1)st polynomial piece.

ppmak (breaks,coefs,sizec) with sizec a row vector of positive
integers, also puts together the ppform of a spline from the information
supplied, but interprets coefs to be of size sizec (and returns an error
when prod(size(coefs)) differs from prod(sizec)). This option is
important only in the rare case that the input argument coefs is an
array with one or more trailing singleton dimensions. For, MATLAB
suppresses trailing singleton dimensions, hence, without this explicit
specification of the intended size of coefs, ppmak would interpret coefs
incorrectly.

The two splines

p1 = ppmak([1 3 4],[1 2 5 6;3 4
p2 = ppmak([1 3 4],[1 2;3 4;5 6;

have exactly the same ppform (2-vector-valued, of order 2). But the
second command provides the coefficients in the arrangement used
internally.
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ppmak([0:2],[1:6]) constructs a piecewise-polynomial function with
basic interval [0..2] and consisting of two pieces of order 3, with the sole
interior break 1. The resulting function is scalar, i.e., the dimension

d of its target is 1. The function happens to be continuous at that
break since the first piece is x| —x? + 2x + 3, while the second piece is
x| —4(x — 1)2 + 5(x—1) + 6.

When the function is univariate and the dimension d is not explicitly
specified, then it is taken to be the row number of coefs. The column
number should be an integer multiple of the number 1 of pieces specified
by breaks. For example, the statement ppmak ([0:2],[1:3;4:6]) leads
to an error, since the break sequence [0:2] indicates two polynomial
pieces, hence an even number of columns are expected in the coefficient
matrix. The modified statement ppmak([0:1],[1:3;4:6]) specifies
the parabolic curve x| —(1,4)x® + (2,5)x + (3,6). In particular, the
dimension d of its target is 2. The differently modified statement
ppmak([0:2],[1:4;5:8]) also specifies a planar curve (i.e., d is 2), but
this one is piecewise linear; its first polynomial piece is x| —(1,5)x + (2,6).

Explicit specification of the dimension d leads, in the univariate

case, to a different interpretation of the entries of coefs. Now the
column number indicates the polynomial order of the pieces, and the
row number should equal d times the number of pieces. Thus, the
statement ppmak ([0:2],[1:4;5:8],2) is in error, while the statement
ppmak([0:2],[1:4;5:8]1,1) specifies a scalar piecewise cubic whose
first piece is x| —x® + 2x2 + 3x + 4.

If you wanted to make up the constant polynomial, with basic interval
[0..1] say, whose value is the matrix eye(2), then you would have to use
the full optional third argument, i.e., use the command

pp = ppmak(0:1,eye(2),[2,2,1,1]);

Finally, if you want to construct a 2-vector-valued bivariate polynomial
on the rectangle [-1 .. 1] x [0 .. 1], linear in the first variable and
constant in the second, say

coefs = zeros(2,2,1); coefs(:,:,1) = [1 0; 0 1];
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then the straightforward
pp = ppmak({[-1 1],[0 1]},coefs);

will fail, producing a scalar-valued function of order 2 in each variable,
as will

pp = ppmak({[-1 1],[0 1]},coefs,size(coefs));

while the following command will succeed:

pp = ppmak({[-1 1],[0 1]},coefs,[2 2 1]);

See the demo “Intro to ppform” for other examples.

See Also fnbrk
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Purpose

Syntax

Description

Prediction intervals for cfit or sfit object

ci = predint(fitresult,x)

ci predint (fitresult,x,level)

ci predint (fitresult,x,level,intopt,simopt)
[ci,y] = predint(...)

ci = predint(fitresult,x) returns upper and lower 95% prediction
bounds for response values associated with the cfit object fitresult
at the new predictor values specified by the vector x. fitresult must
be an output from the fit function to contain the necessary information
for ci. ci is an n-by-2 array where n = length(x). The left column

of ci contains the lower bound for each coefficient; the right column
contains the upper bound.

ci = predint(fitresult,x,level) returns prediction bounds with
a confidence level specified by level. level must be between 0 and 1.
The default value of level is 0.95.

ci = predint(fitresult,x,level,intopt,simopt) specifies the type
of bounds to compute.

intopt is one of

e 'observation' — Bounds for a new observation (default)

e 'functional' — Bounds for the fitted curve
simopt is one of

e 'off' — Non-simultaneous bounds (default)

® 'on' — Simultaneous bounds

Observation bounds are wider than functional bounds because they
measure the uncertainty of predicting the fitted curve plus the random

variation in the new observation. Non-simultaneous bounds are for
individual elements of x; simultaneous bounds are for all elements of x.
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[ci,y] = predint(...) returns the response values y predicted by
fitresult at the predictors in x.

Examples Generate data with an exponential trend:
x = (0:0.2:5)';
y = 2*exp(-0.2*x) + 0.5*randn(size(x));

Fit the data using a single-term exponential:
fitresult = fit(x,y, 'expl1');
Compute prediction intervals:

p11 = predint(fitresult,x,0.95, 'observation', 'off');

(
p12 = predint(fitresult,x,0.95, 'observation','on');
p21 = predint(fitresult,x,0.95, 'functional', 'off');
p22 = predint(fitresult,x,0.95, 'functional', 'on');

Plot the data, fit, and prediction intervals:

subplot(2,2,1)

plot(fitresult,x,y),hold on,plot(x,p11, 'm--"),x1lim([0 51])
title('Nonsimultaneous observation bounds', 'Color','m')
subplot(2,2,2)

plot(fitresult,x,y),hold on,plot(x,p12, 'm--"),xlim([0 51])
title('Simultaneous observation bounds', 'Color','m')
subplot(2,2,3)

plot(fitresult,x,y),hold on,plot(x,p21, 'm--"),xlim([0 51])
title('Nonsimultaneous functional bounds', 'Color','m')
subplot(2,2,4)

plot(fitresult,x,y),hold on,plot(x,p22, 'm--"'),xlim([0 51])
title('Simultaneous functional bounds','Color','m')
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Monsimultaneous observation bounds

Simultaneous observation bounds

*

data

fited curve

— .

data
fitted curve |

¥ X
Monsimultaneous functional bounds Simultaneous functional bounds
25 25
\ . +  data . + data
2 N fitted curve |4 21 fitted curve [{

See Also confint | fit | plot
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Purpose

Syntax

Description

See Also
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Prepare data inputs for surface fitting

[XOut, YOut, ZOut] = prepareSurfaceData(XIn, YIn, ZIn)
[XOut, YOut, ZOut, WOut] = prepareSurfaceData(XIn, YIn, ZIn,
WIn)

[XOut, YOut, ZOut] = prepareSurfaceData(XIn, YIn, ZIn)
transforms data, if necessary, for surface fitting with the fit function.
The function transforms data as follows:

® For table data, transform row (YIn) and column (XIn) headers into
arrays YOut and XOut that are the same size as ZIn. Warn if XIn
and YIn are reversed.

® Return data as columns regardless of the input shapes. Error if the
number of elements do not match. Warn if the number of elements
match, but the sizes are different.

® Convert complex to real (remove imaginary parts) and warn of this
conversion.

e Remove NaN or Inf from data and warn of this removal.
® Convert nondouble to double and warn of this conversion.
[XOut, YOut, ZOut, WOut] = prepareSurfaceData(XIn, YIn,

ZIn, WIn) transforms data including weights (WIn) for surface fitting
with the fit function.

fit | excludedata
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Purpose Problem-dependent parameter names of cfit, sfit, or fittype object
Syntax pnames = probnames(fun)
Description pnames = probnames(fun) returns the names of the problem-dependent

(fixed) parameters of the cfit, sfit, or fittype object fun as a cell
array of strings.

Examples f = fittype('(x-a)"n + b','problem',{'a','b'});
coeffnames(f)
ans =
N
probnames (f)
ans =
g
Y

load census

¢ = fit(cdate,pop,f, 'problem',{cdate(1),pop(1)},...
‘StartPoint',2);

coeffvalues(c)
ans =

0.9877
probvalues(c)
ans =

1.0e+003 *
1.7900 0.0039

See Also fittype | coeffnames | probvalues
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Purpose Problem-dependent parameter values of cfit or sfit object
Syntax pvals = probvalues(fun)

Description pvals = probvalues(fun) returns the values of the problem-dependent
(fixed) parameters of the cfit object fun as a row vector.

Examples f = fittype('(x-a)"n + b','problem',{'a','b'});
coeffnames(f)
ans =
N
probnames (f)
ans =
g
Y

load census

c = fit(cdate,pop,f, 'problem', {cdate(1),pop(1)},...
‘StartPoint',2);

coeffvalues(c)
ans =

0.9877
probvalues(c)
ans =

1.0e+003 *
1.7900 0.0039

See Also fit | fittype | probnames
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Purpose

Syntax

Description

See Also

Numerically integrate sfit object

Q = quad2d(FO, a, b, c, d)
[Q,ERRBND] = quad2d(...)
[Q,ERRBND] = QUAD2D(FO,a,b,c,d,PARAM1,VAL1,PARAM2,VAL2,...)

Q = quad2d(FO, a, b, c, d) approximates the integral of the surface

fit object FO over the planar region @ <X < b and clx) <y < d(x) . The

bounds ¢ and d can each be a scalar, a function handle, or a curve fit
(cfit) object.

[Q,ERRBND] = quad2d(...) also returns an approximate upper bound
on the absolute error, ERRBND.

[Q,ERRBND] = QUAD2D(FO,a,b,c,d,PARAMI,VAL1,PARANM2,VAL2, . ..)
performs the integration with specified values of optional parameters.

See the MATLAB function quad2d for details of the upper bound and
the optional parameters.

quad2d | fit | sfit | cfit
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Syntax

Description
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Put together rational spline

rp rpmak (breaks,coefs)
rp rpmak (breaks,coefs,d)
rpmak (breaks,coefs,sizec)
rs = rsmak(knots,coefs)

rs = rsmak(shape,parameters)

Both rpmak and rsmak put together a rational spline from minimal
information. rsmak is also equipped to provide rational splines that
describe standard geometric shapes. A rational spline must be scalar-
or vector-valued.

rp = rpmak(breaks,coefs) has the same effect as the command
ppmak (breaks, coefs) except that the resulting ppform is tagged as a
rational spline, i.e., as a rpform.

To describe what this means, let R be the piecewise-polynomial

put together by the command ppmak (breaks,coefs), and

let r(x) = s(x)/w(x) be the rational spline put together by the
command rpmak (breaks,coefs). If v is the value of R at x, then
v(1:end-1)/v(end) is the value of r at x. In other words, R(x) =
[s(x);w(x)]. Correspondingly, the dimension of the target of r is one less
than the dimension of the target of R. In particular, the dimension
(of the target) of R must be at least 2, i.e., the coefficients specified
by coefs must be d-vectors with d > 1. See ppmak for how the input
arrays breaks and coefs are being interpreted, hence how they are to
be specified in order to produce a particular piecewise-polynomial.

rp = rpmak(breaks,coefs,d) has the same effect as

ppmak (breaks,coefs,d+1), exceptthat the resulting ppform is tagged
as being a rpform. Note that the desire to have that optional third
argument specify the dimension of the target requires different values
for it in rpmak and ppmak for the same coefficient array coefs.

rpmak (breaks,coefs,sizec) has the same effect as

ppmak (breaks,coefs,sizec) except that the resulting ppform is
tagged as being a rpform, and the target dimension is taken to be
sizec(1)-1.
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Examples

rs = rsmak(knots,coefs) is similarly related to spmak(knots,coefs),
and rsmak (knots,coefs,sizec) to spmak(knots,coefs,sizec). In
particular, rsmak (knots,coefs) puts together a rational spline in
B-form, i.e., it provides a rBform. See spmak for how the input arrays
knots and coefs are being interpreted, hence how they are to be
specified in order to produce a particular piecewise-polynomial.

rs = rsmak(shape,parameters) provides a rational spline in rBform
that describes the shape being specified by the string shape and the
optional additional parameters. Specific choices are:

rsmak('arc',radius,center,[alpha,beta])
rsmak('circle',radius,center)
rsmak('cone',radius,halfheight)
rsmak('cylinder',radius,height)

rsmak ( 'southcap',radius,center)
rsmak('torus',radius,ratio)

with 1 the default value for radius, halfheight and height, and
the origin the default for center, and the arc running through all
the angles from alpha to beta (default is [-pi/2,pi/2]), and the
cone, cylinder, and torus centered at the origin with their major circle
in the (x,y)-plane, and the minor circle of the torus having radius
radius*ratio, the default for ratio being 1/3.

From these, one may generate related shapes by affine transformations,
with the help of fncmb(rs,transformation).

All fn... commands except fnint, fnder, fndir can handle rational
splines.

The commands

runges = rsmak(
rungep = rpmak (

[-5 -5 -5 55 5],[1 1 1; 26 -24 26]);
[-5 5],[0 0 1; 1 -10 26],1);

both provide a description of the rational polynomial r(x) = 1/(x> + 1) on
the interval [-5 .. 5]. However, outside the interval [-5 .. 5], the function
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given by runges is zero, while the rational spline given by rungep
agrees with 1/(x% + 1) for every x.

The figure of a rotated cone is generated by the commands

fnplt(fncmb(rsmak('cone',1,2),[0 0 -1;0 1 0;1 0 0]))
axis equal, axis off, shading interp

A Rotated Cone Given by a Rational Quadratic Spline

A Helix on page 16-177, showing a helix with several windings, is
generated by the commands

arc = rsmak('arc',2,[1;-11,[0 7.3*pi]);

[knots,c] = fnbrk(arc,'k','c');

helix = rsmak(knots, [c(1:2,:);aveknt(knots,3).*c(3,:);
c(3,:)1);

fnplt(helix)
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See Also

10

A Helix

For further illustrated examples, see Chapter 12, “NURBS and Other
Rational Splines”

rsmak | fnbrk | ppmak | spmak
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Purpose

Syntax

Description
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Piecewise biarc Hermite interpolation

c = rscvn(p,u)
¢ = rscvn(p)
¢ = rscvn(p,u) returns a planar piecewise biarc curve (in quadratic

rBform) that passes, in order, through the given points p(:,j) and

is constructed in the following way (see Construction of a Biarc on
page 16-180). Between any two distinct points p(:,j) and p(:,j+1),
the curve usually consists of two circular arcs (including straight-line
segments) which join with tangent continuity, with the first arc starting
at p(:,j) and normal there to u(:,j), and the second arc ending at
p(:,j+1) and normal there to u(:,j+1), and with the two arcs written
as one whenever that is possible. Thus the curve is tangent-continuous
everywhere except, perhaps, at repeated points, where the curve may
have a corner, or when the angle, formed by the two segments ending
at p(:,j), is unusually small, in which case the curve may have a
cusp at that point.

p must be a real matrix, with two rows, and at least two columns,
and any column must be different from at least one of its neighboring
columns.

u must be a real matrix with two rows, with the same number of columns
as p (for two exceptions, see below), and can have no zero column.

¢ = rscvn(p) chooses the normals in the following way. For j=2:end-1,
u(:,j) is the average of the (normalized, right-turning) normals to the
vectors p(:,3)-p(:,j-1) andp(:,j+1)-p(:,i). lfp(:,1)==p(:,end),
then both end normals are chosen as the average of the normals to
p(:,2)-p(:,1)and p(:,end)-p(:,end-1), thus preventing a corner in
the resulting closed curve. Otherwise, the end normals are so chosen
that there is only one arc over the first and last segment (not-a-knot
end condition).

rscvn(p,u), with u having exactly two columns, also chooses the
interior normals as for the case when u is absent but uses the two
columns of u as the end-point normals.
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Examples

Example 1. The following code generates a description of a circle, using
just four pieces. Except for a different scaling of the knot sequence, it 1s
the same description as is supplied by rsmak('circle',1,[1;1]).

p=[10-101; 010 -10]; ¢ =rscvn([p(1,:)+1;p(2,:)+1],p);

The same circle, but using just two pieces, is provided by

c2 = rscvn([0,2,0; 1,1,1]);

Example 2. The following code plots two letters. Note that the second
letter is the result of interpolation to just four points. Note also the use
of translation in the plotting of the second letter.

p=1([-1.8-11-1-1-1;31.75 .5 -1.25 -3 -3 3];
i eye(2); u=1i(:,[21 2121 1]); B = rscvn(p,u);
S = rscvn([1 -1 1 -1; 2.5 2.5 -2.5 -2.5]);

fnplt(B), hold on, fnplt(fncmb(S,[3;0])), hold off
axis equal, axis off

Two Letters Composed of Circular Arcs

Example 3. The following code generates the Construction of a Biarc
on page 16-180, of use in the discussion below of the biarc construction
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Algorithms

16-180

used here. Note the use of fntlr to find the tangent to the biarc at the
beginning, at the point where the two arcs join, and at the end.

p=1[01;00]; u=7_[.5-.1;-.25 .5];

plot(p(1,:),p(2,:),'k"), hold on

biarc = rscvn(p,u); breaks = fnbrk(biarc,'b');
fnplt(biarc,breaks(1:2),'b',8), fnplt(biarc,breaks(2:3),'r',3)
vd = fntlr(biarc,2,breaks);
quiver(vd(1,:),vd(2,:),vd(4,:),-vd(3,:)), hold off

§ \\\ﬁﬂ\\iég )
u

Construction of a Biarc

Given two distinct points, p1 and p2, in the plane and, correspondingly,
two nonzero vectors, u1 and u2, there is a one-parameter family of
biarcs (i.e., a curve consisting of two arcs with common tangent at their
join) starting at p1 and normal there to u1 and ending at p2 and normal
there to u2. One way to parametrize this family of biarcs is by the
normal direction, v, at the point q at which the two arcs join. With a
nonzero vV chosen, there is then exactly one choice of g, hence the entire
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biarc is then determined. In the construction used in rscvn, v is chosen
as the reflection, across the perpendicular to the segment from p1 to
p2, of the average of the vectors u1 and u2, -- after both vectors have
been so normalized that their length is 1 and that they both point to
the right of the segment from p1 to p2. This choice for v seems natural
in the two standard cases: (1) u2 is the reflection of u1 across the
perpendicular to the segment from p1 to p2; (i1) ul and u2 are parallel.
This choice of v is validated by Biarcs as a Function of the Left Normal
on page 16-181 which shows the resulting biarcs when p1, p2, and u2 =
[ .809; .588]are kept fixed and only the normal at p1 is allowed to vary.

Biarcs as a Function of the Left Normal

But it is impossible to have the interpolating biarc depend continuously
at all four data, p1, p2, ul, u2. There has to be a discontinuity as the
normal directions, u1 and u2, pass through the direction from p1 to p2.
This is illustrated in Biarcs as a Function of One Endpoint on page
16-182 which shows the biarcs when one point, p1 = [0;0], and the
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two normals, ul = [1;1] andu2 = [1;-1], are held fixed and only the
other point, p2, moves, on a circle around p1.

;‘=

/
7

[/
us

Biarcs as a Function of One Endpoint

See Also rsmak | cscvn
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Purpose
Syntax

Description

See Also

Put together rational spline for standard geometric shapes

rs = rsmak(shape,parameters)

rs = rsmak(shape,parameters) provides a rational spline in rBform that
describes the shape being specified by the string shape and the optional
additional parameters. Specific choices for shape are:

rsmak('arc',radius,center,[alpha,betal)
rsmak('circle',radius,center)
rsmak('cone',radius,halfheight)
rsmak('cylinder',radius,height)
rsmak('southcap',radius,center)
rsmak('torus',radius,ratio)

with 1 the default value for radius, halfheight and height, and
the origin the default for center, and the arc running through all
the angles from alpha to beta (default is [-pi/2,pi/2]), and the
cone, cylinder, and torus centered at the origin with their major circle
in the (x,y)-plane, and the minor circle of the torus having radius
radius*ratio, the default for ratio being 1/3.

From these, one may generate related shapes by affine transformations,
with the help of fncmb(rs,transformation).

See rpmak for more information on other options.

rpmak
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Purpose

Syntax

Description

Examples
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Assign values in fit options structure

set(options)

s = set(options)
set(options,fldi,vall,fld2,val2,...)
set(options,flds,vals)

set(options) displays all property names of the fit options structure
options. If a property has a finite list of possible string values, these
values are also displayed.

s = set(options) returns a structure s with the same property names
as options. If a property has a finite list of possible string values, the
value of the property in s is a cell array containing the possible string
values. If a property does not have a finite list of possible string values,
the value of the property in s is an empty cell array.

set(options,fldi,vall,fld2,val2,...) sets the properties specified
by the strings f1d7, f1d2, ... to the values vali, val2, ..., respectively.

set(options,flds,vals) sets the properties specified by the cell array

of strings f1ds to the corresponding values in the cell array vals.

Create a custom nonlinear model, and create a default fit options
structure for the model:

f = fittype('a*x"2+b*exp(n*c*x) ', 'problem','n');
options = fitoptions(f);

Set the Robust and Normalize properties of the fit options structure
using property name/value pairs:

set(options, 'Robust', 'LAR', 'Normalize', 'On')

Set the Display, Lower, and Algorithm properties of the fit options
structure using cell arrays of property names/values:

set(opts,{'Disp', 'Low','Alg'},...
{'Final',[0 O O], 'Levenberg'})
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See Also fitoptions | get
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Purpose Set model fit options
Syntax FT = setoptions(FT, options)
Description FT = setoptions(FT, options) sets the fit options of FT to options,

where FT is a fittype, cfit, or sfit object. The FT output argument
must match the FT input argument.

See Also fitoptions | fit | fittype
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Purpose
Syntax

Description

Constructor for sfit object
surfacefit = sfit(fittype,coeffi,coeff2,...)

An sfit object encapsulates the result of fitting a surface to data. They
are normally constructed by calling the fit function, or interactively by
exporting a fit from the Surface Fitting Tool to the workspace. You can
get and set coefficient properties of the sfit object.

You can treat an sfit object as a function to make predictions or
evaluate the surface at values of X and Y.

Like the cfit class, sfit inherits all fittype methods.

surfacefit = sfit(fittype,coeffi,coeff2,...) constructs the
sfit object surfacefit using the model type specified by the fittype
object and the coefficient values coeff1, coeff2, etc.

Note sfit is called by the fit function when fitting fittype objects to
data. To create a sfit object that is the result of a regression, use fit.

You should only call sfit directly if you want to assign values to
coefficients and problem parameters of a fittype object without
performing a fit.

Methods of sfit objects:
argnames Input argument names of cfit,
sfit, or fittype object

category Category of fit of cfit, sfit, or
fittype object

coeffnames Coefficient names of cfit, sfit,
or fittype object
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coeffvalues

confint

dependnames

differentiate

feval

formula

indepnames

islinear

numargs

numcoeffs

plot
predint

probnames

probvalues

quad2d

setoptions

Coefficient values of cfit or sfit,
object

Confidence intervals for fit
coefficients of cfit or sfit object

Dependent variable of cfit, sfit,
or fittype object

Differentiate cfit or sfit object

Evaluate cfit, sfit, or fittype
object

Formula of cfit, sfit, or
fittype object

Independent variable of cfit,
sfit, or fittype object

Determine if cfit, sfit, or
fittype object is linear

Number of input arguments of
cfit, sfit, or fittype object

Number of coefficients of cfit,
sfit, or fittype object

Plot cfit or sfit object

Prediction intervals for cfit or
sfit object

Problem-dependent parameter
names of cfit, sfit, or fittype
object

Problem-dependent parameter
values of cfit or sfit object

Numerically integrate sfit object

Set model fit options
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sfit Constructor for sfit object
type Name of cfit, sfit, or fittype
object
Examples You can treat an sfit object as a function to make predictions or

evaluate the surface at values of X and Y, e.g.,

X =3 -6 * rand( 49, 1 );
y =3 -6 * rand( 49, 1 );

z = peaks( x, y );

sf = fit( [x, yl, z, 'poly32' );
zhat = sf( mean( x ), mean( y ) )

See Also fit | fittype | feval | cfit
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Purpose

Syntax

Description
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Open Surface Fitting Tool

sftool
sftool(x,y,z)
sftool(x,y,z,w)
sftool(filename)

sftool opens Surface Fitting Tool or brings focus to the Tool if it is
already open. Surface Fitting Tool is an interactive environment for
fitting surfaces to data.

sftool(x,y,z) creates a fit to x and y inputs (or predictor data) and
z output (or response data). sftool opens Surface Fitting Tool if
necessary.

X, ¥, and z must be numeric, have two or more elements, and have

compatible sizes. Sizes are compatible if either:

® x,y,and z all have the same number of elements, or

® x and y are vectors, z is a 2D matrix, where length(x) = n,
length(y) = m, and [m,n] = size(z).

sftool(x,y,z,w) creates a fit with weights w. w must be numeric and

have the same number of elements as z.

sftool(filename) loads the surface fitting session in filename into
Surface Fitting Tool. The filename should have the extension .sfit.

Infs, NaNs, and imaginary parts of complex numbers are ignored in
the data.

Surface Fitting Tool provides a flexible and intuitive graphical user
interface where you can interactively fit surfaces to data and view
plots. You can:

¢ Create, plot, and compare multiple surface fits

e Use linear or nonlinear regression, interpolation, local smoothing
regression, or custom equations
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® View goodness-of-fit statistics, display confidence intervals and
residuals, remove outliers and assess fits with validation data

* Automatically generate code for fitting and plotting surfaces, or
export fits to workspace for further analysis

For instructions, see Chapter 3, “Interactive Surface Fitting”.
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Purpose

Syntax

Description
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Smooth response data

yy =
yy =
yy =
yy =
yy =
yy =
yy =

yy =
movin

smooth(y)

smooth(y,span)
smooth(y,method)
smooth(y,span,method)
smooth(y, 'sgolay’',degree)
smooth(y,span, 'sgolay',degree)
smooth(X,y,...)

smooth(y) smooths the data in the column vector y using a
g average filter. Results are returned in the column vector yy.

The default span for the moving average is 5.

The first few elements of yy are given by

yy(1) = y(1)

yy(2) = (y(1) + y(2) +y(3))/3

yy(3) = (y(1) +y(2) + y(3) +y(4) +y(5))/5
4) = (y(2) + y(3) +y(4) +y(5) +y(6))/5

Becau
result

yy =

se of the way endpoints are handled, the result differs from the
returned by the filter function.

smooth(y,span) sets the span of the moving average to span.

span must be odd.

yy =

smooth(y,method) smooths the data in y using the method

method and the default span. Supported values for method are listed

in the

table below.
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method

Description

‘moving’

Moving average (default). A lowpass filter with
filter coefficients equal to the reciprocal of the
span.

"lowess'

Local regression using weighted linear least
squares and a 1st degree polynomial model

'loess'

Local regression using weighted linear least
squares and a 2nd degree polynomial model

‘sgolay’

Savitzky-Golay filter. A generalized moving
average with filter coefficients determined by an
unweighted linear least-squares regression and a
polynomial model of specified degree (default is
2). The method can accept nonuniform predictor
data.

'rlowess'

A robust version of 'lowess' that assigns lower
weight to outliers in the regression. The method
assigns zero weight to data outside six mean
absolute deviations.

‘rloess’

A robust version of 'loess' that assigns lower
weight to outliers in the regression. The method
assigns zero weight to data outside six mean
absolute deviations.

yy = smooth(y,span,method) sets the span of method to span. For
the loess and lowess methods, span is a percentage of the total
number of data points, less than or equal to 1. For the moving average
and Savitzky-Golay methods, span must be odd (an even span is
automatically reduced by 1).

yy = smooth(y, 'sgolay',degree) uses the Savitzky-Golay method
with polynomial degree specified by degree.

yy = smooth(y,span, 'sgolay',degree) uses the number of data
points specified by span in the Savitzky-Golay calculation. span must
be odd and degree must be less than span.
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Tips

Examples
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yy = smooth(x,y,...) additionally specifies x data. If x is not
provided, methods that require x data assume x = 1:1length(y).
You should specify x data when it is not uniformly spaced or sorted.
If x is not uniform and you do not specify method, lowess is used.
If the smoothing method requires x to be sorted, the sorting occurs
automatically.

Another way to generate smoothed data is to fit it with a smoothing
spline. Refer to the fit function for more information.

Load the data in count.dat:

load count.dat

The 24-by-3 array count contains traffic counts at three intersections
for each hour of the day.

First, use a moving average filter with a 5-hour span to smooth all of
the data at once (by linear index) :

c = smooth(count(:));
C1 = reshape(c,24,3);

Plot the original data and the smoothed data:

subplot(3,1,1)
plot(count,':");

hold on

plot(C1,"'-");

title('Smooth C1 (All Data)')

Second, use the same filter to smooth each column of the data
separately:

C2 = zeros(24,3);
for I = 1:3,

C2(:,I) = smooth(count(:,I));
end
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Again, plot the original data and the smoothed data:

subplot(3,1,2)
plot(count,':"');
hold on
plot(C2,'-');

title('Smooth C2 (Each Column)')

Plot the difference between the two smoothed data sets:

subplot(3,1,3)
plot(C2 - C1,'o-")
title('Difference C2 - C1')

Smoagth &1 (Al Data)

400 . r . .
200 .
0 __#qﬁ#?EEEEEEF?** i
0 5 10 15 20 25
Smooth C2 (Each Column)
400 . T . .
200} 7
0 -.-" s | —
0 5 10 15 20 25
Difference C2 - C1
10 T T T T
0t @’_.ﬁh\r\ i
_-10 1 1 1 1 g
U] 5 10 15 20 25

Note the additional end effects from the 3-column smooth.

Examples

X
y

Create noisy data with outliers:

15*rand(150,1);

sin(x) + 0.5*(rand(size(x))-0.5);
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y(ceil(length(x)*rand(2,1))) = 3;

Smooth the data using the loess and rloess methods with a span

of 10%:
yy1l = smooth(x,y,0.1,'loess');
yy2 = smooth(x,y,0.1,'rloess');

Plot original data and the smoothed data.

[xx,ind] = sort(x);

subplot(2,1,1)
plot(xx,y(ind),'b."',xx,yy1(ind),"'r-")
set(gca, 'YLim',[-1.5 3.5])

legend('Original Data', 'Smoothed Data Using '‘'loess''',...

"Location', 'NW")
subplot(2,1,2)
plot(xx,y(ind),'b."',xx,yy2(ind),"'r-")
set(gca, 'YLim',[-1.5 3.5])

legend('Original Data', 'Smoothed Data Using '‘'rloess''',...

"Location', 'NW")
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+  Original Data *

3

2 F|— Smoothed Data Using 'loess' .
1 g

0

+  Original Data *
Smoothed Data Using 'rloess’ 7

Note that the outliers have less influence on the robust method.

See Also fit | sort
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Purpose

Syntax

Description

Examples

Algorithms

See Also
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Solve almost block-diagonal linear system

X = slvblk(blokmat,b)
X = slvblk(blockmat,b,w)
X = slvblk(blokmat,b) returns the solution (if any) of the linear

system Ax = b, with the matrix A stored in blokmat in the spline almost
block-diagonal form. At present, only the command spcol provides such
a description, of the matrix whose typical entry is the value of some
derivative (including the Oth derivative, i.e., the value) of a B-spline

at some site. If the linear system is overdetermined (i.e., has more
equations than unknowns but is of full rank), then the least-squares
solution is returned.

The right side b may contain several columns, and is expected to contain
as many rows as there are rows in the matrix described by blokmat.

x = slvblk(blockmat,b,w) returns the vector x that minimizes the
weighted sum ij(j)((Ax - b))%

sp=spmak (knots,slvblk(spcol(knots,k,x,1),y."')) provides in sp
the B-form of the spline s of order k with knot sequence knots that
matches the given data (x,y), i.e., for which s(x) equals y.

The command bkbrk is used to obtain the essential parts of the
coefficient matrix described by blokmat (in one of two available forms).

A QR factorization is made of each diagonal block, after it was
augmented by the equations not dealt with when factoring the preceding
block. The resulting factorization is then used to solve the linear system
by backsubstitution.

bkbrk | spap2 | spapi | spcol
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Purpose
Syntax

Description

Examples

Algorithms

Locate sites with respect to mesh sites
pointer = sorted(meshsites,sites)

Various commands in this toolbox need to determine the index j
for which a given x lies in the interval [¢..¢; . ], with (¢) a given
nondecreasing sequence, e.g., a knot sequence. This job is done by
sorted in the following fashion.

pointer = sorted(meshsites,sites) is the integer row vector
whose j-th entry equals the number of entries in meshsites that
are < ssites(j), with ssites the vector sort(sites). Thus, if both
meshsites and sites are nondecreasing, then

meshsites(pointer(j)) sites(j) < meshsites(pointer(j)+1)
with the obvious interpretations when

pointer(j) < 1 or length(meshsites) < pointer(j) + 1
Specifically, having pointer(j) < 1 then corresponds to having
sites(j) strictly to the left of meshsites (1), while having

length(meshsites) < pointer(j)+1 then corresponds to having
sites(j) at, or to the right of, meshsites(end).

The statement

sorted([1 112 2 3 3 3],[0:4])

will generate the output 0 3 5 8 8, as will the statement

sorted([3 211323 1],[23041])

The indexing output from sort([meshsites(:)."',sites(:)."']) is
used.
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Purpose

Syntax

Description
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Least-squares spline approximation

spap2(knots,k,x,y)

spap2(1,k,x,y)

sp = spap2(...,x,y,w)
spap2({knorlt,...,knorlm},,k,{x1,...,xm},y)
spap2({knorlt,...,knorlm},k,{x1,...,xm},y,w)

spap2(knots,k,x,y) returns the B-form of the spline f of order k with
the given knot sequence knots for which

(™) y(:,3) = f(x(j)), all j

in the weighted mean-square sense, meaning that the sum
. . (2
> w() |y D= F(x())]
J

1s minimized, with default weights equal to 1. The data values y(:,j)
may be scalars, vectors, matrices, even ND-arrays, and |z|? stands for
the sum of the squares of all the entries of z. Data points with the same
site are replaced by their average.

If the sites x satisfy the (Schoenberg-Whitney) conditions

knots(j) < x(j) < knots(j + &)
(%) j=1,...,length(x) = length(knots) — &

then there is a unique spline (of the given order and knot sequence)
satisfying (¥*) exactly. No spline is returned unless (**) is satisfied for
some subsequence of x.

spap2(1l,k,x,y) , with 1 a positive integer, returns the B-form of a
least-squares spline approximant, but with the knot sequence chosen
for you. The knot sequence is obtained by applying aptknt to an
appropriate subsequence of x. The resulting piecewise-polynomial
consists of 1 polynomial pieces and has k-2 continuous derivatives.
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Examples

If you feel that a different distribution of the interior knots might do
a better job, follow this up with

sp1 = spap2(newknt(sp),k,x,y));

sp = spap2(...,X,y,w) lets you specify the weights w in the error
measure (given above). w must be a vector of the same size as x, with
nonnegative entries. All the weights corresponding to data points with
the same site are summed when those data points are replaced by their
average.

spap2({knorli,...,knorlm},k,{x1,...,xm},y) provides a
least-squares spline approximation to gridded data. Here, each
knorli is either a knot sequence or a positive integer. Further,

k must be an m-vector, and y must be an (r+m)-dimensional

array, with y(:,i1,...,im) the datum to be fitted at the site
[x{1}(i1),...,x{m}(im) ], all i1, ..., im. However, if the spline is to be
scalar-valued, then, in contrast to the univariate case, y is permitted to
be an m-dimensional array, in which case y(i1,...,1im) is the datum to
be fitted at the site [x{1}(i1),...,x{m}(im)], all i1, ..., im.

spap2({knorli,...,knorlm},k,{x1,...,xm},y,w) also lets you
specify the weights. In this m-variate case, w must be a cell array with
m entries, with w{i} a nonnegative vector of the same size as Xxi, or
else w{i} must be empty, in which case the default weights are used
in the ith variable.

sp = spap2(augknt([a,xi,b],4),4,X,y)

is the least-squares approximant to the data x, y, by cubic splines with
two continuous derivatives, basic interval [a..b], and interior breaks
xi, provided xi has all its entries in (a..b) and the conditions (¥*)
are satisfied in some fashion. In that case, the approximant consists
of 1length(xi)+1 polynomial pieces. If you do not want to worry about
the conditions (**) but merely want to get a cubic spline approximant
consisting of 1 polynomial pieces, use instead

sp = spap2(l,4,x,y);
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Algorithms

See Also
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If the resulting approximation is not satisfactory, try using a larger
1. Else use

sp = spap2(newknt(sp),4,Xx,y);
for a possibly better distribution of the knot sequence. In fact, if that
helps, repeating it may help even more.

As another example, spap2(1, 2, X, y); provides the least-squares
straight-line fit to data x,y, while

w = ones(size(x)); w([1 end]) = 100; spap2(1,2, X,y,w);
forces that fit to come very close to the first data point and to the last.

spcol is called on to provide the almost block-diagonal collocation
matrix (Bj,k(xi)), and slvblk solves the linear system (*) in the
(weighted) least-squares sense, using a block QR factorization.

Gridded data are fitted, in tensor-product fashion, one variable at
a time, taking advantage of the fact that a univariate weighted
least-squares fit depends linearly on the values being fitted.

slvblk | spapi | spcol
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Purpose

Syntax

Description

Spline interpolation

spline = spapi(knots,x,y)

spapi(k,x,y)
spapi({knorkil,...,knorkm},{x1,...,xm},y)
spapi(..., 'noderiv')

spline = spapi(knots,x,y) returns the spline f (if any) of order
k = length(knots) - length(x)

with knot sequence knots for which
(*)  f(x(i)) = vy(:,7), all j.

If some of the entries of x are the same, then this is taken in the
osculatory sense, i.e., in the sense that D"Of(x(j) = y(:, j), with m(j) : =
#{1<j: x(1i) =x(j) }, and D"f the mth derivative of f. Thus r-fold
repetition of a site z in x corresponds to the prescribing of value and the
first r — 1 derivatives of f at z. If you don’t want this, call spapi with
an additional (fourth) argument, in which case, at each data site, the
average of all data values with the same data site is matched.

The data values, y(:,j), may be scalars, vectors, matrices, or even
ND-arrays.

spapi(k,x,y) , with k a positive integer, merely specifies the desired
spline order, k, in which case aptknt is used to determine a workable
(though not necessarily optimal) knot sequence for the given sites x. In
other words, the command spapi(k,x,y) has the same effect as the
more explicit command spapi(aptknt(x,k),x,y).

spapi({knorkil,...,knorkm},{x1,...,xm},y) returns the B-form of
a tensor-product spline interpolant to gridded data. Here, each knorki
is either a knot sequence, or else is a positive integer specifying the
polynomial order to be used in the ith variable, thus leaving it to spapi
to provide a corresponding knot sequence for the ith variable. Further,
y must be an (r+m)-dimensional array, with y(:,i1,...,im) the datum
to be fitted at the site [x{1}(i1),...,x{m}(im)], all i1, ..., im,
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unless the spline is to be scalar-valued, in which case, in contrast to the
univariate case, y is permitted to be an m-dimensional array.

spapi(...,'noderiv') with the string 'noderiv' as a fourth
argument, has the same effect as spapi(...) except that data values
sharing the same site are interpreted differently. With the fourth
argument present, the average of the data values with the same data
site is interpolated at such a site. Without it, data values with the
same data site are interpreted as values of successive derivatives to
be matched at such a site, as described above, in the first paragraph
of this Description.

spapi([0 0001 2222],[01112],[201 2 -1])produces
the unique cubic spline f on the interval [0..2] with exactly one interior
knot, at 1, that satisfies the five conditions

f0+) =2, (1) =0, DA1) = 1, D*f(1) = 2, f(2-) = -1
These include 3-fold matching at 1, i.e., matching there to prescribed

values of the function and its first two derivatives.

Here is an example of osculatory interpolation, to values y and slopes s
at the sites x by a quintic spline:

sp = spapi(augknt(x,6,2),[x,x,min(x),max(x)],[y,s,ddy0,ddy1]);

with ddy0 and ddy1 values for the second derivative at the endpoints.

As a related example, if the function sin(x) is to be interpolated at the
distinct data sites x by a cubic spline, and its slope is also to be matched
at a subsequence x(s), then this can be accomplished by the command

sp = spapi(4,[x x(s)], [sin(x) cos(x(s))]);

in which a suitable knot sequence is supplied with the aid of aptknt.
In fact, if you wanted to interpolate the same data by quintic splines,
simply change the 4 to 6.

As a bivariate example, here is a bivariate interpolant.
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Algorithms

Limitations

X -2:.5.2; y = -1:.25:1; [xx, yyl
z exp(-(xx."2+yy."2));
sp = spapi({3,4},{x,y},z); fnplt(sp)

ndgrid(x,y);

As an illustration of osculatory interpolation to gridded data, here is
complete bicubic interpolation, with the data explicitly derived from the
bicubic polynomial g(u,v) = u?v?, to make it easy for you to see exactly
where the slopes and slopes of slopes (i.e., cross derivatives) must be
placed in the data values supplied. Since our g is a bicubic polynomial,
its interpolant, f, must be g itself. We test this.

sites = {[0,1],[0,2]}; coefs = zeros(4,4); coefs(1,1) = 1;
g = ppmak(sites,coefs);
Dxg = fnval(fnder(g,[1,0]),sites);
Dyg = fnval(fnder(g,[0,1]),sites);
Dxyg = fnval(fnder(g,[1,1]),sites);
f = spapi({4,4}, {sites{1}([1,2,1,2]),sites{2}([1,2,1,2])},
[fnval(g,sites), Dyg ;
Dxg.' » Dxygl);
if any( squeeze( fnbrk(fn2fm(f,'pp'), 'c') ) - coefs )
'something went wrong', end

spcol is called on to provide the almost-block-diagonal collocation
matrix (Bj,k(x)) (with repeats in x denoting derivatives, as described
above), and slvblk solves the linear system (*), using a block QR
factorization.

Gridded data are fitted, in tensor-product fashion, one variable at a
time, taking advantage of the fact that a univariate spline fit depends
linearly on the values being fitted.

The given (univariate) knots and sites must satisfy the
Schoenberg-Whitney conditions for the interpolant to be defined.
Assuming the site sequence x to be nondecreasing, this means that we
must have

knots(j) < x(j) < knots(j + &), all j
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(with equality possible at knots(1) and knots(end)). In the multivariate
case, these conditions must hold in each variable separately.

See Also csapi | spap2 | spaps | spline
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Purpose

Syntax

Description

Smoothing spline

sp = spaps(x,y,tol)

[sp,values] = spaps(x,y,tol)
[sp,values,rho] = spaps(x,y,tol)

[...] = spaps(x,y,tol,argl,arg2,...)
[...] = spaps({x1,...,xr},y,tol,...)

sp = spaps(x,y,tol) returns the B-form of the smoothest function f
that lies within the given tolerance tol of the given data points (x(j),
y(:,3)), j=1:1length(x). The data values y(:,j) may be scalars,
vectors, matrices, even ND-arrays. Data points with the same data site
are replaced by their weighted average, with its weight the sum of the
corresponding weights, and the tolerance tol is reduced accordingly.

[sp,values] = spaps(x,y,tol) also returns the smoothed values,
i.e., values is the same as fnval(sp,x).

Here, the distance of the function f from the given data is measured by

E(f) =Y wi) | (G, ) - () [
Jj=1

with the default choice for the weights w making E(f) the composite

max(x) 9
trapezoidal rule approximation to Jmin(x) ly=FI ,and |z|? denoting

the sum of squares of the entries of z.
Further, smoothest means that the following roughness measure is

minimized:

max(x)
FO"= [ awlp™fol?ar

min(x)
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where D™"f denotes the mth derivative of f. The default value for mis 2,
the default value for the roughness measure weight A is the constant
1, and this makes f a cubic smoothing spline.

When tol is nonnegative, then the spline f is determined as the
unique minimizer of the expression pE(f) + F(D™f), with the smoothing
parameter p (optionally returned) so chosen that E(f) equals tol. Hence,
when m is 2, then, after conversion to ppform, the result should be the
same (up to roundoff) as obtained by csaps(x,y,p/(p + 1)). Further, when
tol is zero, then the “natural” or variational spline interpolant of order
2m is returned. For large enough tol, the least-squares approximation
to the data by polynomials of degree <m is returned.

When tol is negative, then p is taken to be -tol.

The default value for the weight function A in the roughness measure is
the constant function 1. But you may choose it to be, more generally,

a piecewise constant function, with breaks only at the data sites.
Assuming the vector x to be strictly increasing, you specify such a
piecewise constant A by inputting tol as a vector of the same size as x.
In that case, tol (i) is taken as the constant value of A on the interval
(x(i-1) .. x(1)), i=2:1ength(x), while tol(1) continues to be used
as the specified tolerance.

[sp,values,rho] = spaps(x,y,tol) alsoreturns the actual value of p
used as the third output argument.

[...] = spaps(x,y,tol,argl,arg2,...) lets you specify the
weight vector w and/or the integer m, by supplying them as an argi. For
this, w must be a nonnegative vector of the same size as x; m must be

1 (for a piecewise linear smoothing spline), or 2 (for the default cubic
smoothing spline), or 3 (for a quintic smoothing spline).

If the resulting smoothing spline, sp, 1s to be evaluated outside its basic
interval, it should be replaced by fnxtr(sp,m) to ensure that its m-th
derivative is zero outside that interval.

[...]1 = spaps({x1,...,xr},y,tol,...) returns the
B-form of an r-variate tensor-product smoothing spline that
1s roughly within the specified tolerance to the given gridded
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data. (For scattered data, use tpaps.) Now y is expected to

supply the corresponding gridded values, with size(y) equal to
[length(x1),...,length(xr)] in case the function is scalar-valued,
and equal to [d,length(x1),...,length(xr)] in case the function

is d-valued. Further, tol must be a cell array with r entries, with
tol{i} the tolerance used during the i-th step when a univariate

(but vector-valued) smoothing spline in the i-th variable is being
constructed. The optional input for m must be an r-vector (with entries
from the set {1,2,3}), and the optional input for w must be a cell array
of length r, with w{i} either empty (to indicate that the default choice
1s wanted) or else a positive vector of the same length as xi.

Examples The statements

w = ones(size(x)); w([1 end]) = 100;
sp = spaps(x,y, 1.e-2, w, 3);

give a quintic smoothing spline approximation to the given data that
close to interpolates the first and last datum, while being within about
1.e-2 of the rest.

X -2:.2:2;5; y=-1:.25:1; [xX,yy] = ndgrid(x,y); rand('seed',39);
z exp(-(xx."2+yy.”2)) + (rand(size(xx))-.5)/30;
sp = spaps({x,y},z,8/(60"2)); fnplt(sp), axis off

produces the figure below, showing a smooth approximant to noisy data
from a smooth bivariate function. Note the use of ndgrid here; use of
meshgrid would have led to an error.
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Reinsch’s approach is used (including his clever way of choosing the

equation for the optimal smoothing parameter in such a way that a

good initial guess is available and Newton’s method is guaranteed to
converge and to converge fast).

[1] C. Reinsch, “Smoothing by spline functions”, Numer. Math. 10
(1967), 177-183.

csaps | spap2 | spapi | tpaps
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Purpose

Syntax

Description

Examples

B-spline collocation matrix

colmat = spcol(knots,k,tau)
colmat spcol(knots,k,tau,argl,arg2,...)

colmat = spcol(knots,k,tau) returns the matrix, with length(tau)
rows and length(knots) -k columns, whose (i,j)th entry is

pmip (tau(i)

This is the value at tau(i) of the m(i)th derivative of the jth B-spline
of order k for the knot sequence knots. Here, tau is a sequence of

sites, assumed to be nondecreasing, and m = knt2mlt(tau), 1.e., m(i) is
#{j < i:tau(j) = tau(@)}, all i.

colmat = spcol(knots,k,tau,argl,arg2,...) alsoreturns that
matrix, but gives you the opportunity to specify some aspects.

If one of the argi is a string with the same first two letters as in
'slvblk', the matrix is returned in the almost block-diagonal format
(specialized for splines) required by slvblk (and understood by bkbrk).

If one of the argi is a string with the same first two letters as in
'sparse', then the matrix is returned in the sparse format of MATLAB.

If one of the argi is a string with the same first two letters as in
'noderiv', multiplicities are ignored, i.e., m(i) is taken to be 1 for all i.

To solve approximately the non-standard second-order ODE

D?y(t) =5 - (y(t) — sin(2f))

on the interval [0..r], using cubic splines with 10 polynomial pieces, you
can use spcol in the following way:

tau = linspace(0,pi,101); k = 4;

knots = augknt(linspace(0,pi,11),K);
colmat = spcol(knots,k,brk2knt(tau,3));
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coefs = (colmat(3:3:end,:)/5-colmat(1:3:end,:))\(-sin(2*tau)."');
sp = spmak(knots,coefs."');

You can check how well this spline satisfies the ODE by computing and
plotting the residual, D?y(¢) — 5 (y(f) — sin(2t)), on a fine mesh:

t = linspace(0,pi,501);

yt = fnval(sp,t);

D2yt = fnval(fnder(sp,2),t);

plot(t,D2yt - 5*(yt-sin(2*t)))

title(['residual error; to be compared to max(abs(D*2y)) = ',...
num2str(max(abs(D2yt)))1)

The statement spcol([1:6],3,.1+[2:4]) provides the matrix

ans =

o

.5900 0.0050 0
.4050 0.5900 0.0050
0 0.4050 0.5900

o

in which the typical row records the values at 2.1, or 3.1, or 4.1, of all
B-splines of order 3 for the knot sequence 1:6. There are three such

B-splines. The first one has knots 1,2,3,4, and its values are recorded
in the first column. In particular, the last entry in the first column is
zero since it gives the value of that B-spline at 4.1, a site to the right
of its last knot.

If you add the string 's1' as an additional input to spcol, then you can
ask bkbrk to extract detailed information about the block structure

of the matrix encoded in the resulting output from spcol. Thus, the
statement bkbrk (spcol(1:6,3,.1+2:4,'s1')) gives:

block 1 has 2 row(s)

0.5900 0.0050 0

0.4050 0.5900 0.0050
next block is shifted over 1 column(s)
block 2 has 1 row(s)
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See Also

0.4050 0.5900 0.0050
next block is shifted over 2 column(s)

This is the most complex command in this toolbox since it has to deal
with various ordering and blocking issues. The recurrence relations are
used to generate, simultaneously, the values of all B-splines of order k
having anyone of the tau(i) in their support.

A separate calculation is carried out for the (presumably few) sites at
which derivative values are required. These are the sites tau(i) with
m(i) > 0. For these, and for every order & —j, j = j,, j, — 1,...,0, with j,
equal to max(m), values of all B-splines of that order are generated by
recurrence and used to compute the jth derivative at those sites of all
B-splines of order k.

The resulting rows of B-spline values (each row corresponding to a
particular tau(i)) are then assembled into the overall (usually rather
sparse) matrix.

When the optional argument 's1' is present, these rows are instead
assembled into a convenient almost block-diagonal form that takes
advantage of the fact that, at any site tau(i), at most k B-splines of
order k are nonzero. This fact (together with the natural ordering of the
B-splines) implies that the collocation matrix is almost block-diagonal,
1.e., has a staircase shape, with the individual blocks or steps of varying
height but of uniform width k.

The command slvblk is designed to take advantage of this
storage-saving form available when used, in spap2, spapi, or spaps,
to help determine the B-form of a piecewise-polynomial function from
interpolation or other approximation conditions.

The sequence tau is assumed to be nondecreasing.

slvblk | spap2 | spapi
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Spline curve by uniform subdivision

spcrv(c,k)
spcrv(c)
spcrv(c,k,maxpnt)

spcrv(c, k) provides a dense sequence f(tt) of points on the uniform
B-spline curve f of order k with B-spline coefficients ¢. Explicitly, this
is the curve

n
fitl> Y Bt—k/2|j,...j+k) c(j),
J=1

<t<n+

N |
Do |

with B(-|a,...,2) the B-spline with knots a,...,z, and n the number of
coefficients in ¢, 1.e., [d,n] equals size(c).

spcrv(c) chooses the order k to be 4.

spcrv(c, k,maxpnt) makes sure that at least maxpnt points are
generated. The default value for the maximum number of sites tt to
be generated is 100.

The parameter interval that the site sequence tt fills out uniformly is
the interval [k/2 .. (n-k/2)].

The output consists of the array f(tt).

The following would show a questionable broken line and its smoothed
version:

points = [0 0110 -1 -1 00 ;
0001210 -1 -2];
plot(points(1,:),points(2,:),':")
values = spcrv(points,3);
hold on, plot(values(1,:),values(2,:)), hold off

Repeated midpoint knot insertion is used until there are at least maxpnt
sites. There are situations where use of fnplt would be more efficient.
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See Also fnplt
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Purpose

Syntax

Description

Tips
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Experiment with some spline approximation methods

splinetool
splinetool(x,y)

splinetool is a graphical user interface (GUI), whose initial menu
provides you with various choices for data including the option of
importing some data from the workspace.

splinetool(x,y) brings up the GUI with the specified data x and vy,
which are vectors of the same length.

The Spline Tool is shown in the following figure comparing cubic spline
interpolation with a smoothing spline on sample data created by adding
noise to the cosine function.
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Bottomline:  smoothsp = spaps(ey 0.02); % spaps iz used to enforce specified tolerance;
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Approximation Methods

The approximation methods and options supported by the GUI are
shown below.

Approximation

Method Option

Cubic Interpolating Adjust the type and values of the end

Spline conditions.

Smoothing Spline Choose between cubic (order 4) and quintic
(order 6) splines. Adjust the value of the
tolerance and/or smoothing parameter.
Adjust the weights in the error and
roughness measures.

Least-Squares Vary the order from 1 to 14. The default

Approximation order is 4, which gives cubic approximating

splines. Modify the number of polynomial
pieces. Add and move knots to improve the
fit. Adjust the weights in the error measure.

Spline Interpolation Vary the order from 2 to 14. The default
order is 4, which gives cubic spline
interpolants. If the default knots supplied
are not satisfactory, you can move them
around to vary the fit.

Graphs
You can generate and compare several approximations to the same
data. One of the approximations is always marked as “current” using a
thicker line width. The following displays are available:
¢ Data graph. It shows:

= The data

= The approximations chosen for display in List of approximations

= The current knot sequence or the current break sequence
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¢ Auxiliary graph (if viewed) for the current approximation. You can
invoke this graph by selecting any one of the items in the View
menu. It shows one of the following:

= The first derivative
= The second derivative

= The error

By default, the error is the difference between the given data values
and the value of the approximation at the data sites. In particular, the
error is zero (up to round-off) when the approximation is an interpolant.
However, if you provide the data values by specifying a function, then
the error displayed is the difference between that function and the
current approximation. This also happens if you change the y-label of
the data graph to the name of a function.

Menu Options

You can annotate and print the graphs with the File > Print to
Figure menu.

You can export the data and approximations to the workspace for
further use or analysis with the File > Export Data and File > Export
Spline menus, respectively.

You can create, with the File > Generate Code menu, a function file
that you can use to generate, from the original data, any or all graphs
currently shown. This file also provides you with a written record of the
commands used to generate the current graph(s).

You can save, with the Replicate button, the current approximation
before you experiment further. If, at a later time, you click on the
approximation so saved, splinetool restores everything to the way
it was, including the data used in the construction of the saved
approximation. This is true even if, since saving this approximation,
you have edited the data while working on other approximations.

You can add, delete, or move data, knots, and breaks by right-clicking
in the graph, or selecting the appropriate item in the Edit menu.
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You can toggle the grid or the legend in the graph(s) with the Tools
menu.

Examples ¢ “Exploring End Conditions For Cubic Spline Interpolation” on page
16-220
e “Estimating the Second Derivative at an Endpoint” on page 16-223
e “Least-Squares Approximation” on page 16-225
® “Smoothing Spline” on page 16-228
Exploring End Conditions For Cubic Spline Interpolation

The purpose of this example is to explore the various end conditions
available with cubic spline interpolation:

1 Type splinetool at the command line.

2 Select Import your own data from the initial screen, and accept
the default function. You should see the following display.
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The default approximation shown is the cubic spline interpolant with
the not-a-knot end condition.

The vector x of data sites is 1inspace(0,2*pi,31) and the values
are cos (x). This differs from simply providing the vector y of values
in that the cosine function is explicitly recorded as the underlying
function. Therefore, the error shown in the graph is the error in
the spline as an approximation to the cosine rather than as an
approximation to the given values. Notice the resulting relatively
large error, about 5e-5, near the endpoints.

For comparison, follow these steps:
¢ (Click on New in the List of approximations.

¢ In Approximation method, select complete from the list of
End conditions.
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® Since the first derivative of the cosine function is sine, adjust the
first-derivative values to their known values of zero at both the

left end and the right end.

This procedure results in the display shown below (after the mouse is
used to move the Legend further down). Note that the right end slope
is zero only up to round-off. Bottomline tells you that the toolbox

function csape was used to create the spline.
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Bottomline:  spline2 = czape(x [0,y 0], 'complete’); % same as splineC: [0y 010

Be impressed by the improvement in the error, which is only about
5e-6.
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4 For further comparison, follow these steps:
® (Click on New in the List of approximations.

* In Approximation method, select natural from the list of End
conditions.

Note the deterioration of the approximation near the ends, an error
of about 2e-3, which is much worse than with the not-a-knot end
conditions.

5 For a final comparison, follow these steps:
® (Click on New in the List of approximations.

e Since we know that the cosine function is periodic, in
Approximation method, select periodic from the list of End
conditions.

Note the dramatic improvement in the approximation, back to an
error of about 5e-6, particularly compared to the natural end
conditions.

Estimating the Second Derivative at an Endpoint

This example uses cubic spline interpolation and least-squares
approximation to determine an estimate of the initial acceleration for
a drag car:

1 Type splinetool at the command line or if the GUI is already
running, click on File > Restart.

2 Choose Richard Tapia’s drag racing data. These data show the
distance traveled by a drag car as a function of time. The message
window asks you to estimate the initial acceleration by setting the
initial speed to zero. Click on OK, or use Space or Enter, to remove
the message window.

3 In Approximation method, select complete from the list of End
conditions.
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4 Adjust the initial speed by changing the first derivative at the left

endpoint to zero.

Look for the value of the initial acceleration, which is given by

the value of the second derivative at the left endpoint. You can
toggle between the first derivative and the second derivative at this
endpoint by clicking on the left end button. The value of the second
derivative should be around 187 in the units chosen. Choose View >
Show 2nd Derivative to see this graphically.

For comparison, click on New, then choose Least-Squares
Approximation as the Approximation method. With this
method, you can no longer specify end conditions. Instead, you may
vary the order of the method. Verify that the initial acceleration is
close to the cubic interpolation value.

The results of this procedure are shown below.
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Bottomline:  spline2 = spap201 4 x¥); % we are starting off with the least squares polynomial approximation of order 4

Least-Squares Approximation

This example encourages you to place five interior knots in such a way
that the least-squares approximation to these data by cubic splines has
an absolute error no bigger than .04 everywhere:

1 Type splinetool at the command line or if the GUI is already
running, click on File > Restart.

2 Choose Titanium heat data.
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3 Select Least-Squares Approximation as the Approximation
method.

4 Notice how poorly this approximates the data since there are no
interior knots. To view the current knots and add new knots, choose
knots from Data, breaks/knots, weights. The knots are now listed
in knots, and also displayed in the data graph as vertical lines.
Notice that there are just the two end knots, each with multiplicity 4.

5 Right-click in the data graph and choose Add Knot. This brings up
crosshairs for you to move with the mouse. Its precise horizontal
location is shown in the edit field below the list of knots. A mouse
click places a new knot at the current location of the crosshairs.
One possible strategy is to place the additional knot at the place
of maximum absolute error, as shown in the auxiliary graph below
the data graph.
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Bottomline:  splinet = spap2(1,4,xv); % we are starting off with the least squares polynomial spproximstion of order 4

If you right-click and choose Replicate Knot, you will increase
the multiplicity of the current knot, which is shown by its repeated
occurrence in Knots. If you don’t like a particular knot, you can
delete it. To delete a specific knot, you must first select it in either
the list of knots or the data graph, and then right-click in the graph
and choose Delete Knot.

6 You could also ask for an approximation using six polynomial pieces,
which corresponds to five interior knots. To do this, enter 6 as #
pieces in Data, breaks/knots, weights.

7 After you have the five interior knots, try to make the error even
smaller by moving the knots. To do this, select the knot you want
to move by clicking on its vertical line in the graph, then use the
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interface control below Knots in Data, breaks/knots, weights and
observe how the error changes with the movement of the knot. You

can also use the edit field to overwrite the current knot location. You
could also try adjust, which redistributes the current knot sequence.

8 Use Replicate in List of approximations to save any good knot
distribution for later use. Rename the replicated approximation to
1stsqr using Rename. To return to the original approximation,
click on its name in List of approximations.

Smoothing Spline

This example experiments with smoothing splines:

1 Type splinetool at the command line or, if the GUI is already
running, click on File > Restart.

2 Choose Titanium heat data.
3 In Approximation method, choose Smoothing Spline.

4 Vary Parameter between 0 and 1, which changes the approximation
from the least-squares straight-line approximation to the “natural”
cubic spline interpolant.

5 Vary Tolerance between 0 and some large value, even inf. The
approximation changes from the best possible one, the “natural” cubic
spline interpolant, to the least-squares straight-line approximation.

6 As you increase the Parameter value or decrease the Tolerance
value, the error decreases. However, a smaller error corresponds to
more roughness, as measured by the size of the second derivative.
To see this, choose View > Show 2nd Derivative and vary the
Parameter and Tolerance values once again.

7 This step modifies the weights in the error measure to force the
approximation to pass through a particular data point.
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® Set Tolerance to 0.2. Notice that the approximation does not
pass through the highest data point. To see the large error at this
site, choose View > Error.

® To force the smoothing spline to go through this point, choose
Error Weights from Data, breaks/knots, weights.

® (lick on the highest data point in the graph and notice its site,
which is indicated in Sites and Values.

® Use the edit field beneath the list of weights to change the current
weight to 1000. Notice how much closer the smoothing spline now
comes to that highest data point, and the decrease in the error at
that site. Turn on the grid, by Tools > Grid, to locate the error
at that site more readily.

This step modifies the weights in the roughness measure to permit
a more accurate but less smooth approximation in the peak area
while insisting on a smoother, hence less accurate, approximation
away from the peak area.

¢ Choose Jumps in Roughness Weight from Data, breaks/knots,
weights.

¢ Choose View > Show 2nd Derivative
e Select any data point to the left of the peak in the data.

® Set the jump at the selected site to -1 by changing its value in
the edit field below it. Since the roughness weight for the very
first site interval is 1, you have just set the roughness weight to
the right of the highlighted site to 0. Correspondingly, the second
derivative has become relatively small to the left of that site.

¢ Select any data point to the right of the peak in the data.

® Set the jump across the selected site to 1. Since the roughness
weight just to the left of the highlighted site is 0, you have just
set the roughness weight to the right of the highlighted site to
1. Correspondingly, the second derivative has become relatively
small to the right of that site. The total effect is a very smooth but
not very accurate fit away from the peak, while in the peak area,
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the spline fit is much better but the second derivative is much
larger, as is shown in the auxiliary graph below.

At the sites where there is a jump in the roughness weight, there
is a corresponding jump in the second derivative. If you increase
the Parameter value, the error across the peak area decreases

but the second derivative remains quite large, while the opposite
holds true away from the peak area.
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Purpose

Syntax

Description

Examples

Taylor coefficients from local B-coefficients

[v,b] = splpp(tx,a)
[v,b] = sprpp(tx,a)

These are utility commands of use in the conversion from B-form to
ppform (and in certain evaluations), but of no interest to the casual user.

[v,b] = splpp(tx,a) provides the matrices v and b, both of the same
size [r,k] as a, and related to the input in the following way.

For i=1:r, b(i,:) are the B-coefficients, with respect to the knot
sequence [tx(i,1:k-1),0,...,0], of the polynomial of order k on
the interval [tx(i,k-1) .. tx(i,k)] whose k B-spline coefficients,
with respect to the knot sequence tx(i,:), arein a(i,:). This is
done by repeated knot insertion (of the knot 0). It is assumed that
tx(1,k-1)<0<=tx(1i,k).

For i=1:r, v(i,:) are the polynomial coefficients for that polynomial,
ie., v(i,j) is the number D*s(0-)/k —j)!, j=1:k, with s having the
knots tx(i,:) and the B-coefficients a(i,:).

[v,b] = sprpp(tx,a) carries out exactly the same job, except

that now b(i,:) are the B-coefficients for that polynomial with
respect to the knot sequence [0,...,0,tx(i,k: 2*(k-1))], and,
correspondingly, v(i,j) is D*s(0 + )/k —j)!, j=1:k. Also, now it is
assumed that tx(i,k-1)<=0<tx(i,k).

The statement [v,b]=splpp([-2 -1 0 1]1,[0 1 0]) provides the
sequence
v = -1.0000 -1.0000 0.5000 = D?s(0-)/2,Ds(0-),s(0-)

with s the B-spline with knots -2, -1, 0, 1. This is so because the 1 in
splpp indicates the limit from the left, and the second argument, [0 1
01, indicates the spline s in question to be

s=0xB(-|[?,-2,-1,0]) +1x B(- | [-2,-1,0,1]) + 0x B(- | [-1,0,1,7])
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1.e., this particular linear combination of the third-order B-splines for
the knot sequence ..., -2, -1,0,1,... (Note that the values calculated do
not depend on the knots marked ?.) The above statement also provides
the sequence b = 0 1.0000 0.5000 of B-spline coefficients for the
polynomial piece of s on the interval [-1. .0], and with respect to the
knot sequence ?, -2, -1, 0, 0, ?.

In other words, on the interval [-1. .0], the B-spline with knots 2, -1,
0, 1 can be written

0xB(-|[?,-2,-1,0D) +1x B(- | [-2,-1,0,0]) + 5x B(- | [-1,0,0,?])

The statement [v,b]l=sprpp([-1 0 1 2],[1 0 0]) provides the
sequence

v = [0.5000 -1.0000 0.5000] = D%s(0+)/ 2, Ds(0+),s(0+)

with s the B-spline with knots ?,-1,0,1. Its polynomial piece on the
interval [0..1] is independent of the choice of ?, so we might as well think
of 7 as -2, i.e., we are dealing with the same B-spline as before. Note
that the last two numbers agree with the limits from the left computed
above, while the first number does not. This reflects the fact that a
quadratic B-spline with simple knots is continuous with continuous
first, but discontinuous second, derivative. (It also reflects the fact that
the leftmost knot of a B-spline is irrelevant for its right-most polynomial
piece.) The sequence b = 0.5000 0 0 also provided states that, on the
interval [0. .1], the B-spline B(‘|[?,—1,0,1]) can be written

0.5x B(-|[0,0,0,1])+ 0x B(- [ [0,0,1,2]) + 0x B( | [0,1,2,2])
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Purpose

Syntax

Description

Put together spline in B-form

spmak (knots,coefs)

spmak (knots,coefs,sizec)
spmak

sp = spmak(knots,coeffs)

The command spmak(...) puts together a spline function in B-form,
from minimal information, with the rest inferred from the input.
fnbrk returns all the parts of the completed description. In this way,
the actual data structure used for the storage of this form is easily
modified without any effect on the various fn... commands that use
this construct.

spmak (knots,coefs) returns the B-form of the spline specified by the
knot information in knots and the coefficient information in coefs.

The action taken by spmak depends on whether the function is
univariate or multivariate, as indicated by knots being a sequence or a
cell array. For the description, let sizec be size(coefs).

If knots is a sequence (required to be non-decreasing), then the
spline is taken to be univariate, and its order k is taken to be
length(knots)-sizec(end). This means that each ‘column’
coefs(:,j) of coefs is taken to be a B-spline coefficient of the spline,
hence the spline is taken to be sizec(1:end-1)-valued. The basic
interval of the B-form is [knots (1) .. knots(end)].

Knot multiplicity is held to be < k. This means that the coefficient
coefs(:,j) is simply ignored in case the corresponding B-spline has
only one distinct knot, i.e., in case knots(j) equals knots(j+k).

If knots is a cell array, of length m, then the spline is taken to be
m-variate, and coefs must be an (r+m)-dimensional array, — except
when the spline is to be scalar-valued, in which case, in contrast to
the univariate case, coefs is permitted to be an m-dimensional array,
but sizec is reset by

sizec = [1, sizec]; r = 1;
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The spline is sizec(1:r)-valued. This means the output of the spline
is an array with r dimensions, e.g., if sizec(1:2) = [2, 3] then the
output of the spline is a 2-by-3 matrix.

The spline is sizec(1:r)-valued, the ith entry of the m-vector k is
computed as length(knots{i}) - sizec(r+i), i=1:m, and the ith
entry of the cell array of basic intervals is set to [knots{i} (1),
knots{i}(end)].

spmak (knots,coefs,sizec) lets you supply the intended size of the
array coefs. Assuming that coefs is correctly sized, this is of concern
only in the rare case that coefs has one or more trailing singleton
dimensions. For, MATLAB suppresses trailing singleton dimensions,
hence, without this explicit specification of the intended size of coefs,
spmak would interpret coefs incorrectly.

spmak prompts you for knots and coefs.

sp = spmak(knots,coeffs) returns the spline sp.

spmak(1:6,0:2) constructs a spline function with basic interval [1. .6],
with 6 knots and 3 coefficients, hence of order 6 - 3 = 3.

spmak (t, 1) provides the B-spline B(‘|t) in B-form.

The coefficients may be d-vectors (e.g., 2-vectors or 3-vectors), in which
case the resulting spline is a curve or surface (in R2 or R3).

If the intent is to construct a 2-vector-valued bivariate polynomial on
the rectangle [-1..1] X [0..1], linear in the first variable and constant in
the second, say

coefs = zeros([2 2 1]); coefs(:,:,1) = [1 0;0 1];
then the straightforward
sp = spmak({[-1 -1 1 1],[0 1]},coefs);

will result in the error message 'There should be no more knots
than coefficients', because the trailing singleton dimension of
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Diagnostics

See Also

coefs will not be perceived by spmak, while proper use of that third
argument, as in

sp = spmak({[-1 -1 1 1],[0 1]},coefs,[2 2 1]);

will succeed. Replacing here [2 2 1] by size(coefs) would not work.

See the demo “Intro to B-form” for other examples.

There will be an error return if the proposed knot sequence fails

to be nondecreasing, or if the coefficient array is empty, or if there
are not more knots than there are coefficients. If the spline is to be
multivariate, then this last diagnostic may be due to trailing singleton
dimensions in coefs.

fnbrk
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Explain spline terms

spterms(term)
expl = spterms(term)
[...,term] = spterms(...)

spterms(term) provides, in a message box, an explanation of the
technical term indicated by the string term as used in the Curve Fitting
Toolbox spline functions and, specifically, in the GUI splinetool. Only
the first few (but at least two) letters of the desired term need to be
specified, and the full term is shown in the title of the message box.

expl = spterms(term) returns, in expl, the string, or cell array of
strings, comprising the explanation of the desired term.

[...,term] = spterms(...) also returns, in term, the fully
spelled-out term actually used.

spterms('sp') gives an explanation of the term ‘spline’, while
spterms('spline i') explains the terms ‘spline interpolation’.

help spterms provides the list of all available terms.
splinetool

“List of Terms” on page A-3
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Purpose

Syntax

Description

Scattered translates collocation matrix

colmat = stcol(centers,x,type)
colmat stcol(...,'tr")

colmat stcol(centers,x,type) isthe matrix whose (i,j)th entry is

v (x(:,)), i=1:size(x,2),j=1:n

with the bivariate functions W; and the number n depending on the
centers and the string type, as detailed in the description of stmak.

centers and x must be matrices with the same number of rows.

The default for type is the string 'tp', and for this default, n equals
size(centers,2), and the functions y; are given by

v (%) =y (x —centers(;, /), j=1:n
with  the thin-plate spline basis function

w(x) =|xl® log xl?

and with |x| denoting the Euclidean norm of the vector x.

Note See stmak for a description of other possible values for type.

The matrix colmat is the coefficient matrix in the linear system

Zajy/j(x(:,i)) =y;, i=1:size(x,2)
J

that the coefficients q; of the function f= ¥,a;y; must satisfy in order
that f interpolate the value y, at the site x(:,1), all i.
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colmat = stcol(...,'tr') returns the transpose of the matrix
returned by stcol(...).

Example 1. The following evaluates and plots the function

f) =w(x—c)+yx—cy) +y(x—c3)—3.5p(x)

on a regular mesh, with y the above thin-plate basis function, and with
¢,, €y, €4 three points on the unit circle; see the figure below.

a=1[0,2/3*pi,4/3*pi]; centers = [cos(a), 0; sin(a), O];
[xx,yy] = ndgrid(linspace(-2,2,45));

Xy = [xx(:) yy(:)1.";

coefs = [1 1 1 -3.5];

zz = reshape( coefs*stcol(centers,xy,'tr') , size(xx));
surf(xx,yy,zz), view([240,15]), axis off

L S 7
“L&Aﬁﬁﬁ%ﬂ

X

Example 2. The following also evaluates, on the same mesh, and plots
the length of the gradient of the function in Example 1.
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zz = reshape( sqrt(...
([coefs,0]*stcol(centers,xy, 'tp10','tr'))."2 + ...
([coefs,0]*stcol(centers,xy, 'tr', 'tp01'))."2),
size(xx));
figure, surf(xx,yy,zz), view([220,-15]), axis off

See Also spcol | stmak
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Put together function in stform

stmak (centers,coefs)
st = stmak(centers,x,type)
st = stmak(centers,coefs,type,interv)

stmak(centers,coefs) returns the stform of the function f given by

f(x) = 2 coefs(:, j) -y (x — centers(:, j))
j=1

with
2 2
v(x) = |xl” log|xl
the thin-plate spline basis function, and with |x| denoting the
Euclidean norm of the vector x.

centers and coefs must be matrices with the same number of columns.

st = stmak(centers,x,type) stores in st the stform of the function f
given by

fx) =Y coefs(:, )y (x)

J=1
with the y; as indicated by the string type, which can be one of the
following:
® 'tp00', for the thin-plate spline;

® 'tp10', for the first derivative of a thin-plate spline wrto its first
argument;

e '"tp01', for the first derivative of a thin-plate spline wrto its second
argument;

e 'tp', the default.



stmak

Here are the details.

'tp00' wi(x) = o(lx—c;|?), c; =centers(:,j), j=1:n-3
with @(¢) = tlog(t)
W, o(x) = x(1)
Y, () = x(2)
w,@) =1
'tp10" wix) = o(lx—c;|?), c;=centers(:,j), j=1:n-1
with @) = (D,f)(logt + 1), and D, ¢ the partial derivative of ¢ = t(x) = |x — ¢l Z
wrto x(1)
w,x) =1
'tp01' wi(x) = o(lx—c;|?), c; =centers(:,j), j=1:n-1
with @(?) = (D,t)(logt + 1), and D,t the partial derivative of ¢ = t(x) = |x — ¢l 2
wrto x(2)
w,@) =1
"tp' wix) = o(lx—c;|?), ¢, =centers(:,j), j=1:n
default .
(default) | Lo o) = tlog(t)
st = stmak(centers,coefs,type,interv) also specifies the basic
interval for the stform, with interv{j} specifying, in the form [a,b],
the range of the jth variable. The default for interv is the smallest
such box that contains all the given centers.
Examples Example 1. The following generates the figure below, of the thin-plate

spline basis function, y(x) = |9c|2 loglxl2 , but suitably restricted to show
that this function is negative near the origin. For this, the extra lines
are there to indicate the zero level.

inx = [-1.5 1.5]; iny = [0 1.2];

fnplt(stmak([0;0],1),{inx,iny})
hold on, plot(inx,repmat(linspace(iny(1),iny(2),11),2,1),'r")
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view([25,20]),axis off, hold off

Example 2. We now also generate and plot, on the very same domain,
the first partial derivative D,y of the thin-plate spline basis function,
with respect to its second argument.

inx = [-1.5 1.5]; iny = [0 1.2];
fnplt(stmak([0;0],[1 O], 'tp01',{inx,iny}))
view([13,10]),shading flat,axis off

Note that, this time, we have explicitly set the basic interval for the
stform.

The resulting figure, below, shows a very strong variation near the
origin. This reflects the fact that the second derivatives of y have a
logarithmic singularity there.
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See Also
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subplus

Purpose Positive part
Syntax Xp = subplus(x)
Description Xp = subplus(x) returns (x),, i.e., the positive part of x, which is x

if x is nonnegative and 0 if x is negative. In other words, xp equals
max (x,0). If x is an array, this operation is applied entry by entry.

Examples Example 1. Here is a plot of the essential part of the subplus function,
as generated by

X = -2:2; plot(x,subplus(x),'linew',4), axis([-2,2,-.5,2.5])

25

1.5f

0.5¢

-0.5 . . . . . . .
-2 -15 -1 -0.5 0 0.5 1 15 2

Example 2. The following anonymous function describes the so-called
hat function:

hat = @(x) subplus(x) - 2*subplus(x-1) + subplus(x-2);
i.e., the spline also given by spmak (0:2,1), as the following plot shows.

X = -.5:.5:2.5; plot(x,hat(x),"'linew',4), set(gca, 'Fontsize',16)
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Description

Examples
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Titanium test data

[x,y] = titanium

[x;y]

titanium returns measurements of a certain property of

titanium as a function of temperature. Since their use in , these data
have become a standard test for data fitting since they are hard to fit by
classical techniques and have a significant amount of noise.

The plot of the data shown below is generated by the following

commands:

[x5y]

= titanium; plot(x,y,'ok'), set(gca, ' 'Fontsize',16)

2.2
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C. de Boor and J. R. Rice, Least squares cubic spline approximation II -
Variable knots, CSD TR 21, Comp.Sci., Purdue Univ., April 1968.
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Purpose

Syntax

Description

Thin-plate smoothing spline

tpaps(x,y)
tpaps(x,y,p)
[...,p] = tpaps(...)

tpaps(x,y) is the stform of a thin-plate smoothing spline f for the
given data sites x(:,j) and the given data values y(:,j). The x(:,j)
must be distinct points in the plane, the values can be scalars, vectors,
matrices, even ND-arrays, and there must be exactly as many values as
there are sites.

The thin-plate smoothing spline f is the unique minimizer of the
weighted sum

PE(f)+1-pR(f)

with E(f) the error measure
. (|2
E(f) =Y |yC, )~ f(xG,))|
J
and R(f) the roughness measure

2
R(f) = [(DiDyf| +2|Dy Dy f” +| Dy Dy )

Here, the integral is taken over all of R?, |z|? denotes the sum of
squares of all the entries of z, and Df denotes the partial derivative of f
with respect to its ith argument, hence the integrand involves second
partial derivatives of f. The smoothing parameter p is chosen so that
(1-p)/p equals the average of the diagonal entries of the matrix A,
with A + (1-p)/p*eye(n) the coefficient matrix of the linear system
for the n coefficients of the smoothing spline to be determined. This
choice of p is meant to ensure that we are in between the two extremes,
of interpolation (when p is close to 1 and the coefficient matrix is
essentially A) and complete smoothing (when p is close to 0 and the
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coefficient matrix is essentially a multiple of the identity matrix). This
should serve as a good first guess for p.

tpaps(x,y,p) also inputs the smoothing parameter, p, a number
between 0 and 1. As the smoothing parameter varies from O to 1,
the smoothing spline varies, from the least-squares approximation to
the data by a linear polynomial when p is 0, to the thin-plate spline
interpolant to the data when p is 1.

[...,p] = tpaps(...) also returns the smoothing parameter
actually used.

Example 1. The following code obtains values of a smooth function at
31 randomly chosen sites, adds some random noise to these values, and
then uses tpaps to recover the underlying exact smooth values. To
illustrate how well tpaps does in this case, the code plots, in addition to
the smoothing spline, the exact values (as black balls) as well as each
arrow leading from a smoothed value to the corresponding noisy value.

rand('seed',23); nxy = 31;

Xy = 2*(rand(2,nxy)-.5); vals = sum(xy."2);

noisyvals = vals + (rand(size(vals))-.5)/5;

st = tpaps(xy,noisyvals); fnplt(st), hold on

avals = fnval(st,xy);

plot3(xy(1,:),xy(2,:),vals, 'wo', 'markerfacecolor', 'k")

quiver3(xy(1,:),xy(2,:),avals,zeros(1,nxy),zeros(1,nxy),
noisyvals-avals, 'r'), hold off
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Example 2. The following code uses an interpolating thin-plate spline
to vector-valued data values to construct a map, from the plane to the
plane, that carries the unit square {x: |x(j)| < 1,j = 1:2} approximately
onto the unit disk {x : x(1)? + x(2)? < 1} , as shown by the picture
generated.

n = 64; t = linspace(0,2*pi,n+1); t(end) = [];
values = [cos(t); sin(t)];

centers = values./repmat(max(abs(values)),2,1);
st = tpaps(centers, values, 1);

fnplt(st), axis equal

Note the choice of 1 for the smoothing parameter here, to obtain
interpolation.
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0.8

0.6

0.4r

0.2

The determination of the smoothing spline involves the solution of a
linear system with as many unknowns as there are data points. Since
the matrix of this linear system is full, the solving can take a long time
even if, as is the case here, an iterative scheme is used when there are
more than 728 data points. The convergence speed of that iteration is
strongly influenced by p, and is slower the larger p is. So, for large
problems, use interpolation, i.e., p equal to 1, only if you can afford
the time.

csaps | spaps
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Purpose
Syntax

Description

Examples

See Also

Name of cfit, sfit, or fittype object

name = type(fun)

name = type(fun) returns the custom or library name name of the
cfit, sfit, or fittype object fun as a character array.

f = fittype('a*x"2+b*exp(n*x)"');
category(f)

ans =

custom

type(f)

ans =

customnonlinear

g = fittype('fourierd');
category(g)

ans =

library

type(9)

ans =

fourier4

fittype | category | cflibhelp

16-251



type

16-252



Bibliography

[1] Barber, C. B., D. P. Dobkin, and H. T. Huhdanpaa. “The Quickhull
Algorithm for Convex Hulls.” ACM Transactions on Mathematical Software.
Vol. 22, No. 4, 1996, pp. 469-483.

[2] Bevington, P. R., and D. K. Robinson. Data Reduction and Error Analysis
for the Physical Sciences. 2nd ed. London: McGraw-Hill, 1992.

[3] Branch, M. A., T. F. Coleman, and Y. Li. “A Subspace, Interior, and
Conjugate Gradient Method for Large-Scale Bound-Constrained Minimization
Problems.” SIAM Journal on Scientific Computing. Vol. 21, No. 1, 1999,

pp. 1-23.

[4] Carroll, R. J., and D. Ruppert. Transformation and Weighting in
Regression. London: Chapman & Hall, 1988.

[6] Chambers, J., W. S. Cleveland, B. Kleiner, and P. Tukey. Graphical
Methods for Data Analysis. Belmont, CA: Wadsworth International Group,
1983.

[6] Cleveland, W. S. “Robust Locally Weighted Regression and Smoothing
Scatterplots.” Journal of the American Statistical Association. Vol. 74, 1979,
pp. 829-836.

[7] Cleveland, W. S., and S. J. Devlin. “Locally Weighted Regression: An
Approach to Regression Analysis by Local Fitting.” Journal of the American
Statistical Association. Vol. 83, 1988, pp. 596-610.

[8] Daniel, C., and F. S. Wood. Fitting Equations to Data. Hoboken, NdJ:
Wiley-Interscience, 1980.



B Bibliography

B-2

[9] DeAngelis, D. J., J. R. Calarco, J. E. Wise, H. J. Emrich, R. Neuhausen,
and H. Weyand. “Multipole Strength in 2C from the (e,e’a) Reaction for
Momentum Transfers up to 0.61 fm'1.” Physical Review C. Vol. 52, No. 1,
1995, pp. 61-75.

[10] de Boor, C. A Practical Guide to Splines. Berlin: Springer-Verlag, 1978.

[11] Draper, N. R., and H. Smith. Applied Regression Analysis. 3rd ed.
Hoboken, NJ: Wiley-Interscience, 1998.

[12] DuMouchel, W., and F. O’Brien. “Integrating a Robust Option into

a Multiple Regression Computing Environment.” Computing Science and
Statistics: Proceedings of the 21st Symposium on the Interface. (K. Berk and
L. Malone, eds.) Alexandria, VA: American Statistical Association, 1989,
pp. 297-301.

[13] Goodall, C. “A Survey of Smoothing Techniques.” Modern Methods
of Data Analysis. (J. Fox and J. S. Long, eds.) Newbury Park, CA: Sage
Publications, 1990, pp. 126-176.

[14] Holland, P. W., and R. E. Welsch. “Robust Regression Using Iteratively
Reweighted Least-Squares.” Communications in Statistics—Theory and
Methods. Vol. A6, 1977, pp. 813-827.

[15] Huber, P. J. Robust Statistics. Hoboken, NJ: Wiley-Interscience, 1981.

[16] Hutcheson, M. C. “Trimmed Resistant Weighted Scatterplot Smooth.”
Master’s Thesis. Cornell University, Ithaca, NY, 1995.

[17] Levenberg, K. “A Method for the Solution of Certain Problems in Least
Squares.” Quarterly of Applied Mathematics. Vol. 2, 1944, pp. 164—168.

[18] Marquardt, D. “An Algorithm for Least-Squares Estimation of Nonlinear
Parameters.” SIAM Journal on Applied Mathematics. Vol. 11, 1963, pp.
431-441.

[19] Orfanidis, S. J. Introduction to Signal Processing. Englewood Cliffs, NJ:
Prentice-Hall, 1996.



Bibliography

[20] Press, W. H., S. A. Teukolsky, W. T. Vetterling, and B. P. Flannery.
Numerical Recipes in C: The Art of Scientific Computing. Cambridge, UK:
Cambridge University Press, 1993.

[21] Street, dJ. O., R. J. Carroll, and D. Ruppert. “A Note on Computing
Robust Regression Estimates Via Iteratively Reweighted Least Squares.” The
American Statistician. Vol. 42, 1988, pp. 152-154.

[22] Watson, David E. Contouring: A Guide to the Analysis and Display of
Spatial Data. Tarrytown, NY: Pergamon, 1992.

B-3



B Bibliography

B-4



Symbols and Numerics

1-column matrix 6-8
1-row matrix 6-8
2D A-10

3D A-10

A

adjusted R-square 5-33
adjusted residuals 5-23
algorithms 5-26
almost block-diagonal 16-7
collocation matrix 16-205
in spcol 16-213
linear system 16-198
use 16-211
Analysis GUI
census data example 2-17
appropriate knot sequence 10-7
aptknt 16-2
area enclosed by spline curve 7-13
argnames 16-4
augknt 16-5
use 7-14 10-7 14-12 14-15 14-21 16-40
augmented knot sequence 16-5
aveknt 16-6
use 14-17 16-155
axes limit control
census data example 2-11
nonparametric fit example 2-108

B in B-spline 10-7
B-form 10-3
discussion of 8-5
in spmak 16-233
smoothness conditions 10-7
vs ppform 9-8
B-representation 6-5

B-spline
coefficients 14-10
example 16-231 16-234
(Glossary) A-5
in CAGD 10-8
in spcol 16-211
in spcrv 16-214
normalized 8-5
of order k 8-5
some sample figures 10-4
support of 8-7
via bspline 16-11
B\x8e zier 16-98
backslash operator 5-20
banded 8-7 14-24
banded linear system 8-7
basic interval 16-129
as set in ppmak 16-162
cautionary note 16-100 16-120
extension outside 10-3
for the B-form 16-233
for the pp-form 9-3
of B-form 10-3
outside of 14-22
use 14-22
use in
fnder 16-109
fnint 16-113
fnjmp 16-115
fnmin 16-117
newknt 16-150
basis A-6
basis function
in stform 13-2
of thin-plate spline A-8
in stcol 16-237
in stmak 16-240
(Overview) 8-11
basis map 14-3
BBform 16-98

Index-1



Index

bell-shaped 16-10 center
best fit 2-9 of a shifted power form A-5
best interpolant 8-8 of an stform A-8
biarc 16-178 16-180 center and scale 2-9
bias 14-25 centers 13-2
bicubic spline example 7-15 16-38 centripetal 16-48
bisquare weights cfit 16-13
robust fitting 5-23 cflibhelp 16-14
bivariate 6-5 cftool 16-21
bkbrk 16-7 chbpnt 16-28
in spcol 16-211 Chebyshev polynomial 14-14
bounds Chebyshev spline 14-14
confidence circle, spline approximation to 10-11
census data example 2-14 circular arc 16-178
definition 5-34 clamped end condition 16-34
prediction code generation
definition 5-34 getting started 4-5
break modifying code 4-38
example 9-4 overview 4-30
in ppform 9-2 running code 4-33
interior 10-7 coefficient
use 14-12 confidence bounds 5-35
vs knot 10-7 constraints
break sequence Fit Options GUI 2-58
example 9-4 16-165 Fourier series example 2-94
in ppform 9-2 Gaussian example 2-104
breaks (Glossary) A-5 starting values
breaks vs knots 10-2 Fit Options GUI 2-58
conversion 10-7 Gaussian example 2-104
brk2knt 16-8 structure
bspligui 16-9 piecewise polynomials 2-107
bspline coefficient of multiple determination 5-32
use 10-4 coeffnames 16-30
coeffvalues 16-31
C collocation 14-9
in spcol 16-211
CAGD 12-8 matrix 10-12
carboni2alpha data set 2-83 constructed in spcol 16-211
category 16-12 use in spapi 16-205
census data example 2-3 use 14-8

Index-2



Index

collocation matrix

in stcol 16-237
column-vector 6-8
complex data

importing 2-23
composing function with a matrix 16-105
confidence bounds

census data example 2-14

definition 5-34

Legendre polynomial example 2-88
confint 16-32
constraints

Fit Options GUI 2-58

Fourier series example 2-94

Gaussian example 2-104
constructive approach to splines 8-8
control point

example 10-10

of a spline curve 10-2

of a spline function 16-6
control polygon

example 12-9

of a spline function 16-6

use 14-16
conversion

B-form to ppform 8-7

via splpp,sprpp 16-231
coordinates with respect to a basis A-6
covariance matrix of coefficient estimates 5-36
csape 16-34
csapi 16-40

example 16-129

use 16-125
csaps 16-42
cscvn 16-48

in getcurve 16-142
cubic

B-spline

example 10-4
Hermite 16-5

smoothing spline 8-8
spline
example 14-14
cubic means order 4 10-2
cubic smoothing spline
via csaps 16-42
cubic spline
via spap2 16-201
via spapi 16-204
cubic spline curve
via cscvn 16-48
cubic spline interpolation 5-45 16-34
via csapi 16-40
Curry-Schoenberg Theorem A-6
curvature 10-10
curve A-4
finding point on 7-14
plotted via fnplt 16-118
via spmak 16-234
vs function A-4
curve fitting methods 4-11
examples 4-15
getting started 4-2
overview 4-9
curve fitting objects 4-10
examples 4-15
getting started 4-2
overview 4-9
curve fitting session
saving fit results 2-19
Curve Fitting Tool
Fourier series example 2-96
Gaussian example 2-103
Legendre polynomial example 2-88
nonparametric fit example 2-108
prediction bounds 5-42
rational example 2-65
residuals 5-40
robust fit example 2-73
starting 2-2

Index-3



Index

custom equations

general
Fourier series example 2-91
Gaussian example 2-101
robust fit example 2-68

linear
Legendre polynomial example 2-83
robust fitting example 2-68

D

d-valued A-3
d-vector 6-8
data 2-48 2-68
excluding 2-37
fitting procedure
census data example 2-5
general steps 2-48
importing 2-3
sectioning 2-37
smoothing 2-30
See also predictor data, response data
Data GUI
Data Sets pane 2-22
Smooth pane 2-31
data point A-8
multiplicity
in sorted 16-199
in spapi 16-203
data sets
deleting 2-24
enso 2-91
flvote2k 2-68
gauss3 2-101
hahn1 2-62
importing 2-22
renaming 2-24
Data Sets pane
census data example 2-4

Index-4

description 2-22
data site A-8
data tips

robust fit example 2-73
data value A-8
datastats 16-50
default

coefficient parameters

fit options 2-61

confidence level for bounds 5-36
degree raising 16-107
degrees of freedom 5-33 14-9
deleting

data sets 2-24

exclusion rules 2-39
dependnames 16-52
derivative

of a rational spline A-7
design matrix 5-19
determining the best fit 2-9
differential equation

non-standard 16-211
differentiate 16-53
differentiating a fit

example 4-24
differentiation

discrete 16-150

in the pp sense 16-110

of B-form 16-110

via fnder 16-109
dimension A-6
discrete

differentiation 16-150

least-squares approximation 14-21
domain of a function A-3
draftsman’s spline 8-3
dual functional 8-7

use in fn2fm 16-99



Index

end
break 9-3
knot 10-3
end conditions 16-34
clamped 16-35
complete 16-35
curved 16-35
Lagrange 16-35
natural 16-35
not-a-knot 16-34
other 16-36
variational 16-35
enso data set 2-91
equal quality data 5-17
equations
custom 2-77
library 2-53
equidistribute 16-150
error distributions 5-17
error measure 8-8
(Glossary) A-9
in csaps 16-42
in spaps 16-207
in splinetool 16-228
in tpaps 16-247
error sum of squares 5-32
error weight A-9
evaluation
of tensor product spline 14-20
simultaneous 16-129
via fnval 16-128
examples
curve fitting objects and methods 4-15
excluding and sectioning data 2-44
Fourier series fit 2-91
Gaussian fit 2-101
importing data 2-24
Legendre polynomial fit 2-83
nonparametric fit 2-106

rational fit 2-62

robust fit 2-68

smoothing data 2-33
Exclude GUI

description 2-38

example 2-46

robust fit example 2-71
excludedata 16-59
excluding data

example 2-44 4-18

marking outliers 2-39

sectioning 2-42
exclusion rule

definition 2-38

robust fitting example 2-71
exponentials

fit type definition 2-54
extension beyond basic interval

B-form 10-3

cautionary note 16-100

ppform 9-3

via fnxtr 16-130
extrapolation 16-130

census data example 2-17

F

feval 16-64

filtering data
moving average 5-4
Savitzky-Golay 5-6

finite differencing parameters 2-60

fit 16-67

fit convergence criteria 2-61

Fit Editor
census data example 2-5
Legendre polynomial example 2-88
nonparametric fit example 2-106
robust fit example 2-72

fit options

Index-5



example 4-21
Fit Options GUI
description 2-58
Fourier series example 2-94
Gaussian example 2-104
fitoptions 16-75
fitting
algorithms 5-26
fit options 2-58
least-squares method
linear 5-18
nonlinear 5-25
nonparametric 2-106
numerical results 2-12
parametric 2-52
procedure
census data example 2-5
general steps 2-48
visual results 2-9
Fitting GUI
census data example 2-7
Fit Editor 2-5
fitting process 2-48

nonparametric fit example 2-106

numerical fit results 2-12
robust fit example 2-72
Table of Fits 2-5
fittype 16-86
flvote2k data set 2-68
fn2fm 16-98
fnbrk 16-101
use 14-16 14-22 14-28
fnchg 16-104
fncmb 16-105
use 7-15 16-36
fnder 16-109
use 14-16 16-36
fndir 16-111
fnint 16-113
vs fnder 16-109

Index-6

fnjmp 16-115
fnmin 16-116
fnplt 16-118
use 7-11 14-15 16-48
vs spcrv 16-214
fnrfn 16-121
fntlr 16-122
fnval 16-128
use 14-17 14-24 to 14-25 16-36
fnxtr 16-130
use 14-5
fnzeros 16-133
formula 16-138
Fourier series
example 2-91
fit type definition 2-54
franke 14-20 16-139
Franke function 14-20
picture 14-24
function A-3
vs curve A-4
function reference
argnames 16-4
category 16-12
cfit 16-13
cflibhelp 16-14
cftool 16-21
coeffnames 16-30
coeffvalues 16-31
confint 16-32
datastats 16-50
dependnames 16-52
differentiate 16-53
excludedata 16-59
feval 16-64
fit 16-67
fitoptions 16-75
fittype 16-86
formula 16-138
get 16-140



Index

indepnames 16-143
integrate 16-144
islinear 16-146
numargs 16-152
numcoeffs 16-153
plot 16-156
predint 16-167 16-170
probnames 16-171
probvalues 16-172
quad2d 16-173
set 16-184
setoptions 16-186
sfit 16-187
sftool 16-190
smooth 16-192
type 16-251
functional
dual 8-7

G

Gauss points 14-9
Gauss-Newton algorithm 5-26
gauss3 data set 2-101
Gaussian
example 2-101
fit type definition 2-55
general equations
custom 2-79
General Equations pane 2-79
Fourier series example 2-93
Gaussian example 2-101
get 16-140
getcurve 16-142
good interpolation sites
from chbpnt 16-28
from Chebyshev spline 14-14
via aveknt 16-6
goodness of fit 5-28

census data example 2-9
statistics 5-31

graphically viewing data 2-26
Greville site 10-12
gridded data

example 7-15 14-20
smoothing 16-208

GUI

H

Analysis
census data example 2-17
Create Custom Equation 2-77
Data 2-22
Exclude 2-38
Fit Options
description 2-58
Fourier series example 2-94
Gaussian example 2-104
Fitting
census data example 2-7

Legendre polynomial example 2-88
nonparametric fit example 2-106

rational example 2-64

robust fit example 2-72
Plotting

census data example 2-19

smoothing data example 2-36
Table Options

census data example 2-13

goodness of fit evaluation 5-41

hahni data set 2-62

hat function 16-244
hat matrix 5-20
helix 16-176

Hermite

cubics 16-5

Hermite interpolation 16-178 16-203

Index-7



Index

| J
implicit 6-4 Jacobian 5-26
importing data 2-3 jump

description 2-22 allow for 10-7

example 2-24 ignored in fnder 16-110
indepnames 16-143 in derivative 8-6
influential data 2-41
Infs K

importing 2-23

removing 2-47 knot 7-5
integral average
definite 7-11 use 14-15
indefinite 16-113 . Vi?. aveknt 16-6
integral equation 6-4 nsertion
integrate 16-144 used in fn2fm 16-99

used in spcrv 16-214
used in splpp 16-231

integrating a fit
example 4-24

integration 16-109 interior 14-21
interior multiplicity 16-119
break 9-3 at endpoints 10-7
knot 10-3 at endpoints:cautionary note 16-119
interpolant multiplicity vs smoothness 8-6
variational sequence
via csaps 16-43 appropriate 10-7
via spaps 16-208 improved 16-150

in B-form 10-2
in spcol 16-211

interpolants 5-45
interpolation A-8

by thin-plate spline 16-249 of a spline (Glossary) A-7
Hermite 7-14 16-203 optimal 16-154

optimal 16-154 simple (Glossary) A-7

via cscvn 16-48 knots vs breaks 10-2

via spapi 16-203 conversion 10-7

via spaps 16-208 knt2brk 16-148

interpolation points, good 16-6 knt2mlt 16-148

interval notation (Glossary) A-3
islinear 16-146 L

iteratively reweighted least squares 5-23 Lagrange end condition 16-36

LAR 5-23
least absolute residuals 5-23

Index-8



Index

least-squares
approximation
by “natural” cubic splines 14-2
discrete:example 14-21
discrete:via slvblk 16-198
(Glossary) A-9
via spap2 16-200
via spline 14-7
in csaps 16-43
in spaps 16-208
least-squares fitting
linear 5-18
nonlinear 5-25
robust 5-23
weighted linear 5-21
Legendre polynomials
example 2-83
generating 2-84
Levenberg-Marquardt algorithm 5-26
leverages 5-23
library models 2-53
limit from the left
in splpp 16-231
via fnval 16-129
limit from the right 16-129
linear
combination of functions 16-105
dependence 14-29
operations 16-105
space A-6
linear equations
custom 2-78
fit options 2-58
Linear Equations pane 2-78
robust fit example 2-70
linear interpolation 5-45
linear least squares 5-18
loading the curve-fitting session 2-20
local
polynomial coefficients 8-4

power form
(Glossary) A-5
in ppform 9-2
local regression 5-7
robust 5-11
loess 5-7
lowess 5-7

M

m-variate A-5
MAD

robust fitting 5-24
marking outliers 2-39
matrix

banded 8-7
matrix-valued A-3
maximum

via fnmin 16-116
median absolute deviation

robust fitting 5-24
mesh 16-41
meshgrid 16-41
minimize 8-8
minimum

via fnmin 16-116
models

custom 2-77

library 2-53
Moebius 11-6
moving average filtering 5-4
multiple correlation coefficient 5-32
multiplicity

in a sequence 16-148

of a data point 16-203

of a knot 8-6

vs smoothness

in bspligui 16-9

multivariable (see multivariate) 11-2
multivariate 11-2

Index-9



Index

example 16-38

in fnval 16-129
overview 8-10
tensor product 11-2
vs univariate A-3

naming conventions 6-8
NaNs

importing 2-23

removing 2-47
natural

(Glossary) A-10

in csaps 16-43

in cscvn 16-48
ND-valued A-3 A-11

nearest neighbor interpolation 5-45

nested multiplication 16-129
newknt 16-150
use 14-12
Newton’s method
example 14-10
in optknt 16-155
noise 8-8
noisy 7-8
nonlinear equations
fit options 2-58
fitting 5-25
nonlinear least squares 5-25
nonlinear system
in optknt 16-155
nonparametric fitting
example 2-106
methods 2-106
normal equations 5-19
normalization 2-9
normalized B-spline 8-5

not-a-knot end condition 16-34 16-178

in csape 16-41

Index-10

numargs 16-152

numcoeffs 16-153
numerically viewing data 2-28
NURBS 12-8

o

optimal
interpolation 16-154
knot sequence 16-154
optknt 16-154
order 10-5
of a polynomial A-4
of a pp 9-4
of a spline 8-7
of ppform 9-2
osculatory 16-203
outliers
definition 2-37
marking 2-39
removing 2-47
robust fit 5-23
overfitting
census data example 2-15

goodness of fit evaluation 5-43

P

parabolic 10-5

curve

example 16-165

spline 14-21
parametric

bicubic spline 16-38

cubic spline curve 16-48
parametric fitting 2-52
parametrization A-4

chord-length 7-12
parametrized 16-214
pchip 5-46



Index

perfect spline 16-115
periodic 16-48
PGS 6-4
piecewise cubic
example 16-165
piecewise polynomials 5-46
piecewise-polynomial
(Glossary) A-5
in ppform 9-2
placeholder notation A-3
plot 16-156
plotting 16-118
Plotting GUI
census data example 2-19
smoothing data example 2-36
point on a curve
finding 7-14
polygon 14-16
polynomial part of stform 13-2
polynomials
census data example 2-5
fit type definition 2-55
Legendre 2-84
piecewise 5-46
rational models 2-56
polyval 9-3
power form A-5
power series
fit type definition 2-56
pp 9-4
pp-representation 6-5
ppform
from fncmb 16-107
from spline 6-5
of a B-spline 16-11
(Overview) 8-3
via ppmak 16-162
vs B-form 9-8
ppmak 16-162
prediction bounds

definition 5-34

prediction intervals

example 4-28

predictor data

census data example 2-4
importing 2-23
sectioning 2-39
viewing numerically 2-29

predint 16-167 16-170
preprocessing data 2-47

excluding and sectioning 2-37
smoothing 2-30

Preview window 2-25
probnames 16-171
probvalues 16-172
projection matrix 5-20

Q

@R decomposition 5-20
QR factorization 16-205

in spap2 16-202
in spapi 16-205
use in slvblk 16-198

quad2d 16-173
quality of data

weighted linear least squares 5-21

quartic 10-10

R-square 5-32

adjusted 5-33
negative values 5-33

radial basis function 8-11 13-2
range of a function A-3
rational spline 12-2

from rpmak,rsmak 16-174
(Glossary) A-7

rationals

Index-11



Index

example 2-62
fit type definition 2-56
RBF 8-11
rBform 12-6
recovery scheme 16-154
recurrence relation
for B-splines 8-7
use in fnval 16-129
use in spcol 16-213
regression
sum of squares 5-32
weights 5-8

least squares 5-21

Remez algorithm 14-16
removing Infs, NaNs, and outliers 2-47
renaming

data sets 2-24

exclusion rules 2-39
residual degrees of freedom 5-33
residuals

adjusted 5-23

comparing multiple fits 2-9

definition 5-29

displaying

census data example 2-7
goodness of fit evaluation 5-29

excluding data with 2-45
response data

census data example 2-4

importing 2-23

sectioning 2-39

viewing numerically 2-29
restriction to an interval 9-6
right-click menu 2-27
RMSE 5-34

robust

fitting

Index-12

alternative to excluding data 2-42
example 2-68
regression schemes 5-23

robust fitting
example 4-22
robust least squares 5-23
robust smoothing 5-11
robust weights
fitting 5-24
Rodrigues’ formula 2-84
root mean squared error 5-34
roughness measure 8-8
(Glossary) A-9
in csaps 16-42
in spaps 16-207
in splinetool 16-229
in tpaps 16-247
roughness weight A-10
row-vector 6-8
rpform 12-6
rpmak 16-174
rscvn 16-178
rsform 12-6
rsmak 16-174
rubber band selection 2-44

S

saving
analysis results
workspace variables 2-18
fit results
curve fitting session 2-19
workspace variables 2-15
Savitzky-Golay filtering 5-6
scalar-valued vs vector-valued A-3
scaling of a function 16-105
scatter plot 2-27
scatter plot smooth 5-7
scattered
data
in tpaps 16-247
translates 13-2



Index

Schoenberg 8-3 A-5
Schoenberg-Whitney
conditions

(Glossary) A-9

in optknot 16-155

in spap2 16-200
in spapi 16-205
theorem
(Glossary) A-9
(Overview) 8-7
secant method 14-17
sectioning data
definition 2-37
example 2-44
rules 2-42
session 2-19
set 16-184
setoptions 16-186
sfit 16-187
sftool 16-190

shape-preserving interpolation 5-45

shifted power form A-5
side conditions 14-9
simple knot A-7
sine functions 2-57
site A-8
slvblk 16-198
in spap2 16-202
in spapi 16-205
smooth 16-192
Smooth pane
description 2-31
example 2-34
smoothing A-9
parameter
(Glossary) A-10
in csaps 16-42
in spaps 16-208
in tpaps 16-248
(Overview) 8-8

spline 8-10
smoothing data
definition 2-30
example 2-33
example 1 4-16
example 2 4-17
local regression 5-7

moving average filtering 5-4
Savitzky-Golay filtering 5-6
smoothing parameter 5-13

smoothing spline 5-13
smoothness 16-9
across breaks 8-5
across knot 10-2
condition 10-7
guaranteed 16-5
in B-form 10-5

multiplicity of 8-6

sort 16-199
sorted 16-199
span 2-30
spap2 16-200

use 14-21 14-25 to 14-26 14-28

spapi 16-203

use 7-5 14-15 14-18
spaps 16-207
sparse 16-211

matrix 16-213
spcol 16-211

in spap2 16-202

in spapi 16-205

use 10-6 10-12 14-10 14-12 14-24

spcrv 16-214

vs fnplt 16-214
sphere

via csape 16-38

via rsmak 12-5
spline 5-46

approximation to a circle 10-11
cubic interpolant 5-45

Index-13



Index

curve
area enclosed by 7-13
example 10-10
via cscvn 16-48
via spapi 7-12
via spcrv 16-214
draftsman’s 8-3
naming of 8-3
smoothing 5-13
specified 10-2
splinetool 16-216
splpp 16-231
spmak 16-233
use 10-9 14-12 14-24 16-11 16-117
sprpp 16-231
spterms 16-236
SSE, SSR, SST 5-32
staircase shape 16-213
standard error 5-34
starting values
Fit Options GUI 2-58
Gaussian example 2-104
stcol 16-237
stform
from stmak 16-240
stmak 16-240
structure of coefficients 2-107
subdivision 16-214
subplus 16-244
sum of sine functions
fit type definition 2-57
sum of squares
error 5-32
regression 5-32
total 5-32
support of a B-spline 8-7
surface A-4
surface fitting methods 4-41
surface fitting objects 4-41

Index-14

T

Table of Fits 2-5
Table Options GUI
census data example 2-13
goodness of fit evaluation 5-41
target of a function A-3
Taylor
polynomial
example 16-126
via fntlr 16-122
series 8-3
tensor product 11-2 16-129
example 14-20
(Glossary) A-4
polynomial A-5
thin-plate spline 8-10
(Glossary) A-8
titanium 16-246
Tools menu 2-27
torus
via rsmak 16-174 to 16-175
total sum of squares 5-32
tpaps 16-247
transformations 5-2
trivariate 8-10
truncated 8-3
trust-region algorithm 5-26
type 16-251

U

uniform
knot sequence 14-21
mesh 16-43
unimodal 16-10
unique spline 16-200
uniqueness of B-form 10-7
unit circle 12-3
univariate vs multivariate A-3



Index

\"

value outside basic interval 9-7
variational 16-43
approach to splines 8-8
interpolant
via csaps 16-43
via spaps 16-208
vector
curve 16-119
in this toolbox 6-8
is always a column matrix 9-2
-valued
example 14-21
in spmak 16-234
splines 7-12
vs scalar-valued A-3
viewing data

graphically 2-26
numerically 2-28

w

Weibull distribution
fit type definition 2-58
weighted linear least squares 5-21
weights
regression
least squares 5-21
robust
least squares 5-23
viewing numerically 2-29
workflow
object-oriented fitting 4-13

Index-15



	toc
	Getting Started
	Curve Fitting Toolbox Product Overview
	Product Overview
	Key Features
	Interactive and Programmatic Environments

	Curve Fitting
	Interactive Curve Fitting
	Programmatic Curve Fitting

	Surface Fitting
	Interactive Surface Fitting
	Programmatic Surface Fitting

	Spline Fitting
	Interactive Spline Fitting
	Programmatic Spline Fitting


	Interactive Curve Fitting
	Interactive Curve Fitting Example
	Opening Curve Fitting Tool
	Importing Data
	Interactive Curve Fitting Procedure
	The Data Fitting Procedure
	Determining the Best Fit
	Saving the Fit Results

	Analyzing the Fit
	Saving the Analysis Results

	Saving Your Work
	Save the Session
	Generate Code to a File


	Preprocessing Data
	Importing Data
	Introduction
	Creating a Data Set
	Working with Data Sets
	Example: Importing Data

	Viewing Data
	Viewing Data Graphically
	Viewing Data Numerically

	Smoothing Data
	Introduction
	Creating a Smoothed Data Set
	Smoothing Method
	Working with Smoothed Data Sets
	Example: Smoothing Data

	Excluding and Sectioning Data
	Introduction
	Exclusion Rules
	Excluding Individual Data Points
	Excluding Data Sections in the Domain or Range
	Marking Outliers
	Sectioning
	Example: Excluding and Sectioning Data

	Missing Values and Outliers

	Fitting Data
	Parametric Fitting
	Introduction
	Library Models
	Exponentials
	Fourier Series
	Gaussian
	Polynomials
	Power Series
	Rationals
	Sum of Sines
	Weibull Distribution

	Specifying Fit Options
	Introduction
	Fitting Method and Algorithm
	Finite Differencing Parameters
	Fit Convergence Criteria
	Coefficient Parameters

	Example: Rational Fit
	Example: Robust Fitting

	Creating Custom Models
	Custom Models vs. Library Models
	Creating Custom Models
	Linear Equations
	General Equations

	Editing and Saving Custom Models
	Example: Legendre Polynomial
	Example: Fourier Series
	Example: Gaussian with Exponential Background

	Nonparametric Fitting
	Introduction
	Example: Nonparametric Fitting


	Interactive Surface Fitting
	Fitting a Surface
	Introducing the Surface Fitting Tool
	How to Fit a Surface
	Opening the Surface Fitting Tool
	Selecting Data
	Selecting Compatible Size Data
	Troubleshooting Data Problems

	Refining Your Fit
	Removing Outliers
	Selecting Validation Data
	Exploring and Customizing Plots
	Using Rotation, Data Cursor, and Outlier Exclusion
	Customizing the Fit Display


	Interactive Surface Fitting Examples
	Franke Data Interactive Surface Fitting Example
	Biopharmaceutical Interactive Surface Fitting Example

	Selecting Fit Settings
	Introduction
	Selecting Fit Category
	Using Center and Scale Setting
	Using Interpolant Fit Category
	Using Polynomial Fit Category
	Defining Polynomial Terms for Polynomial Fit Category

	Using Lowess Fit Category
	Using Custom Equation Fit Category

	Fitting Multiple Surfaces 
	Introduction
	Fitting Additional Surfaces
	Duplicating a Surface Fit
	Deleting a Surface Fit

	Comparing Surface Fits
	Introduction
	Displaying Multiple Fits Simultaneously
	Displaying Surface, Residual, and Contour Plots
	Surface Plot
	Residuals Plot
	Contour Plot

	Using the Statistics in the Table of Fits

	Generating Code and Exporting Fits to the Workspace
	Introducing Programmatic Surface Fitting
	Generating Code from the Surface Fitting Tool
	Exporting a Fit to the Workspace

	Working with Sessions
	Overview
	Saving Sessions
	Reloading Sessions
	Removing Sessions


	Programmatic Curve and Surface Fitting
	Introducing Programmatic Curve Fitting
	Using Curve Fitting Objects and Methods
	Interactive Code Generation

	Curve Fitting Objects and Methods
	Overview
	Curve Fitting Objects
	Curve Fitting Methods
	Workflow for Object-Oriented Fitting
	Examples
	Example: Smoothing Data I
	Example: Smoothing Data II
	Example: Excluding Data
	Example: Specifying Fit Options
	Example: Robust Fitting
	Example: Differentiating and Integrating a Fit
	Example: Prediction Intervals


	Generating Code From Curve Fitting Tool
	Overview
	The Generated Code
	Running the Generated File
	Components of the Generated File
	Modifying the Code

	Programmatic Surface Fitting
	Surface Fitting Objects and Methods
	Overview
	Surface Fitting Objects and Methods

	Automotive Fuel Efficiency Programmatic Surface Fitting Example
	Load and Preprocess Data
	Fit and Plot Surfaces of Fuel Efficiency
	Create a Table from the Surface

	Biopharmaceutical Drug Interaction Programmatic Surface Fitting 
	Load Data
	Create Model Fit Type
	Fit a Surface to Algometry
	Fit a Surface to Tetany
	Fit a Surface to Sedation
	Fit a Surface to Laryingoscopy



	Curve Fitting Techniques
	Data Transformations
	Filtering and Smoothing
	Moving Average Filtering
	Savitzky-Golay Filtering
	Local Regression Smoothing
	Lowess and Loess
	The Local Regression Method
	Robust Local Regression

	Smoothing Splines

	Least-Squares Fitting
	Introduction
	Error Distributions
	Linear Least Squares
	Weighted Least Squares
	Robust Least Squares
	Nonlinear Least Squares

	Residual Analysis
	Introduction
	Computing Residuals
	Goodness-of-Fit Statistics
	Sum of Squares Due to Error
	R-Square
	Degrees of Freedom Adjusted R-Square
	Root Mean Squared Error

	Confidence and Prediction Bounds
	Calculating and Displaying Confidence Bounds
	Calculating and Displaying Prediction Bounds

	Example: Residual Analysis

	Interpolants

	Spline Fitting
	Getting Started with Splines
	Introducing Spline Fitting
	Spline Overview
	Interactive Spline Fitting
	Programmatic Spline Fitting

	Curve Fitting Toolbox Splines and MATLAB Splines
	Curve Fitting Toolbox Splines
	MATLAB Splines

	Expected Background
	Technical Conventions
	Vectors
	Naming Conventions
	Arguments for Curve Fitting Toolbox Spline Functions

	Acknowledgments

	Some Simple Spline Examples
	Introduction
	Cubic Spline Interpolation
	Cubic Spline Interpolant of Smooth Data
	Periodic Data
	Other End Conditions
	General Spline Interpolation
	Knot Choices
	Smoothing
	Least Squares

	Using the Spline Fits
	Vector-Valued Functions
	Fitting Values at N-D Grid
	Fitting Values at Scattered 2-D Sites

	Types of Splines
	Introduction
	Polynomials vs. Splines
	ppform
	B-form
	Knot Multiplicity
	B-Spline Properties
	Constructive vs. Variational
	Multivariate Splines
	Rational Splines

	The ppform
	Introduction
	ppform
	Construction
	Available Commands

	The B-form
	Introduction
	B-form
	B-Splines
	Knot Multiplicity
	Choice of Knots
	Splines
	Construction
	Example: A Spline Curve
	Available Commands

	Tensor Product Splines
	Introduction
	B-form
	Construction and Use
	ppform
	Example: The Mobius Band

	NURBS and Other Rational Splines
	Introduction
	Example: Circle
	Example: Sphere
	rsform: rpform, rBform
	Available Commands

	The stform
	Introduction
	Properties of the stform
	Available Commands

	Advanced Spline Examples
	Least-Squares Approximation by “Natural” Cubic Splines
	Problem
	General Resolution
	Need for a Basis Map
	A Basis Map for “Natural” Cubic Splines
	The One-line Solution
	The Need for Proper Extrapolation
	The Correct One-Line Solution
	Least-Squares Approximation by Cubic Splines

	A Nonlinear ODE
	Problem
	Approximation Space
	Discretization
	Numerical Problem
	Linearization
	Linear System to Be Solved
	Iteration

	Construction of the Chebyshev Spline
	What Is a Chebyshev Spline?
	Choice of Spline Space
	Initial Guess
	Remez Iteration

	Approximation by Tensor Product Splines
	Choice of Sites and Knots
	Least Squares Approximation as Function of y
	Approximation to Coefficients as Functions of x
	The Bivariate Approximation
	Switch in Order
	Least Squares Approximation as Function of x

	Approximation to Coefficients as Functions of y
	The Bivariate Approximation
	Comparison and Extension


	Splines Glossary
	Introduction
	List of Terms


	Function Reference
	Fitting Curves and Surfaces
	Data Preprocessing
	Data Fitting
	Fit Type Methods
	Curve Fit Methods
	Surface Fit Methods
	Fit Postprocessing
	Information and Help

	Fitting Splines
	Spline GUI Access
	Spline Construction
	Spline Operators
	Spline Breaks, Knots, and Sites
	Spline Utilities


	Functions — Alphabetical List
	Bibliography
	Index

	tables
	Default Starting Points and Constraints
	Expected Buchanan Votes in Palm Beach County
	Legendre Polynomials up to Fourth Degree
	Types of Confidence and Prediction Bounds
	Types of Prediction Bounds
	Interpolant Methods


